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About This Guide

This guide explains how to configure and manage My webMethods Server as a system
administrator. The guide explains how, as a My webMethods Administrator (not the
same as a system administrator), you can manage users, groups, and roles for the
applications that run on My webMethods Server. In addition, the guide describes how to
develop and manage pages for display by My webMethods Server.

Software AG Command Central
Software AG Command Central is a tool that release managers, infrastructure engineers,
system administrators, and operators can use to perform administrative tasks from
a single location. Command Central can assist with the following configuration,
management, and monitoring tasks:

Infrastructure engineers can see at a glance which products and fixes are installed,
and where. Engineers can also easily compare installations to find discrepancies.

System administrators can configure environments using a single web UI, command-
line tool, or API so maintenance can be performed with a minimum of effort and
risk.

Release managers can prepare and deploy changes to multiple servers using
command-line scripting for simpler, safer lifecycle management.

Operators can monitor server status and health, as well as start and stop servers
from a single location. They can also configure alerts to be sent to them in case of
unplanned outages.

For more information about Software AG Command Central, see the Command Central
documentation.
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Exporting My webMethods Server Assets
For information on extracting My webMethods Server assets for use with Deployer, see
the "MWS Runtime Assets" topic in the webMethods CAF Development Help.

Document Conventions

Convention Description

Bold Identifies elements on a screen.

Narrowfont Identifies storage locations for services on webMethods
Integration Server, using the convention folder.subfolder:service .

UPPERCASE Identifies keyboard keys. Keys you must press simultaneously
are joined with a plus sign (+).

Italic Identifies variables for which you must supply values specific to
your own situation or environment. Identifies new terms the first
time they occur in the text.

Monospace
font

Identifies text you must type or messages displayed by the
system.

{ } Indicates a set of choices from which you must choose one. Type
only the information inside the curly braces. Do not type the { }
symbols.

| Separates two mutually exclusive choices in a syntax line. Type
one of these choices. Do not type the | symbol.

[ ] Indicates one or more options. Type only the information inside
the square brackets. Do not type the [ ] symbols.

... Indicates that you can type multiple options of the same type.
Type only the information. Do not type the ellipsis (...).
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Online Information
Software AG Documentation Website

You can find documentation on the Software AG Documentation website at hp://
documentation.softwareag.com. The site requires Empower credentials. If you do not
have Empower credentials, you must use the TECHcommunity website.

Software AG Empower Product Support Website

You can find product information on the Software AG Empower Product Support
website at hps://empower.softwareag.com.

To submit feature/enhancement requests, get information about product availability,
and download products, go to Products.

To get information about fixes and to read early warnings, technical papers, and
knowledge base articles, go to the Knowledge Center.

Software AG TECHcommunity

You can find documentation and other technical information on the Software AG
TECHcommunity website at hp://techcommunity.softwareag.com. You can:

Access product documentation, if you have TECHcommunity credentials. If you do
not, you will need to register and specify "Documentation" as an area of interest.

Access articles, code samples, demos, and tutorials.

Use the online discussion forums, moderated by Software AG professionals, to
ask questions, discuss best practices, and learn how other customers are using
Software AG technology.

Link to external websites that discuss open standards and web technology.

http://documentation.softwareag.com
http://documentation.softwareag.com
https://empower.softwareag.com
https://empower.softwareag.com/Products/default.asp
https://empower.softwareag.com/KnowledgeCenter/default.asp
http://techcommunity.softwareag.com
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Introduction to My webMethods Server
My webMethods Server is a run-time container for functions made available by
webMethods applications. The user interface in which you perform these functions
is called My webMethods. My webMethods provides a ready-made environment in
which users can perform functions on webMethods applications, and administrators
can manage access to those functions. In addition, My webMethods Server gives you
the capability to develop additional user interface pages, and a broad-based set of
administrative tools with which to manage the increased capabilities.

My webMethods Server recognizes two types of administrators, based on the functions
they perform:

Administrator Description

My webMethods
Administrator

The default administrator of My webMethods. This
user can perform user management functions and
manage external directory services. As installed,
the user ID is “Administrator and the password is
“manage. For more information about functions
available to this user, see " My webMethods
Administrator Functions" on page 81.

System administrator The system administrator for My webMethods
Server. This user can manage My webMethods
Server, including analysis, configuration, content,
and user management. As installed, the user ID
is “SysAdmin and the password is “manage. This
administrator does not use the My webMethods
user interface. For more information about
functions available to this account, see "System
Administrator Functions" on page 205.

In some cases, both types of administrator can perform the same functions, such as
performing user management. Where there are differences between the My webMethods
and system user interfaces, the procedures describe both.

This guide is organized into multiple parts:

These activities... Are described here...

Geing started as an administrator,
changing the configuration of My
webMethods Server, using external

"Startup and Configuration" on page
19
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These activities... Are described here...
web servers, and running servers from
the command line.

Managing users, groups and roles as a
My webMethods Administrator.

" My webMethods Administrator
Functions" on page 81

Managing the advanced capabilities
of My webMethods Server as a system
administrator.

"System Administrator Functions" on
page 205

Developing and managing user
interface pages.

"Server Page Development" on page
317

For additional information:

These activities... Are described here...

Installation and initial configuration of
My webMethods Server.

Installing webMethods and Intelligent
Business Operations Products

The basic activities an individual user
can perform on My webMethods
applications.

Working with My webMethods

Starting My webMethods Server on Windows
If My webMethods Server is configured on Windows computers as a service, you can
start it with this command.

To start My webMethods Server on a Windows host

1. Open the Control Panel and double-click the Administrative Tools icon.

2. In the Administrative Tools window, double-click the Services icon.

3. In the Services window, double-click the service named Software AG My
webMethods Server 9.8.

If there is more than one instance of the service, the second instance has an index
value of (2), the third instance has an index value of (3), and so forth.

4. Click Start.

After a few seconds, the status changes to Started.
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For information on controlling My webMethods Server from the command line, see
"Running My webMethods Server from the Command Line" on page 51.

Stopping My webMethods Server on Windows
If My webMethods Server is configured on Windows computers as a service, you can
stop it with this command.

To stop My webMethods Server on a Windows host

1. Open the Control Panel and double-click the Administrative Tools icon.

2. In the Administrative Tools window, double-click the Services icon.

3. In the Services window, double-click the service named Software AG My
webMethods Server 9.8.

If there is more than one instance of the service, the second instance has an index
value of (2), the third instance has an index value of (3), and so forth.

4. Click Stop.

After a few seconds, the status changes to Stopped.

For information on controlling My webMethods Server from the command line, see
"Running My webMethods Server from the Command Line" on page 51.

Getting Started as an Administrator
The following sections describe some basic functions you can perform to get started
using My webMethods Server:

Functions Described here...

Log in "Logging Into My webMethods Server
" on page 24

Log out "Logging Out of My webMethods
Server " on page 25

Change your password "Changing the Administrator
Password" on page 26

Logging Into My webMethods Server
My webMethods Server has a user interface that you access using a web browser.



M
Odd Header

Getting Started with My webMethods Server

Administering My webMethods Server Version 9.8 25

To log into My webMethods Server

1. Access the My webMethods Server Login page by entering a URL in a web browser:
http://host :port

where:

host  is the host name of the machine on which My webMethods Server is
installed.

port  is the port on which My webMethods Server listens for incoming requests.
The default port for My webMethods Server is 8585.

For example, if the host name isrubicon.company.com and it uses the default port
(8585), type the following URL:
http://rubicon.company.com:8585

2. User Name and Password fields:

If you are... User Name Password

My webMethods
Administrator

Administrator manage

System administrator SysAdmin manage

Note: When logging in, the value you specify in the user name is case insensitive.
However, after logging in, My webMethods Server uses the case of the
user name that is defined in your user account. For example, if the user
account is defined as “Administrator, you can log in using “administrator.
When My webMethods Server needs to use the user name, for example, for
HTTP authentication, it uses the version defined in the user account, which
is “Administrator.

Important: To keep My webMethods Server secure, you should change the default
administrator password. For instructions about how to change the
password, see "Changing the Administrator Password" on page 26.

3. Click Login.

After you log in, My webMethods Server displays the Administrator home page.

Logging Out of My webMethods Server
Perform the following procedure to log out of My webMethods Server.

To log out of My webMethods Server

Click the Logout link, which is located at the top of all My webMethods pages.
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Changing the Administrator Password
Change your password by editing the fields on the User Information panel of your profile.

To change your password

1. Click My Profile, located at the top of all My webMethods pages.

2. On the User Information  panel, type your new password in the Password field.

3. In the Confirm Password field, type your new password again for confirmation.

4. Click Apply.
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Post-Installation Configuration Changes
When you install My webMethods Server, it has a default configuration. You can
specify the type and location of the database used by the server and the HTTP port the
server uses, but nothing else. After the installation is completed and you have a default
instance of My webMethods Server running, you can make changes to the configuration,
a few of which are shown here:

Configuration change Where to find more information

Change the HTTP port or add an
HTTPS port for an external web server.

"Changing Listener Ports" on page
30

Change the levels of logging messages
collected by the server

"Controlling Server Logging" on page
250

Add or remove components deployed
with the server

"Installing Portlets or Other
Deployable Server Components"
on page 279 and "Uninstalling
Portlets or Other Deployable Server
Components" on page 280

Add server instances on the same
machine

"Guidelines for Multiple My
webMethods Server Instances" on page
29 and "Creating a New Server
Instance" on page 58

The My webMethods Server Embedded Database
Under some circumstances, you can configure My webMethods Server during
installation to use an embedded database instead of an external RDBMS. You can use the
embedded database when you are:

Installing My webMethods Server for the sole purpose of running the Broker
Messaging user interface in My webMethods.

Installing My webMethods Server for the sole purpose of running Command
Central.

Not installing My webMethods Server in a production environment.

Not clustering instances of My webMethods Server.

If you are installing My webMethods Server for any other purpose, you must use an
external RDBMS.
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Important: You cannot later switch to write data to an external RDBMS instead of the
embedded database.

Important: My webMethods Server uses Derby, a file-based database, as its embedded
database. If one database file gets corrupted, the entire database might
become unusable. Software AG therefore recommends backing up the
My webMethods Server_directory\MWS\server\server_instance \data\db
folder regularly so you will be able to return to the last known good state
if necessary. If you do not take a backup, you can restore the database to
an empty state from the My webMethods Server_directory\MWS\server
\template-derby.zip\data\db directory.

Did You Install Without Specifying a Database?
It is possible to install My webMethods Server without either the embedded database or
an external database. In this case, if you want to use an external database, you need to
configure a database connection for My webMethods Server before the server will start.
To set or modify external database connections, use the mws.db.xml file, which you can
find at this location:

Software AG_directory\MWS\server\server_name \config

You need to specify the following values:

Element Value

<URL> The URL to the database server

<USER> The database user name

<PASSWORD> The password of the database user

After you save and close the ms.db.xml file, start My webMethods Server.

Guidelines for Multiple My webMethods Server Instances
You can run multiple instances of My webMethods Server on the same machine, but
each server instance must have its own external resources. This is not the same as
clustering, which is described in " My webMethods Server Clustering" on page 171.
The following guidelines apply to running two or more server instances on the same
machine:

Each My webMethods Server instance must have its own database; for a given
database server, the following configuration entries must be unique among all My
webMethods Server instances that use the same database server:
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Database user name

Database name or tablespace name

For My webMethods Server instances running concurrently on the same machine,
the following host/port number combinations, if used, must be unique among all
servers:

HTTP port. The default is 8585.

HTTPS port (if used).

Java Management Extensions (JMX) port. The default is 5002.

Changing Listener Ports
You can change the HTTP listener port or add an HTTPS listener port for an external
web server. Management of listener ports takes place in Cluster Administration.

Note: In you are using webMethods Monitor and configure My webMethods Server
to use anything other than the default listening port of 8585, you will get
an Access Denied error on the Administration > Business Processes (Monitor
portlet) page. To resolve this issue, you need to enter the correct non-default
port number in the MWS SAML Resolver URL value defined on the Settings >
Resources page of the Integration Server Administrator.

Changing the HTTP Listener Port for a Standalone Server
To change only the HTTP listener port for a standalone server instance

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Cluster Settings > Basic Configuration.

As system administrator: Administration Dashboard > Configuration > Cluster
Administration > Basic Configuration.

2. In the HTTP PORT field, type the new port number and click Submit.

3. Restart My webMethods Server for the new seing to take effect.

Changing HTTP and HTTPS Listener Ports
To change HTTP and HTTPS listener ports for a server instance

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Cluster Settings > Advanced or Cluster Configuration.
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As system administrator, click Administration Dashboard > Configuration > Cluster
Administration > Advanced or Cluster Configuration.

2. In the HTTP PORT field, type the port number to be used by the HTTP listener.

This field must always have a valid port number.

3. In the HTTPS PORT field, type the port number to be used by the HTTPS listener.

A value of 0 (zero) in this field disables the listener.

The default digital certificates use by the HTTPS Listener are described in
"Certificates Used for Secure Connections" on page 38.

4. Click Submit to save your seings.

5. Restart My webMethods Server for the new seing to take effect.

Changing the JMX Listener Port
The default Java Management Extensions (JMX) listener port is 5002. If
multiple instances of My webMethods Server are running on the same
computer, or if some other application is already using that port, you need to
assign a different port number. You can change the JMX listener port in the
com.softwareag.jmx.connector.pid-5002.properties file.

To change the JMX listener port

1. In a text editor, open the com.softwareag.jmx.connector.pid-5002.properties file for
the server instance. You can find the file at this location:

Software AG_directory
\profiles\MWS_server_name \configuration\
com.softwareag.platform.config.propsloader

2. Edit the port= statement with the new JMX listener port number and save the file.

3. Restart My webMethods Server for the new seing to take effect.

Changing the JCR Repository RMI Listener Ports
When using a remote Java Content Repository (JCR), the connection to the JCR is
implemented using an RMI to communicate with the client My webMethods Server. My
webMethods Server uses the following ports for the JCR RMI connection:

rmiPort. The port for the RMI registry. The default port number is 10999.

rmiServerObjectPort. The port used by the remote client to communicate with the
remote object that is provided by My webMethods Server. The default port number
is 10998. A value of 0 (zero) generates a random port number.
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Important: If your server is protected by a firewall and you want to allow remote JCR
connections to My webMethods Server, you must configure your firewall
to open both the rmiPort and the rmiServerObjectPort. In that scenario, you
should use a non-zero value for the rmiServerObjectPort so that the port
number does not change every time My webMethods Server is restarted.

To change the rmiPort or rmiServerObjectPort number from the default

1. As system administrator, go to Administrative Folders > Administration Dashboard >
Configuration > CAF Application Runtime Configuration.

2. In the Keywords field, type wm_mws_config to search for the wm_mws_config
deployed application.

My webMethods Server returns the Administration application in the search results.

3. Click Administration > Web Application > Environment Entries.

4. In the rmiPort and rmiServerObjectPort fields, type new values for the port numbers
and click Apply.

Specifying the Java Location for My webMethods Server
My webMethods Server must point to a Java location. By default, My webMethods
Server points to the location of the JDK installed in the Software AG_directory/jvm
directory.

You can specify a non-default JDK or JRE to be used by My webMethods Server. If you
do so, do not delete the default JDK because it is used by the Software AG Installer.

Important: If you specify a non-default JRE or JDK, apply maintenance updates from the
appropriate vendor on a regular basis, as you would for JREs and JDKs you
install yourself.

Note: Software AG tests products only with the JDKs installed by the Software AG
Installer. If you redirect products to use a different JDK or JRE and encounter
issues, Software AG might require you to reproduce the issues with the JDK
that is installed by the Software AG Installer.

To specify a non-default JDK or JRE, you must make changes in multiple locations.

Setenv File under /MWS/bin/

You must modify the Java location specified in the setenv.bat or .sh file located here:

Software AG_directory/MWS/bin/setenv.[bat | sh]

Open the setenv.bat or setenv.sh file in a text editor. Edit the JAVA_HOME parameter
to point to the non-default JDK or JRE installation directory, then save and close the file.
For example:
set JAVA_HOME= C:\myjava17
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Setenv File under /profiles

You must modify the Java location specified in the setenv.bat or .sh file located here:

Software AG_directory/profiles/MWS_server_name /bin/setenv.[bat | sh]

Open the setenv.bat or setenv.sh file in a text editor. Edit the JAVA_EXEC parameter to
point to the non-default JDK or JRE installation directory, then save and close the file.
For example:
set JAVA_EXEC= "C:\myjava17\bin\java"

The wrapper.conf File

You must modify the Java location specified in the wrapper.conf file located here:

Software AG_directory/profiles/MWS_server_name /configuration/wrapper.conf

Open the wrapper.conf file in a text editor. Edit the wrapper.java.command parameter
to point to the non-default JDK or JRE installation directory, then save and close the file.
For example:
wrapper.java.command=C:\myjava17\bin\java

The custom_wrapper.conf File

You must modify the Java location specified in the custom_wrapper.conf file located
here:

Software AG_directory/profiles/MWS_server_name /configuration/custom_wrapper.conf

Open the custom_wrapper.conf file in a text editor. Edit the set.JAVA_HOME parameter
to point to the non-default JDK or JRE installation directory, then save and close the file.
For example:
set.JAVA_HOME=C:\\ myjava17

Managing Redirection in My webMethods Server
In My webMethods Server, when you click a buon or other action on a page, it can
result in a redirection that takes you to an external site. While redirection is a useful
feature, it has the potential to point a user to a malicious external site. Direct links
created using the Link control or the Bookmark workspace tool are not affected by this
issue.

A whitelist is a list of trusted entities, in this case trusted servers. Using the Redirection
Whitelist Administration page, you can create a whitelist containing servers to which
My webMethods Server can safely redirect a request.

By default, My webMethods Server does not allow redirection to any external site,
making it less prone to malicious exploitation. The server does allow redirection to the
cluster frontend, localhost, and the loopback address (127.0.0.1), which are required
for operation.



M
Even Header

Changing the My webMethods Server Configuration

Administering My webMethods Server Version 9.8 34

If you need to allow redirection to external servers, you can add them using the
Redirection Whitelist Administration page. Servers are identified by host name or IP
address. The whitelist is stored in the server database, making it available to all servers
in a My webMethods Server cluster.

Adding Servers to a Whitelist
You can allow redirection to an external address by adding it to the whitelist. By default,
the cluster front end, localhost, and the loopback address (127.0.0.1), are included in
the list.

To add an external address to the whitelist

1. As system administrator, click Administration Dashboard >Configuration > Redirection
Whitelist Administration.

2. Click Add Server, type in the hostname or IP address of a trusted server, click Apply,
and then click Save.

My webMethods Server will now allow URL redirection to the new server.

Removing Servers from a Whitelist
If an external address is included in the whitelist, you can remove it. By default, the
cluster front end, localhost, and the loopback address (127.0.0.1), are included in the
list and cannot be removed.

To remove an external address from the whitelist

1. As system administrator, click Administration Dashboard >Configuration > Redirection
Whitelist Administration.

2. Click the check box for the server to be removed, click Remove Server, and click Save.

The server is now removed from the whitelist.
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Using My webMethods Server as an HTTPS Client
If you want to connect My webMethods Server to a server using HTTPS, you must
set up the trusted CA store file (the cacerts file) that the JVM running in the My
webMethods Server machine uses. The trusted CA store file must contain the CA
certificates of the servers to which My webMethods Server will be issuing HTTPS
requests.

For example, if you use webMethods Monitoror the WmTaskClient Package, you must
identify the Integration Server to which My webMethods Server issues requests on
behalf of Monitor pages. If you choose to have the requests issued using HTTPS, you
must then set up the trusted CA store file of the JVM running in the My webMethods
Server machine to contain the CA certificate of the Certificate Authority that signed the
Integration Server certificate.

You import CA certificates into the trusted CA store file of the JVM using the JVM’s
keytool command. By default, the trusted CA store file is located in the following
location where Software AG_directory is the location where you installed your
webMethods o operating_system  identifies the operating system you use:

Software AG_directory
\jvm\operating_system \jre\lib\security\cacerts

For example, if you are using Windows, the location of the trusted CA store file is:

Software AG_directory
\jvm\jvm\jre\lib\security\cacerts

Importing CA Certificates
To import CA certificates into the trusted CA store file of the My webMethods Server JVM

1. Locate the CA certificate you need to add to the trusted CA store file and ensure it is
available on the machine running My webMethods Server.

2. At a command line prompt, type the following command to move to the jvm\lib
\security directory:
cd Software AG_directory \jvm\operating_system \jre\lib\security

3. Type the following command to import the CA certificate into the trusted CA store
file:
..\..\..\bin\keytool -import -v -keystore 
cacerts -file <cacert.der > -alias <aliasName >

where:

-file <cacert.der>  identifies the path and file name of the file that contains the CA
certificate you want to import
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-alias <aliasName>  assigns an alias to the certificate to identify the entry in the key
store file. Select a value that is meaningful to you.

For example, to import the CA certificate named serverCAcert.der, which is stored in
the same directory as the cacerts file, and identify the new entry in the key store file
as SERVERCA, you would use the following command:
..\..\..\bin\keytool -import -v -keystore 
cacerts -file serverCAcert.der -alias SERVERCA

4. After entering the keytool command, the command prompts you for the password
for the cacerts file. Type the password. By default, the password is changeit.

5. After entering the password, the keytool command prompts to verify that you want
to import the CA certificate. Type y for yes.

6. To ensure that the CA certificate was successfully imported into the trusted CA store
file, enter the following command:
..\..\..\bin\keytool -list -keystore cacerts

The keytool command prompts for the password for the cacerts file. Type the
password.

Example

Assume that you want the WmTaskClient Package to communicate with Integration
Server on the same computer using SSL. In this example, we use the default My
webMethods Server truststore.

1. If you have not already done so, configure My webMethods Server to use an HTTPS
port, as described in "Communicating with webMethods Applications Using
HTTPS" on page 39. For example, set the HTTPS port to 8586.

2. In Integration Server, configure the WmTaskClient Package to communicate using
the HTTPS port configured in the previous step (8586).

3. Create a temporary directory in which to store the CA certificate, such as C:\temp.

4. At a command line prompt, move to the directory of the JVM keytool command:
cd Software AG_directory \jvm\operating_system \jre\lib\security

5. Type the following command to extract the CA certificate from the default My
webMethods Server truststore:
keytool -export -alias "softwareag demo" -file c:\temp\sagca.crt 
-keystore Software AG_directory \MWS\server\default\config\ 
security\sagdemoca.jks

6. At the prompt, type the truststore password. For the default My webMethods Server
truststore, the password is manage.

7. To import the CA certificate into the trusted CA store of the JVM, type the following
command:
keytool -import -trustcacerts -file c:\temp\sagca.crt 
-alias "softwareag demo" -keystore  Software AG_directory \jvm\ 
jvm160_32\jre\lib\security\cacerts
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Note: If you are running on a 64-bit operating system, change jvm160_32 to
jvm160_64.

8. At the prompt, type the password for the trusted CA store file of the JVM. By default,
the password is changeit.

9. To verify that you want to import the CA certificate, type y for yes.

10. Restart Integration Server so it will use the new CA certificate.

Certificates Used for Secure Connections
My webMethods Server includes two default keystores you can use to set up and test
your HTTPS listener:

A keystore, which contains a key pair used to set up encrypted connections between
client and server. The default keystore file is localhost.p12, which contains a
demonstration certificate and a private key for the Jey SSL server used by My
webMethods Server.

A truststore, which contains trusted digital certificates from a certification authority
(CA). The default truststore file sagdemoca.jks contains a Software AG CA certificate
that allows one instance of My webMethods Server to trust SSL (Secure Sockets
Layer) connections from another instance, or from other webMethods products.

My webMethods Server stores these keystores at this location for each server instance:

Software AG_directory\MWS\server\server_instance \config\security\

For production environments, you can use certificates from a commercial authority such
as Verisign or use an internal authority.

Replacing Keystores
The wrapper.conf file sets the values the javax.net.ssl system properties use for
communication using SSL. You can edit the custom_wrapper.conf file to replace the
keystore or truststore for an instance of My webMethods Server.

To replace the keystore or truststore

1. Open the custom_wrapper.conf file for the server instance in a text editor. You can
find the file at this location:

Software AG_directory\profiles\MWS_server_name \configuration\

2. In the custom_wrapper.conf file, add or change the values of the SSL properties as
needed and save the file:
# SSL Properties 
set.JAVA_KEYSTORE=Software AG_directory \MWS\server\default\config 
    \security\localhost.p12 
set.JAVA_KEYSTORETYPE=pkcs12 
set.JAVA_KEYSTORE_PASSWORD=encrypted_password
set.JAVA_TRUSTSTORE=Software AG_directory \MWS\server\default\config 
    \security\sagdemoca.jksset.JAVA_TRUSTSTORETYPE= 
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    jksset.JAVA_TRUSTSTORE_PASSWORD=encrypted_password

3. Restart My webMethods Server.

To provide an encrypted password for the keystore, see "Generating an Encrypted
Password" on page 39.

Generating an Encrypted Password

When replacing keystores, you should provide an encrypted password. Use the
following procedure to generate the password, and then copy and paste it into the
appropriate location in custom_wrapper.conf file.

Note: This procedure requires the installation of a Java Development Kit (JDK),
preferably Java 7 or later. If the installed Java package is not included in
your PATH environment variable, you must run the command from the \bin
directory of your Java installation.

To generate an encrypted password

1. Open a command prompt window in the webMethods installation directory.

2. Run the following command:
java -cp common/lib/wm-caf-common.jar 
com.webmethods.caf.common.CipherUtil <password to encrypt>

3. The command returns an encrypted version of the specified password. Copy this
encrypted password and paste it into the appropriate location in the file.

Communicating with webMethods Applications Using HTTPS
By default, My webMethods Server communicates with other webMethods applications
using the HTTP protocol. You can change to the HTTPS protocol by doing the following:

To cause My webMethods Server to communicate only through the HTTPS protocol

1. In My webMethods Server do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Cluster Settings > Advanced or Cluster Configuration.

As system administrator: Administration Dashboard > Configuration > Cluster
Administration > Advanced or Cluster Configuration.

2. In the MWS Front End URL field, modify the URL as follows:

Change http to https.

Change the port number.

For example, change this URL:
http://my_host:8585



M
Even Header

My webMethods Server and HTTPS

Administering My webMethods Server Version 9.8 40

To this:
https://my_host:7238

3. In the HTTP Port field, do either of the following:

If you are running My webMethods Server as a standalone server, change the
value to 0 (zero).

If you are running My webMethods Server in a cluster, type the port number to
be used by the HTTP listener. This field must always have a valid port number.

4. In the HTTPS Port field, change the value to the port number and click Submit.

5. Restart My webMethods Server.

6. Notify administrators of all webMethods applications that communicate with My
webMethods Server of the new HTTPS port number.

Managing Authentication Certificates as My webMethods
Administrator
As My webMethods Administrator you can manage authentication certificates for users
who connect to Integration Server or other webMethods applications. Authentication
certificates do not govern a connection between a user and My webMethods Server.
To be assigned a certificate, the user must be a member of the system directory service
or an external directory service connected to My webMethods Server (see "Managing
Directory Services" on page 84).

The assignment of users to authenticates follows these rules:

A user can be assigned to multiple certificates.

An instance of a certificate can have only one user assigned to it, but you can add
multiple instances of a certificate, each with a different certificate type, and assign a
different user to each instance.

You can perform the following actions with Certificates:

Function For more information see...

Add a certificate "Adding an Authentication Certificate"
on page 41

Search for a certificate "Searching for Authentication
Certificates" on page 42

View details of a certificate "Viewing Details of an Authentication
Certificate" on page 43
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Function For more information see...

Assign a user to a certificate "Assigning a User to an Authentication
Certificate" on page 44

Change users for a certificate "Changing Users for an Authentication
Certificate" on page 44

Delete a certificate "Deleting an Authentication
Certificate" on page 45

Adding an Authentication Certificate
To add a certificate, do the following:

To add an authentication certificate

1. In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Certificates.

2. Click Add New Certificate.

3. Click Browse, navigate to the location of the certificate file you want to add, and click
Open.

4. From the Certificate Type list, choose the type authentication certificate to be used by a
client connecting to Integration Server or other webMethods application:

Certificate Type Purpose

SSL (default) Authenticates the message sender. The credentials are
supplied in the protocol header.

Verify Verifies the digital signature on incoming messages to
Integration Server.

Encrypt Encrypts outgoing messages from Integration Server.

Verify and Encrypt Both verifies the digital signature on incoming messages
and encrypts outgoing messages. Used if a user has the
same certificate for sending and receiving messages.

Message
Authentication

Authenticates the message sender. The credentials are
supplied in the message header.

5. Click Upload.
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The certificate appears on the Certificates panel.

Searching for Authentication Certificates
You can search for authentication certificates based on a number of criteria.

To perform a search for authentication certificates

1. In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Certificates > Search > Advanced.

2. Select any criteria that can define the certificate you want to find.

Criteria How to enter it

CERTIFICATE INFO  

Type Choose the certificate type assigned to the certificate.
Valid types are described in "Adding an Authentication
Certificate" on page 41. The default is Any.

Issuer Name Type the common name of the certificate issuer. This
field is not used if you leave it blank.

Serial Number Type the serial number assigned to the certificate. This
field is not used if you leave it blank.

Subject Name Type the common name of the subject. This field is not
used if you leave it blank.

VALID NOT BEFORE DATE

Range Choose a range of dates from the selection provided. The
default is All.

Start Date Type a start date using the format M/D/YYYY; if you use
an incorrect format, the border turns red. Or click the
Choose Date icon .

End Date Type an end date using the format M/D/YYYY; if you
use an incorrect format, the border turns red. Or click
Choose Date icon .

VALID NOT AFTER DATE
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Criteria How to enter it

Range Choose a range of dates from the selection provided. The
default is All.

Start Date Type a start date using the format M/D/YYYY; if you
use an incorrect format, the border turns red. Or click
Choose Date icon .

End Date Type an end date using the format M/D/YYYY; if you
use an incorrect format, the border turns red. Or click
Choose Date icon .

3. After you have selected search criteria, click Search.

Viewing Details of an Authentication Certificate
You can view the details associated with an authentication certificate.

To view the details of an authentication certificate

1. In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Certificates.

2. If the certificate is not visible in the Certificates panel, use the Search panel to locate it,
as described in "Viewing Details of an Authentication Certificate" on page 43.

3. Locate the certificate and click the Details icon .

The following details are available:

Certificate Detail Description

Type The certificate type assigned when the certificate was
added, as described in "Adding an Authentication
Certificate" on page 41.

Subject CN The common name of the host being authenticated.

Issuer CN The common name of the issuer.

Serial Number The serial number assigned to the certificate.

Valid Not Before The date before which the certificate is not valid.

Valid Not After The date after which the certificate is not valid.



M
Even Header

My webMethods Server and HTTPS

Administering My webMethods Server Version 9.8 44

Certificate Detail Description

User The user’s name.

4. To return to the list of certificates, click Close.

Assigning a User to an Authentication Certificate
You can assign only one user to an instance of an authentication certificate. The
procedure for doing so is described here. To assign the same certificate to multiple users,
add a separate instance of the certificate ("Adding an Authentication Certificate" on page
41) for each user.

To assign a user to an authentication certificate

1. In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Certificates.

2. If the certificate is not visible in the Certificates panel, use the Search panel to locate it,
as described in "Searching for Authentication Certificates" on page 42.

3. Locate the certificate and click the Details icon .

4. On the Edit Certificate area, click Set.

5. In the Keywords field, type a user ID, click Search, move the user to the Selected box,
and click Apply.

6. Click Close.

Changing Users for an Authentication Certificate
You can exchange one user for another in an existing authentication certificate.

To change users for an authentication certificate

1. In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Certificates.

2. If the certificate is not visible in the Certificates panel, use the Search panel to locate it,
as described in "Searching for Authentication Certificates" on page 42.

3. Locate the certificate and click the Details icon .

4. On the Edit Certificate area, click Set.

5. In the Keywords field, type the user ID for the new user, click Search, move the user
to the Selectedbox, and click Apply.

This action replaces the former user with the new user.

6. Click Close.
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Removing a User from an Authentication Certificate
You can remove a user who is assigned to an existing authentication certificate.

To remove a user from an authentication certificate

1. In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Certificates.

2. If the certificate is not visible in the Certificates panel, use the Search panel to locate it,
as described in "Searching for Authentication Certificates" on page 42.

3. Locate the certificate and click the Details icon .

4. On the Edit Certificate area, click Remove.

5. Click Close.

Deleting an Authentication Certificate
You can view the details associated with an authentication certificate.

To view the details of an authentication certificate

1. In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Certificates.

2. If the certificate is not visible in the Certificates panel, use the Search panel to locate it,
as described in "Searching for Authentication Certificates" on page 42.

3. In the search results, select the check boxes beside the certificates you want to delete,
and click Delete.
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Integration with Web Servers
My webMethods Server can integrate with the leading web servers, such as Microsoft
Internet Information Server or Apache HTTP Server. The primary mechanism for
integrating My webMethods Server with a third party web server in a distributed
deployment scenario requires the use of a small plug-in that is installed and configured
on the web server. This plug-in forwards HTTP requests from the web server to My
webMethods Server.

My webMethods Server provides an integrated servlet engine with Jey, which is a
built-in web server that supports both HTTP and HTTPS. As such, having a separate
web server tier is not a hard requirement.

There are several reasons for configuring My webMethods Server with an external web
server (or cluster of web servers). The most notable reason is to adhere to corporate
IT policies and procedures. My webMethods Server supports a flexible deployment
model that allows an external web server (or cluster of web servers) to handle all HTTP
requests that can be separately load balanced.

Integrating an external web server to handle HTTP requests requires configuring a
web server plug-in on the external web server machine(s). The web server plug-in
leverages code from the Jakarta web server project which is used extensively across
many production-quality web server products.

My webMethods Server and Apache
You can use My webMethods Server on UNIX platforms with the Apache HTTP Server,
from the Apache Software Foundation. If you want to use the Apache HTTP Server, you
may find these external references useful:

For information on using the Apache mod_proxy_hp module: hp://
hpd.apache.org/docs/2.2/mod/mod_proxy_hp.html

For information on using the Apache mod_proxy module: hp://hpd.apache.org/
docs/2.2/mod/mod_proxy.html

For information on using the Apache mod_proxy_balancer module: hp://
hpd.apache.org/docs/2.2/mod/mod_proxy_balancer.html

My webMethods Server and IIS
Software AG does not include Internet Information Services (IIS) components in an
installation of My webMethods Server, nor does My webMethods Server explicitly
support the use of IIS as a web server. However, if you want to use IIS, you may find
these external references useful:

http://httpd.apache.org/docs/2.2/mod/mod_proxy_http.html
http://httpd.apache.org/docs/2.2/mod/mod_proxy_http.html
http://httpd.apache.org/docs/2.2/mod/mod_proxy.html
http://httpd.apache.org/docs/2.2/mod/mod_proxy.html
http://httpd.apache.org/docs/2.2/mod/mod_proxy_balancer.html
http://httpd.apache.org/docs/2.2/mod/mod_proxy_balancer.html
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For general information and discussions on using IIS as a reverse proxy: hp://
www.iis.net/

To use IIS with Apache Tomcat: hp://tomcat.apache.org/connectors-doc/
webserver_howto/iis.html

http://www.iis.net/
http://www.iis.net/
http://tomcat.apache.org/connectors-doc/webserver_howto/iis.html
http://tomcat.apache.org/connectors-doc/webserver_howto/iis.html
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Command Syntax for My webMethods Server
There are times when it is useful to start and stop the server from the command line.
Starting the server this way, for example, allows you to use debug mode so you can
record or display server activity. There are several commands you can use to control
operation of the server, as described in the following procedure.

To control the server from the command line

1. At a command line prompt, type the following command to move to the server’s bin
directory:
cd Software AG_directory \MWS\bin

2. Type the following command:

For Windows: mws.bat -option -option ... command

For UNIX: mws.sh -option -option ... command

where option  is any of the following:

Option Description

-d[ebug] Starts the server in debug mode. DEBUG statements
appear in the console window and a Java debug listener
opens on port 10033.

-n nodename In a clustered environment, the nodename assigned to
the server instance. Not required if the server is running
standalone, or if it is the master node of a cluster. See "
My webMethods Server Clustering" on page 171 for
information on clusters.

-s server name The name of the server instance. Not required if you are
controlling the default server. You can find the server
instances on a machine by looking here:

Software AG_directory\MWS\server

and command  is any command in the following table. Note that when you execute
the following commands, you cannot add Java parameters using the command line:

- start

- stop

- restart
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- installservice

In this case, you can add these Java parameters by editing the corresponding
custom_wrapper.conf file and adding the parameters as additional properties. For
more information, see "Configuring JVM Seings for My webMethods Server " on
page 67.

Command Description

help Prints command syntax in the console window.

init Starts My webMethods Server, initializes the My
webMethods Server database, and then stops the server.

ping If the server is stopped, indicates this fact. If the server is
running, returns information, including what ports the
server is using.

restart Stops a running server and then starts it again.

run Starts the server in the same console.

start Starts the server in a new console window. On UNIX based
operating systems the process is started in background
execution mode.

stop Stops a running server.

updatesinfo Displays information about any fixes that have been
installed to My webMethods Server, the My webMethods
Server Common Library, or the user interfaces of installed
webMethods applications.

The following commands are for Windows only:

installservice Registers the server as a Windows service.

restartservice Stops a server that is registered as a Windows service and
then starts it again.

startservice Starts a server that is registered as a Windows service.

stopservice Stops a server that is registered as a Windows service.
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Command Description

uninstallservice Unregisters the server as a Windows service.

The following commands are for UNIX only:

installservice Registers the server as a UNIX service.

The following parameters are required by the command:

mws.user=<A user that MWS runs with>

platform=<suse or redhat>

The platform parameter is mandatory only when My
webMethods Server is installed on Linux based operating
systems, such as SuSE, or RedHat

uninstallservice Unregisters the server as a UNIX service.

The following parameter is required by the command:

platform=<suse or redhat>

The platform parameter is mandatory only when My
webMethods Server is installed on Linux based operating
systems, such as SuSE, or RedHat

The following commands configure or delete server instances:

delete Deletes an existing instance of My webMethods Server.
Accepts only the -s option. See "Deleting a Server Instance"
on page 61.

getconfig Downloads a configuration file from the My webMethods
Server database. See "Modifying Configuration Files Stored
in the Database" on page 71.

putconfig Uploads a configuration file to the My webMethods Server
database

new Creates a new server instance. See "Creating a New Server
Instance" on page 58.

update Used as part of a product fix, updates classpaths and
deploys new or updated components. Accepts only the -s
option.
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Command Description

Note: Use this command only as directed while installing a
fix supplied by Software AG.

Initial Server Startup
The first time you start an instance of My webMethods Server, you need to initialize
the My webMethods Server database. This requirement exists for a new installation of
the product or a new server instance that uses a separate database (see "Creating a New
Server Instance" on page 58).

To initialize a new instance of My webMethods Server

1. At a command line prompt, type the following command to move to the server’s bin
directory:
cd Software AG_directory \MWS\bin

2. At the same command prompt, initialize the server instance using this command:

For Windows: mws.bat -s servername init

For UNIX: mws.sh -s servername init

The -s servername  option is required only if this is not the default server instance.
After the database is initialized, the server automatically stops.

3. Restart My webMethods Server.

Simple Start and Stop Commands
If you want to start or stop a server, without having to use the server name or node
name as part of the command syntax, there are commands associated with each server
instance on a machine. This feature is not necessary for a standalone server, but may be
useful if you have multiple servers on a machine.

To start or stop a specific server

1. At a command line prompt, type the following command to move to the server’s
home directory:
cd Software AG_directory \MWS\server\server_instance \bin

where server_instance  is the name of the server.

2. Type one the following commands:



M
Even Header

Running My webMethods Server from the Command Line

Administering My webMethods Server Version 9.8 56

Purpose Operating system Command

Windows run.batStart the server in the same console
window

UNIX run.sh

Windows startup.batStart the server in a new console
window

UNIX startup.sh

Windows shutdown.batStop the server

UNIX shutdown.sh

Start, Stop and Execute My webMethods Server Commands
on Multiple Server Instances
If you want to start, stop, or execute a My webMethods Server command on all server
instances at one go, there are commands associated with all server instances, installed on
a machine.

To start, stop, or execute a command on all server instances

1. At a command line prompt, type the following command to move to the command’s
home directory:
cd Software AG_directory \MWS\bin

2. Type one the following commands:

Purpose Operating system Command

Windows mwsall.batExecute a command on all server
instances.

Note: the following commands are not
supported:
run
new
ant

UNIX mwsall.sh

Windows startall.batStart all server instances. The server
instances are started consequently
in alphabetical order. On Windows
operating systems, the command

UNIX startall.sh
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Purpose Operating system Command
starts a server instance as a service if
it has a registered service, otherwise
it starts the instance as a process.
On UNIX based operating systems,
the command starts the instances as
processes only.

Windows stopall.batStop the server instances. The
command calls
mws.bat (or .sh) stop

for all server instances.

UNIX stopall.sh

The OSGi Profile Commands
When using My webMethods Server from the command line, there are several
commands you can use to manage the OSGi profile for a server instance. The command
syntax is:
mws -s servername OSGi-profile-command

If the server is the default server, the -s option is not needed.

Command Description

create-osgi-profile Uses the My webMethods Server bundles to create
an OSGi profile for the specified server instance.
The profile name is the name specified by the -s
option with MWS_ preceding it.

delete-osgi-profile Deletes the OSGi profile for the specified server
instance.

deprecate-osgi-profile Renames the OSGi profile for the specified server
instance with a date and time value. You can then
use the create-osgi-profile command to create
a new profile.

update-osgi-profile Updates the OSGi profile for the specified server
instance. Resets the server name, the service name,
and the JAVA_HOME variable, and updates the
OSGi bundles associated with the server instance.
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When do I need to create an OSGi profile?

If you create a new server instance, you need to create an OSGi profile for it as well. The
create-osgi-profile command is included in "Creating a New Server Instance" on
page 58.

When do I need to update an OSGi profile?

You need to use the update-osgi-profile command when you modify the
configuration of a server instance or install a new webMethods application to run on an
existing server instance. See "The OSGi Profile Commands" on page 57.

Before updating an OSGi profile, you should consider making a backup copy of the
custom_wrapper.conf file, which is described in "Modifying Configuration Files" on
page 63.

When do I need to deprecate an OSGi profile?

When you deprecate an OSGi profile, you rename the profile so it is no longer associated
with the server instance. In this case, you use the deprecate-osgi-profile command,
followed by the create-osgi-profile command for the same server instance. It is the
equivalent of performing an update-osgi-profile command and saving a backup
copy.

When do I need to delete an OSGi profile?

Strictly speaking, either deleting the OSGi profile or deleting the server instance (mws
delete) would have the same effect. Using both commands would completely remove
the server configuration from the installation directory. Using the delete-osgi-
command this way is shown in "Deleting a Server Instance" on page 61.

Also, you could use the delete-osgi-profile command, followed by the create-
osgi-profile command for the same server instance. It is the equivalent of performing
an update-osgi-profile command.

Before deleting an OSGi profile, you should consider making a backup copy of the
custom_wrapper.conf file, which is described in "Modifying Configuration Files" on
page 63.

Creating a New Server Instance
You can run multiple instances of My webMethods Server on the same machine, but
each server instance must have its own external resources. For more information, see
"Guidelines for Multiple My webMethods Server Instances" on page 29.

When you start a new instance of My webMethods Server the first time, it takes about
five minutes to initialize.The server then stops and restarts automatically.

Use the following command-line syntax to create an instance of My webMethods Server
on the current machine.
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Note: Unless you are using the embedded database, the four db.xxx  parameters are
required. If you do not include them, the command will fail.

To create an instance of My webMethods Server from the command line

1. If you have not already done so, use the Database Component Configurator to create
a unique database or tablespace for this server instance, as described in Installing
webMethods and Intelligent Business Operations Products . This step is not required if
the server is using the embedded database.

2. At a command line prompt, type the following command to move to the server’s bin
directory:
cd Software AG_directory \MWS\bin

3. Type the following command:
mws new [-Dparameter =value ...]

where parameter  is any of the following:

Parameter Description

server.name Name of the server instance. The default server name
is default.

http.port Port number on which the server instance listens.
Must be unique among server instances on the
machine. The default port number is 8585.

db.type (Required for all but embedded database) The type of
database used by the server instance. The choices are:

 ms Microsoft SQL Server

 oracle Oracle

 db2 DB2

db.url (Required for all but embedded database) Database
connection URL, based on the type of database and
the driver. See the following example.

db.username (Required for all but embedded database) User name
assigned to the My webMethods Server database.

db.password (Required for all but embedded database) Password of
the My webMethods Server database user.
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Parameter Description

https.port (Optional) The HTTPS listener port. A value of 0
disables the listener.

debug.port (Optional) The Java debug port. The default port
number is 10033.

http.proxy.host (Optional) The proxy host name.

http.proxy.port (Optional) The proxy port number.

http.proxy.user (Optional) The proxy user name.

http.proxy.password (Optional) The proxy password.

http.proxy.hosts (Optional) Bypass proxy hosts. Separate the entries
omiing any spaces and using a vertical bar(|
symbol).

server.features The set of component features configured with the
server instance: The choices are:

 core The minimum set of features needed
to support development of JSR 168
portlets using Software AG Designer.
This is a pure runtime, with a single
skin and shell, and no administration or
configuration features.

 default The standard set of My webMethods
Server features, but without extras or
development tools found in the MWS/
components folder. This is the default
value.

 fabric The default My webMethods Server
taxonomy with all installed My
webMethods Server user interfaces.

 all The standard set of features plus
all components found in the MWS/
components folder.
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The command creates the instance of My webMethods Server based on the input
parameters you have provided.

4. At the same command prompt, create the new OSGi profile for the server instance
using this command:
mws -s server_name  create-osgi-profile

The -s servername  option is required only if this is not the default server instance.

5. Restart My webMethods Server.

Examples:

Example with an external database:

Server name: test
HTTP port: 8090
Database server (SQL Server): db_server
Database name: my_wm_msql
Database user name: mws_user
Database password: password
> mws new -Dserver.name=test -Dhttp.port=8090 
-Ddb.type=ms -Ddb.url=jdbc:wm:sqlserver:db_server:1433; 
DatabaseName=my_wm_msql;SelectMethod=direct;MaxPooledStatements=100 
-Ddb.username=mws_user -Ddb.password=password 
[Configuration output displayed in console window....] 
> mws -s test run

Same example, but with the embedded database:
> mws new -Dserver.name=test -Dhttp.port=8090

Deleting a Server Instance

Important: When you issue this command, there is no confirmation before the delete
operation takes place. Use this command with extreme caution.

To delete an instance of My webMethods Server from the command line

1. Stop the My webMethods Server instance.

See "Command Syntax for My webMethods Server " on page 52.

2. At a command line prompt, type the following command to move to the server’s bin
directory:
cd Software AG_directory \MWS\bin

3. Type this command:
mws -s server_name  delete

where server_name  is the name of the server to be deleted.
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Example:
> mws -s test delete

Log Files for mws Commands
Every time you issue one of the mws commands from the command line, My
webMethods Server creates a log file of information wrien to the console. The
command name takes this form:

command-name _server-instance .log

where:

command-name  is the name of the mws command.

server-instance  is the name of the server instance affected by the command.

For example, if you issue this command:

mws -s alpha create-osgi-profile

The resulting log file has the name create-osgi-profile_alpha.log.

The log files are wrien to this location:

Software AG_directory\MWS\bin

When you issue an mws command and a log file for that command already exists, My
webMethods Server completely overwrites the existing log file. If you want to maintain
the old log file, make a backup copy of it before reissuing the command.

If the mws command is unsuccessful, one quick way to check the log file is to search for
the existence of this exit code:
ExitCode: 13

Following that code, you should find the missing requirement, possibly am missing
bundle or feature ID. If you cannot find an obvious reason for the failure, be prepared to
make a copy of the log file available to Software AG Global Support.
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The Java Service Wrapper
My webMethods Server runs on the on the Software AG Common Platform, which in
turn runs in a Java Virtual Machine (JVM). The Java Service Wrapper is an application
developed by Tanuki Software, Ltd. It is a utility program that launches the JVM in
which My webMethods Server runs.

In addition to launching the JVM, the Java Service Wrapper offers features for
monitoring the JVM, logging console output, and generating thread dumps. The
following sections describe how My webMethods Server uses the features of the Java
Service Wrapper. For an overview of the Java Service Wrapper, see the webMethods
cross-product document, Working with the webMethods Product Suite and the Java Service
Wrapper.

The Java Service WrapperConfiguration Files
For My webMethods Server, the configuration files for the Java Service Wrapper reside
in the following directory.

Software AG_directory/profiles/MWS_instanceName /configuration

When you start My webMethods Server, property seings in the following files
determine the configuration of the JVM and the behavior of the logging and monitoring
features of the Java Service Wrapper.

File name Description

wrapper.conf Contains property seings that are installed by My
webMethods Server.

Do not modify the contents of this file unless asked to do
so by Software AG.

custom_wrapper.conf Contains properties that modify the installed seings in
wrapper.conf.

If you need to modify the property seings for the Java
Service Wrapper, you make your changes in this file.

wrapper.conf.template Contains seings that are applied to the wrapper.conf file
when My webMethods Server is updated or upgraded.
Do not modify this file.

The file is located here:

Software AG_directory\MWS\server\server_name \config\
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JVM Configuration
When the Java Service Wrapper launches the JVM, it provides configuration seings
that, among other things, specify the size of the Java heap, the size of the PermGen area,
and the directories in the classpath.

The JVM Configuration Properties
The wrapper.java properties in the Java Service Wrapper configuration files determine
the configuration of the JVM in which My webMethods Server runs.

The JVM property seings that My webMethods Server installs are suitable for most
environments. However, you can modify these properties if the installed seings do
not suit your needs. For procedures and additional information, see "Configuring JVM
Seings for My webMethods Server " on page 67.

The Wrapper Log
My webMethods Server has its own logging mechanism, described in "Controlling
Server Logging" on page 250. In addition, the Java Service Wrapper records console
output in a log file. The log contains the output sent to the console by the wrapper itself
and by the JVM in which My webMethods Server runs. The wrapper log is especially
useful when you run My webMethods Server as a Windows service, because console
output is normally not available to you in this mode.

The Java Service Wrapper log for My webMethods Server is located in the following file:

Software AG_directory\profiles\MWS_server_name \logs\wrapper.log

To view the log, open the log file in a text editor.

The Logging Properties
The wrapper.console and wrapper.log properties in the wrapper configuration files
determine the content, format, and behavior of the wrapper log.

The logging seings that My webMethods Server installs are suitable for most
environments. However, you can modify the following properties if the installed
seings do not suit your needs. For procedures and additional information, see the
webMethods cross-product document, Working with the webMethods Product Suite and the
Java Service Wrapper.

Property Value

wrapper.logfile.maxsize Maximum size to which the log can grow.

wrapper.logfile.maxfiles Number of old logs to maintain.
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Fault Monitoring
The Java Service Wrapper can monitor the JVM for the specified conditions and then
restart the JVM or perform other actions when it detects these conditions.

The following table describes the fault-monitoring features My webMethods Server uses
or allows you to configure. To learn more about these features, see the webMethods
cross-product document, Working with the webMethods Product Suite and the Java Service
Wrapper.

Feature Enabled? User configurable?

JVM timeout Yes Yes. See the wrapper.ping properties in
"Configuring My webMethods Server Seings"
on page 67.

Deadlock detection No Yes. See the wrapper.check.deadlock
properties in "Configuring Wrapper JVM
Checks" on page 69.

Console filtering Yes Yes. See "Console Filtering Properties" on page
66.

Console Filtering Properties
The wrapper.filter properties in the wrapper configuration files determine whether
the wrapper monitors the console for specified messages. My webMethods Server
installs pre-defined filters that monitor the console for certain messages. For information
about the installed filters, see "Configuring JVM Out-of-Memory Checks" on page
69.

You can add additional filters to the Java Service Wrapper using the following
properties. See the webMethods cross-product document, Working with the webMethods
Product Suite and the Java Service Wrapper for procedures and additional information.

Property Value

wrapper.filter.trigger.n String of text that you want to detect in
the console output.

wrapper.filter.action.n Action that occurs when the Java Service
Wrapper detects the string of text.

wrapper.filter.allow_wildcards.n Flag (TRUE or FALSE) that specifies
whether the Java Service Wrapper



M
Odd Header

Modifying Configuration Files

Administering My webMethods Server Version 9.8 67

Property Value
processes wildcard characters that
appear in wrapper.filter.trigger.n .

wrapper.filter.message.n Message that displays when the Java
Service Wrapper detects the string of
text.

Generating a Thread Dump
The Java Service Wrapper provides a utility for generating a thread dump when My
webMethods Server is running as a Windows service. A thread dump can help you
locate thread contention issues that can cause thread blocks or deadlocks.

For information about generating a thread dump using the Java Wrapper Service, see the
webMethods cross-product document, Working with the webMethods Product Suite and the
Java Service Wrapper.

Configuring JVM Settings for My webMethods Server
The following topics describe modifications you can make to JVM seings. To modify
JVM seings, you make changes to the custom_wrapper.conf file.

To modify JVM settings

1. In a text editor, open the custom_wrapper.conf file for the server instance. You can
find the file at this location:

Software AG_directory\profiles\MWS_server_name \configuration\

2. Add or modify statements as needed and save the file.

3. Restart My webMethods Server for the new seing to take effect.

Configuring My webMethods Server Settings
You can use the custom_wrapper.conf file to configure the following seing for a My
webMethods Server instance:

Parameter Value Description

wrapper.ping.timeout= 120 If set to 0, the wrapper will
never time out, but a real
indicator whether the server
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Parameter Value Description
is suspended will not exist
either.

Setting Initial and Maximum Memory Limits
You can configure the initial and maximum amount of memory that is allocated by
the JVM at startup. The Java Service Wrapper uses these parameters, shown with their
default values:

Parameter Value in megabytes

wrapper.java.initmemory= 128

wrapper.java.maxmemory= 1024

To use the default values that are configured in the JVM itself, specify zero (0) in the
properties of the custom_wrapper.conf file. For example:
wrapper.java.maxmemory=0

Note: If you specify a value for the wrapper.java.initmemory memory property,
make sure that it is smaller than the value of thewrapper.java.maxmemory
property.

Raising the Maximum Memory Limit on UNIX

On UNIX or Linux systems, if My webMethods Server fails to initialize, you may need
to increase the maximum amount of available memory or the maximum open files
limit. This need can occur if you have multiple language packs installed, or if there are
multiple webMethods components installed on the server.

In the custom_wrapper.conf file, specify the maximum memory limit in megabytes. To
double the maximum available memory, for example, change this value:
wrapper.java.maxmemory=1024

to this:
wrapper.java.maxmemory=2048

Each UNIX platform has its own method for configuring Open File limits. Here is an
example on how to increase the maximum Open Files limit parameters on Linux:
ulimit -c unlimited 
ulimit -n 8192

Check with your administrator to make these changes on Linux or other UNIX
platforms.
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For information on editing this custom_wrapper.conf, see "Configuring JVM Seings for
My webMethods Server " on page 67.

Configuring Wrapper JVM Checks
The Java Service Wrapper can perform internal detection of deadlock threads or out of
memory conditions within the JVM. By default, the deadlock detection is disabled in the
My webMethods Server service and if you want to use this functionality, you need to
enable it manually in the custom_wrapper.conf file.

The following table describes the available parameters.

Parameter Default
Value

Description

wrapper.check. deadlock= FALSE Controls the operating state of the
functionality.

wrapper.check.deadlock.
interval=interval

60 Controls the deadlock detection
interval in seconds.

wrapper.check.deadlock.
action=action

RESTART Controls the action if a deadlock
condition occurs.

wrapper.check.deadlock.
output=output

FULL Controls the output of the
wrapper. Valid values are:

FULL

SIMPLE

NONE

Configuring JVM Out-of-Memory Checks
You can configure the properties that control and resolve the out-of-memory conditions
by filtering the console output of the JVM. These properties use this syntax:
wrapper.filter.element .<n> =parameter

The number n  starts from one and increases by one for each consecutive element. As a
rule, the chain of additional parameters must start at 1 and be consecutive. However, if
you enable wrapper.ignore_sequence_gaps property, the sequence can be broken.

The following table describes the available parameters, the recommended values, and
the corresponding descriptions.
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Parameter Recommended Value Description

wrapper.filter.
trigger.n=

java.lang.OutOfMemory
Error

Enables a query for
an out-of-memory
condition on the console
output of the JVM.

wrapper.filter.
action.n=

RESTART Controls the action if
the configured filter is
met (an out-of-memory
condition occurs).

wrapper.filter.
message.n=

The JVM has run out
of memory.

Controls the message
that is displayed if the
filter is met (an out-
of-memory condition
occurs).

Additional JVM Parameters
There are some parameters that do not relate to My webMethods Server but to the JVM
itself. These parameters use this syntax:
wrapper.java.additional.n =parameter

The number n  starts from one and increases by one for each consecutive element. As a
rule, the chain of additional parameters must start at 1 and be consecutive. For example:
# Java Additional Parameters 
wrapper.java.additional.1=-Dosgi.install.area="%OSGI_INSTALL_AREA%" 
wrapper.java.additional.2=-Declipse.ignoreApp=true 
wrapper.java.additional.3=-Dosgi.noShutdown=true

The following table describes some available parameters.

Parameter and Description

wrapper.java.additional.n=-XX:MaxPermSize=size

The permanent generation space available in the JVM. The default is 128m

wrapper.java.additional.n=-DproxySet=true

Starts the program without a graphical user interface window.

wrapper.java.additional.n=-Dhttp.proxyHost=host_name

The host name of the proxy server.
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Parameter and Description

wrapper.java.additional.n=-Dhttp.proxyPort=port_number

The port number on the proxy server.

wrapper.java.additional.n=-Dhttp.proxyUser=user_name

A user name used for authentication.

wrapper.java.additional.n=-Dhttp.proxyPassword=password

A password used for authentication.

wrapper.java.additional.n=-Dhttp.nonProxyHosts=bypass_hosts

A list of hosts that should be reached directly, bypassing the proxy. Entries are
separated by a vertical bar ( | ).

Modifying Configuration Files Stored in the Database
Many configuration files that could be found in the directory structure of earlier versions
of My webMethods Server are now stored in the server database. You can get those
configuration files from the database using the mws getconfig command.

Most of the configuration files are stored in the My webMethods Server database
by default, instead of in the local file system. To edit any My webMethods Server
configuration file, you need to download the file from the database. The following table
shows the files you can download using the mws getconfig command.

Note: File names and file contents are case sensitive.

Configuration file Purpose

cache.xml Increase cache size.

cluster.xml Contain configuration data for each node in a
cluster.

defaultPortletAppWeb.xml Modify properties of a web application.

defaultPartitionPortlets.properties List the portlets affected by the phase
provider for the default cluster partition.
If you have multiple cluster partitions,
it is possible to have multiple portlets
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Configuration file Purpose
properties files, each having the file name
partition_name PortletsProperties.xml

email.properties Configure email servers.

iconMap.properties Map mime types (Content types) to icons
located in the ui\images directory.

jey.xml Configure the Jey server.

log4j.init.properties Turn internal debugging on or off (Apache
Log4J logging package).

log4j.override.properties Modify properties of the Apache Log4J
logging package.

logging.properties Customize logging folders, paerns, and so
forth.

mimeTypes.properties Customize mime types.

perfUtil.properties Enable and disable the performance service

phaseProvider.xml Modify the server polling interval. If
you have multiple cluster partitions,
it is possible to have multiple phase
provider files, each having the file name
partition_name PhaseProvider.xml.

storageConfig.xml Configure content services.

systemPaths.properties Configure the location of logs or the temp
folder.

systemProperties.properties Contain persisted System.properties.

defaultPortletAppWeb.xml Modify properties of a web application.

email.properties Configure email servers.

Note: It is not necessary that a My webMethods Server instance be running, but the
My webMethods Server database needs to be running.
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To edit configuration files for My webMethods Server

1. At a command line prompt, type the following command to move to the server’s bin
directory:
cd Software AG_directory \MWS\bin

2. To retrieve a configuration file from the My webMethods Server database, type this
command:
mws getconfig file name

where file name  is the name of the configuration file you intend to edit.

For example:
mws getconfig cluster.xml
mws getconfig logging.properties

3. Open the downloaded configuration file in a text editor and modify it as needed.

You can find the file at this location:

Software AG_directory\MWS\server\server_name \config

4. To deploy the revised file to the My webMethods Server database, type this
command:
mws putconfig file name

5. Delete the file from the \server_name \config directory.

If you do not delete the file, this server instance will continue to use the local version
of the configuration file.

6. Restart the node using this command:
mws -s server_name  restart

Changes to configuration files are not applied until after a restart.

Configuring My webMethods Server to Run in 32-bit on
Solaris, HP-UX, or Linux
On Solaris, HP-UX, or Linux systems, it is necessary to specify whether the computer
has a 32- or 64-bit architecture. By default, My webMethods Server is configured to run
in 64-bit mode. You can switch the server to 32-bit mode.

To configure My webMethods Server to run in 32-bit mode on Solaris or HP-UX

1. Use this command to stop My webMethods Server:
mws -option  stop

Options are described in "Command Syntax for My webMethods Server " on page
52.

2. Open this file in a text editor:
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Software AG_directory/MWS/bin/setenv.sh

3. Locate this text:
rem to use 64 bit JVM uncomment next line 
set JAVA_D64=-d64

and comment the second line:
rem to use 64 bit JVM uncomment next line 
rem set JAVA_D64=-d64

4. Save and close the file.

5. Use this command to update the OSGi profile:
mws -option  update-osgi-profile

6. Restart My webMethods Server.

Configuring Role or Group Cache Lifecycle Calculation
By default, the role cache or group cache for a user is recalculated on every user login.
Conditions in which the calculation involves user or group searches that take a long
time can result in poor performance in My webMethods Server and in LDAP servers
to which it is connected. A configuration option in the cache.xml file enables the role
cache or group cache to be persisted across user log-ins, causing large performance
improvements.

Because the roles are no longer calculated at user login, this optimization modifies the
dynamic role capability. With the default seing, where the roles are calculated at user
login, the user gains or loses role changes at that time. With the new seing, if a dynamic
query role changes the results, the user does not immediately get the change. Role
changes made by the system administrator will, however, be recognized. In this mode,
static roles function correctly with the new seing. Dynamic roles do not return expected
changes until an administrator changes role membership or adds a description, or until
the various caches time out.

Under optimization, because My webMethods Server does not control group definition,
the Group cache is not updated until the cache entry times out or a system restart occurs.
If users change group membership frequently, group cache optimization may not be
desirable.

The choice of whether to perform role cache or group cache recalculation at login is a
trade-off between performance and functionality.

To configure role cache or group cache lifecycle calculation

1. At a command line prompt, type the following command to move to the server’s bin
directory:
cd Software AG_directory \MWS\bin

2. To retrieve the cache.xml file from the My webMethods Server database, type the
following command:
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mws getconfig cache.xml

3. Open the downloaded cache.xml file in a text editor and modify it as needed.

You can find the file at this location:

Software AG_directory\MWS\server\server_name \config

4. Open the cache.xml file in a text editor and locate the cache.

Role cache:
<cache name="RoleCache" 
class="com.webmethods.portal.service.cache.impl.RoleCache" 
    maxSize="1000" 
    defaultCacheTimeout="3600000" 
    roleCacheLifecycle="0" 
    isClustered="true" 
    ID="11" 
    enabled="true"/>

Group cache:
<cache name="GroupCache" 
class="com.webmethods.portal.service.cache.impl.GroupCache" 
    maxSize="1000" 
    defaultCacheTimeout="3600000" 
    groupCacheLifecycle="0" 
    isClustered="true" 
    ID="19" 
    enabled="true"/>

5. Modify the value of roleCacheLifecycle or groupCacheLifecycle as needed:

Value Action

0 (Default) Causes the cache to be recalculated at user login.

1 Causes the cache to be persisted across user logins.

6. Save and close the file.

7. To deploy the revised file to the My webMethods Server database, type the following
command:
mws putconfig cache.xml

8. Delete the file from the \server_name \config directory.

If you do not delete the file, this server instance will continue to use the local version
of the configuration file.

9. Restart the node using the following command:
mws -s server_name  restart

Changes to configuration files are not applied until after a restart.
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Configuring HTTP Listeners to Use a Single IP Address
My webMethods Server binds its listener ports on all available IP addresses. When
you have installed My webMethods Server on server hardware with multiple network
interfaces, you can bind the HTTP listener ports to a single IP address, as described in
the following topics.

Configuring Jetty Listeners to Use IP Addresses
Jey creates several listening ports on the My webMethods Server.

Ports for HTTP, HTTPS, and Apache JServ Protocol (AJP)

Random socket acceptor ports for HTTP, HTTPS, and AJP

If you have installed My webMethods Server on server hardware with multiple
network interfaces, you can bind the HTTP listener ports to a single IP address. Use this
procedure to configure a specific IP address to the port used by the Jey listeners.

Configuring the Jey listening ports requires specifying the IP addresses in the
jetty.xml configuration file.

To configure specific IP addresses to be used by Jetty listeners

1. Open the jetty.xml file in an editor, go to the HTTP, HTTPS, or AJP connectors
element.

2. In each element, look for the following property set.

<Set name="Host">0.0.0.0</Set>

When the value is 0.0.0.0, Jey can use all available IP addresses.

3. Replace the 0.0.0.0 value to bind a listener to a specific IP address.

Configuring IP Addresses in GLUE Web Services Registry
If your instance of My webMethods Server has Central Configuration installed, the
GLUE web services registry was created to use a range of ports from 16000 to 16025.
You configure the IP address in the GlueServiceRegistryProperties.xml file to use a
specific IP address.

If you have installed My webMethods Server on server hardware with multiple
network interfaces, you can bind the HTTP listener ports to a single IP address. Use this
procedure to configure a specific IP address to the port used by the GLUE web services
registry.
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To configure a specific IP address

1. Go the installation directory for My webMethods Server, navigate to MWS/server/
default/config/engine, and open the GlueServiceRegistryProperties.xml file in
an editor.

2. Look for the following property:

<entry key="service.address">0.0.0.0</entry>

3. Replace the value, 0.0.0.0, with the IP address.

Configuring an IP Address for the SOAP Monitor Portlet
The SOAP Monitor portlet that is used to debug issues with web service calls from other
portlets opens port 5001.

If you have installed My webMethods Server on server hardware with multiple network
interfaces, you can bind the HTTP listener ports to a single IP address.

In the custom_wrapper.conf file, specify a value for the following parameter:
wrapper.java.additional.203=-Dsoap.monitor.bind.address=IP-address |host name

where IP-address  or host name  is the IP address or host name of the SOAP Monitor
portlet listener.

For information on editing this file, see "Configuring JVM Seings for My webMethods
Server " on page 67.

Configuring an IP Address for the JCR Repository RMI Server
When using a Java Content Repository (JCR), the connection to the JCR is implemented
using an RMI to communicate with My webMethods Server. The default JCR listener
port is 10999.

If you have installed My webMethods Server on server hardware with multiple network
interfaces, you can bind the HTTP listener ports to a single IP address.

In the custom_wrapper.conf file, specify a value for the following parameter:
wrapper.java.additional.204=-Dmws.jcr.rmi.bind.address=IP-address |host name

where IP-address  or host name  is the IP address or host name of the JCR repository RMI
server listener.

For information on editing this file, see "Configuring JVM Seings for My webMethods
Server " on page 67.
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Configuring My webMethods Server on Multi-Home Machines
If you are configuring My webMethods Server on multi-home machines (that is,
machines that have multiple network interfaces and IP addresses), follow the steps
below to bind My webMethods Server listeners to a single IP address.

1. Shut down My webMethods Server.

2. Bind the HTTP, HTTPS, and AJP listeners to the IP address as described below.
Perform the steps for only one server instance. When you save the changes to the My
webMethods Server database, they will take effect for all server instances.

a. Go to the Software AG_directory /MWS/bin directory, open a command window,
and run the following command:
mws.{bat|sh} -s instance_name  getconfig jetty.xml

b. Go to the Software AG_directory /MWS/server/instance_name /config directory and
open the jey.xml file in a text editor.

c. For each listener, remove the following element if present:
<Set name="host"><Property name="jetty.host" /></Set>

Add the following element:
<Set name="host">IP_address </Set>

d. Save the changes to the My webMethods Server database by running this
command:
mws.{bat|sh} -s instance_name  putconfig jetty.xml

e. Go to the Software AG_directory /MWS/server/instance_name /config directory and
delete the jey.xml file.

3. For each cluster node, go to the Software AG_directory /MWS/server/instance_name /
config/engine directory, open the GlueServiceRegistryProperties.xml file, and specify
the IP address on the following element:
<entry key="service.address">IP_address </entry>

4. For each cluster node, bind the SOAP monitor and JCR servers to the IP address as
follows:

a. Go to the Software AG_directory /profiles/MWS_instance_name /configuration
directory and open the wrapper.conf and custom_wrapper.conf files.

b. Specify values for the following parameters:
wrapper.java.additional.203=-Dsoap.monitor.bind.address=IP_address |host name

where IP-address  or host name  is the IP address or host name of the SOAP
Monitor portlet listener.
wrapper.java.additional.204=-Dmws.jcr.rmi.bind.address=IP_address |host name

where IP-address  or host name  is the IP address or host name of the JCR
repository RMI server listener.
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5. The JMX server will not use the wrapper.conf directive to bind to an IP address, so
you must specify the binding in the JMX connector properties file instead. For each
cluster node, do the following:

a. Go to the Software AG_directory /profiles/MWS/instance_name /configuration/
com.softwareag.pl atform.config.propsloader directory and back up the
com.softwareag.jmx.connector.pid-500number .properties file.

b. Open the file and add the following line:
host=IP_address

6. Restart My webMethods Server.

Configuring Whether Diagnostics Are Executed at Startup
By default at startup, My webMethods Server performs the following diagnostic actions:

Determines the fixes that have been applied to My webMethods Server

Executes the dbintegritycheck tool that searches for potential database errors

You can prevent My webMethods Server from performing one or both of
these diagnostic actions by updating the phaseProvider.xml configuration file.
The phaseProvider.xml configuration file is located in the database or under
My webMethods Server_directory\server\server instance \config.

Preventing My webMethods Server from Listing Installed Fixes at
Startup
My webMethods Server determines the installed fixes at server startup and logs the list
of installed fixes to the _full_.log file.

Because determining the list of fixes might take a few minutes, you might want to
disable this action at server startup. To prevent My webMethods Server from listing
installed fixes at startup, edit the startupDiagnostics section of the phaseProvider.xml
configuration file as shown below.
<Phase class="com.webmethods.portal.system.init.impl.DefaultPhase" 
              enabled="true" name="startupDiagnostics"> 
      <PhaseInfo class="com.webmethods.portal.system.impl.UpdatesInfo" 
              enabled="false" name="updatesInfo"/> 
   . 
   . 
   . 
</Phase>
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Preventing My webMethods Server from Executing dbintegritycheck
at Startup
The My webMethods Server automatically executes the dbintegritycheck tool at startup
and logs the results to the _full_.log file. The dbintegritycheck tool reviews the dynamic
business objects (DBOs) deployed to My webMethods Server to search for potential
errors that might have occurred if a DBO was installed or upgraded incorrectly.

Although it is recommended that you keep this action enabled, you can prevent My
webMethods Server from executing dbintegritycheck at startup. To do so, edit the
startupDiagnostics section of the phaseProvider.xml configuration file as shown
below.
<Phase class ="com.webmethods.portal.system.init.impl.DefaultPhase" 
      enabled="true" name="startupDiagnostics"> 
   <PhaseInfo 
      class="com.webmethods.portal.system.impl.DbIntegrityCheckLauncher" 
      enabled="false" name="dbIntegrityCheck"/>     . 
   . 
   . 
</Phase>
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Overview of My webMethods Configuration
You can perform the following configuration functions as My webMethods
Administrator or as a system administrator.

This function... Is described here...

Manage internal and external directory
services.

"Managing Directory Services" on page
84

Connect to external data sources (such
as databases) to make them available to
My webMethods Server.

"Managing External Data Sources" on
page 100

Configure the mail server seings used
by the server when processing email.

"Managing Email Seings" on page
108

Manage My webMethods Server
clusters.

" My webMethods Server Clustering"
on page 171

Where there are differences between the My webMethods and system user interfaces,
the procedures describe both.

Managing Directory Services
A directory is similar to a database in that it contains a collection of entries (in this case,
individuals), each of which has a set of aributes, such as names, email addresses, and
so forth. A directory service provides a mechanism for delivering information about the
entries in the directory.

My webMethods Server includes an internal directory service. However, if you are
using an external directory (for example, if you are using Lightweight Directory Access
Protocol (LDAP), you can configure My webMethods Server to also access user and
group information from the external directory service.

Internal directory service. The internal directory service that is provided with My
webMethods Server is called the system directory service. My webMethods Server
stores information about users, groups, and roles that you define in this system
directory service to the My webMethods Server database.

Use the system directory service if you need to maintain only a moderate number
of users and groups. When you install My webMethods Server, the users described
in the following table are automatically defined in the system directory service.
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For instructions about how to change passwords for these users, see "Editing
Information for a User" on page 124.

User Name Description

My
webMethods
Administrator

The default administrator of My webMethods. This user can
perform user management functions and manage external
directory services. As installed, the user ID is Administrator and
the password is "manage".

Important: Change the password for this user.

System
Admin

The system administrator for My webMethods Server. This
user can manage My webMethods Server, including analysis,
configuration, content, and user management. As installed,
the user ID is SysAdmin and the password is "manage". This
administrator does not use the My webMethods user interface.
For more information about functions available to this account,
see "System Administrator Functions" on page 205.

Important: Change the password for this user.

Deleted
Items

A user account that is used internally by My webMethods Server
to store work done by a user with administrative privileges
when that user is deleted from the system. As installed, the user
account is DeletedItems and the password is "manage".

Important: For security reasons, change the password for this user.

Designer The page designer for My webMethods Server. This user has
privileges My webMethods Server similar to those of the system
administrator. As installed, the user ID is Designer and the
password is "manage". For more information about functions
performed by this account, see "Server Page Development" on
page 317.

Important: Change the password for this user.

Guest An anonymous user. This user can read pages that allow
anonymous access, such as the login page. Otherwise, this user
cannot read, modify, or delete content unless permission is
explicitly granted by an administrator. As installed, the user ID
for this user is Guest.

Portal
Developer

Portal Developer. This user can customize the look and feel of
the portal user interface by modifying shells and skins. Can
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User Name Description
develop portal pages and add content. As installed, the user ID
for this user is PortalDev and the password is "password".

Important: For security reasons, change the password for this user.

webMethods
System

A user account that is used internally by My webMethods
Server to invoke web services. My webMethods Server uses
this account for web service authentication from one server to
another. As installed, the user account is WEBM_SYSUSER and
the password is "manage".

Important: Do not delete this user account. For security reasons,
change the password for this user. Changes to the
password for this account must be provided to
administrators for webMethods applications that use it
when communicating with My webMethods Server.

webMethods
Cluster

A user account that is used internally by My webMethods Server
for authentication among servers in a cluster. As installed, the
user account is WEBM_CLUSTERUSER and the password is
"manage".

Important: Do not delete this user account. For security reasons,
change the password for this user on one node of the
cluster and then restart all nodes for the password to take
effect.

External directory services. In addition to the system directory service, My webMethods
Server can support multiple external directory services, allowing you to manage a
much larger and diverse group of users. If your company has one or more directory
services, My webMethods Server can connect to those services. In addition, you can
use a database as a directory service.

Note: During login, conditions in which the role cache or group cache calculation
involves user or group searches that take a long time can result in poor
performance in My webMethods Server and in LDAP servers to which it
is connected. See "Configuring Role or Group Cache Lifecycle Calculation"
on page 74.

Setting Up the Internal System Directory Service
No set up is required for the internal system directory service beyond configuring
the My webMethods Server database. Configuring the database was required during
the installation of My webMethods Server, as described in Installing webMethods and
Intelligent Business Operations Products
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Managing External Directory Services
You can perform the following functions for external directory services:

Function... For more information, see...

Identify an external LDAP, ADSI, or
ADAM directory service.

"Configuring an External LDAP, ADSI,
or ADAM Directory Service" on page
87

Identify an external database directory
service.

"Configuring an External Database
Directory Service" on page 94

Allow users defined in an external
directory access to My webMethods.

"Allowing Externally Defined Users to
Perform Actions from My webMethods
" on page 96

Update the properties defined for an
external directory service.

"Updating the Configuration for a
Directory Service" on page 98

Modify the order in which My
webMethods Server searches directory
services for information.

"Updating the Search Order for Search
Directory Services" on page 99

Delete the configuration for a directory
service to stop My webMethods Server
from using the directory service.

"Deleting a Directory Service
Configuration" on page 100

Configuring an External LDAP, ADSI, or ADAM Directory Service
Use the following procedure to configure My webMethods Server to use an external
LDAP, ADSI, or ADAM directory service.

To configure an external LDAP, ADSI, or ADAM directory service

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Directory Services > Create New Directory Service.

As system administrator: Administration > User Management > Directory Services
Administration > Create New Directory Service.

2. In Directory Type field: the option that describes the type of directory service:
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This option... Configures this type of directory service...

LDAP Lightweight Directory Access Protocol. An internet protocol that
allows client programs to query LDAP directory servers about
entries using their aributes.

ADSI Active Directory Service Interfaces. A set of interfaces for
querying and manipulating objects in Microsoft Active Directory,
providing an LDAP view of the objects. Active Directory is tightly
coupled with the Windows operating system.

ADAM Active Directory Application Mode, a standalone directory server
offered by Microsoft. ADAM is an LDAP implementation that can
be installed and uninstalled without affecting the Active Directory
structure of a network.

3. Click Next.

4. Fill in the appropriate form fields for the directory service you want to add. You
should be prepared to provide the following information:

Section Property Description

Name A name to identify the external directory service.
My webMethods Server uses this name when it
needs to identify the external directory service in
the user interface.

General

Description (Optional) A descriptive comment about the
external directory service.

 Keywords One or more keywords to be used in searching
for external directory services.

Cache Capacity The number of database queries you want to
cache. The default is 1000.

Cache

Cache Timeout The length of time that queries should remain in
the cache unless the cache capacity is exceeded.
The default is 1 hour.

Connection
Information

Service Enabled Specifies whether the service is active. Seings
are:

Yes. This service is enabled (the default)
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Section Property Description

No. This service is disabled

Connection
Error Threshold

The number of connection errors that should
occur before the service is disabled. The default
is 10.

Provider URL The URL for the external directory service using
this syntax:

ldap://host_name :port_number

For example: ldap://my_host:389

Base DN The base distinguished name for the
external directory service. For example,
ou=mywebMethods,o=webmethods.com

Groups DN (Optional) The distinguished name for a group.

User DN (Optional) The base distinguished name to find
groups or users, which might be a different
location then the distinguished name specified
for Base DN.

Security
Principal

The distinguished name required to log in to the
external directory service.

Security
Credentials

The password required to log in to the external
directory service.

Failover URLs Other LDAP servers that the system can use
in the event that the primary LDAP server
(identified by Provider URL) fails. If you specify
more than one failover provider URLs, separate
each with a space.

Search Timeout The maximum length of time (in seconds) that
the system allows an LDAP query to run before
the query times out. If you do not want the query
to time out, specify 0. The default is 0.

 Enable Default
Wildcard
Searches

Specifies whether you want to enable wildcard
searches.

Yes. Enable default wildcard searches (the default)
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Section Property Description

No. Disable default wildcard searches

Disabling wildcard searches might help
performance for large servers. By default, all
queries have wildcards appended. When using
wildcards, servers do not use any internal
indexes for search performance.

 Enable Group
Across Directory
Service

If you have multiple external directory services
configured on My webMethods Server, the
server can query for group membership across
all of the configured directory services. This
feature is useful for large organizations that have
multiple directory services but need to support
group memberships that span those services.
Enabling this option can noticeably degrade
login performance.

No. Group Across Directory Service (the default)

Yes. Enable Group Across Directory Service

See "Group Membership across Directory
Services" on page 93.

 Enable
GroupQuickSearch

(Active Directory only) Enables the server to
determine the group membership of a user
using one query instead of a recursive search.
Users must be members of an Active Directory
security or regular group. Enabling this option
can noticeably improve login performance.

No. Do not use GroupQuickSearch (the default)

Yes. Enable GroupQuickSearch

 ActiveDirectory
Domain URLs

(Active Directory only) Enables you to specify
multiple Active Directory Domain URLs,
separated by spaces.

Advanced
Object
Filters

User Object
Filter

Specifies an LDAP query that My webMethods
Server applies to all queries when searching
for users. Use a technical ldap query that limits
the type of objects that are exposed via My
webMethods Server.
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Section Property Description

Note: It is recommended that you examine the My
webMethods Server directory debug logs to
ensure that the query is working correctly.

 Group Object
Filter

Specifies an LDAP query that My webMethods
Server applies to all queries when searching for
groups. Use a technical ldap query that limits
the type of objects that are exposed via My
webMethods Server.

Note: It is recommended that you examine the My
webMethods Server directory debug logs to
ensure that the query is working correctly.

User Object
Class

The User Object Class aribute for the external
directory service.

User ID The User ID aribute for the external directory
service.

First Name The First Name aribute for the external
directory service.

Last Name The Last Name aribute for the external
directory service.

Full Name The Full Name aribute for the external
directory service.

E-mail Address The Email Address aribute for the external
directory service.

User
Attributes

Password The Password aribute for the external directory
service.

 User Disabled (Optional) The name of an aribute in the
external directory service that identifies a user as
being disabled.

 User Disabled
Value Regex

(Optional) A regular expression used to evaluate
the User Disabled aribute for the external
directory service.
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Section Property Description

Group Object
Class

The Group Object Class aribute for the external
directory service.

Group ID The Group ID aribute for the external directory
service.

Group Name The Group Name aribute for the external
directory service.

Group Members The Group Members aribute for the external
directory service.

Group
Attributes

Group E-mail The Group Email aribute for the external
directory service.

Minimum
Connections

The minimum number of connections to the
external directory service that you want kept
open at all times.

Maximum
Connections

The maximum number of connections to the
external directory service that you want open at
any time.

Note: In some LDAP implementations, the
paging cookie is bound to a specific LDAP
connection. Make sure the maximum
connections value is large enough to handle
concurrent LDAP searches and the maximum
connection time value is long enough to
ensure that searches can be finished.

Connection
Pool

Maximum
Connection Time

The maximum amount of time you want to allow
an open connection to the external directory
service before the connection is recycled. The
server resets this time for each LDAP search to
make sure the same LDAP connection stays alive
during the search process.

 Auto Reconnect Whether you want My webMethods Server to
automatically reconnect to the directory service
server if the connection to the server is closed,
for example, if there is a network outage or if the
server is shut down for planned maintenance.
Select the Auto Reconnect check box if you
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Section Property Description
want My webMethods Server to automatically
reconnect when the server becomes available.

 Clean Up
Interval

The interval between times My webMethods
Server cleans up expired LDAP connections.

5. At the boom of the page, click Finish.

Tip: To test your configuration to ensure you have correctly configured the
external directory service, perform a query to search for users or groups
that are defined in the external directory service. For instructions for how
to perform a query, see "Searching for Existing Users, Groups, or Roles" on
page 112.

Group Membership across Directory Services
If you have multiple LDAP, ADSI, or ADAM directory services configured on My
webMethods Server, the server can query for group membership across all of the
configured directory services. This feature is useful if Users need to be in a branch of the
Directory Tree that is distant enough from Groups that it is inefficient to have only one
directory service mounted at a root that encompasses both users and groups. Instead,
you might configure two directory services. One service points at the root of the User
branch while the other points at the root of the Group branch. For example, you might
have a directory structure similar to this:

o=MyCompany, ou=Americas, ou=US, ou=Groups
o=MyCompany, ou=Americas, ou=US, ou=Users
o=MyCompany, ou=Americas, ou=Mexico, ou=Groups
o=MyCompany, ou=Americas, ou=Mexico, ou=Users
and so forth....

My webMethods Server would not perform well with a single directory service
pointing to o=MyCompany. Instead the administrator might create multiple directory
services pointing to ou=Americas and other regional OUs. But suppose that Groups
can have members from multiple regions, as might be common in large international
organizations. In that case, it is possible for the membership of a Group to span multiple
directory services.

To make it possible to query for group membership across all configured directory
services, set Enable Group Across Directory Service for each directory service to Yes. Enable
Group Across Directory Service.

Note: Enabling this feature can noticeably degrade login performance.
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Configuring an External Database Directory Service
Use the following procedure to configure My webMethods Server to use an external
database directory service.

Note: To use a database directory service, you must first connect to the database
as an external data source. See "Managing External Data Sources" on page
100.

To configure an external database directory service

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Directory Services > Create New Directory Service.

As system administrator: Administration > User Management > Directory Services
Administration > Create New Directory Service.

2. In Directory Type field, click Database:

3. Click Next.

4. Fill in the appropriate form fields for the database directory service. You should be
prepared to provide the following information:

Section Property Description

Name A name to identify the external database
directory service. My webMethods Server
uses this name when it needs to identify the
external database directory service in the
user interface

General

Description (Optional) A descriptive comment about the
external database directory service.

User ID The name of the query field containing the
user ID value.

User DN The name of the query field containing the
distinguished name value for the user.

Attributes

User First Name The name of the query field containing the
user first name.
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Section Property Description

User Last Name The name of the query field containing the
user last name.

User Full Name (Optional) The name of the query field
containing the user full name. If you do not
supply an aribute, the full name is derived
from the User First Name and User Last Name
aributes.

User E-mail (Optional) The name of the query field
containing the user email address.

User Disabled (Optional) The name of an aribute in the
external directory service that identifies a
user as being disabled.

User Disabled Value
Regex

(Optional) A regular expression used to
evaluate the User Disabled aribute for the
external directory service.

Group ID The name of the query field containing the
group ID value.

Group DN The name of the query field containing the
distinguished name value for the user.

Group Name The name of the query field containing the
group name.

Group E-mail (Optional) The name of the query field
containing the group email address.

Configuration Authentication
Handler

The page that handles authentication for
the database. By default, My webMethods
Server provides a clear-text authentication
handler.

Database Datasource The database to be used as a data store. For
a database to appear in the list, you must
first use the DataSource Administration
page to connect to the external database.
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Section Property Description

Query Lookup User
by ID

A SQL query that returns a user record
based on the user ID.

This query must return all user aributes, as
described under Attributes in this table.

Query Authenticate A SQL query that returns persisted user
credentials for authentication.

Various queries (Optional) You can define several additional
SQL queries, as needed. Sample language is
provided for each type of query.

Cache Enabled Determines whether My webMethods
Server will aempt to save the load on the
database by using cached data whenever
possible. Select:

Yes to enable caching

No to disable caching

Cache Capacity The number of database queries you want
to cache. The default is 1000.

Cache

Cache Timeout The length of time that queries should
remain in the cache unless the cache
capacity is exceeded. The default is 1 day.

5. At the boom of the page, click Finish.

Tip: To test your configuration to ensure you have correctly configured the
external directory service, perform a query to search for users or groups
that are defined in the external directory service. For instructions for how
to perform a query, see "Searching for Existing Users, Groups, or Roles" on
page 112.

Allowing Externally Defined Users to Perform Actions from My
webMethods
By configuring an external directory service, you provide My webMethods Server
with the information it needs to connect to and retrieve information from the external
directory service. After configuring the external directory service, users defined in
the external directory service will be able to log into My webMethodsbut will not have
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permission to do anything else. You need to take the following additional steps to allow
users to perform actions from My webMethods:

Create one or more LDAP query roles or database roles to identify the users who
should be granted access to My webMethods, described in Creating a Role to Define
Externally Defined Users You Want to Access My webMethods  next in this chapter.

Add the roles you have created to the My webMethods Users role, described in
"Adding a Role to the My webMethods Server Users Role" on page 97.

Creating a Role to Define Externally Defined Users You Want to Access My
webMethods
For each external directory service that you configure, create one or more roles that
identify the users or groups of users that you want to allow access to My webMethods
Server.

For an LDAP, ADSI, or ADAM directory service, create an LDAP query role.

For a database directory service, create a database role.

To create a role to identify users who will be granted access to My webMethods

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System Wide > User
Management > Roles > Add Role.

As system administrator: Administration Dashboard > User Management > Manage
Roles > Add Role.

2. In the Role Name field, specify the name you want to assign to the new role, for
example, “SystemX-My webMethods Users.

3. To specify the type of role you want to create, move it to the Selected Items box:

LDAP Query Role Provider—LDAP, ADSI, or ADAM directory service

Database Role Provider—database directory service

4. Click Create Role.

5. Specify the membership for the role. For more information about how to define the
membership:

For an LDAP, ADSI, or ADAM directory service, see "Adding an LDAP Query
Role" on page 160.

For a database directory service, see "Adding a Database Role" on page 164.

6. Click Save.

Adding a Role to the My webMethods Server Users Role
To grant those users who are identified by the roles you created access to My
webMethods, add the roles to the My webMethods Server Users role.
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To grant users access to My webMethods

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System Wide > User
Management > Roles.

As system administrator: Administration Dashboard > User Management > Manage
Roles.

2. In the Keyword text box, type My webMethods Users, and click Search.

3. In the search results panel, click Edit for the My webMethods Users role.

4. Click the Members tab.

5. Click Edit Members.

6. Search for the principals you want to add and for each you want to make a member
of the My webMethods Users role, move the role name to the Selected panel.

7. After you have selected all roles that identify users you want to assign to the My
webMethods Users role, click Apply.

8. Click Save to make the membership changes to the My webMethods Users role.

Updating the Configuration for a Directory Service
After you initially configure an external directory service or database directory service,
you might need to update the values you specified for one or more of the properties. Use
the following procedure to update the values of properties associated with a directory
service.

To update the configuration for a directory service

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Directory Services > List Directory Services.

As system administrator: Administration Dashboard > User Management > Directory
Services Administration > List New Directory Services.

2. On the List Directory Services panel, do one of the following:

Click the name of the directory service configuration you want to modify.

Click the Tools icon  (  in My webMethods) for the directory service
configuration and then click Properties.

3. Make your changes to the properties for the directory service.

4. After making your changes, click Apply.
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Updating the Search Order for Search Directory Services
Some actions that you can perform using My webMethods Server can result in the
system querying multiple directory services. Use the following procedure to order your
directory services to control the order in which My webMethods Server searches your
directory services.

To update the order in which My webMethods Server searches external directory services

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Directory Services > Modify Directory Search Order.

As system administrator: Administration Dashboard > User Management > Directory
Services Administration > Modify Directory Search Order.

My webMethods Server searches the external directory services in the order they
are listed in the Select list.

2. To reorder the list, move directory services up or down as needed.

3. After you have set the search order, click Apply.

4. Restart Integration Server for the changes to take affect.

Note: Seing the search order does not affect the order in which My webMethods
Server displays directory services in lists throughout the user interface.

Disabling User Accounts
You can prevent users from logging into My webMethods Server based on the value of a
specified aribute in an external directory service.

Note: webMethods products that use Common Directory Services for
authentication, such as Integration Server and Optimize are affected by this
feature. A user disabled in My webMethods Server is disabled in those other
products as well.

To disable user accounts for an external directory service.

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Directory Services > List Directory Services.

As system administrator: Administration Dashboard > User Management > Directory
Services Administration > List New Directory Services.

2. On the List Directory Services panel, do one of the following:
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Click the name of the directory service.

Click the Tools icon  (  in My webMethods) for the directory service and then
click Properties.

3. Locate the properties needed to disable user accounts.

For an LDAP, ADSI, or ADAM directory service, look in the User Attributes
section.

For a database directory service, look in the Attributes section.

4. In the User Disabled field, type the name of the aribute in the external directory
service that will determine the User Disabled status.

The exact value is dependent on the external directory service and the class of users
you want to disable.

5. In the User Disabled Value Regex field, type a regular expression to match against the
value of the User Disabled property. When the value matches, the user is disabled

6. After making your changes, click Apply.

Deleting a Directory Service Configuration
If you no longer want My webMethods Server to have access to users and groups
defined in an external directory service, you can delete the configuration information for
that external directory service using the following procedure.

To delete the configuration for an external directory service

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Directory Services > List Directory Services.

As system administrator: Administration Dashboard> User Management > Directory
Services Administration > List Directory Services.

2. Click the Tools icon  (  in My webMethods) for the directory service
configuration and then click Delete.

Managing External Data Sources
On the Data Source Administration page, you can connect to external data sources (such
as databases) and make them available to My webMethods Server. Before you can create
and use a database directory service, for example, you need to configure the data source.

The Data Source Administration page supports connections to Microsoft SQL Server,
Oracle, DB2 Universal, Sybase Adaptive Server, or Informix databases. There are also
options for configuring ODBC and custom connections.
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Note: Before you configure a data source for connecting to DB2 Universal, Sybase
Adaptive Server, or Informix databases, you must have a corresponding
database driver for each respective database application. My webMethods
Server distribution does not include database drivers for DB2 Universal,
Sybase Adaptive Server, or Informix databases.

You can connect the following external data sources to My webMethods Server:

External data source... For more information, see...

Microsoft SQL Server "Adding a Microsoft SQL Server Data Source" on
page 101

Oracle "Adding an Oracle Data Source" on page 102

DB2 Universal "Adding a DB2 Universal Data Source" on page
103

Sybase Adaptive Server "Adding a Sybase Adaptive Server Data Source" on
page 103

Informix "Adding an Informix Data Source" on page 104

Generic ODBC "Adding a Generic ODBC Data Source" on page
105

Custom JDBC "Adding a Custom Data Source" on page 105

You can perform the following additional functions for external data sources:

Function... For more information, see...

Modify the properties of the
connection to the external data source.

"Modifying a Data Source" on page
107

Deleting a connection to an external
data source.

"Deleting a Data Source" on page
108

Adding a Microsoft SQL Server Data Source
To connect a Microsoft SQL Server data source to My webMethods Server, use the
following procedure:
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To add a new data source for Microsoft SQL Server databases

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods > Data
Sources > Add DataSource.

As system administrator: Administration Dashboard > Configuration > DataSource
Administration > Add DataSource.

2. Type a unique DataSource Name to be used by My webMethods Server on the View
DataSources panel.

3. Type a Display Name to be used when you identify a data source to use for a database
directory service.

4. Select MS SQL Server from the Server Type list and click Next.

5. Type the SQL Server host name.

6. Type the port number used by the SQL Server. The default port is 1433.

7. Type the database name.

8. Type a valid SQL Server user name and password that, at a minimum, has READ
access to the database to which you will connect.

9. Click Submit.

Adding an Oracle Data Source
To connect an Oracle data source to My webMethods Server, use the following
procedure:

To add a new data source for Oracle databases

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods > Data
Sources > Add DataSource.

As system administrator: Administration Dashboard > Configuration > DataSource
Administration > Add DataSource.

2. Type a unique DataSource Name to be used by My webMethods Server on the View
DataSources panel.

3. Type a Display Name to be used when you identify a data source to use for a database
directory service.

4. Select Oracle from the Server Type list and click Next.

5. Type the Oracle host name.

6. Type the port number on which the Oracle host is running. The default port is 1521.
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7. Type the instance name (SID) for the database.

8. Type a valid Oracle database user name and password that, at a minimum, has
READ access to the database to which you will connect.

9. Click Submit.

Adding a DB2 Universal Data Source
To connect a DB2 Universal data source to My webMethods Server, use the following
procedure:

To add a new data source for DB2 Universal databases

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods > Data
Sources > Add DataSource.

As system administrator: Administration Dashboard > Configuration > DataSource
Administration > Add DataSource.

2. Type a unique DataSource Name to be used by My webMethods Server on the View
DataSources panel.

3. Type a Display Name to be used when you identify a data source to use for a database
directory service.

4. SelectDB2 Universal from the Server Type list and click Next.

5. Type the DB2 host name.

6. Type the port number that DB2 is running on.

7. Type the instance name for the database.

8. Type a valid DB2 user name and password that, at a minimum, has READ access to
the database to which you are connecting.

9. Click Submit.

Adding a Sybase Adaptive Server Data Source
To connect a Sybase Adaptive Server data source to My webMethods Server, use the
following procedure:

To add a new data source for Sybase Adaptive Server databases

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods > Data
Sources > Add DataSource.
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As system administrator: Administration Dashboard > Configuration > DataSource
Administration > Add DataSource.

2. Type a unique DataSource Name to be used by My webMethods Server on the View
DataSources panel.

3. Type a Display Name to be used when you identify a data source to use for a database
directory service.

4. Select Sybase Adaptive Server from the Server Type list and click Next.

5. Type the Sybase Server host name.

6. Type the port number that Sybase Server is running on.

7. Type the instance name for the database.

8. Type a valid Sybase Server user name and password that, at a minimum, has READ
access to the database to which you are connecting.

9. Click Submit.

Adding an Informix Data Source
To connect a Informix data source to My webMethods Server, use the following
procedure:

To add a new data source for Informix databases

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods > Data
Sources > Add DataSource.

As system administrator: Administration Dashboard > Configuration > DataSource
Administration > Add DataSource.

2. Type a unique DataSource Name to be used by My webMethods Server on the View
DataSources panel.

3. Type a Display Name to be used when you identify a data source to use for a database
directory service.

4. Select Informixfrom the Server Type list and click Next.

5. Type the Informix host name.

6. Type the port number on which the Informix host is running.

7. Type the database name.

8. Type the Informix server name.

9. Type a valid Informix user name and password that, at a minimum, has READ
access to the database to which you are connecting.
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10. Click Submit.

Adding a Generic ODBC Data Source

Note: My webMethods Server can use any ODBC connection that is manually
configured at the operating system level (such as Windows Server). My
webMethods Server uses a standard Java JDBC-ODBC bridge driver to
connect to the ODBC data sources on the underlying operating system.
Consult you Microsoft vendor documentation for details on how to configure
an ODBC data source at the operating system level.

To connect a generic ODBC data source to My webMethods Server, use the following
procedure:

To add a new data source for generic ODBC databases

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods > Data
Sources > Add DataSource.

As system administrator: Administration Dashboard > Configuration > DataSource
Administration > Add DataSource.

2. Type a unique DataSource Name to be used by My webMethods Server on the View
DataSources panel.

3. Type a Display Name to be used when you identify a data source to use for a database
directory service.

4. Select Generic ODBC from the Server Type list and click Next.

5. Type the ODBC data source name that matches the ODBC data source configured at
the operating system level.

6. Type a valid user name and password that, at a minimum, has READ access to the
database to which you are connecting.

7. Click Submit.

Adding a Custom Data Source

Note: This option is an advanced data source configuration and requires you to
specify a valid JDBC driver class name, connection URL, user name, and
password. Consult your vendor documentation to get specific instructions on
where to locate the proper database drivers for the database application that
you wish to connect to from the server.
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To connect a custom data source to My webMethods Server, you need to declare the
driver JAR file as a fragment of the com.webmethods.caf.server bundle and then use the
My webMethods Server user interface to add the datasource.

To add a new data source for a custom database

1. If My webMethods Server is running, stop it.

2. Copy the driver *.jar files into the Software AG_directory \MWS\lib directory.

3. In the Software AG_directory \MWS\lib directory, create a text file with the name
driver-name .bnd, where driver-name  is the name of the driver .jar file.

For example, if you are using the oracle thin driver, ojdbc6.jar, the file name is
ojdbc6.bnd.

4. In the file, provide instructions for the OSGi bundle conversion.

In the following example, replace the values in italics  as appropriate. For Bundle-
Version, it is typical to use the version number of the JAR file, but any unique
number is valid. You can, in fact, just use the value in this example:
# attach as fragment to the caf.server bundle 
Fragment-Host: com.webmethods.caf.server 
Bundle-SymbolicName: mws.jar.ojdbc6 Bundle-Version: 0.9.0 .v${tstamp} 
Include-Resource: ojdbc6 .jar 
-exportcontents: * 
Bundle-ClassPath: ojdbc6 .jar 
Import-Package: *;resolution:=optional

5. At a command line prompt, move to the server’s bin directory:
Software AG_directory \MWS\bin

6. Type this command:
mws.bat -s default update-osgi-profile

7. Restart your My webMethods Server instance.

8. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods > Data
Sources > Add DataSource.

As system administrator: Administration Dashboard > Configuration > DataSource
Administration > Add DataSource.

9. Type a unique DataSource Name to be used by My webMethods Server on the View
DataSources panel.

10. Type a Display Name to be used when you identify a data source to use for a database
directory service.

11. Select Custom JDBC from the Server Type list and click Next.

12. Type the JDBC Connection class for the custom drivers you want to use for the data
source connection.

13. Type a valid connection URL.
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14. Type a valid user name and password that, at a minimum, has READ access to the
database to which you are connecting.

15. Click Submit.

Modifying a Data Source

Note: You cannot modify the default data source, which is the My webMethods
Server database.

To modify a data source connection to My webMethods Server, use the following
procedure:

To modify an existing data source

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods > Data
Sources > View DataSources.

As system administrator: Administration Dashboard > Configuration > DataSource
Administration > View DataSources.

2. Click the Tools icon  (  in My webMethods) for the data source you want to
modify, and then click Modify.

3. In the first page of the Datasource Properties wizard, modify one or more of these
fields:

In this field... Do this...

Datasource Name Type a different unique data source name to be used by
My webMethods Server on the View DataSources panel.

Display Name Type a different display name for the data source to be
used when you identify a data source to use for a database
directory service.

Server Type From the list, select a different database type.

4. Click Next.

5. In the second page of the Datasource Properties wizard, modify one or more of the
fields identify the location, names, and passwords for the data source.

6. Click Submit.
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Deleting a Data Source

Note: You cannot delete the default data source, which is the My webMethods
Server database.

To delete a data source connection to My webMethods Server, use the following
procedure:

To delete a data source

1. To navigate to the correct page, do one of the following:

In My webMethods: Administration > My webMethods > Data Sources > View
DataSources.

As system administrator: Administration > Configuration > DataSource Administration >
View DataSources.

2. Click the Tools icon  (  in My webMethods) for the data source you want to
modify, and then click Remove.

Managing Email Settings
The E-mail Administration page is used to configure the mail server seings used by the
server when processing email.

To configure an email server to send server notifications

1. Navigate to one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods > E-Mail
Servers

As system administrator: Administration Dashboard > Configuration > E-mail
Administration.

2. Type the following information:

Property Description

Transport
Protocol

Identifies the email protocol to be used. The default and only
valid value is smtp.

SMTP Hosts Identifies the SMTP server. Specify the server's host name. For
example: smtp.server.com. If you specify two or more hosts,
type one address per line.
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Property Description

SMTP Port Identifies the port number. Specify the SMTP server's port
number. For example, 25.

SMTP
Username

Optional. Identifies the user name that My webMethods
Server is to supply for authentication. If the SMTP server
requires authentication, specify the user name to supply to
satisfy the authentication challenge.

SMTP Password Optional. Identifies the password associated with the SMTP
Username. If the SMTP server requires authentication, specify
the appropriate password.

SMTP TLS
Enabled

Optional. Indicates whether to use an encrypted SMTP
connection (by means of TLS). If the SMTP server requires
authentication, set to one of the following:

true TLS is enabled.

false (default) TLS is not enabled.

SMTP Timeout Defines the maximum period of time to wait for a response
from the server, specified in milliseconds. Default value is
60000.

SMTP
Connection
Timeout

Defines the maximum period of time for a given SMTP
session, specified in milliseconds. Default value is 60000.

SMTP Debug
Enabled

Optional. Indicates whether to enable debugging for email
activities. My webMethods Server writes the debugging
information to the My webMethods Server logs. Set to one of
the following:

true Debugging is enabled.

false (default) Debugging is not enabled.

From Name Defines the default "From" name. Specify the default name
to use in the "From" field of the email messages that My
webMethods Server sends using the SMTP server.

Note: Text in this field is subject to the requirements of the
RFC822 Internet Text Message standard. For example,
text in parentheses, as in "(Important)", is treated as a
comment and is removed when the message is created,
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Property Description
and bracketed text, such as "[Status]", is treated as an
optional element and is also removed.

From E-Mail
Address

Defines the default "From" email address. Specify the default
email address to use in the "From" field of the email messages
that My webMethods Server sends using the SMTP server.

Skin Optional. Identifies the skin to use when rendering My
webMethods Server email notifications. Specify a My
webMethods Server skin.

Admin E-mail
Address

Defines the email address of the My webMethods Server
administrator. This is used as the 'from' address for
administrative email messages sent on behalf of the server.

3. Click Save Settings.

Managing Calendars
Software AG Designer and My webMethods Server support the use of business
calendars and user calendars to assist with task definition, assignment, and behavior.
Both business and user calendars are set up and configured in My webMethods Server.
Each type of calendar is configured separately, and you can define business calendars
only, user calendars only, or both.

User and business calendars are most often used by the Task Engine in the assignment
and scheduling of tasks. For complete information about creating and managing user
and business calendars, see the PDF publication webMethods Task Engine User’s Guide.
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Searching for Existing Users, Groups, or Roles
You can search for the following:

Users and groups defined in the internal system directory service

Users and groups defined in external directory services

Roles

To search for users, groups, or roles

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > User Management >
User_type  > Search .

As system administrator: Administration Dashboard > User Management > Manage
User_type  > Search .

where User_type is Users, Groups, or Roles.

2. For users and groups, from the Name list select the directory service where the users
or groups are defined.

If you select Any Directory, all directory services connected to the server are searched.

3. In the Keyword field of the Search panel, do one of the following:

For... Type any of these search criteria...

Users First name

Last name

Email address

User ID

Groups Group name

Group ID

Group email address

Roles Role name

Role ID

The search is not case sensitive. If you leave the text box blank, My webMethods
Server returns information for all entries in the selected directory service.

4. Click Go.
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My webMethods Server displays the results in a table format.

For information on exporting the results of a search, see "Exporting Search Results to
a .csv File" on page 117

Advanced Searches
As a system administrator, you can perform an advanced search for users or groups,
based on user or group information and extended aributes. You cannot perform an
advanced search for roles.

To perform an advanced search for users or groups

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > User Management >
User_type  > Search.

As system administrator: Administration Dashboard > User Management > Manage
User_type  > Search .

where User_type is Users, Groups, or Roles.

2. For users or groups, from the Directory Service list select the directory service where
the users or groups are defined.

If you select Any Directory, all directory services connected to the server are searched.

3. For users, in the Core Attributes panel, fill in any of the following fields that are part of
User Information:

In this field... Do this...

First Name Type a first name for the saved search.

Last Name Type a last name for the saved search.

User ID Type a user ID for the saved search.

E-mail Address Type a user email address for the saved search.

4. For groups, in the Core Attributes panel fill in any of the following fields that are part
of Group Information:

In this field... Do this...

Group Name Type a group name for the saved search.
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In this field... Do this...

Group ID Type a group ID for the saved search.

E-mail Address Type a group email address for the saved search.

5. In the Extended Attributes panel, choose an extended aribute by doing the following:

a. From the Attribute Provider list, choose an aribute provider.

For more information on aribute providers, see "Aribute Providers" on page
207.

b. In the Attribute Value field, type or modify the value to be used in the saved search.

6. Click Go.

My webMethods Server displays the results in a table format.

For information on exporting the results of a search, see "Exporting Search Results to
a .csv File" on page 117

Using Saving Searches
If there is a search you perform regularly, you can save search criteria that you can
reuse. The following sections describe some actions you can perform with saved
searches:

This action... Is described here...

Create a new saved search "Creating a Saved Search" on page
114

Use a saved search "Using a Saved Search" on page 115

Modify a saved search "Modifying a Saved Search" on page
116

Delete a delete a saved search "Deleting a Saved Search" on page
117

Creating a Saved Search
To create a saved search for a user, group, or role, follow these steps:
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To create a saved search

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > User Management >
User_type  > Search.

As system administrator: Administration Dashboard > User Management > Manage
User_type  > Search.

where User_type is Users, Groups, or Roles.

2. For users and groups, in the Directory Service list choose the directory service that
contains the users you want to find.

If you select Any Directory, all directory services connected to the server are searched.

3. In the search field of the Search panel, do one of the following:

For... Type this to be used as search criteria...

Users The complete or partial user ID

Groups The complete or partial group ID

Roles The complete or partial role name

4. Click Save.

5. In the Search Name field of the Save Searches dialog box, type a name by which you
can identify the search criteria and click OK.

Using a Saved Search
You can use a saved search to find users, groups, or roles that match the criteria.

To perform a saved search

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > User Management >
User_type  > Saved.

As system administrator: Administration Dashboard > User Management > Manage
User_type  > Saved.

where User_type is Users, Groups, or Roles.

2. In the Saved Search list, choose the name of the saved search and click Go.
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Modifying a Saved Search
You can modify an existing saved search.

To modify a saved search

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > User Management >
User_type  > Saved.

As system administrator: Administration Dashboard > User Management > Manage
User_type  > Saved.

where User_type is Users, Groups, or Roles.

2. In the Saved Search list, choose the name of the saved search to be modified and click
Details.

3. Do any of the following:

In the search field of the Saved panel, change the search criteria.

For users and groups, in the Directory Service list change the directory service in
which to perform the search.

For users, in the Core Attributes panel modify any of the following fields that are
part of the User Information panel described in "User Information" on page 125.

In this field... Do this...

First Name Add, modify, or remove a first name for the saved search.

Last Name Add, modify, or remove a last name for the saved search.

User ID Add, modify, or remove a user ID for the saved search.

E-mail Address Add, modify, or remove an email address for the saved
search.

For groups, in the Core Attributes panel modify any of the following fields that
are part of the Group Information panel described in "Group Information" on page
135.

In this field... Do this...

Group Name Add, modify, or remove a group name for the saved
search.
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In this field... Do this...

Group ID Add, modify, or remove a group ID for the saved search.

E-mail Address Add, modify, or remove a group email address for the
saved search.

In the Extended Attributes panel, choose an extended aribute by doing the
following:

i. From the Attribute Provider list, choose an aribute provider.

For more information on aribute providers, see "Aribute Providers" on
page 207.

ii. In the Attribute Value field, type or modify the value to be used in the saved
search.

4. To update the saved search, click Save.

Deleting a Saved Search
When you no longer need a saved search, you can delete it.

To delete a saved search

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > User Management >
User_type  > Saved.

As system administrator: Administration Dashboard > User Management > Manage
User_type  > Saved.

where User_type is Users, Groups, or Roles.

2. In the Saved Search list, choose the name of the saved search to be deleted and click
Delete.

Exporting Search Results to a .csv File
You can export search results to a comma-delimited text file (.csv file) if the search
results panel includes the Export Table function.

After exporting search results to a .csv file, you can then import the .csv file into
Microsoft Excel, Microsoft Access, or any other application that accepts the .csv file
format.

To export search results

1. In the search results panel, click Export Table.
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2. From the Character Encoding list, select the character encoding to use.

3. Click Export.

4. Use the file-download mechanism in your browser to browse to the location where
you want to save the .csv file.
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Overview of Users and Groups
You can manage users and groups as My webMethods Administrator or as a system
administrator (or as a user with administrator privileges, as described in "Overview of
Roles" on page 156. Where there are differences between the My webMethods and
system user interfaces, the procedures describe both.

Users
To access My webMethods, the system must have access to a definition for the user. To
define users, you can:

Add users to the internal system directory service. You provide all information about the
user, for example the user ID the user is to supply to log into the system and the
user’s password. The following sections in this chapter describe how to manage
users in the internal system directory:

"Adding Users" on page 122

"Searching for Existing Users, Groups, or Roles" on page 112

"Editing Information for a User" on page 124

"Disabling Login for a User" on page 124

"Assigning a User to a Group" on page 131

"Deleting a User" on page 132

Access users already defined in external directory services. If your users are defined in one
or more external directory services, you can configure My webMethods Server to
use the external directory services. As a result, those users can access and use My
webMethods. For more information, see "Managing External Directory Services" on
page 87.

Note: With My webMethods Server, you can use a combination of users that are
defined in both the internal system directory service and external directory
services.

Groups
You can logically organize collections of users into groups, which allows you to identify
a group of users by a group name rather than identifying each user individually. For
example, if you want to assign a group of users to a role, you can simply assign the
group containing the users to the role, rather than identifying each user individually.

To define a group, you can do the following:
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Add groups to the internal system directory service. You provide information about
the group and define its membership. You can assign both individual users or
other groups to be a members. The users and groups that you assign to a group
that is defined in the internal system directory service must also be defined in the
internal system directory service. That is, you cannot assign users or groups that
are defined in an external directory service to an internally-defined group. The
following sections in this chapter describe how to manage groups in the internal
system directory:

"Adding Groups" on page 134

"Searching for Existing Users, Groups, or Roles" on page 112

"Editing Group Information" on page 135

"Managing Members of a Group" on page 137

"Making a Group a Member of Another Group" on page 138

"Deleting Groups" on page 139

Access groups already defined in external directory services. If you want to use groups
that are defined in one or more external directory services, you can configure My
webMethods Server to use the external directory services. For more information, see
"Managing External Directory Services" on page 87.

Note: With My webMethods Server, you can use a combination of groups that are
defined in both the internal system directory service and external directory
services.

Managing Users
The following table lists the functions you can perform for users based on whether they
are defined in the internal system directory service or an external directory service, and
where in this guide you can find more information about how to perform the function:

Where the user is defined Function For more information, see...

Add users "Adding Users" on page
122

Disable user log-in "Disabling Login for a
User" on page 124

Internal system
directory service

Edit user information "Editing Information for
a User" on page 124
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Where the user is defined Function For more information, see...

Assign users to groups "Assigning a User to a
Group" on page 131

Delete users "Deleting a User" on
page 132

External directory
service

Allow users defined in
an external directory
service access to My
webMethods

"Allowing Externally
Defined Users to
Perform Actions from
My webMethods " on
page 96

Search for users "Searching for Existing
Users, Groups, or Roles"
on page 112

Assign a user to a role "Creating Roles" on
page 158

Assign user-specific
values for dynamic
aributes that are
associated with a role

"Seing User-Specific
Values for Dynamic
Aributes" on page
167

Allow users access to
view functions and take
actions within them.

"Access Privileges and
Functional Privileges"
on page 144

Either:

Internal system
directory service

External directory
service

Locate a user’s home
folder.

"Locating a User’s
Home Folder (System
Administrator Only)" on
page 132

Adding Users
Before a user can access and use My webMethods, you must either add the user to the
internal system directory service or configure My webMethods Server to use the external
directory service where the user is defined. For more information about configuring an
external directory service, see "Managing External Directory Services" on page 87. The
following procedure describes how to add a user to the internal system directory service.

Note: When a My webMethods Administrator adds a new system user, that user
is automatically added to the My webMethods Users role. When a system



M
Odd Header

Managing Users and Groups

Administering My webMethods Server Version 9.8 123

administrator adds a new user, that user is not automatically added to the My
webMethods Users role.

To add a user

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Users > Add User.

As system administrator: Administration Dashboard > User Management > Manage
Users > Add User.

2. Fill in the following fields for the user you want to add to the internal system
directory service:

In this field... Specify...

User ID The user ID that you want to assign to the user you are
adding. My webMethods Server uses the user ID when
forming the distinguished name (DN) for the user.

The user ID can be 1 through 255 characters and can
contain only alphanumeric ASCII characters with no
spaces. The user ID is not case sensitive.

Note: My webMethods Server adds the user ID to the
internal system directory service using the case
you specify. My webMethods Server typically
regards user IDs as case-insensitive; however, My
webMethods Server uses the case you specify for
actions that are case-sensitive, for example, HTTP
authentication.

Password The password for the new user.

Confirm Password The same password you specified in the Password field.

First Name The first name of the user you are adding. My
webMethods Server uses the user’s first and last name
when displaying the user’s name on pages in the user
interface.

Last Name The last name of the user you are adding.

E-mail Address (Optional) The email address for the user you are
adding. My webMethods Server uses the email address
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In this field... Specify...
when it needs to send a notification to the user by means
of an email message.

3. Click Create.

Editing Information for a User
You can edit the information for a user defined in the internal system directory service.
If a user is defined in an external directory service, you can edit only My webMethods
Server-specific information. You must update the external directory service directory to
change seings that My webMethods Server obtains from the external directory. For a
list of the fields that My webMethods Server maintains for a user, see"User Information"
on page 125.

To edit a user

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Users.

As system administrator: Administration Dashboard > User Management > Manage
Users.

2. Search for the user you want to edit. For more information, see "Searching for
Existing Users, Groups, or Roles" on page 112.

3. In the search results, click any link in the row of the user you want to edit or click the
Edit icon .

4. Make the changes you want to the user’s information and click Save.

For a description of all the fields on each panel, including whether you can update a
field or whether a field is view-only, see User Information next in this chapter.

Important: My webMethods Server displays the information grouped on various
panels. After making changes to information on a single panel, be sure to
click Save to save your changes before selecting another panel.

Disabling Login for a User
You can deny a user defined in the internal system directory service the ability to log
into My webMethods Server. To disable login for users defined in an external directory
service, see "Disabling User Accounts" on page 99.

Note: webMethods products that use Common Directory Services for
authentication, such as Integration Server and Optimize are affected by this
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feature. A user disabled in My webMethods Server is disabled in those other
products as well.

To disable log-in for a user

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Users.

As system administrator: Administration Dashboard > User Management > Manage
Users.

2. Search for the user you want to edit. For more information, see "Searching for
Existing Users, Groups, or Roles" on page 112.

3. In the search results, click any link in the row of the user you want to disable or click
the Edit icon .

4. Select the Login Disabled option and click Save.

User Information
The following table lists the information that My webMethods Server maintains for a
user. In the table, the Panel column identifies the panel on the Edit User page where the
field is maintained.

Note: The order of panels on the Edit User page differs between administrator and
system administrator. Additionally, the Calendar, LDAP Aributes, and
Database Aributes panels are only provided on the administrator Edit User
page.

Panel Description

User
Information

Aributes that you specify when you add a user to the internal
system directory service. This panel is not editable for users in an
external directory service.

This panel is part of the user’s profile, and users can update some of
the fields; that is users can update the password and email address.

 Fields Description

 User ID The user ID that a user supplies to log into My
webMethods. The user ID is defined when the
user is added and cannot be changed.

 Password The password the user must supply to log
into My webMethods. My webMethods Server
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Panel Description
masks this field when it is displayed in the user
interface.

If you want to change the user’s password,
update the Password and Confirm Password
fields.

 Confirm Password The same as the Password field.

 First Name The first name of the user.

 Last Name The last name of the user.

 E-mail Address An optional email address for the user that
My webMethods Server can use when it needs
to send a notification to the user via an email
message.

 Login Disabled The user is not allowed to log in. This option
applies only to users in the internal system
directory.

 Distinguished Name
(DN)

The distinguished name for the user. You
cannot update this field. My webMethods
Server forms this field using information
defined for the user.

User Profile Aributes that My webMethods Server maintains regardless of the
directory service the user is a member of.

Note: Values in this panel that relate to a locale, and which display as
Default, do not represent the user’s default locale. Rather, they
represent a null value.

 Fields Description

 First Name The first name of the user from the User
Information panel. You cannot edit this field on
the User Profile panel. To change the first name,
edit the value on the User Information panel.

 Last Name The last name of the user from the User
Information panel. You cannot edit this field on
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Panel Description
the User Profile panel. To change the last name,
edit the value on the User Information panel.

 Middle Name The user’s middle name.

 Title The user’s title, for example, Mr., Mrs., or Ms.
If the title you want to use does not appear in
the list, select Other. My webMethods Server
prompts you for the title you want to use.

 Name Suffix The suffix that should appear after the user’s
name, if any, for example, Jr., Sr., PhD, III. If
the suffix you want to use does not appear in
the list, select Other. My webMethods Server
prompts you for the suffix you want to use.

 Preferred Language/
Locale

The user’s language and locale.

 Address 1Address 2 The street address for the user.

 Custom Address (Optional) Additional information that is
needed when more than a postal code is
required for the user’s address, for example,
special instructions.

 City The city where the user is located.

 State/Province The state or province where the user is located.

 Postal Code The postal code for the user, for example, a ZIP
Code if the user is located in the United States.

 Country/Region ID The country where the user is located.

 Phone 1 Area Code The user’s area code.

 Phone 1 Number The user’s phone number.

 Phone 1 Extension The extension at which the user can be reached,
if any.
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Panel Description

 Phone 1 Country
Code

The country code associated with the user’s
phone number.

 Default Date Format The date format that is used by default.

 Default Time Format The time format that is used by default.

 Default Time Zone The time zone that is used by default.

 Default Number
Format

The number format that is used by default.

 Default Currency
Format

The currency format that is used by default.

User
Preferences

User preferences for the display of information in My webMethods.

This panel is part of the user’s profile, and as a result, users can
update these fields from their profiles. For more information, see the
Working with My webMethods guide.

 Fields Description

 Start Page Provides the ability to specify one of the
following as a start page.

Application Page. Specifies an application page
to open as a start page.

Workspace. Specifies a workspace to open as a
start page.

Clear. Restores default start page seings.

 Items Per Page The number of items to display on one page
when My webMethods Server displays items
in a table for this user. If the number of items
to display exceeds the number you specify
for Items Per Page, the user can navigate to
subsequent pages to view the remaining items.

 Close Open Tabs on
Login

You can select the check box to cause all
previously open tabs in the last user session to
automatically be closed upon login.
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Panel Description

 Open Last Active
Tab on Login

You can select the check box to open the last
active tab after the user logs in.

 Show Delete
Workspace
Confirmation

You can select the check box to display a
confirmation dialog box when a user deletes a
workspace.

 Show Delete
Window
Confirmation

When you delete a window from a workspace,
this preference indicates whether you want
My webMethods to prompt you to confirm
the action. When this check box is cleared and
you delete a window from a workspace, My
webMethods immediately deletes the window
without asking for confirmation.

 Show Close All Tabs
Confirmation

You can select the check box to display a
confirmation dialog box when a user closes all
of the tabs.

 Auto-Save when
Navigating to a
Different Workspace

You can select the check box to automatically
save a workspace before you navigate to a
different workspace.

Roles Roles to which a user is assigned and the dynamic aributes
associated with each role. For more information about:

"Creating Roles" on page 158

Defining dynamic aributes and seing their values, see "Defining
Dynamic Aributes Associated with a Role" on page 166.

Note: If a user is assigned to dynamic roles, the list of roles might
not always be completely accurate. My webMethods Server
determines the roles to which a user belongs when a user logs
into the system. If a characteristic of a user changes that would
make the user ineligible to be a member of the role, the system
will continue to consider the user a member of the role until the
next login when the system determines the user’s roles for the
session.

 Fields Description

 Role Precedence A list of roles to which the user is assigned. The
roles are listed in precedence order.
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Panel Description

To reorder the roles, move them up or down as
needed.

 Role Member
Attributes

A list of dynamic aributes associated with
the selected role. Dynamic aributes provide
more information about a role. For example, if
there is a “Customer Service” role, you might
add a “Location” aribute to identify where
the user assigned to the “Customer Service”
role is located. For each aribute, the following
information is listed:

Attribute, which is the display name specified
when the aribute is added to the role.

Data Type, which is the data type of the
aribute.

Role Value, which is the default value for
the aribute. All users are assigned this
value unless specifically overridden by a
user-specific value. For more information
about seing the default value, see "Defining
Dynamic Aributes Associated with a Role"
on page 166.

User Value which the user-specific value for
the aribute. For more information about
seing a user-specific value, see "Seing User-
Specific Values for Dynamic Aributes" on
page 167.

Calendar A calendar for business or personal use.

Note: For information about creating and managing user and business
calendars, see the PDF publication webMethods Task Engine
User’s Guide.

 User Business
Calendar

Provides a calendar to be used as a business
calendar.

 User Personal
Calendar

Provides a calendar to be used as a personal
calendar.

LDAP
Attributes

If the user is defined in an external directory service, this panel lists
a set of aributes from the external directory service. The fields
on this panel are based on the external directory service. LDAP
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Panel Description
aributes must be set by the system administrator. See "Exposing
LDAP Aributes from an External Directory Service" on page 211.

Database
Attributes

If the user is defined in an external database directory service, this
panel lists a set of aributes from the external database directory
service. The fields on this panel are based on the external database
directory service. Database aributes must be set by the system
administrator; see "Exposing Database Aributes from an External
Directory Service" on page 213.

Groups Groups to which the user belongs.

 Fields Description

 Location Identifies where My webMethods Server
obtains the items it displays in the left panel of
Group Membership field.

 Group Membership The left panel lists the items available to select.

 Selected Items The right panel, Selected Items, lists the groups
to which the user is assigned, if any.

 Search You can use the Search field to help you search
for and quickly locate an item in the Group
Membership left panel. This is useful when the
left panel contains more items than will display
on a single page.

Note: Values in this panel that relate to a locale, and which display as Default, do not
represent the user’s default locale. Rather, they represent a null value.

Assigning a User to a Group
You can assign users that you have defined in the internal system directory service
to groups that you have also defined in the internal system directory service. For
information on creating groups, see "Adding Groups" on page 134.

Note: You cannot assign users that are defined in an external directory service to a
group defined in the internal system directory. Similarly, you cannot assign
users defined in the internal system directory service to an externally-defined
group. You can, however, assign both internal and external users to a role. See
"Managing Roles and Access to My webMethods " on page 155.
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To assign a user in the system directory service to a group in the system directory service

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Users.

As system administrator: Administration Dashboard > User Management > Manage
Users.

2. Search for the user that you want to assign to a group. For more information, see
"Searching for Existing Users, Groups, or Roles" on page 112. Be sure to select system
from the Name list.

3. In the search results, click any link in the row of the user you want to edit or click the
Edit icon .

4. Click Groups.

5. For each group to which the user should be a member, move it to the Selected Items
box.

6. With all groups in the Selected Items box, click Save (Apply in system administration).

Deleting a User
You can remove users that you have previously defined in the internal system directory
service.

To delete users from the internal system directory service

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Users.

As system administrator: Administration Dashboard > User Management > Manage
Users.

2. Search for the users that you want to delete. For more information, see "Searching for
Existing Users, Groups, or Roles" on page 112. Be sure to select system from the Name
list.

3. In the search results, select the check boxes beside the user IDs for the users you
want to delete, and click Delete.

Locating a User’s Home Folder (System Administrator Only)
A system administrator can locate and browse to a user's personal folders. Use this
feature if items become unavailable to the user because of permissions changes, or to
remove content when a user is no longer actively using the server.
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To locate a user’s Home folder

1. As system administrator: Administration Dashboard > User Management > Locate a User's
Home Folder.

2. Click Browse.

3. To select a user, move that user to the Selected Items box and click Select.

4. To open the home folder for the user you selected, click Apply.

Managing Groups
The following table lists the functions you can perform for groups based on whether
they are defined in the internal system directory service or an external directory service,
and where in this guide you can find more information about how to perform the
function:

Where the group is defined Function For more information, see...

Add groups "Adding Groups" on
page 134

Edit group information "Editing Group
Information" on page
135

Define the membership
for a group

"Managing Members of
a Group" on page 137

Make a group a member
of another group

"Making a Group a
Member of Another
Group" on page 138

Internal system
directory service

Delete groups "Deleting Groups" on
page 139

External directory
service

Allow My webMethods
Server to use groups
defined in an external
directory service

"Allowing Externally
Defined Users to
Perform Actions from
My webMethods " on
page 96
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Where the group is defined Function For more information, see...

Search for groups "Searching for Existing
Users, Groups, or Roles"
on page 112

Assign a group to a role "Creating Roles" on
page 158

Either:

Internal system
directory service

External directory
service

Allow users access to
view functions and take
actions within them.

"Access Privileges and
Functional Privileges"
on page 144

Adding Groups
You can define groups of users in the internal system directory service. To do so, first
create the group. After the group is created, you can add members to the group.

To create a group

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Groups > Add Group.

As system administrator: Administration Dashboard > User Management > Manage
Groups > Add Group.

2. Fill in the following fields for the group you want to add to the internal system
directory service:

In this field... Specify...

Group ID An ID for the group. My webMethods Server uses this ID in
the distinguished name (DN) for the group.

The group ID can be 1 through 255 characters and can
contain only alphanumeric ASCII characters with no spaces.
The group ID is not case sensitive.

Group Name The name that you want to assign to the group you are
adding. The group name can be 1 through 255 characters.

E-mail Address (Optional) The email address for the group you are adding.

3. Click Create.
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Editing Group Information
You can edit the information for a group defined in the internal system directory service.
If a group is defined in an external directory service, you must update the external
directory service directory to change seings that My webMethods Server obtains from
the external directory. For a list of the fields that My webMethods Server maintains for a
group, see "Group Information" on page 135.

To edit a group

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Groups.

As system administrator: Administration Dashboard > User Management > Manage
Groups.

2. Search for the group you want to edit. For more information, see "Searching for
Existing Users, Groups, or Roles" on page 112.

3. In the search results, click any link in the row of the group you want to edit or click
the Edit icon .

4. Make the changes you want to the group information and click Save (Apply in system
administration).

For a description of all the fields on each panel, including whether you can update a
field or whether a field is view-only, see Group Information next in this chapter.

Important: My webMethods Server displays the information grouped on various
panels. After making changes to information on a single panel, be sure
to click Save (Apply in system administration) to save your changes before
selecting another panel.

Group Information
The following table lists the information that My webMethods Server maintains for a
group. In the table, the Panel column identifies the panel on the Edit Group page where
the field is maintained.

Panel Description

Group
Information

Aributes that you specify when you add a group.

 Fields Description
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Panel Description

 Group ID The group ID assigned to a group. The group
ID is defined when the group is added and
cannot be changed.

 Group Name The group name for the group.

 E-mail Address The email address for the group.

 Distinguished Name
(DN)

The distinguished name for the group. You
cannot update this field. My webMethods
Server forms this field using information
defined for the group.

Groups Groups to which the current group belongs.

 Fields Description

 Location Identifies where My webMethods Server
obtains the items it displays in the left panel of
Group Membership field.

 Group Membership The left panel lists the items available to select.

 Selected Items The right panel, Selected Items, lists the groups
to which the group is assigned, if any.

 Search You can use the Search field to help you search
for and quickly locate an item in the Group
Membership left panel. This is useful when the
left panel contains more items than will display
on a single page.

Group
Members

The members that are assigned to this group. The members can be
users and other groups.

 Fields Description

 Location Identifies where My webMethods Server
obtains the items it displays in the left panel of
Group Members field.

 Group Members The left panel lists the items available to select.
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Panel Description

 Selected Items The right panel, Selected Items, lists the users
and groups that are members of the group.

 Search You can use the Search field to help you search
for and quickly locate an item in the Group
Members left panel. This is useful when the left
panel contains more items than will display on
a single page.

LDAP
Attributes

If the group is defined in an external directory service, this panel
lists a set of aributes from the external directory service. The fields
on this panel are based on the external directory service. LDAP
aributes must be set by the system administrator. See "Exposing
LDAP Aributes from an External Directory Service" on page 211.

Database
Attributes

If the user is defined in an external database directory service, this
panel lists a set of aributes from the external database directory
service. The fields on this panel are based on the external database
directory service. Database aributes must be set by the system
administrator; see "Exposing Database Aributes from an External
Directory Service" on page 213.

Managing Members of a Group
Members of a group can be users or other groups. You can add members to a group
defined in the internal system directory service if they are also defined in the same
directory service.

Note: To work with users and groups defined in external directory services, use the
mechanisms provided by the external directory services.

To manage members in a group defined in the internal system service directory

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Groups.

As system administrator: Administration Dashboard > User Management > Manage
Groups.

2. Search for the group you want to edit. For more information, see "Searching for
Existing Users, Groups, or Roles" on page 112.

3. In the search results, click any link in the row of the group you want to edit or click
the Edit icon .
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4. Click Group Members.

5. To manage the members of the group, do any of the following:

To add users (in the system directory service) to the group, move them to the
Selected Items box.

To remove users from the group, move them from the Selected Items box.

To add groups (in the system directory service) to the group, move them to the
Selected Items box.

To remove groups from the group, move them from the Selected Items box.

6. When the Selected Items box lists all the members you want in the group, click Save
(Apply in system administration).

Making a Group a Member of Another Group
You can make a group a member of another group as long as both groups are defined in
the internal system directory service. When one group becomes a member of a second
group, all members of the first group also become members of the second group.

Note: You cannot assign groups that are defined in an external directory service
to a group defined in the internal system directory. Similarly, you cannot
assign groups defined in the internal system directory service to an externally-
defined group. You can, however, assign both internal and external groups to
a role. See "Managing Roles and Access to My webMethods " on page 155.

To make a group a member of another group

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Groups.

As system administrator: Administration Dashboard > User Management > Manage
Groups.

2. Search for the group you want to edit. For more information, see "Managing External
Directory Services" on page 87.

3. In the search results, click any link in the row of the group you want to edit or click
the Edit icon .

4. Click Groups.

5. To manage the membership of the group in other groups, do either of the following:

To make the current group a member of other groups (in the system directory
service), move the parent groups to the Selected Items box.

To remove the current group as a member of other groups, move the parent
groups from the Selected Items box.
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6. When the Selected Items box lists all the groups of which the current group should be
a member, click Save (Apply in system administration).

Deleting Groups
You can remove groups that you have previously defined in the internal system
directory service.

Note: When you delete a group, the definition for the group is removed, but the
individual members of the deleted group (users and/or other groups) are not
deleted.

To delete groups from the internal system directory service

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Groups.

As system administrator: Administration Dashboard > User Management > Manage
Groups.

2. Search for the groups you want to delete. For more information, see "Searching for
Existing Users, Groups, or Roles" on page 112. Be sure to select system from the Name
list.

3. In the search results, select the check boxes beside the names for the groups you
want to delete, and click Delete.
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Managing Permissions in My webMethods
The My webMethods administrator and the system administrator can manage
permissions as shown here:

This administrator... Can manage permissions for these resources...

My webMethods webMethods applications, Tasks, and Workspaces.

System webMethods applications, Tasks, Workspaces, Content
Objects, Portlet Types, and Security Realms.

You can manage permissions for users, groups, and roles in whatever combination is
needed.

Adding Permissions
The basic workflow in assigning permissions is to search for the resources on which to
assign permissions.

To assign permissions

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide >
Permissions Management.

As system administrator: Administration Dashboard > Configuration > Permissions
Management.

2. On the Search panel, from the Resource Type list, choose the resource type to be
managed.

Resource type Description

webMethods
Applications

webMethods applications that are installed in this instance
of My webMethods.

Tasks Tasks associated with webMethods Task Engine.

Workspaces Workspaces that have been created on this instance of My
webMethods.

Content Object (System administrator only) Any resource on this instance of
My webMethods Server, including files, folders, and pages.
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Resource type Description

Portlet Types (System administrator only) Portlet types installed on this
instance of My webMethods Server.

Security Realm (System administrator only) Security realms created on this
instance of My webMethods Server. See "Using Security
Realms" on page 148.

3. If needed, apply a filter to narrow the search.

When you choose a Resource Type, a FILTER list appears with a defined set of
filtering criteria. There are no filtering criteria for the webMethods Applications
Resource Type because all installed applications are included.

a. From the FILTER list, choose the filtering criteria.

For example, Workspace Name.

b. Type a value to be searched for.

c. If you need to add an additional filtering criterion, click  or  (depending on
what type of administrator you are).

4. Click Search.

The results of the search appear in the Found list.

5. Move resources into the Selected list.

You can perform multiple searches to add resources to the list. Also, you can save
searches to make it easier to locate the same resources again. See "Using Saving
Searches" on page 114.

6. On the Edit Permissions panel, click Add Users/Groups/Roles, search for Principals and
move them to the Selected list.

You can perform multiple searches to add Principals to the list. For more
information, see "Searching for Existing Users, Groups, or Roles" on page 112.

7. After all Principals have been selected, click Add.

The Permissions panel is displayed in a tree format containing the permissions that
can be granted or denied for the Resource Type.

8. Click the Grant or Deny option for the seings, click OK, and then click Apply.

If neither option is selected, permissions for a seing will be determined from
another source.
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Modifying Permissions
You can modify previously set permissions to server resources. You can modify
permissions for users, groups, or roles (Principals), or delete them entirely.

To modify permissions

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide >
Permissions Management.

As system administrator: Administration Dashboard > Configuration > Permissions
Management.

2. If you have a saved search for the resources to be modified, do the following:

a. Click the Saved tab, choose the saved search from the Saved Search list and click
Search

b. Move the result of the search to the Selected list and click Next.

3. Otherwise search for the resources by doing the following:

a. On the Search panel, from the Resource Type list, choose the resource to be
managed.

b. If needed, apply a one or more filters to narrow the search.

c. Click Search.

d. Move resources into the Selected list.

e. Click Next.

4. To modify permissions for a Principal, do the following:

a. In the Permissions column of the Edit Permissions panel, click the link for the
user, group, or role.

b. Modify permissions for the various seings as needed, and click OK.

5. To delete permissions for a user, group, or role, select the checkbox in that row and
click Delete.

6. Click Apply.

Access Privileges and Functional Privileges
Two important ways in which permissions are used in My webMethods are Access
Privileges and Functional Privileges.
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Privilege type Description

Access Privileges The rights of a user, group, or role to view applications
and features in the Navigation panel and access pages
associated with them in My webMethods. The granting of
Access Privileges, by itself, allows only the capability to
view.

Functional
Privileges

The rights of a user, group, or role to make changes
within an application or feature, such as to create
and modify a workspace. The granting of Functional
Privileges is meaningless unless Access Privileges are also
granted.

The list of Access Privileges and Functional Privileges is determined by which
webMethods applications are installed. Both the My webMethods administrator and the
system administrator can grant or deny these privileges for users, groups, or roles.

Tip: If you need to set the same set of privileges for multiple users, groups, and
roles, you should consider aggregating all of them into a single role.

To manage Access Privileges and Functional Privileges

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide >
Permissions Management.

As system administrator: Administration Dashboard > Configuration > Permissions
Management.

2. On the Search panel, from the Resource Type list, choose webMethods Applications.

By default, My webMethods applications are already in the Selected list.

3. Click Next.

4. On the Edit Permissions panel, click Add Users/Groups/Roles, search for users, groups
or roles, move them to the Selected list, and click Add.

Note: You can add only users or groups or roles in this action. You cannot mix
the three types.

The Permissions panel is displayed, showing a tree list containing the permissions
that can be granted or denied for Access Privileges and Functional Privileges.

5. In the tree list, select options as needed to assign Access Privileges and Functional
Privileges.

Click Grant for each privilege that is to be granted.
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Click Deny for each privilege that is to be denied.

Clear both options to neither explicitly grant or deny the privilege. Permissions
will be determined from another source.

6. Click OK and then click Apply.

Managing Permissions for an Individual Resource
As system administrator you can manage individual resources within My webMethods
Server. You can control the access of any Principal (user, group, or role) to a server
resource or a hierarchy of server resources. Denying access to a server resource also
prevents a Principal from seeing the resource in server navigation, such as in any listing
of the resource’s siblings or the contents of the resource's parent.

Note: The information in this section relates to managing permissions to pages
and other server resources you develop that are not part of a webMethods
application.

This function... Is described here...

Determine the owner of a server
resource and change owners if needed.

"Viewing and Changing the Owner of
a Server Resource" on page 146

Add a Principal to the permissions list
for a server resource.

"Adding a Principal to the Permissions
for a Server Resource" on page 147

Modify the permissions for a Principal
who currently has access rights
assigned for the server resource.

"Modifying Permissions for a Server
Resource" on page 147

Remove a Principal from the
permissions list for a server resource.

"Removing a Principal from Server
Resource Permissions" on page 148

Seing an Authentication Scheme for a
server resource.

"Assigning an Authentication Scheme
to a Server Resource" on page 232

Viewing and Changing the Owner of a Server Resource
To view and change the owner of a server resource

1. For a server resource, such as a page, click the Tools icon (  or ) and then click
Permissions.
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2. Click the Owner tab.

The Owner panel shows the owner of the server resource.

3. To change the resource owner, do the following:

a. In the Keywords field, type a user ID, click Search, move the user to the Selected
box, and click Apply.

b. Click Apply.

Adding a Principal to the Permissions for a Server Resource
Remember that a Principal is a user, group, or role.

To add a Principal to the permissions for a server resource

1. For a server resource, such as a page, click the Tools icon (  or ) and then click
Permissions.

2. On the Edit Permissions panel, click Add Users/Groups/Roles, search for Principals, and
move them to the Selected list.

You can perform multiple searches to add Principals to the list. For more
information, see "Searching for Existing Users, Groups, or Roles" on page 112.

3. After all Principals have been selected, click Add.

The Permissions panel is displayed in a tree format containing the permissions that
can be granted or denied for the resource.

4. In the tree list, select options as needed.

Click Grant to explicitly grant permission.

Click Deny to explicitly deny permission.

Clear both options to neither explicitly grant nor deny permission. Permissions
will be determined from another source.

5. Click OK and then click Apply.

Modifying Permissions for a Server Resource
To modify the permissions for a server resource

1. For a server resource, such as a page, click the Tools icon (  or ) and then click
Permissions.

2. To modify permissions for a Principal, do the following:

a. In the Permissions column of the Edit Permissions panel, click the link for the
Principal.

b. Modify permissions for the various seings as needed, and click OK.
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Click Grant to explicitly grant permission.

Click Deny to explicitly deny permission.

Clear both options to neither explicitly grant nor deny permission.
Permissions will be determined from another source.

3. Click Apply.

Removing a Principal from Server Resource Permissions
Remember that a Principal is a user, group, or role.

To remove a Principal from the permissions for a server resource

1. For a server resource, such as a page, click the Tools icon (  or ) and then click
Permissions.

2. On the Edit Permissions panel, select the checkbox for a Principal and click Delete.

3. Click Apply.

Using Security Realms
As a system administrator, when you manage permissions, as described in "Managing
Permissions for an Individual Resource" on page 146, you do so one resource at
a time. This method is satisfactory for small servers, but can be cumbersome as the
number of pages and users increases. Security Realms allow system administrators to
manage permissions for resources based on users, groups, or roles, making it easier to
manage large servers. After a Security Realm is applied to a resource, individually set
permissions do not apply unless you specifically choose to set them.

For convenience, you can organize Security Realms into folders called containers. My
webMethods Server has the following Security Realm containers by default:

This container... Holds...

Forum Realms Security Realms that manage permissions for forums.

My webMethods
Security Realms

Security Realms that manage permissions for My
webMethods resources.

Portal Resources Security Realms that manage permissions for My
webMethods Server resources

The Security Realms Administration page allows you to create, rename, and remove
containers, as described in these sections:
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This function... Is described here...

Create a container "Creating a Container" on page 150

Remove a container "Removing a Container" on page
151

Rename a container "Renaming a Container" on page
151

There are several default Security Realms that manage permissions for My webMethods
Server resources, all of which reside in the Portal Resources container. System
administrators have the right to read, modify or delete the server resources; other users
have permissions as described here:

This Security Realm... Manages permissions for these My webMethods Server
resources...

Administrative
Commands

Administrative resources. Permits only server
administrators to read, modify, or delete the resource.

Directory Management
Commands

Resources that manage users, group, and roles.
Permits users to view or execute the resource.
Anonymous users are denied access.

Directory Service
Commands

Resources that manage directory services. Permits
users to view or execute the pages. Anonymous users
are denied access.

Portal Developer
Commands

Resources for the development and maintenance
of pages and content. Members of the Developers
group are granted the right to read, modify, or delete
the resource. Permits users to view or execute the
resource. Anonymous users are denied access.

Public Commands Resources for interacting with a server, such as
logging in. Permits all users, including anonymous
users, to read or execute the resource, but not to
modify or delete it.

Restricted Commands Resources for interacting with a server after one has
logged in. Permits users who have logged in to read
or execute the resource, but not to modify or delete it.
Anonymous users are denied access.
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This Security Realm... Manages permissions for these My webMethods Server
resources...

User Profile
Management
Commands

Resources that control the look and feel of the
server. Permits users to view or execute the resource.
Anonymous users are denied access.

The Security Realms Administration page allows you to create and manage Security
Realms you can use for your content. There are several functions you can perform on
this page:

This function... Is described here...

Create a Security Realm "Creating a Security Realm" on page
151

Remove a Security Realm "Removing a Security Realm" on page
152

Rename a Security Realm "Renaming a Security Realm" on page
153

Add resources to a Security Realm "Adding Resources to a Security
Realm" on page 153

Remove resources from a Security
Realm

"Removing Resources from a Security
Realm" on page 153

Creating a Container
You can create a container at the same level as the default containers or you can create a
container within a container.

To create a new container

1. As system administrator, click Administration > Configuration > Security Realms
Administration.

2. Do one of the following:

To create a container... Do this...

At this level Go on to the next step.
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To create a container... Do this...

Within a container at this level Click the name of the container to
reveal its contents.

3. Click Create New Container.

4. In the Name field, type a display name for the container.

5. (Optional) In the Description field, type a description.

6. Click Create Container.

Removing a Container

Important: If you remove a container, any Security Realms or other containers within it
are also removed.

To remove a container

1. As system administrator, click Administration Dashboard > Configuration > Security Realms
Administration.

2. Click the Tools icon  for the container you want to remove, and then click Remove
Container.

Renaming a Container
To rename a container, do the following:

To rename a container

1. As system administrator, click Administration Dashboard > Configuration > Security Realms
Administration.

2. Click the Tools icon  for the container you want to rename, and then click Modify
Container.

3. In the Name field, type the new name.

4. (Optional) In the Description field, type a new description.

5. Click Update.

Creating a Security Realm
To create a new Security Realm

1. As system administrator, click Administration Dashboard > Configuration > Security Realms
Administration.
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2. Click the name of the container in which to create the Security Realm.

Note: After you have created a Security Realm within a container, you cannot
move it to another container.

3. Click Create New Security Realm.

4. In the Name field, type a display name for the Security Realm.

5. (Optional) In the Description field, type a description.

6. (Optional) To add an extended type, move it to the Selected Items box and click Select.

7. (Optional) To add an external policy provider, move it to the Selected Items box.

8. Click Create Security Realm.

9. Click the Tools icon  for the new Security Realm, and then click Configure
Permissions.

10. On the Edit Permissions panel, click Add Users/Groups/Roles, search for Principals, and
move them to the Selected list.

You can perform multiple searches to add Principals to the list. For more
information, see "Searching for Existing Users, Groups, or Roles" on page 112.

11. After all Principals have been selected, click Add.

The Permissions panel is displayed in a tree format containing the permissions that
can be granted or denied for the Security Realm.

12. In the tree list, select options as needed.

Click Grant to explicitly grant permission.

Click Deny to explicitly deny permission.

Clear both options to neither explicitly grant nor deny permission. Permissions
will be determined from another source.

13. Click OK and then click Apply.

Removing a Security Realm
To remove a Security Realm, do the following:

To remove a Security Realm

1. As system administrator, click Administration Dashboard > Configuration > Security Realms
Administration.

2. Click the name of the container in which the Security Realm resides.

3. Click the Tools icon  for the Security Realm you want to remove, and then click
Remove Security Realm.
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Renaming a Security Realm
To rename a Security Realm, do the following:

To rename a Security Realm

1. As system administrator, click Administration Dashboard > Configuration > Security Realms
Administration.

2. Click the name of the container in which the Security Realm resides.

3. Click the Tools icon  for the Security Realm you want to rename, and then click
Modify Security Realm.

4. In the Name field, type the new name.

5. (Optional) in the Description field, type a new description.

6. Click Update.

Adding Resources to a Security Realm
To add resources to a Security Realm, do the following:

To add resources to a Security Realm

1. As system administrator, click Administration Dashboard > Configuration > Security Realms
Administration.

2. Click the name of the container in which the Security Realm resides.

3. Click the Tools icon  for the Security Realm you want to manage, and then click
Manage Objects.

4. On the Manage Security Realm panel, click Add Portal Resource.

5. In the left panel, browse to a server resource to be added to the Security Realm.

6. To have the Security Realm manage a server resource, move the resource to the
Selected Items box and click Add Items.

Removing Resources from a Security Realm
To remove resources from a Security Realm, do the following:

To remove resources from a Security Realm

1. As system administrator, click Administration Dashboard > Configuration > Security Realms
Administration.

2. Click the name of the container in which the Security Realm resides.
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3. Click the Tools icon  for the Security Realm you want to manage, and then click
Manage Objects.

4. For the resource you want to remove, Click the Tools icon  and then click Remove.
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Overview of Roles
A role is a collection of users, groups, or other roles. For information about creating roles,
see "Creating Roles" on page 158.

A set of default roles is installed with My webMethods Server, to which you can add
users, groups, and other roles as needed:

Default role Description

Admin Role Provides access to all My webMethods Server
resources. By default, the SysAdmin and Designer
users are members of this role.

My webMethods
Administrators

Provides access to user management and other
functions needed by the My webMethods
Administrator, who is a default member of this role.

My webMethods Users Provides access to the My webMethods user interface
for all users of My webMethods applications. By
default, the My webMethods Server Administrator
is a member of this role, but you must add all
other users to it. See "Granting Users Access to My
webMethods and the My webMethods Users Role" on
page 157.

The members assigned to a role can span across multiple directory services. That
is, their membership can include users, groups, and roles defined in the internal
directory service, as well as, users and groups defined in external directory services.
The membership of a role can be static, like groups where each member is specifically
assigned. However, you can also make the membership of a role dynamic. It is valid
for roles to be recursive, making it possible for roles to be members of each other. The
following table lists the different ways you can define the membership of a role, whether
the membership is static or dynamic, and where to find more information in this chapter
about how to define membership for each type of role.

Membership of a role defined by
specifying...

Static or
Dynamic

For more information, see...

The users, groups, and other roles
you want to be members of the role

Static "Adding a Static Role"
on page 159
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Membership of a role defined by
specifying...

Static or
Dynamic

For more information, see...

An LDAP query that queries
an external directory service to
determine the users or groups
assigned to the role

Dynamic "Adding an LDAP
Query Role" on page
160

The criteria for a rule that My
webMethods Server executes to
determine the users and groups
assigned to the role

Dynamic "Adding a Rule-Based
Role" on page 161

A database query that queries
a database directory service to
determine the users or groups
assigned to the role

Dynamic "Adding a Database
Role" on page 164

You can associate dynamic aributes with a role to provide more information about a
role. For example, if there is a “Customer Service role, an administrator might add a
“Location aribute to identify where the user assigned to the “Customer Service role is
located. When you add the aribute to the role, you assign it a value. This becomes the
default value for the aribute. Continuing with the example, assume your main service
center is in Ohio. As a result, when you add the “Location aribute to the “Customer
Service role, you assign it the value Ohio. You can also assign user-specific values to a
dynamic aribute. Once again, continuing with the example, assume you have a user
that is a member of the “Customer Service role, but who is located in Colorado rather
than Ohio. You can assign that user a specific value of Colorado for the “Location
aribute in the “Customer Service role.

For more information about dynamic aributes, see the following sections in this
chapter:

"Seing User-Specific Values for Dynamic Aributes" on page 167

"Deleting Dynamic Aributes Assigned to a Role" on page 168

Granting Users Access to My webMethods and the My
webMethods Users Role
My webMethods Server includes the My webMethods Users role, which is already
defined for you. The My webMethods Users role governs access to My webMethods.
That is, a user must be a member of the My webMethods Users role for the system to
allow the user to log into the user interface. The My webMethods Users role is a static
role; that is, the membership of the My webMethods Users role is a specified list of users,
groups, and other roles.
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Users Defined in the Internal System Directory Service
When you add users to the internal system directory service, My webMethods Server
automatically assigns the new users to the My webMethods Users role. You do not need
to take any further action.

Externally-Defined Users
You can configure My webMethods Server to obtain information about users and
groups from external directory services. After configuring an external directory
service, you need to take further action to identify the externally-defined users that you
want to be able to access My webMethods. These users must be identified in the My
webMethods Users role. For information about using external directory services with
My webMethods Server, see "Configuring an External LDAP, ADSI, or ADAM Directory
Service" on page 87 and "Allowing Externally Defined Users to Perform Actions from
My webMethods " on page 96.

Creating Roles
The following table describes the types of roles you can create. The differences in
these roles are only in how you identify the membership of the role, and not how My
webMethods Server uses the roles. My webMethods Server uses all roles, regardless of
type, in the same manner.

Role You identify the membership of the role by specifying...

Static Role A collection of users, group, and roles that are members of the role
you are creating. The membership of the role does not change unless
you manually edit the role and change its membership. See Adding
a Static Role next in this chapter.

Note: This is similar to a group except that role membership can
span multiple directory services.

LDAP
Query
Role

An LDAP query. The users, groups, and roles that match the query
become members of the role. The membership of the role is dynamic
based on the outcome of the query at run time. See Adding an LDAP
Query Role.

Rule
Based
Role

A rule that My webMethods Server executes to determine the
membership. The users, groups, and roles that match the rule
become members of the role. The membership of the role is dynamic
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Role You identify the membership of the role by specifying...
based on the outcome of the execution of the rule at run time. See
"Adding a Rule-Based Role" on page 161.

Database
Role

A query for a database directory service. The users, groups, and
roles that match the query become members of the role. The
membership of the role is dynamic based on the outcome of the
query at run time. See "Adding a Database Role" on page 164.

Adding a Static Role
A static role is a simple collection of users, groups, and other roles.

To create a static role

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Roles > Add Role.

As system administrator: Administration Dashboard > User Management > Manage
Roles > Add Role.

2. In the Role Name field, type the name you want to assign to the new role.

3. To select the Static Role Provider, move that role provider to the Selected Items box.

4. Click Create Role.

Editing Members of a Static Role
To edit the members of a static role, do the following:

To edit members in a static role

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Roles

As system administrator: Administration Dashboard > User Management > Manage
Roles

2. Search for the static role to which you want to add members. For more information,
see "Searching for Existing Users, Groups, or Roles" on page 112.

3. In the search results, click the role name or click the Edit icon .

4. On the Members panel, click Edit Members.

5. To add members, do the following:
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a. Under Search For, choose the Users, Groups, or Roles option.

b. In the Keywords field, type a keyword representing the users, groups, or roles you
want to search for, and click Search.

c. Move one or more users, groups, or roles to the Selected box.

6. To delete members from the static role, move them from the Selected box.

7. Click Apply.

Adding an LDAP Query Role
An LDAP query role is based on an LDAP query to an external directory service. Any
user or group that meets the requirements of the query is a member of the role.

To create an LDAP query role

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Roles > Add Role.

As system administrator: Administration Dashboard > User Management > Manage
Roles > Add Role.

2. In the Role Name field, type the name you want to assign to the new role.

3. To select the LDAP Query Role Provider, move that role provider to the Selected Items
box.

4. Click Create Role.

5. In the LDAP Query field type a valid LDAP query.

6. Select the Simple Query option if the query in the LDAP Query field contains simplified
LDAP query syntax.

Unless you are creating a complex LDAP query, the query syntax can be
cumbersome to use. With the Simple Query option, the syntax is filled in for you. For
example, to find all persons whose manager has the user ID abrown, the simple
query syntax is manager=abrown.

7. In LDAP Directory Service, click Browse.

8. Move the LDAP directory service to the Selected Items box and click Select.

9. In the Principal Type list, choose whether the query searches for Users or Groups.

10. To update the LDAP query, click Save (Apply in system administration).
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Adding a Rule-Based Role
A rules-based role is based on a server rule. Any user, group, or role that matches the
rule is a member of the role.

To create a rule-based role

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Roles > Add Role.

As system administrator: Administration Dashboard > User Management > Manage
Roles > Add Role.

2. In the Role Name field, type the name you want to assign to the new role.

3. To select the Rule Based Role Provider, move that role provider to the Selected Items
box.

4. Click Create Role.

5. Under the Match Criteria heading, select Match All Criteria Below or Match Any Criteria
Below as the criteria for the rule-based role.

6. Fill in the appropriate match criteria for the rule-based role using the following
guidelines:

User DN Value(s): A regular expression that matches any part of the current user's
directory distinguished name (DN). In the field, type the portions of the DN to
which you want a match.

For example, ou=Engineering.*ou=US matches a user with the following DN:
uid=joe,ou=Development,ou=Engineering,ou=Midwest,ou=US,o=webMethods

Domain Name Expression: A regular expression that matches any part of the name of
the current user's directory service as registered in My webMethods Server. In the
field, type the directory service name to which you want a match.

For example, US (without quotes) matches a user from the US Corporate directory
service. This is a very effective way to govern the look and feel for users that may be
in different user directories, such as partners.

Group DN and Role DN Expression: A regular expression that matches any part of any
group or role of which the current user is a member. In the field, type the portions of
the DN to which you want a match.

For example, ou=Engineering matches a user belonging to a group with the
following DN:
cn=portal,ou=Engineering,ou=Midwest,ou=US,o=webMethods.
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User Attributes: One or more pairs of user aributes and their values from the user’s
record. If you have more than one user aribute, the value set in Match Criteria
determines how aributes are matched:

Match Criteria value How the rule is applied

Match All Criteria Below Each regular expression must match some part
of the corresponding aribute value for the
current user.

Match Any Criteria Below Any regular expression in the list can match
some part of the corresponding aribute value
for the current user.

For example, if the rule is configured to match all criteria, and the configured user
aribute pairs are the following:

Name Value
office

Bellevue

telephonenumber
(425) 564-0000

and the current user's aribute values are the following:

Name Value (current user)
office

Bellevue

telephonenumber
(206) 123-4567

the rule does not match the current user because it matches the office aribute
value but not the telephonenumber aribute value. If, however, the rule is
configured to match any criteria, the preceding example rule does match the current
user.

To create an aribute-value pair, click Add. At the prompt, type the aribute name
and click OK. At the prompt, type the value to be matched and click OK.

Request Headers: One or more pairs of HTTP header aributes and values. You can
match anything that appears within an HTTP header, such as the browser agent
string or the kinds of MIME types the user will accept. The rule can be a regular
expression, or a simple text string. If you have more than aribute-value pair, the
value set in Match Criteria determines how aributes are matched:
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Match Criteria value How the rule is applied

Match All Criteria Below Each regular expression must match some part
of the corresponding aribute value for the
request header.

Match Any Criteria Below Any regular expression in the list must match
some part of the corresponding aribute value
for the request header.

For example, if the rule is configured to match all criteria, and the configured request
header pairs are the following:

Name Value

Accept-Charset utf-8

Accept-Language ja

and the request header values for the current user are the following:

Name Value (current user)

Accept-Charset ISO-8859-1,utf-8;q=0.7

Accept-Language en-us,en;q=0.5

the rule does not match the current user because it matches the Accept-Charset
header value but not the Accept-Language header value. If, however, the rule was
configured to match any criteria, the rule does match the current user.

To create an aribute-value pair, click Add. At the prompt, type the aribute name
and click OK. At the prompt, type the value to be matched and click OK.

Parent Resource: A resource that matches the current resource or a parent of the
current resource. To select a resource, click Browse to open the resource selector and
select a resource against which to match the rule.If you want match a resource that is
referenced by an alias, you can optionally click Use Alias to select an existing alias on
My webMethods Server.

Resource Type: A resource type that matches the current resource type. To select a
resource type, click Browse to open the resource selector and select a resource type,
from the Extended Types folder, against which to match the rule.If you want match
a resource type that is referenced by an alias, you can optionally click Use Alias to
select an existing alias on My webMethods Server.
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Resource Property: One or more pairs of resource properties and values. If you know
the internal name of a property associated with a resource, you can match it. If you
have more than one property-value pair, the value set in Match Criteria determines
how properties are matched:

Match Criteria value How the rule is applied

Match All Criteria Below Each regular expression must match some
part of the corresponding aribute value for
the request header.

Match Any Criteria Below Any regular expression in the list must
match some part of the corresponding
aribute value for the request header.

For example, if you want to match files that are PDFs, the property-aribute pair is
mimeType=pdf.

To create an property-value pair, click Add. At the prompt, type the aribute name
and click OK. At the prompt, type the value to be matched and click OK.

7. Click Apply.

Adding a Database Role
A database role is based on a query to a database directory service. Any user, group, or
role that matches the rule is a member of the role.

Note: To create a database role, you must first connect to the database as an external
data source. See "Managing External Data Sources" on page 100.

To create a database role

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Roles > Add Role.

As system administrator: Administration Dashboard > User Management > Manage
Roles > Add Role.

2. In the Role Name field, type the name you want to assign to the new role.

3. To select the Database Role Provider, move that role provider to the Selected Items box.

4. Click Create Role.

5. From the Datasource list, select the database to be used as a data store.

6. If the role can include users, in the Query User field, type a SQL query that returns a
record for a given user in the database who should be a member of the role.
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The parameters to the query are:

{uid}—Principal unique ID

{dn}—Principal distinguished name

An example of a valid query is:
select * from user-roles where roleID=‘Admin’ and userid=‘{uid}’

7. If the role can include groups, in the Query Group field, type a SQL query that returns
a record for a given group in the database that should be a member of the role.

8. Click Save.

Editing Information for a Role
To update the information for a role, perform the following procedure:

To edit a role

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Roles

As system administrator: Administration Dashboard > User Management > Manage
Roles

2. Search for the role that you want to edit. For more information, see "Searching for
Existing Users, Groups, or Roles" on page 112.

3. In the search results, click the role name or click the Edit icon .

4. Make the changes you want to the role and click Save (Apply in system
administration).

Important: My webMethods Server displays the information grouped on various
panels. After making changes to information on a single panel, be sure
to click Save (Apply in system administration) to save your changes before
selecting another panel.

The following table lists the panels displayed for a role and the sections in this
chapter that contains a procedure that describes how to edit the information on that
panel:

Panel See...

Role Information "Adding a Static Role" on page 159

"Adding an LDAP Query Role" on page 160

"Adding a Database Role" on page 164
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Panel See...

Dynamic Attributes "Defining Dynamic Aributes Associated with a Role" on
page 166

Deleting Roles
If you no longer need a role, you can delete it.

Note: When you delete a role, the members of the role (users, groups, and/or other
roles) are not deleted.

To delete a role

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Roles

As system administrator: Administration Dashboard > User Management > Manage
Roles

2. Search for the roles you want to delete. For more information, see "Searching for
Existing Users, Groups, or Roles" on page 112.

3. In the search results, select the check boxes beside the roles you want to delete, and
click Delete.

Defining Dynamic Attributes Associated with a Role
You can associate dynamic aributes with a role. Some webMethods applications use
dynamic aributes.

When you define the aribute in the role, you assign it a value. The value you assign to
the role is considered the default value. The default value is used for all users unless a
user-specific value is defined for the aribute.

To define a dynamic attribute for a role

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Roles

As system administrator: Administration Dashboard > User Management > Manage
Roles

2. Search for the role. For more information, see "Searching for Existing Users, Groups,
or Roles" on page 112.
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3. In the search results, click the role name or click the Edit icon .

4. Click Dynamic Attributes.

5. Click Add Attribute.

6. Fill in the following fields:

In this field... Specify...

Attribute Name The internal name for the dynamic aribute. There are no
restrictions on what characters you can use for this name.

Display Name The name you want My webMethods Server to use when it
displays information about this aribute in the user interface.

Data Type The data type of the aribute. Select a data type from the list.

Value The value you want assigned to the aribute. This is the
default value for the aribute. This value will be used for
all users assigned to this role unless a user-specific value is
defined for the aribute. For more information, see "Seing
User-Specific Values for Dynamic Aributes" on page 167.

7. Click Save.

Setting User-Specific Values for Dynamic Attributes
The default value assigned to a dynamic aribute is the default for all users unless you
assign a user-specific value for the aribute. To assign a user-specific value to a dynamic
aribute, perform the following procedure.

To assign a user-specific value to a dynamic attribute

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Users.

As system administrator: Administration Dashboard > User Management > Manage
Users.

2. Search for the user for which you want to assign a user-specific value to a dynamic
aribute. For more information, see "Searching for Existing Users, Groups, or Roles"
on page 112.

3. In the search results, click any link in the row of the user or click the Edit icon .

4. Click Roles.
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5. In the Role Member Attributes panel, locate the dynamic aribute for which you want
to assign a user-specific value, and type the value in the User Value column.

Note that in the display the aributes are grouped by role; the role name appears
before the list of aributes assigned to the role.

6. Click Save (Apply in system administration).

Changing the Order of Dynamic Attributes Assigned to a Role
You can change the order in which dynamic aributes display for a role. Changing the
order affects only how the system displays the aributes in the Role Member Attributes
panel for a user, but does not otherwise affect how the aributes are used by My
webMethods Server or by webMethods applications.

To change the order of dynamic attributes assigned to a role

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Roles

As system administrator: Administration Dashboard > User Management > Manage
Roles

2. Search for the role. For more information, see "Searching for Existing Users, Groups,
or Roles" on page 112.

3. In the search results, click the role name or click the Edit icon .

4. Click Dynamic Attributes and then click Change Attribute Order.

5. To reorder dynamic aributes, move them up or down as needed.

6. When the dynamic aributes are in the order you want, click Save (Apply in system
administration).

Deleting Dynamic Attributes Assigned to a Role
If you no longer want one or more dynamic aributes assigned to a role, you can delete
them.

To delete one or more dynamic attributes assigned to a role

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > System-Wide > User
Management > Roles

As system administrator: Administration Dashboard > User Management > Manage
Roles



M
Odd Header

Managing Roles and Access to My webMethods

Administering My webMethods Server Version 9.8 169

2. Search for the role. For more information, see "Searching for Existing Users, Groups,
or Roles" on page 112.

3. In the search results, click the role name or click the Edit icon .

4. Click Dynamic Attributes.

5. Select the check boxes beside the dynamic aributes you want to delete, and click
Delete Selected Attributes.

6. Click Save.



M
Even Header

Administering My webMethods Server Version 9.8 170



M
Odd Header

My webMethods Server Clustering

Administering My webMethods Server Version 9.8 171

12   My webMethods Server Clustering

■   How a My webMethods Server Cluster Works ..........................................................................     172

■   Planning your My webMethods Server Cluster .........................................................................     176

■   Building a My webMethods Server Cluster ................................................................................    178

■   Modifying the Cluster Configuration ...........................................................................................    179

■   Cluster Status and Control .........................................................................................................    186

■   Removing a Component from a Cluster ....................................................................................     188

■   Managing Content Storage ........................................................................................................     188

■   The cluster.xml File ....................................................................................................................     190

■   Creating a Cluster Node From an Image ..................................................................................     193

■   Partitioning Applications on Cluster Nodes ................................................................................    194



M
Even Header

My webMethods Server Clustering

Administering My webMethods Server Version 9.8 172

How a My webMethods Server Cluster Works
A My webMethods Server cluster is an active/active environment in which multiple
server instances run at the same time, sharing the My webMethods Server database. A
My webMethods Server cluster achieves high scalability by distributing the workload
among multiple servers. This model is different from an active/passive environment,
which makes use of a standby server. A My webMethods Server cluster achieves high
availability through the use of shared resources, allowing the cluster to continue to
function when a node is taken out of service.

To create a cluster, you need to install an instance of My webMethods Server on each
machine in the cluster. All nodes of the cluster share the same My webMethods Server
database, which contains shared configuration information and a system content service.
You should install the same set of webMethods applications (such as Task Engine), My
webMethods User Interfaces, and language packs on each node in the cluster. If an
application is not installed on a particular node, the components of the application are
not functional on that node.

The system content service stores and retrieves files published by individual users and
various objects used by webMethods applications running on My webMethods Server.
The system content service is installed as part of My webMethods Server and does not
require any configuration before use. Once published, content is available to all nodes in
the cluster. The system content service works well for small files. However, if you need
to store large files (1 MB or larger) or a large number of files you should consider the use
of an optional network file system.

Cluster architecture

The nodes in the cluster exchange information when they run. There are two methods of
communication:
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Through the My webMethods Server database. Cluster bookkeeping is maintained
this way.

Through HTTP. When a server delegates another server to run a command, it does
so through the HTTP port of the target server.

Content Services
The default system content service stores files in the My webMethods Server database.
You cannot modify the system content service configuration.

If users of My webMethods Server will store large files (1 MB or larger) or a large
number of files, the system content service may not be adequate for your file storage
needs. In such cases, you should use a network content service to provide higher
capacity. My webMethods Server supports network file storage by means of a file
system content service, which requires a file share.

On Windows, the file system content service uses a UNC (Uniform Naming Convention)
path to connect to a network file storage device. On UNIX, the network file storage must
be mounted as a local resource. To support cluster high availability, the network file
storage device should have failover support.

For information on configuring a network content service, see "Managing Content
Storage" on page 188.

The Front End URL
In a production environment, all users and all webMethods applications that
communicate with the My webMethods Server cluster need to use the Front End URL
established for the cluster, described in "Seing the Front End URL" on page 179. In
addition, a production cluster should include the use of a load balancer or external web
server, as shown in "High Availability in a My webMethods Server Cluster" on page
174.

In practice, users log into the Front End URL through the load balancer. In turn, the load
balancer distributes calls to the nodes. A cluster can have only one Front End URL.

Note: The load balancer must be set up to use sticky sessions. A user session, once
established, is routed to the same server machine until the session is closed.

When an HTTP request is issued to produce a My webMethods Server page, My
webMethods Server uses the actual host name and port number of that request, no
maer how the request is routed: directly or indirectly through the load balancer or web
server. In these cases a Front End URL is not necessary.

For several use cases, like generating My webMethods Server URLs from within
email notifications or creating links to tasks from within Task Engine, Front End URL
configuration is required because no HTTP request is available at that time.
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High Availability in a My webMethods Server Cluster
By itself, a My webMethods Server cluster does not provide high availability. You must
also ensure the availability of data stored by the nodes in the cluster. To provide high
availability, the database server used by the My webMethods Server database must have
a failover capability.

If the cluster uses the default system content service, it in turn uses the My webMethods
Server database, so it is covered by the database server failover capability. However, if
you use a network content service, the network file storage device must have failover
capability to support cluster high availability.

Any description of the configuration of third-party failover devices is beyond the scope
of this guide.

Requirements for a highly available My webMethods Server cluster

Component Deployment in a My webMethods Server Cluster
A My webMethods Server cluster uses an asymmetrical mode of deploying components
such as portlets or deployable packages.

In Asymmetrical component deployment mode, a component deployed to a node is
not automatically deployed to other nodes in the cluster. In Asymmetrical deployment
mode, you need to manually deploy a component locally to each node where it is
needed. In this mode it is possible to have different versions of a component running
at the same time on different nodes of a cluster. Because component registration is
centralized in the My webMethods Server database, the registration is performed
only once by the first node on which the component is deployed. Because of this
dependency, changes made to a component that can affect component registration or My
webMethods Server taxonomy can potentially break other versions of the component
residing on a different node. Some examples of changes to a component that can cause
changes to the My webMethods Server database schema are:

Adding or removing a portlet preference.
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Adding, removing, or changing a field in a DBO (Dynamic Business Object) table.

Adding, removing, or changing a field in a task type business data.

Adding, removing, or updating My webMethods Server taxonomy

Asymmetrical component deployment mode enables you to deploy and test a modified
component on one or more nodes before deploying it to the entire cluster.

Cluster Roles
There are several cluster roles that can be assigned to a node in a cluster. These include:

The Auto Deploy cluster role allows for the automatic deployment of portlets that are
copied to the Software AG_directory\MWS\server\server_instance \deploy directory
(of a node that has the Auto Deploy role). A cluster can have multiple Auto Deploy
nodes. This role is enabled by default, but is only needed if you want the automatic
deployment capability. It is often desirable to have this role disabled in a production
environment to reduce the possibility of unauthorized modification of the server.
This role does not affect cluster high availability.

The Notification cluster role is responsible for formaing and sending email
notifications, and notifications that are sent to a user. A cluster can have multiple
Notification nodes. The Notification role is enabled by default, but is needed only
if you use notifications in your production environment. For example, if you are
running Task Engine, users will not receive task notifications if the Notification role
is not enabled. For high availability it is recommended that you have more than
one cluster node in this role. If all Notifications nodes go down, notification request
messages continue to accumulate in the queue. No notifications are generated
or delivered until one or more Notification nodes comes back online and starts
processing them.

The Search role is responsible for indexing all content that is exposed to the
embedded search engine, maintaining the search index, and performing the
searches. The Search role is enabled by default, and should be enabled on all cluster
nodes where the search functionality will be needed. The Search role is important to
server operation and there are core features that will not operate without it.

Permissions Management

Workspace Management and Add to Workspace

Each cluster node maintains a local copy of the search index, improving the
performance and reliability of searches. If the search index becomes corrupted
on one cluster node, you can remove that node from the load balancer while the
search index is rebuilt on that node. In the meantime, the other nodes can continue
servicing requests.

The Task engine cluster role is responsible for all Task Engine activities, such as
queuing tasks, processing task rules, searching and retrieving task data. A cluster
can have multiple Task Engine roles. This role is enabled by default, but is needed
only if you actually have Task Engine running on your cluster. For high availability
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it is recommended that all nodes have this role enabled unless a specific node is not
included in the load balancer configuration and never services end-user or Process
Engine requests.

Guidelines for Assigning Specific Cluster Roles
You can assign cluster roles to each node in a cluster following the guidelines that
follow. Any time you change the roles assigned to a cluster node, you need to restart the
node for the assignments to take effect.

The Auto Deploy, Task Engine, and Notification roles can be assigned to as many
nodes as you need.

Nodes that are running one or more roles can be further broken down and
separately clustered. This may be necessary if your scalability requirements warrant
seing up additional cluster roles to handle increased traffic.

The configuration data for each node is stored in the cluster.xml file. It is possible
to edit the data for your cluster directly in the cluster.xml file, provided you know
the proper data structures and values for the properties of your cluster.For more
information, see "The cluster.xml File" on page 190.

Any changes to the cluster configuration will require each node to be restarted.

Planning your My webMethods Server Cluster
The following diagram shows just one of many types of distributed deployments that
can be configured with My webMethods Server.
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A My webMethods Server Cluster Network Diagram

The preceding diagram assumes that there will be three server machines operating in
a cluster, each with its own cluster roles. The machines defined in the web tier include
a hardware-based load balancer and two web server machines. The following sections
illustrate the process that an administrator would work through to build a cluster.
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The procedure for configuring Apache in an external load-balanced web server cluster
configuration with your deployment is explained in "Using My webMethods Server with
Web Servers" on page 47.

Building a My webMethods Server Cluster
Consider the following when building a My webMethods Server cluster:

All servers in the cluster must use the sameMy webMethods Server database. Make
sure that you use the same My webMethods Server database JDBC URL when you
install each node in the cluster.

You must install the same set of webMethods applications (such as Task Engine), My
webMethods User Interfaces, and language packs on each node in the cluster.

To build a My webMethods Server cluster, install each node in the cluster following
the instructions provided in Installing webMethods and Intelligent Business Operations
Products. You must provide the following information:

The HTTP port number for each server instance. The default value is 8585.

Note: If you install two server nodes on the same machine, you must use a
different HTTP port for each node.

The JDBC URL for the My webMethods Server database. The URL must include
any additional properties needed to support database server failover.

The Installer creates a default instance of My webMethods Server.

You can start the nodes in the cluster concurrently or one after the other, depending
on your needs. The first time you start each node, it performs bootstrap activities and
loads shared configuration files from the My webMethods Server database. The node
is automatically added to the cluster. You can also add nodes to a cluster manually,
as described in "Adding a Node to a Cluster" on page 180.

Important: Do not make any cluster configuration changes while you are
starting cluster nodes for the first time. If you do so, you may lose the
configuration of the nodes that perform self-configuration automatically
when starting for the first time.

If the startup of a node completes successfully, you can open a browser window and
log into My webMethods Server as system administrator to verify that the node is
running correctly.

If you are building a production cluster, perform the following steps:

If you know you will need a network content service, set it up as described in
"Managing Content Storage" on page 188.
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If you already have a load balancer or external web server set up, change the
Front End URL to point there as described in "Seing the Front End URL" on
page 179.

Modifying the Cluster Configuration
You can perform several functions to modify the configuration of a standalone server, a
cluster, or a node in a cluster.

This function... Is described here...

Specify a Front End URL to be used by
the cluster.

"Seing the Front End URL" on page
179

Specify the webMethods Universal
Messaging Server to be the JMS
provider.

"Using the Universal Messaging Server
as a JMS Provider" on page 180

Add a node to the cluster. "Adding a Node to a Cluster" on page
180

Modify properties of a standalone
server or a node in a cluster.

"Modifying a Node in a Cluster" on
page 181

Delete a node from a cluster. "Deleting a Node from a Cluster" on
page 183

Setting the Front End URL
All users and all webMethods applications that communicate with the My webMethods
Server cluster need to use the Front End URL established for the cluster. By default, this
value is the URL of the first node of the cluster. This URL can point to a load balancer or
external web server. A cluster can have only one Front End URL.

To change the Front End URL for a cluster

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Cluster Settings > Advanced or Clustered Configuration.

As system administrator: Administration Dashboard > Configuration > Cluster
Administration > Advanced or Clustered Configuration.

2. In the MwS Front End URL field, type a fully qualified URL:
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hp://host_name :port number

3. Click Submit.

Using the Universal Messaging Server as a JMS Provider
You can use the webMethods Universal Messaging Server as a JMS (Java Message
Service) provider.

To use the Universal Messaging server as a JMS provider

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Cluster Settings > Advanced or Clustered Configuration.

As system administrator: Administration Dashboard > Configuration > Cluster
Administration > Advanced or Clustered Configuration.

2. Select the Universal Messaging Server option.

3. In the JNDI Provider URL field, type the following URL:

nsp://localhost:9000

4. Click Submit.

Adding a Node to a Cluster
A node is automatically added to the cluster when you start it for the first time. The new
node must have the same My webMethods Server database as the other nodes in the
cluster and should have the same set of webMethods applications (such as Task Engine),
My webMethods User Interfaces, and language packs on each node in the cluster.

To add a node to a cluster

1. Install the cluster node following instructions provided in Installing webMethods
and Intelligent Business Operations Products . You need to provide the following
information:

The HTTP port number for this server instance. The default value is 8585.

The JDBC URL for the My webMethods Server database used by the cluster. This
URL should include any additional properties needed to support database server
failover.

The Installer creates a default instance of My webMethods Server.

2. Start the My webMethods Server instance.

The first time you start an additional node, it performs bootstrap activities and loads
shared configuration files from the My webMethods Server database. The node is
automatically added to the cluster.
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Modifying a Node in a Cluster
You can modify several properties for a node in a cluster or a standalone instance of
My webMethods Server. Common reasons to modify a node are to add security by
specifying an HTTPS port, add support for an external web server, or change cluster
roles. You can also modify the properties of a cluster node or a standalone server
manually. See "The cluster.xml File" on page 190.

To modify a standalone server or a node in a cluster

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Cluster Settings > Advanced or Clustered Configuration.

As system administrator: Administration Dashboard > Configuration > Cluster
Administration > Advanced or Clustered Configuration.

2. For a standalone server or a node in the cluster, do any of the following.

In the HOST field, change the host name (including domain if appropriate) or IP
address of the machine where the node is to run.

The specified host name or IP address must resolve to the correct machine
running the node. It must be valid for all nodes in the cluster. See your network
administrator for information about host names and network setup at your site.

In the HTTP PORT field, change the port number to be used by the HTTP listener.

This field must always have a valid port number.

In the HTTPS PORT field, type the port number to be used by the HTTPS listener.

A value of 0 (zero) in this field disables the listener.

Note: My webMethods Server includes a sample HTTP certificate that you
can use to set up and test your HTTPS listener. The sample is located
in the Software AG_directory \MWS\server\server_instance \config
\localhost.p12 file (see "Certificates Used for Secure Connections" on
page 38). For production environments, be sure to obtain an actual
Certificate from a qualified authority such as Verisign.

To select one or more roles for a node, select the check box for the role.

3. Click Submit.

4. Restart the cluster or standalone server for the changes to take affect, as described
in "Restarting or Stopping All Nodes in a Cluster" on page 188 or "Restarting or
Stopping Individual Nodes in a Cluster" on page 187.
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Assigning a Search Role to a Node
The Search role is enabled by default. You can assign the Search role to nodes on the
cluster as needed.

To assign the Search role to a node

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Cluster Settings > Advanced or Clustered Configuration.

As system administrator: Administration Dashboard > Configuration > Cluster
Administration > Advanced or Clustered Configuration.

2. Select the Search option for nodes that are to be assigned the role and clear the option
for nodes that should not have the Search role.

3. Restart the cluster or standalone server for the changes to take affect, as described
in "Restarting or Stopping All Nodes in a Cluster" on page 188 or "Restarting or
Stopping Individual Nodes in a Cluster" on page 187.

Renaming a Node
Nodes in a cluster are automatically given node names when you add them to the
cluster. This name appears in these locations in the My webMethods Server user
interface:

Field Name My webMethods Server page

NAME Advanced or Clustered Configuration

NODE NAME Cluster Status and Control

You can change the name of any node manually by doing the following:

To rename a node in a cluster

1. At a command line prompt on the machine that contains the node, move to the bin
directory of the server instance:

Software AG_directory\MWS\bin

2. To retrieve the cluster.xml file from the My webMethods Server database, type this
command:
mws getconfig cluster.xml

3. Open the cluster.xml file in a text editor.

You can find the file at this location:
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Software AG_directory\MWS\server\server_name \config

4. In the cluster.xml file, change the name aribute of the Component element for this
node and save the file:
<Component
      class="com.webmethods.portal.system.cluster.impl.Server"
      enabled="true"
         name="node_name "><Properties

5. To deploy the revised cluster.xml file to the My webMethods Server database, at the
command line prompt type this command:
mws putconfig cluster.xml

6. Delete the cluster.xml file from the \server_name \config directory.

If you do not delete the cluster.xml file, this node will continue to use the local
version of the file.

7. Open the custom_wrapper.conf file for the server instance in a text editor. You can
find the file at this location:

Software AG_directory\profiles\MWS_server_name \configuration\

8. In the custom_wrapper.conf file, change the value of the NODE_NAME statement
and save the file:
set.NODE_NAME=node_name

9. Open either the cluster.node.properties or cluster.node.properties.bak file
(whichever file is present) in a text editor. You can find the file at this location:

Software AG_directory\MWS\server\server_name \config\

10. Edit the name=node_name statement and save the file.

11. Restart the node, as described in "Restarting or Stopping Individual Nodes in a
Cluster" on page 187.

Deleting a Node from a Cluster
When a node in a My webMethods Server cluster is no longer in use, you should delete
it from the cluster by doing the following:

To delete a node from a cluster

1. From another node, stop the node to be deleted from the cluster, as described in
"Restarting or Stopping Individual Nodes in a Cluster" on page 187.

2. To retrieve the cluster.xml file from the My webMethods Server database, type this
command:
mws getconfig cluster.xml

3. Open the cluster.xml file in a text editor, which you can find at this location:

Software AG_directory\MWS\server\server_name \config
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4. In the cluster.xml file, locate the node to be deleted, remove the entire <Component>
element for this node, and save the file. For example:
<Component
  class="com.webmethods.portal.system.cluster.impl.Server"
  enabled="true"
    name="node_name "><Properties
.
.
.
</Component>

5. To deploy the revised cluster.xml file to the My webMethods Server database, type
this command:
mws putconfig cluster.xml

6. Delete the cluster.xml file from the \server_name\config directory.

7. Restart the cluster, as described in "Restarting or Stopping All Nodes in a Cluster" on
page 188.

Uninstalling a Node
If you uninstall a My webMethods Server instance that is a node in a cluster, the
node is automatically deleted from the cluster configuration. If the My webMethods
Server database is not available at the time of uninstallation, you must delete the node
manually as described in "Deleting a Node from a Cluster" on page 183.

Modifying Database Connection Retries
If a server loses its connection with the My webMethods Server database, it tries to
reestablish the connection. This would be the case if a database failover occurs in a high
availability environment. You can modify the number of times the server retries the
connection and the interval it waits between retries. If you have multiple servers in a
cluster, you need to modify these values individually on each machine. Also, if you
have multiple server instances on the same machine (the default server plus one or more
additional servers), you need to modify the values for each server instance.

My webMethods Server database connection information for each server instance is
maintained in the mws.db.xml file found in this location:

Software AG_directory\MWS\server\server_name \config

You can modify the following database retry values:

Value Description

Retry count The number of times My webMethods Server aempts to re-
execute a SQL statement in the case of connection loss, deadlock,
or any other SQL error not normally expected If the value is:
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Value Description

0—the server does not try to reestablish the connection.

An integer of 1 or more—the server retries the connection that
number of times.

Typically, you should set the retry count to no more than three. If
the server needs more than that number, there are problems with
the connection or with the database server.

Retry delay The time in milliseconds the server waits between retries. The
retry delay value should be large enough to allow for a failover
to occur, and is dependent on the configuration of your database
server.

To modify retry behavior for a single My webMethods Server database connection, do
the following.

To modify database retry behavior for a server instance

1. Open the mws.db.xml file, which you will find at the following location, in a text
editor:

Software AG_directory\MWS\server\server_name \config

2. To change the number of retries, for each node in the cluster, add the <RETRYCOUNT>
element to mws.db.xml within the <PARAMS></PARAMS> tags:
<RETRYCOUNT>2</RETRYCOUNT>

3. To change the number of milliseconds to delay between retries, for each node in the
cluster, add the <RETRYDELAY> element to mws.db.xml within the <PARAMS></
PARAMS> tags:
<RETRYDELAY>300</RETRYDELAY>

The combined elements might look like this:
<PARAMS> 
   . 
   . 
   . 
   <!-- retry count on error --> 
   <RETRYCOUNT>2</RETRYCOUNT> 
   <!-- delay in ms between retries  --> 
   <RETRYDELAY>300</RETRYDELAY> 
</PARAMS>

4. Save the file and restart the My webMethods Server instance.

5. Repeat this procedure for each node in the cluster.
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Cluster Status and Control
You can see status information about a node in a cluster or a a standalone server, restart
or stop an individual node, or restart or stop an entire cluster.

This function... Is described here...

Display a page of status information
for the nodes in the cluster.

"See Status Information About a
Cluster" on page 186

Restart or stop an individual node in a
cluster.

"Restarting or Stopping Individual
Nodes in a Cluster" on page 187

Restart or stop all nodes in a cluster at
once.

"Restarting or Stopping All Nodes in a
Cluster" on page 188

See Status Information About a Cluster
You can update status information for the nodes in a cluster or a standalone server
manually. To see status information about the nodes in a cluster or a standalone server,
do the following:

To see status information about nodes in a cluster

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Cluster Settings > Cluster Status and Control.

As system administrator: Administration Dashboard > Configuration > Cluster
Administration > Cluster Status and Control.

2. To update the status information on the Status and Control page, click Refresh.

The Status and Control page has the following fields:

Field Description

Indicator of whether the node is running or not. Click the icon for
a node to update individual status. Click  to update status for
all nodes. The status icons are:

 The node is running

 The node is stopped
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Field Description

NODE NAME The node name assigned to the node. If you click the node name,
the browser connects directly to the node using the current
window. You can change this name manually, as described in
"Renaming a Node" on page 182.

ROLES The cluster roles currently assigned to the node.

UP TIME The time since the node was last started in days, hours, and
minutes.

ACTIVE USERS The number of active users for the node. This number may not
equal the exact number of logged-in users because it can include
guest sessions and abandoned sessions.

ACTIONS Actions you can take on the node, as described in "Restarting or
Stopping Individual Nodes in a Cluster" on page 187.

Restarting or Stopping Individual Nodes in a Cluster
You can restart or stop an individual node in a cluster.

To restart or stop individual nodes in a cluster

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Cluster Settings > Cluster Status and Control.

As system administrator: Administration Dashboard > Configuration > Cluster
Administration > Cluster Status and Control.

2. For the node to be acted upon, do either of the following:

Click Restart.

The node is stopped, causing the  icon to be displayed. After the node is
restarted, the  icon returns.

Click Shutdown.

The node is stopped. After you have stopped the node, you cannot restart it from
this page. You need to start the My webMethods Server instance on the host
machine.
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Restarting or Stopping All Nodes in a Cluster
You can restart or stop all nodes in a cluster with a single command.

To restart or stop all nodes in a cluster

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Cluster Settings > Cluster Status and Control.

As system administrator: Administration Dashboard > Configuration > Cluster
Administration > Cluster Status and Control.

2. Do either of the following:

Click Restart Cluster.

The nodes are stopped and restarted one at a time beginning with the first node
in the table. If the first node is the one from which you issue this command,
the restart will begin with the next node. Your node is restarted after all other
nodes have restarted. The page does not automatically refresh after the node is
restarted. You should manually refresh the browser after a minute or so. The
login screen is displayed when the clustered is fully restarted.

Click Shutdown Cluster.

All nodes are stopped. To restart the nodes, you need to start the My
webMethods Server instance on each host machine.

Removing a Component from a Cluster
Because all nodes in a cluster use the same My webMethods Server database,
registration information for all deployed components is shared among the nodes. If you
remove a component from one node, the registration is removed from the database and
the component is no longer available on any node.

To remove a component from a cluster

Remove the component file from each node's deploy folder (if each node has the
Autodeploy role enabled)

—OR—

Use Deployer to roll back the component on each node in the cluster

Managing Content Storage
The Content Service page allows system administrators to manage the storage locations
available for content published to the server, which is physically stored in the locations
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configured in the content service. It typically resides on a separate file server for backup
purposes and to provide a failover capability for high availability in a My webMethods
Server cluster.

The default system content service stores files in the My webMethods Server database.
You cannot modify the system content service but it is visible on the Content Service
page.

If users of My webMethods Server store large files (1 MB or larger) or a large number
of files, the system content service may not be adequate for your file storage needs. In
such cases, you should provide a network content service to provide higher capacity.
My webMethods Server supports network file storage by the use of a file system.

My webMethods Server stores the binary content of a file in a content service (either
system or network) when you:

Publish a file to the server

Update a file

Check in a new version of a versioned file

The physical binary content is stored in the content service as long as the file object exists
in My webMethods Server. The binary content is marked for deletion when you delete
the corresponding file object on My webMethods Server, but the actual file is not deleted
until the regularly scheduled purging period. Typically, My webMethods Server purges
deleted objects at 2 A.M, server time.

When you set a new default content service, all new content is directed to that service,
but content stored in an existing service, such as the system content service, continues to
be accessed from that service.

To configure a new Content Service for the server repository

1. As system administrator: Administration Dashboard > Content > Content Service > Create
New Content Service.

2. In the Service Name field, type a name for your new content service.

The user ID can be 1 through 255 characters and can contain only alphanumeric
ASCII characters with no spaces.

3. From the Type list, select File System and click Next.

4. Type a physical storage location for your content service.

On Windows, use a valid UNC path. The format of a UNC path is:

\\server\volume\directory\

and is not case-sensitive. For example:

\\my_sys\C$\temp

On UNIX, use the path the mounted location of the network storage:

\mounted_location\folder
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Note: There are many ways to configure an external content repository for My
webMethods Server. This example assumes your network administrator
has provided the proper security seings to allow all servers in a cluster
to have read/write access to the network file system. If My webMethods
Server runs as a Windows service, make sure the user account used to run
the service has the right access privileges for the network file system.

5. Click Apply.

6. To make the new content service the default content service, click Tools for the
new service and then click Set As Default.

The new Content Service becomes the default location for storing new content that is
published to the server.

The cluster.xml File
The cluster.xml file contains configuration information for a standalone server or for
all servers in a cluster. This file resides in the My webMethods Server database. My
webMethods Server adds new servers to this file when you add nodes to a cluster,
and modifies it when you make changes in the Cluster Administration page. You can
also modify the cluster.xml file manually, as shown in "Renaming a Node" on page
182and "Deleting a Node from a Cluster" on page 183. The following fragment
shows a basic configuration for a node in a cluster, including these properties:

Property Description

Node name server-one-node59581

Host name server-one

HTTP port 8585

HTTPS port 0—Indicates the HTTP listener is disabled.

Roles Indicates the cluster roles supported by this server are
autodeploy, taskengine, and notification.

  
<Component
   class="com.webmethods.portal.system.cluster.impl.Server"
      enabled="true"
      name="server-one-node59581"><Properties
      host="server-one" name="http"
      port="8585"/>
   <Properties
      host="server-one" name="https"
      port="0"/>
   <Role
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      name="autodeploy"/>
   <Role
      name="taskengine"/>
   <Role
      name="notification"/>
/Component>

You can perform the following actions in the cluster.xml file:

Action Description

Add a node Add a complete <Component> element to the
file, as shown in the preceding example. In this
case, the node must already exist and must use
the same My webMethods Server database as
other nodes in the cluster. The node name in the
cluster.xml file must agree with the node name in the
custom_wrapper.conf file on the host machine for that
node, or must be specified in the command line used
to start the node:mws -n node_name  start

Rename a node Change the node name of a node.

Modify aributes Edit any of the aributes for a node, including node
name, HTTP, and HTTPS ports, and cluster roles.

Delete a node Remove the complete <Component> element that
defines the node.

Modify the Front End
URL

Edit the frontEndUrl aribute, not shown in the
example.

Editing the cluster.xml File
To edit the cluster.xml file a My webMethods Server instance does not have to be
running, but the My webMethods Server database does.

To edit the cluster.xml file

1. At a command line prompt on any machine that hosts a cluster node, move to the bin
directory of the server instance:

Software AG_directory\MWS\bin

2. To retrieve the cluster.xml file from the My webMethods Server database, type this
command:
mws getconfig cluster.xml

3. Open the cluster.xml file in a text editor.



M
Even Header

My webMethods Server Clustering

Administering My webMethods Server Version 9.8 192

You can find the file at this location:

Software AG_directory\MWS\server\server_name \config

4. Make a backup copy of the cluster.xml file.

5. Modify the contents of the cluster.xml file as needed.

6. To deploy the revised cluster.xml file to the My webMethods Server database, at the
command line prompt type this command:
mws putconfig cluster.xml

7. Delete the cluster.xml file from the \server_name \config directory.

If you do not delete the cluster.xml file, this node will continue to use the local
version of the file.

8. Restart the cluster, as described in "Restarting or Stopping All Nodes in a Cluster" on
page 188.

Backing Out of a Change to the cluster.xml File
If you use the Cluster Administration page to make a change to a cluster.xml file
that introduces an error, you can return to the previous configuration using the
cluster.xml.bak file. A My webMethods Server instance does not have to be running, but
the My webMethods Server database does.

To back out of a change to the cluster.xml file

1. At a command line prompt on any machine that hosts a cluster node, move to the bin
directory of the server instance:

Software AG_directory\MWS\bin

2. To retrieve the cluster.xml.bak file from the My webMethods Server database, type
this command:
mws getconfig cluster.xml.bak

3. Change the name of cluster.xml.bak to cluster.xml.

4. To deploy the revised cluster.xml file to the My webMethods Server database, at the
command line prompt type this command:
mws putconfig cluster.xml

5. Delete the cluster.xml file from the \server_name \config directory.

If you do not delete the cluster.xml file, this node will continue to use the local
version of the file.

6. Restart the cluster, as described in "Restarting or Stopping All Nodes in a Cluster" on
page 188.
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Creating a Cluster Node From an Image
One method to create a cluster is to save an image of a machine with an installed
My webMethods Server instance and other products, and move it to a new machine.
This effort saves installation time and results in an identical configuration on the
new machine. It is recommended that you create an image of a fully initialized My
webMethods Server instance instead of just a My webMethods Server installation. The
My webMethods Server instance becomes fully initialized after it has been started for the
first time and the administrator successfully logs in and then stops it.

Before you can use the new node in a cluster, you need to make a few changes. The new
machine needs to have access to the My webMethods Server database, but you should
not start My webMethods Server before making the following changes.

To add a node created from an image

1. On the machine with a new image, at a command line prompt, move to the bin
directory of the server instance:

Software AG_directory\MWS\bin

2. To retrieve the cluster.xml file from the My webMethods Server database, type this
command:
mws getconfig cluster.xml

3. Open the cluster.xml file in a text editor.

You can find the file at this location:

Software AG_directory\MWS\server\server_name \config

4. Copy the entire <Component> element for the server instance on the original
machine and paste it back into the cluster.xml file.

5. For the new <Component> element, make these changes:

a. Change the name- value to a node name descriptive of the new node.

b. Change the host- property to host name of the new machine

For example:
name="server-one-node59581"><Properties
host="server-one" name="http"

might be changed to this:
name="node2"><Properties
host="server-two" name="http"

c. As needed, change the <Role> values to reflect the cluster roles to be assumed by
the new node.

6. To deploy the revised cluster.xml file to the My webMethods Server database, at the
command line prompt type this command:
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mws putconfig cluster.xml

7. Delete the cluster.xml file from the \server_name \config directory.

If you do not delete the cluster.xml file, this node will continue to use the local
version of the file.

8. Open the custom_wrapper.conf file for the server instance in a text editor. You can
find the file at this location:

Software AG_directory\profiles\MWS_server_name \configuration\

9. In the custom_wrapper.conf file, change the value of the NODE_NAME statement
and save the file:
set.NODE_NAME=node_name

10. Start the My webMethods Server instance.

11. If the startup completes successfully, open a browser window and log into My
webMethods Server as SysAdmin, to verify it is running correctly.

12. Restart each node in the cluster.

You can restart nodes manually, or you can do so from within My webMethods
Server, as described in "Restarting or Stopping All Nodes in a Cluster" on page
188.

Partitioning Applications on Cluster Nodes
In a My webMethods Server cluster, partitioning is the division of applications
among nodes of the cluster. By configuring cluster partitions, you can control which
applications run on a node and which do not run. Partitioning is not the same as
asymmetrical mode ("Component Deployment in a My webMethods Server Cluster" on
page 174), which causes components to be deployed to a node manually. Partitioning
controls the actual execution of components.

Why Would I Want Partitions?

There are several practical reasons why you might want to create partitions in your
cluster:

Separation of clients

Through the use of load balancer rules, you can route one set of users to one node
and another set of users to a different node. Users on a partition have access to only
the set of applications you choose to provide for them.

Beer control over application management

Because you run certain applications only within one partition, it is easier to update
an application while the rest of the cluster continues to operate normally.

Cache stability and memory usage
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If a particular node experiences slow performance due to heavy traffic, users on
other nodes are not affected. In the current Task Engine architecture for example,
tasks typically reside in an in-memory cache. The existence of too many task
instances in the cache will overrun the available memory.

Guidelines for Partitions

There are a few things you should know about how partitions are created within a
cluster:

By default, a cluster has a single partition. If there is only one partition, all nodes
are part of it, regardless of whether you have explicitly listed them as part of the
partition.

Each node is part of a partition. Any nodes you have not specifically listed as part of
a partition become members of the last partition defined in the configuration files.
See "Creating and Modifying Partitions" on page 195

Each partition is associated with a phaseProvider.xml file, which governs whether
portlets are enabled or disabled. If a partition is not associated with a specific phase
provider file, it is associated with the default phase provider by default.

Creating and Modifying Partitions
By default, there is one partition that includes all cluster nodes, as described in "The
Default Partition Configuration" on page 198. To create or modify additional
partitions, you need to modify the partition configuration files.

My webMethods Server uses configuration files to manage partitioning on a cluster.

clusterPartitions.xml—Modify this file to add partitions to the cluster and assign
nodes to each partition. See "The Cluster Partition File" on page 196.

partition_name PhaseProvider.xml—Create and modify these files to specify whether
portlets are enabled or disabled. See "The Phase Provider File" on page 196.

Each partition can have its own phase provider file. A partition that does not have a
unique phase provider associated with it uses the default phaseProvider.xml file.

partition_name Portlets.properties—Create and modify one of these files for each
phase provider. This file lists the portlets affected by the phase provider for a specific
partition. See "The Portlets Properties File" on page 197.

Each partition can have its own portlets properties file. If all portlets in the partition
are enabled, a portlets properties file is not required.

Note: File names and file contents are case sensitive.

My webMethods Server stores these configuration files in the My webMethods
Server database. To get access to these files so you can modify them, see "Modifying
Configuration Files Stored in the Database" on page 71.
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The Cluster Partition File
The cluster partition file, clusterPartitions.xml, defines the partitions on the
cluster and assigns nodes to each partition.The data structure for a partition in the
clusterPartitions.xml file looks like this:
<ClusterPartitions> 
   <Partition name="partition_name " 
         frontEndUrl="http://some.url.com "> 
      <Component name="component_name "> 
      </Component>     
   </Partition> 
</ClusterPartitions>

where:

partition_name Is the name assigned to the partition. Other configuration files
use this name to identify the partition.

some.url.com An alternate Front End URL.

The frontEndUrl aribute is optional, allowing the partition
to use a different Front End URL than the cluster as a whole.
If you omit this aribute, the partition uses the frontEndUrl
value in the cluster.xml file.

component_name The name of a component (a cluster node) that is part of the
partition. The component name is the same as the component
name in the cluster.xml file.

Entries in clusterPartitions.xml conform to the following rules:

There is one Partition element for each partition in the cluster. There is always at
least one Partition element.

Each Component element represents a cluster node that is a member of the partition.
There can be zero or more nodes specified for a partition.

If there is only one Partition element in the file, all cluster nodes are members of
that partition, regardless of whether they are represented by a Component element.

Any cluster node not specifically represented within a Partition element is
automatically a member of the last partition defined in the file.

The Phase Provider File
A phase provider file, partition_name PhaseProvider.xml, determines whether portlets
are enabled or disabled for a partition. Each partition can have its own phase provider
file. A partition that does not have a unique phase provider associated with it uses the
default phaseProvider.xml file. The portion of the phase provider file that applies to this
topic is in the portlet phase nested inside the CoreServices phase:
<!-- All services come on line  --> 
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<Phase name="CoreServices" enabled="true" 
   class="com.webmethods.portal.system.init.impl.DefaultPhase"> 
      . 
      . 
   <PhaseInfo name="portlet" enabled="true" 
      class="com.webmethods.portal.service.portlet.impl.PortletProvider" 
      initFile="config:/adminPortlets.properties" 
      initFileComponentsEnabled="false" 
   /> 
      . 
      . 
/>

where:

initFile Specifies the portlets properties file containing
a list of portlets to be affected by the phase
provider for the partition.

initFileComponentsEnabled Specifies whether the portlets listed in the
partition portlets properties file are to be
enabled or disabled:

false: The listed portlets will be disabled.

true: The listed portlets are the only ones that
will be enabled.

In the example above, the portlets properties file is adminPortlets.properties and the
initFileComponentsEnabled aribute is false, meaning that file contains a list of
portlets to be disabled.

The initFile and initFileComponentsEnabled aributes are not required. If you
omit these aributes, all portlets are enabled in the partition.

Note: To create a new phase provider file for a partition, make a copy of the default
phaseProvider.xml file and make changes as needed.

The Portlets Properties File
The portlets properties file, partition_name Portlets.properties, lists the portlets affected
by the phase provider for a specific partition. For development or testing purposes, you
can override the phase provider for individual portlets.

The structure of the portlets properties file is simple. Each portlet resides on a separate
line, followed by the = sign, as shown in this example:
wm_task_chart___taskchart= 
wm_task_search___taskinboxsearchbar= 
wm_task_search___taskinboxsearchresults= 
wm_task_search___tlmsearchresults= 
wm_task_search___tlmsearchquery=

A portlets properties file is not required for a partition in which all portlets are enabled.
In this case, you can omit the initFile and initFileComponentsEnabled aributes
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in the phase provider file, which would otherwise manage use of the portlets properties
file.

Temporarily Overriding the Phase Provider File

For development or testing, you can temporarily override the default behavior of the
phase provider for an individual file. By prefixing a + or - sign to the = sign, you can
specify how the portlet will act:

+= Causes the portlet to be enabled, regardless of the phase provider.

-= Causes the portlet to be disabled, regardless of the phase provider.

Say, for example, the initFileComponentsEnabled aribute is false, which causes all
portlets listed in the portlets properties file to be disabled. To enable any portlet in the
list above, change = to +=, such as this:
wm_task_search___processsearchbar+=

When you later remove the + sign, the portlet will be disabled along with the other
portlets in the list.

The Default Partition Configuration
By default, there is one partition that includes all cluster nodes. The partition name is
"default". The set of configuration files for the default partition is:

clusterPartitions.xml—In the default state, this file defines only the default partition.

phaseProvider.xml—This phase provider file supports the default partition. These
aributes are set:
initFile="config:/defaultPartitionPortlets.properties" 
initFileComponentsEnabled="false"/>

defaultPartitionPortlets.properties—This file is empty by default.

In the default configuration, all portlets in the default partition are enabled.

Example: Creating Cluster Partitions
The following procedure shows the creation of cluster partitions by editing
configuration files. This procedure is intended as a demonstration and is not a real-
world example. Prior to this procedure, a cluster exists, having five nodes:

default
node2
node3
node4
node5

The example creates three partitions for the cluster:
default (all portlets are enabled)
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partition2 (a specified group of portlets is disabled)
partition3 (a specified group of portlets is disabled, but some are temporarily
enabled)

To create partitions through editing configuration files

1. At a command line prompt, type the following command to move to the server’s bin
directory:
cd Software AG_directory \MWS\bin

2. To retrieve the clusterPartitions.xml file from the My webMethods Server database,
type this command:
mws getconfig clusterPartitions.xml

3. To retrieve the phaseProvider.xml file from the My webMethods Server database,
type this command:
mws getconfig phaseProvider.xml

4. To retrieve the defaultPartitionPortlets.properties file from the My webMethods
Server database, type this command:
mws getconfig defaultPartitionPortlets.properties

5. Open the downloaded clusterPartitions.xml file in a text editor.

You can find all the downloaded files at this location:

Software AG_directory\MWS\server\server_name \config

6. Edit the clusterPartitions.xml file using the syntax in "The Cluster Partition File" on
page 196 to add partition2 and partition3 to the cluster.

The modified clusterPartitions.xml file looks like this:
<?xml version="1.0" encoding="UTF-8"?> 
<ClusterPartitions> 
    <Partition name="default" frontEndUrl="http://my.company.server:8585"> 
        <Component name="default"> 
        </Component> 
    </Partition>    
    <Partition name="partition2"> 
        <Component name="node2"> 
        </Component> 
        <Component name="node3"> 
        </Component> 
    </Partition> 
    <Partition name="partition3"> 
    </Partition> 
</ClusterPartitions>

Based on this file:

The default partition contains the default node

partition2 contains node2 and node3

partition3 contains node4 and node5 (the last partition in the file contains all
nodes not specifically assigned to other partitions)
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7. Save and close the clusterPartitions.xml file.

As a result, the default partition is established according to the The Default Partition
Configuration, with all portlets enabled.

8. Make a copy of phaseProvider.xml and name it partition2PhaseProvider.xml.

9. Open the partition2PhaseProvider.xml file in a text editor.

10. In the portlet phase nested inside the CoreServices phase, change
defaultPartitionPortlets.properties to partition2Portlets.properties so
the file looks like this:
<PhaseInfo name="portlet" enabled="true" 
    class="com.webmethods.portal.service.portlet.impl.PortletProvider" 
    initFile="config:/partition2Portlets.properties" 
    initFileComponentsEnabled="false"/>

The phase provider now points to partition2Portlets.properties. Because
initFileComponentsEnabled is set to false, portlets listed in that file will be disabled.

11. Save and close the partition2Portlets.properties file.

12. Make a copy of defaultPartitionPortlets.properties and name it
partition2Portlets.properties.

13. Open the partition2Portlets.properties file in a text editor and add a list of the
portlets that are to be disabled in partition2.

For example:
# These portlets will not be initialized. 
wm_task_chart___taskchart= 
wm_task_search___taskinboxsearchbar= 
wm_task_search___taskinboxsearchresults= 
wm_task_search___tlmsearchresults= 
wm_task_search___tlmsearchquery=

In the user interface, these portlets have the following uses:

" taskchart " displays Task Charts

" tlmsearchquery " displays Task List Management

The remaining portlets display My Inbox

14. Save and close the partition2Portlets.properties file.

As a result, certain portlets will be disabled on partition2 (node2 and node3).

Note: The procedure steps for partition3 demonstrate how to temporarily
override a phase provider file ("Temporarily Overriding the Phase
Provider File" on page 198). As a result, the steps are abbreviated
because they largely duplicate the steps for partition2.

15. Make a copy of phaseProvider.xml and name it partition3PhaseProvider.xml.

16. In partition3PhaseProvider.xml change, defaultPartitionPortlets.properties
to partitionPortlets.properties.
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17. Make a copy of partition2Portlets.properties and name it
partition3Portlets.properties.

As a result, partition3 is configured to disable the same portlets as partition2.

18. In partition3Portlets.properties, prefix the = at the end of the last two portlets with a
+.

For example:
# These portlets will not be initialized. 
wm_task_chart___taskchart= 
wm_task_search___taskinboxsearchbar= 
wm_task_search___taskinboxsearchresults= 
wm_task_search___tlmsearchresults+= 
wm_task_search___tlmsearchquery+=

Note: The choice of portlets is arbitrary for this example.

As a result, partition3 (node4 and node5) has the same portlets disabled as
partition2, but a subset of the portlets are enabled.

19. To deploy the new and revised files to the My webMethods Server database, type
this command for each file:
mws putconfig file name

20. Delete all of these files from the \server_name \config directory.

If you do not delete the files, cluster will continue to use the local version of the
configuration file.

21. Restart each node in the cluster using this command:
mws -s server_name  restart

Changes to configuration files are not applied until after a restart.

Verifying the Components are Disabled
To verify that portlets are disabled in the scenario described in "Example: Creating
Cluster Partitions" on page 198, you would take the following general actions.

1. In the clusterPartitions.xml file, assign a separate frontEndUrl aribute for each
partition.

2. Browse to the Front End URL of the default partition2 and log in as My webMethods
Administrator.

3. In the navigation pane, click Task List Management.

This choice corresponds to these portlets:
wm_task_search___tlmsearchresults= 
wm_task_search___tlmsearchquery=

The Task List Management displays without errors

4. Browse to the Front End URL of partition2 and log in as My webMethods
Administrator.
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5. In the navigation pane, click Task List Management.

Because the portlets are disabled, you will see an error.

Viewing Partitions in the My webMethods Server User Interface
To create and modify partitions, you need to use the configuration files described in
"Creating and Modifying Partitions" on page 195. But you can view information
about existing partitions in the My webMethods Server User Interface.

To view information about partitions

1. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Cluster Settings > Cluster Partitions.

As system administrator: Administration Dashboard > Configuration > Cluster
Administration > Cluster Partitions.

The Cluster Partitions page contains the following information:

Column Name Purpose

Name The partition name as defined in the cluster partition file.
You can click the partition name to display a page with
information about the partition.

Front End URL The Front End URL used by the partition.

Nodes The number of nodes in the partition.

Partition Rule The rule applied to the partition by the phase provider
file, which determines whether components are Enabled or
Disabled.

Managed
Components

The number of components (web applications and portlets)
in the partition that are managed by the portlets properties
file. The status of managed components can differ from the
Partition Rule set by the phase provider file. For status of
individual components, see "The Components Tab of the
Partition Page" on page 203.

Detail  — A link to the page containing specific information about
the partition.

2. To find information about a specific partition, click the Name column or the  icon.



M
Odd Header

My webMethods Server Clustering

Administering My webMethods Server Version 9.8 203

The Nodes Tab of the Partition Page
The Nodes tab of a partition page contains information about the nodes that are part
of that partition. The information on this tab reflects the nodes defined in the cluster
partition file.

Column Purpose

Name The name assigned to the node, as defined in the cluster partition
file.

Host The name of the host machine on which the node resides.

HTTP Port The HTTP port used by the node.

HTTPS Port The port used by the HTTPS listener of the node. A value of 0
indicates the HTTPS listener is disabled.

The Components Tab of the Partition Page
The Components tab of a partition page contains information about the web applications
and portlets that are part of that partition. The information on this tab reflects the
seings you have created in the phase provider and partition properties files for the
partition.

There are two tree views, depending on how you want to list the components.

Tree View Description

Categories Lists components by category.

Portlets Lists components in order, regardless of category.

To switch between the two views, choose the Category Tree View option or the Portlet Tree
View option.

Column Purpose

Component A tree view of components. Expand a node to reveal the
portlets that are part of the web application.

Category (Portlets tree view only) The name of the category to which
a component belongs. Examples are Administration and
Communication.
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Column Purpose

Name The name of the component as it is installed in My
webMethods Server. This name is different from the
descriptive name used in the Component column.

The status of the component. The status icons are:

The component is enabled in this partition.

Status

The component is disabled in this partition.
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What are Attribute Providers?
There are a variety of ways to provide and use aributes belonging to My webMethods
Server users. Basic to each user are the My webMethods Server aributes: home page,
skin, and number of lines displayed per page. In addition, there are Principal Aribute
Providers:

Attribute provider Description

Core Aributes A set of core aributes such as user ID and email address.
If the user is in the system directory service, some fields
are editable. If the user is in an external directory service,
all fields are read only. See "The Core Aributes Aribute
Provider" on page 210.

User Profile A rich set of user aributes that you can maintain regardless
of which directory service the user is a member of. The
aributes are stored in the My webMethods Server database.
Once established for each user, the User Profile Aributes
can be used for wiring globally within My webMethods
Server. See "The User Profile Aribute Provider" on page
211.

LDAP A set of aributes from the external directory service. You
can specify which aributes are exposed from a given
directory service. See "The LDAP Aribute Provider" on page
211.

Database A set of aributes from an external database directory
service. You can specify which aributes are exposed from
a given directory service. See "The Database Aribute
Provider" on page 212.

Notification A set of addresses, such as email, at which the user can
receive notifications from My webMethods Server. See "The
Notification Aribute Provider" on page 213.

Dynamic A set of aributes whose values can change depending on
the roles the user is a member of. See "The Dynamic Aribute
Provider" on page 214.

Principal Aribute Providers are useful because any aribute they expose can be made
available as wiring for a portlet. For example, suppose a portlet uses a postal code to
display certain information when a user views a page. If the postal code is provided by
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wiring from a Principal Aribute Provider, when the postal code aribute is modified
within a directory service, the portlet uses the modified aribute value.

Principal Aribute Providers are not enabled by default. To enable them, use the
Principal Profile Administration page, described in "Managing the Display of Principal
Aribute Providers" on page 214.

Using Attribute Providers
The Profile page for a user, group, or role displays the various sets of aributes as well
as memberships in groups or roles. Depending on the directory service to which a user
or group belongs, you can edit some aributes, or expose them for use in global wiring.

To see an example of the Profile page, as a system administrator, in the standard links,
click My Profile. The page displayed is the Profile page for SysAdmin.

To see the Profile page for any user, group, or role, follow this search procedure:

To find the Profile page for a user, group, or role

1. As system administrator: Administration Dashboard > User Management > Manage
User_type  > Search.

where User_type is Users, Groups, or Roles.

2. Search for the user you want to edit. For more information, see "Searching for
Existing Users, Groups, or Roles" on page 112.

3. In the search results, click any link in the row of the user, group, or role, or click the
Edit icon .

The Profile page for the user, group, or role is displayed.

4. The following sections describe the Aribute Providers available in My webMethods
Server.

This Attribute Provider... Is described here...

Core Aributes "The Core Aributes Aribute Provider" on page
210

User Preferences "The User Preferences Aribute Provider" on page
210

User Profile Aributes "The User Profile Aribute Provider" on page
211

Ldap Aributes "The LDAP Aribute Provider" on page 211
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This Attribute Provider... Is described here...

Database Aributes "The Database Aribute Provider" on page 212

Notification Aributes "The Notification Aribute Provider" on page
213

Dynamic Aributes "The Dynamic Aribute Provider" on page 214

The Core Attributes Attribute Provider
The Core Aributes Aribute Provider contains a set of aributes such as user ID and
email address. Some fields are editable, depending on directory service membership.

User Information Panel
For individual users, the contents of the Core Aributes Aribute Provider appears on
the Profile page as the User Information panel. For users in the system directory service,
some fields, such as the email address, are editable. To edit information in this panel, see
"Editing Information for a User" on page 124.

For members of external directory services, this information is not editable, but it is
available for the global wiring feature described in "Wiring a Principal Aribute to a
Portlet Property" on page 337.

Group Information Panel
For groups, the contents of the Core Aributes Aribute Provider appears on the Profile
page as the Group Information panel. For groups in the system directory service, some
fields, such as the email address, are editable. To edit information in this panel, see
"Editing Group Information" on page 135.

For groups in external directory services, this information is not editable but it is
available for the global wiring feature described in "Wiring a Principal Aribute to a
Portlet Property" on page 337.

Role Information Panel
For roles, the contents of the Core Aributes Aribute Provider appears on the Profile
page as the Role Information panel. The fields are not editable, but the information is
available for the global wiring feature described in "Wiring a Principal Aribute to a
Portlet Property" on page 337.

The User Preferences Attribute Provider
User preferences are basic to any user of My webMethods Server. A My webMethods
Server Administrator, system administrator, or the individual user (if given permission)
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can edit these basic aributes. To edit user preferences, see "Editing Information for a
User" on page 124.

The User Profile Attribute Provider
The User Profile Aribute Provider has a rich set of user aributes that you can maintain
regardless of which directory service the user is a member of. The aributes are stored
in the My webMethods Server database. Once established for each user, the User Profile
Aributes can be used with the global wiring feature described in "Wiring a Principal
Aribute to a Portlet Property" on page 337.

A My webMethods Server Administrator, system administrator, or the individual user
(if given permission) can edit the User Profile aributes. You need to enter the user
profile aributes individually for each user, or allow the user to do so. You can use all
of the aributes or a subset that is appropriate to your needs. To edit the User Profile
aributes, see "Editing Information for a User" on page 124.

The LDAP Attribute Provider
The LDAP Aribute Provider displays a specified set of aributes from the external
directory service to which a user or group belongs. The aributes displayed in the
LDAP Attributes panel are not editable but they are available for the global wiring feature
described in "Wiring a Principal Aribute to a Portlet Property" on page 337.

Note: If the LDAP Aribute Provider is not enabled by default. See "Managing the
Display of Principal Aribute Providers" on page 214.

This aribute provider is not applicable to users or groups in the system directory
service. Similar aributes are included in the User Profile Aribute Provider described
in "The User Profile Aribute Provider" on page 211.

Displaying the LDAP Attribute Provider
You cannot modify the contents of the LDAP Attributes panel on a Profile page, but you
can display it if needed. To search for the Profile page of a user or group, see "Searching
for Existing Users, Groups, or Roles" on page 112.

Exposing LDAP Attributes from an External Directory Service
The LDAP Aributes Provider displays user aributes that are exposed from an external
directory service. You can expose selected aributes that are then available for the global
wiring feature.

To expose LDAP attributes from an external directory service

1. As system administrator: Folders > System > Service* > Directory > Principal Attribute
Providers > Provider_type .
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where Provider_type  is User Principal Attribute Providers or Group Principal Attribute
Providers.

* You might have to click Next multiple times to find Service displayed in the table.

2. For Ldap Attributes, click the Tools icon  and then click Properties.

You should now be on the Properties of LDAP Aributes page.

3. Under LDAP Attribute Names, click Add.

4. Type the aribute name exactly as it is used in the external directory service and
click OK.

For example, the aribute name for email on a particular directory service might be
mail.

5. Under LDAP Attribute Titles, click Add.

6. Type a display name for the aribute for use within My webMethods Server and
click OK.

For example, for the mail aribute, you might type a display name of Email.

7. If you have multiple LDAP aributes, make sure the order in the LDAP Attribute
Names and LDAP Attribute Titles lists are the same.

The order in which aributes and titles appear in the lists determine the order in
which they are displayed in the Ldap Attributes panel on the Profile page.

8. Click Apply.

The Database Attribute Provider
The Database Aribute Provider displays a specified set of aributes from the external
database directory service to which a user or group belongs. The aributes displayed in
the Database Attributes panel are not editable but they are available for the global wiring
feature described in "Wiring a Principal Aribute to a Portlet Property" on page 337.

Note: If the Database Aribute Provider is not enabled by default. See "Managing
the Display of Principal Aribute Providers" on page 214.

This aribute provider is not applicable to users or groups in the system directory
service. Similar aributes are included in the User Profile Aribute Provider described
in "The User Profile Aribute Provider" on page 211.

Displaying the Database Attribute Provider
You cannot modify the contents of the Database Attributes panel on a Profile page, but you
can display it if needed. To search for the Profile page of a user or group, see "Searching
for Existing Users, Groups, or Roles" on page 112.
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Exposing Database Attributes from an External Directory Service
The Database Aributes Provider displays user or group aributes that are exposed
from an external database directory service. You can expose selected aributes that are
then available for the global wiring feature.

To expose database attributes from an external database directory service

1. As system administrator: Folders > System > Service* > Directory > Principal Attribute
Providers >Provider_type .

where Provider_type  is User Principal Attribute Providers or Group Principal Attribute
Providers.

* You might have to click Next multiple times to find Service displayed in the table.

2. For Database Attributes, click the Tools icon  and then click Properties.

You should now be on the Properties of Database Aributes page.

3. Under Attribute Names, click Add.

4. Type the aribute name exactly as it is used in the external database directory
service and click OK.

Important: An aribute used here must be returned by the Query Lookup User by ID
aribute in the database directory service. See "Configuring an External
Database Directory Service" on page 94.

For example, the aribute name for postal code on a particular directory service
might be zipcode.

5. Under Attribute Titles, click Add.

6. Type a display name for the aribute for use within My webMethods Server and
click OK.

For example, for the zipcode aribute, you might type a display name of Zip Code.

7. If you have multiple database aributes, make sure the order in the Attribute Names
and Attribute Titles lists are the same.

The order in which aributes and titles appear in the lists determine the order in
which they are displayed in the Database Attributes panel on the Profile page.

8. Click Apply.

The Notification Attribute Provider
The Notification Aribute Provider allows you to specify the various addresses at
which a user can receive notifications.A My webMethods Server Administrator, system
administrator, or the individual user (if given permission) can edit these basic aributes.
To edit user preferences, see "Editing Information for a User" on page 124.



M
Even Header

Attribute Providers

Administering My webMethods Server Version 9.8 214

Note: The Notification Aribute Provider is not enabled by default. See "Managing
the Display of Principal Aribute Providers" on page 214.

User preferences are basic to any user of My webMethods Server. A My webMethods
Server Administrator, system administrator, or the individual user (if given permission)
can edit these. To edit user preferences and notifications, see "Editing Information for a
User" on page 124.

The Dynamic Attribute Provider
The Dynamic Aribute Provider allows you to provide an aribute for a role. A user,
group, or role that is a member of a role has all dynamic aributes of the role. If a user
is a member of multiple roles, and multiple roles have aributes with the same key, you
can determine which role will have precedence. In addition, you can assign an aribute
value to a user, overriding the aribute values provided by roles. Dynamic aributes are
available for the global wiring feature described in To edit user preferences, see "Editing
Information for a User" on page 124.

Note: The Dynamic Aribute Provider is valid only for roles. Users and groups have
dynamic aributes based on roles of which they are members.

For information on functions you can perform on dynamic aributes, see "Defining
Dynamic Aributes Associated with a Role" on page 166.

Managing the Display of Principal Attribute Providers
If all Principal Aribute Providers were displayed on a Profile page by default, the
page would be crowded and potentially difficult to read. On the Principal Profile
Administration page, you can choose which Principal Aribute Providers to display
on a Profile page and the order in which they appear. You can set Principal Aribute
Providers for users, groups, and roles:

This list... Configures the display of...

USER Attribute Providers The Profile page for a user. By default, the Core
Aributes Provider is displayed as the User Information
panel. Other default aribute providers are Groups,
Roles, and User Preferences. You can add any
Principal Aribute Provider applicable to an
individual user.

GROUP Attribute Providers The Profile page for a group. By default, the Core
Aributes Provider is displayed as the Group
Information panel.The default aribute providers
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This list... Configures the display of...
are Groups and Group Members. You can add any
Principal Aribute Provider applicable to a group.

ROLE Attribute Providers The Profile page for a role. By default, the Core
Aributes Provider is displayed as the Role Information
panel.The other default aribute provider is Dynamic
Aributes.

You can perform the following functions on the Principal Profile Administration page:

This function... Is described here...

Add a Principal Aribute Provider to
the Profile page

"Adding a Principal Aribute
Provider" on page 215

Rearrange the position of Principal
Aribute Providers on the Profile page

"Changing the Display Order for
Principal Aribute Providers" on page
215

Remove a Principal Aribute Provider
from the Profile page

"Removing a Principal Aribute
Provider" on page 216

Adding a Principal Attribute Provider
To add a Principal Aribute Provider to a Profile page, use the following procedure.

To add a Principal Attribute Provider to a Profile page

1. As system administrator: Administration Dashboard > User Management > Principal Profile
Administration.

2. In the USER, GROUP, or ROLE Attribute Providers area, click Add.

3. To specify the Principal Aribute Provider want to add, move it to the Selected Items
box and click Select.

4. At the boom of the page, click Apply.

Changing the Display Order for Principal Attribute Providers
To change the order in which Principal Aribute Providers appear on a Profile page, use
the following procedure.
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To change the display order for Principal Attribute Providers

1. As system administrator: Administration Dashboard > User Management > Principal Profile
Administration.

2. In the USER, GROUP, or ROLE Attribute Providers area, To reorder Principal Aribute
Providers, move them up or down as needed.

The first aribute provider in the list has the left-most position on the Profile page,
followed by the second aribute provider, and so on.

3. At the boom of the page, click Apply.

Removing a Principal Attribute Provider
To remove a Principal Aribute Provider from a Profile page, use the following
procedure.

To remove a Principal Attribute Provider from a Profile page

1. As system administrator: Administration Dashboard > User Management > Principal Profile
Administration.

2. In the USER, GROUP, or ROLE Attribute Providers area, select a Principal Aribute
Provider from the list and then click Remove.

3. At the boom of the page, click Apply.
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Overview of My webMethods Server Security
My webMethods Server has many different features and functions that contribute to
its overall security infrastructure. When discussing security, it is always necessary to
separate the discussion of authentication (Auth) from Authorization (AZ). While they
are almost always related, the two concepts are distinct and work together to contribute
to an overall security solution.

Authentication is defined as an assurance that a party to some computerized transaction
is not an impostor. Authentication typically involves using a password, certificate, PIN,
or other information that can be used to validate identity. The goal of authentication is to
simply verify that “you are who you say you are.”

Authorization is defined as the process of determining, by evaluating applicable access
control information, whether a party is allowed to have the specified types of access to
a particular resource. Usually, authorization is in the context of authentication. Once
a party is authenticated, that party may be authorized to perform different types of
activities.

My webMethods Server provides built-in infrastructure for both authentication and
authorization. My webMethods Server is also designed in a way that allows it to be
extended so that existing security infrastructure can be re-used and leveraged for both
authentication and authorization. This chapter discusses both the built in mechanisms
and the extensible mechanisms.

In My webMethods Server, you can apply both authentication and authorization to the
entire server or to individual server resources, which include folders, pages, portlets,
links, documents, files, or custom objects.

Server Authentication
My webMethods Server supports many different ways for users to identify themselves.
These different methods are called Authentication Schemes. These schemes are simply
different ways to gather user credentials and validate their authenticity. The different
types of authentication schemes that are supported are:

This authentication scheme... Is described here...

Forms authentication "Forms Authentication" on page 219

Anonymous authentication "Anonymous Authentication" on page
219

Basic authentication "Basic Authentication" on page 219
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This authentication scheme... Is described here...

NTLM authentication "NTLM Authentication" on page 219

HTTP header authentication "HTTP Header Authentication" on
page 220

User-defined authentication schemes "Extended and Extensible
Authentication Schemes" on page
221

Forms Authentication
Forms authentication is the default authentication scheme for My webMethods
Server. This authentication scheme presents a form to a user and gathers the necessary
credentials that are passed to the server by means of a form POST (data is passed to
the server’s standard input). It is simple to customize the form or page that is used for
authentication. It is also easy to present different forms and pages based on a wide
variety of different criteria. For example, it is very likely that you would want to provide
different login experiences for users accessing a server from mobile devices than for
users accessing the server from a browser.

Anonymous Authentication
The anonymous authentication scheme is used when you do not want to challenge users
for credentials. My webMethods Server honors an anonymous request and establishes
a session with the server as a special Guest user, but the user is never prompted for
credentials. The anonymous authentication scheme is used for unprotected areas of
the server that might be public facing and do not contain sensitive information. By
associating the request with a session and a user ID of Guest, an administrator can
extend behaviors of anonymous access by controlling permissions of the Guest user.
Guest is one of the default users installed as part of the system directory service. It is
also possible to track session activity of anonymous users for reporting requirements.

Basic Authentication
Basic authentication is one of the original and most compatible authentication schemes
for programs using HTTP as a transport mechanism. Unfortunately, it is also one of
the least secure, as it sends the username and password unencrypted to the server. The
credentials are typically passed in as HTTP header parameters. The user experience for
basic authentication is a popup window that renders in the native windowing system.
For example, when you use basic authentication on Windows, a Windows dialog box
opens to prompt the user for credentials before the request can be honored.

NTLM Authentication
NTLM (Windows NT LAN Manager) is an authentication protocol used in various
Microsoft network protocol implementations and supported by the NTLM Security
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Support Provider (NTLMSSP). Originally used for authentication and negotiation of
secure DCE/RPC, NTLM is also used throughout Microsoft's systems as an integrated
single sign-on mechanism. On Windows deployments, when NTLM is set up and
configured as an authentication scheme for My webMethods Server, users do not
need to re-authenticate for server resources if they are already logged into a Windows
domain. You can choose either NTLM or NTLM version 2 (NTLMv2) authentication.

To use NTLM authentication you need to explicitly specify the Primary Domain
Controller for the domain, as described in "Configuring NTLM Authentication" on page
234.

To use NTLMv2, you need to purchase the Jespa Java software library from IOPLEX
Software. For information on configuring NTLMv2, see "Configuring NTLMv2
Authentication" on page 235.

Note: You can use either the webMethods NTLM authentication or NTLMv2, but
not both at the same time.

HTTP Header Authentication
My webMethods Server can be configured to accept External HTTP authentication
credentials from third-party security and access control products (such as Computer
Associates, Oblix, and so forth). These credentials are case sensitive, depending
on platform and web server and are most likely to be headers such as sm_user or
SM_USER.

When you configure and set up HTTP header authentication within My webMethods
Server, the server uses credentials from a third-party authentication engine. Typically,
these third parties use a security agent to intercept the request prior its geing to the
server. The basic flow of events in this request is:

1. The user aempts to go to a server resource.

2. Prior to connecting to the server, if the third-party security agent does not see
the proper credentials, the agent redirects the user to a mechanism that gathers
credentials.

3. The user provides the credentials and is then redirected back to the server resource.

4. The server reads the appropriate HTTP header and maps the user appropriately.

To configure this interaction between the server and the third-party security agent,
you need to take these actions.

5. After My webMethods Server installation, configure the third-party product to
protect the server, which typically involves creating a policy that protects the server
URL.

6. Verify that the server and the third-party security product are configured to look
at the same directory store. See "Managing External Data Sources" on page 100 for
more information on directory services.
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7. Configure the server to look for the right HTTP header. See "Configuring External
Configuration Credentials" on page 275.

Note: In the case of SiteMinder from Computer Associates, it is also necessary
to specify the Logout URI in SiteMinder. In the SiteMinder Administrator
applet, modify the logoutURI aribute to be '/?method=logout' (without
the quotes)

Important: The HTTP Header Authentication Administration page should only be
enabled if you are using a third-party security provider. After the page is
enabled, the server acts as though all users have been authenticated.

Extended and Extensible Authentication Schemes
My webMethods Server provides hooks for developers to provide their own custom
authentication schemes. To develop a custom authentication scheme, create a portlet,
implement the correct interfaces, and register it with the server. Once created, the new
authentication scheme participates in the security infrastructure just like any other
authentication scheme that is provided as part of My webMethods Server.

My webMethods Server has a concept of a default authentication scheme that is
applied to an entire deployment. A newly configured server uses forms as its default
authentication scheme. The server challenges initial requests for protected resources
with a form requiring the user to type a user name and password.

At any time, you can change the default authentication scheme for a server to one of
the registered authentication schemes. For more information, see "Specifying a Default
Authentication Scheme" on page 231.

Every server resource can have an authentication scheme that overrides the seing for
the entire deployment. For example, you might have one set of pages and portlets that
are completely anonymous and others that require user credentials to be presented. You
would do this by associating the anonymous authentication scheme with the resources
that do not require authentication. For information on managing authentication schemes
for individual server resources, see "Assigning an Authentication Scheme to a Server
Resource" on page 232.

Extending Login and Splash Page Behavior
To understand the login process and flow of events, it helps to analyze an example of
how a system administrator would extend a deployment to have custom login page
behavior. The following set of steps uses the concepts of anonymous access, forms-based
authentication, and login pages to form a solution. Some of the steps require developer
knowledge.

1. Design a page that has a login portlet on it. Once the page is created, set the
authentication scheme of the page to “anonymous” so everyone can get to the page
and be presented with the login portlet.

Optionally, you can set access rights on other parts of the page so that the login page
has different appearances, depending on the identities of users. To address even
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broader requirements of personalizing the login page, it is also easy to set up custom
login pages based on rules themselves.

2. After seing the authentication scheme of the page to anonymous, make sure the
login portlet itself can be seen by a Guest user (see Guest in "Managing Directory
Services" on page 84.

You may also want to modify the look and feel of the page by removing title bars,
adding explicit instructions, or implementing other business requirements.

3. You can control where a user is redirected after login. In the Properties page for
the login portlet, modify the Login Target property to the page where the user is
redirected. Keep in mind that the Login Target be static or it can be an alias. If you
use an alias like /user.current.start.page, you can alternatively set up start page rules
to govern different start pages based on information about the user logging in.

It is also possible to redirect a request, if not authenticated, to go to the appropriate
login page. To do so, modify the Redirect URI property of the authentication scheme
assigned to the page. When an unauthenticated user requests the page, the user is
redirected to the specified page. As with login targets, a redirect URI can be either
static or an alias.

Making a Custom Authenticator Available to Integration Server
If you implement a custom authenticator portlet to be used with a database directory
service forMy webMethods Server, and if Integration Server is configured to use
Common Directory Services, you need to take additional steps to enable authentication
for users logging into Integration Server.

To make a custom authenticator available to Integration Server

1. Stop all webMethods components.

2. Open the custom authenticator .pdp file using the .zip extractor of your choice.

3. Extract the /WEB-INF/lib/custom_authenticator .jar from the .pdp (the name will vary
with the naming convention of your custom component).

4. To make the custom authenticator available to all Integration Server instances, copy
the extracted .jar file into this location:

Integration Server_directory/lib/jars/

5. To make the custom authenticator available to a specific Integration Server instance,
copy the extracted .jar file into this location:

Integration Server_directory/instances/instance_name /lib/jars/

6. Modify Common Directory Services configuration files by doing the following:

a. Locate the following .jar file:

Software AG_directory\common\lib\wm-mws-library.jar

b. Extract these two files from the wm-mws-library.jar file.
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initPortlets.propertiesinitXTypes.properties

c. Open each of these files in a text editor and use this syntax to add the name of the
custom authenticator portlet as the last line of the file:
custom_authenticator =

Use the other portlet names in these files as examples.

d. Save each file and repackage them both in the wm-mws-library.jar file.

7. Restart all webMethods components.

Security Assertion Markup Language
My webMethods Server supports single sign-on through the Security Assertion Markup
Language (SAML), an XML-based framework for the exchange of security information.
Using SAML, an application on a target computer grants access based on an assertion
from the source computer.

My webMethods Server can be the calling program, or Security Provider, or can be
configured to authenticate the user sign-on for a target web application. For information,
see "Seing up Single Sign-On" on page 281.

Server Authorization
After a user request has been authenticated by the server, it is usually necessary to
do some authorization checks to make sure that the user making the request has the
necessary privilege to act on that resource. In My webMethods Server, the most common
way to do authorization checks is by evaluating Access Control Lists (ACLs). ACLs can
be associated with every kind of server resource, such as pages, portlets, and so forth.

More advanced concepts like verbs and mechanics (groupings of business logic) are
server resources as well, and therefore also participate in the ACL evaluation model.
This feature allows developers to programmatically lock down capabilities of the server.

To understand the authorization engine in My webMethods Server, look at the
composition of an ACL. An ACL is a list of Access Control Entries (ACEs). An ACE is a
simple structure containing an element called a Principal and an element called a Right
Set.

A Principal is a user, group or role. Some examples of Principals are:

Principal Example of a Principal

User Myles Perkins

Group Members of the Perkins family

Role A role definition that resolves to Myles, such as, “Users who have
the ‘Job Title aribute value set to ‘Product Manager.’
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Right Sets are groupings of actions that can be performed on a server resource. An
example of a Right Set is “Grant the ability to read. Right Sets themselves are broken
down into two distinct parts, Capabilities and Seings. Different types of server
resources have different Capabilities associated with them. For example, pages have
Capabilities that include “Add Portlet To Page” while folders have Capabilities that
include “Create Sub Folder” and “Can Read Items in this Folder.”

The other part of a Right Set, the Seing, can have four possible values: DELEGATE,
DENY, GRANT or NONE. Each Capability that makes up a Right Set has a Seing value.
Right Sets are made up of many Capability-Seing pairings. Here is an example of a
Right Set:
DENY + create sub folder
GRANT + read

This particular Right Set is made up of two Capability-Seing pairings. If associated
with a folder resource, this Right Set is resolved to deny a Principal the ability to create
sub folders but grant the ability to actually read the folder.

The values for Seings have the following meanings:

This Setting value... Has this effect for the Principal...

DENY Denies the access to perform the capability.

GRANT Explicitly grants access to perform the capability.

DELEGATE Explicitly grants access and gives the right to assign the
capability to another Principal.

NONE Provides no explicit Seing. Authorization for this server
resource will be determined from another source.

The following figure shows the relationships described in this section.
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Anatomy of an ACL

As an example, to deny read access to Brian and the Marketing Group from the
Engineering page, we would have the following setup:

The server resource is the Engineering page.

The Engineering page has an ACL associated with it that contains two ACEs:

Principal Right Set

Brian DENY read

Marketing
Group

DENY read

Controlling Permissions on Server Resources
If you have authorization to change access to a server resource, you use the Permissions
portlet of My webMethods Server to assign access control to it. For example, if you
are the owner of the Engineering folder in the previous example, a wizard in the
Permissions portlet allows you to select one or more Principals and Right Sets, and
associate them with that folder. For more information on controlling permissions, see
"Managing Permissions" on page 141.

You do not have to explicitly grant and deny access for every newly created object. If
you give your taxonomy a lile forethought, you can keep the potential maintenance
burden to a minimum. My webMethods Server employs a method called static
propagation of its access rights on server objects when they are created. This means that
at creation time, a server resource receives its access rights from its parent resource.
If subsequent changes are made to the parent's access rights, these rights are not
dynamically updated in the child object. However, you can use the Permissions portlet
to cause parent objects to apply access rights explicitly to their children.
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To illustrate static propagation and parent-child interaction as it relates to access rights,
we will return to the previous example of the Engineering folder. In that example, the
Engineering folder has BRIAN DENY. As the owner of the Engineering folder, a user
creates a sub folder called Secret Project. Because of static propagation, the new Secret
Project folder has BRIAN DENY at the time of creation. If the owner goes back and
changes the permissions of the Engineering Folder to allow Brian access, Brian still does
not have access to the Secret Project sub folder.

Authorization Determination
Now that you have a background in the concepts of making an authorization decision,
you can see how access is actually determined at run time. When a server resource is
requested, the server evaluates the ACL associated with that resource against the context
in which the current request is generated. If a user requests access to a page, the ACL for
that page is evaluated to determine whether the user request should be honored.

There are a few simple rules in determining authorization that handle a large percentage
of any conflicts that may arise:

DENY always takes precedence over Allow (It is good to be paranoid in dealing with
security)

Users always take precedence over groups and roles

To illustrate these rules and how they are applied to resolve conflict, we return to the
example Engineering folder. In the following example, there are three ACE entries in the
ACL associated with the Engineering folder:
BRIAN + DENY READ
MARKETING GROUP + DENY READ
BRIAN + GRANT READ

If Brian is a member of the Marketing group (and even if he wasn't) he is denied access
to the Engineering folder. The user-based ACE takes precedence over the group-based
ACE so the MARKETING GROUP ACE has no effect. Subsequently, the conflict between
BRIAN being granted and denied access is resolved by denying access because DENY
always wins.

Lists, pages, child objects and Searches

As mentioned earlier, a Principal can be a user, group, or role. Information about a
Principal comes from a directory service. My webMethods Server has an embedded
system directory service, described in "Managing Directory Services" on page 84, as well
as the ability to tie to external directory servers. Examples of these external directory
servers are Active Directory, LDAP servers, ADAM, and an RDBMS. In addition, group
and role information for My webMethods Server authorization decisions is determined
when a user logs into the server. If a user's group membership changes during an active
session, the change is not reflected in the server until the user logs out and logs back
in. See "Managing Users and Groups" on page 119 for more information about users,
groups, roles, and directory services.
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Security Realms

My webMethods Server provides a feature called Security Realms to augment its
security model. Security Realms are collections of server resources that share the same
ACL. The use of Security Realms makes it possible to easily manage permissions on
large numbers of server resources. By adding the resources directly to a Security Realm,
a system administrator can add Principal information to that realm to control access.

Security Realms become very useful if you have a large number of server resources and
only a few access levels. For example, you may have a large customer-facing server that
has a large number of portlets, pages and areas of taxonomy. However, this server may
only have three levels of access that need to managed: Gold, Silver and Bronze. With
each level represented by a Security Realm with the appropriate pages, portlets and
taxonomy elements in them, a system administrator needs only to add a new customer
to the appropriate Security Realm, granting the customer the correct level of access.
Likewise, changing a customer from one level to another is a simple one-step operation.

Used in the appropriate deployments, Security Realms add value, not only by
minimizing the administrative burden, but by greatly reducing the number of
underlying records required to support the security model. For example, assume a
server has 500,000 server resources and you are managing permissions for 50 users, all of
whom have the same access:

Managing permissions by ACL requires 25 million records in the My webMethods
Server database.

Managing permissions by Security Realm uses one Security Realm and one role
with 50 members, requiring a total of three records in the My webMethods Server
database.

It should be noted that if a server resource is added to a Security Realm, the Security
Realm access control has precedence over an individual ACL and authentication scheme
for that resource.

For information on managing Security Realms, see "Using Security Realms" on page 148.

Server Verbs and Access Control

A server verb is an operation such as publishing, deleting, updating, subscribing, and
seing permissions, which is available through the My webMethods Server API. As
noted earlier, server verbs are server resources that can also participate in the security
model of the server. In this way, one can control granular access to server capabilities
programmatically as well as through the Administrative Dashboard. It should be noted
that server verbs typically have two levels of security checks, performed in this order:

1. Does the user have access to the server verb itself?

2. Does the user have the rights to the resource upon which the server verb is trying to
act.

A system administrator can control access to server verbs using the Security Realms
Administrative page. My webMethods Server ships with default Security Realms to
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help administrators manage access to different server capabilities. The default Security
Realms are described in "Using Security Realms" on page 148.
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Authorization Decisions in My webMethods Server
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Managing Authentication
An authentication scheme is a way to gather user credentials and validate their
authenticity. Within My webMethods Server, you can manage authentication for a
server as a whole by specifying a default authentication scheme. As delivered, the forms
authentication scheme is the default for all server resources. In addition, every server
resource can have an authentication scheme that overrides the seing for the entire
deployment.

Note: A Security realm always takes precedence over an authentication scheme.

My webMethods Server uses the following authentication schemes:

Scheme Description

Anonymous Allows unrestricted access to a server resource. Used for
unprotected areas of the server that might be public facing
and do not contain sensitive information. Because a user is
not challenged for credentials, the anonymous authentication
scheme is appropriate for login pages.

Forms Presents a form to an unauthenticated user and gathers the
necessary credentials that are passed to the server. The forms
authentication scheme is the default for all server resources
because it redirects unauthenticated requests to a default login
page.

Basic Typically passes credentials as HTTP header parameters. The
user experience for basic authentication is a popup window that
renders in the native windowing system.

HTTP
Header

Accepts external HTTP authentication credentials from third-
party security and access control products (such as Computer
Associates, Oblix, and so forth). After this authentication scheme
is enabled, the server ignores all other authentication schemes.
See "Configuring External Configuration Credentials" on page
275.

NTLM Used for authentication in various Microsoft network protocol
implementations. On Windows deployments, when the ntlm
authentication scheme is the default for a server, users do not
need to re-authenticate for server resources if they are already
logged into a Windows domain.To use NTLM authentication, see
one of these topics:



M
Odd Header

Managing Security

Administering My webMethods Server Version 9.8 231

Scheme Description

"Configuring NTLM Authentication" on page 234

"Configuring NTLMv2 Authentication" on page 235

SAML Supports single sign-on through the Security Assertion Markup
Language (SAML). Using SAML, an application on a target
computer grants access based on an assertion from the source
computer. See "Seing up Single Sign-On" on page 281.

You can perform the following types of functions to manage authentication in My
webMethods Server.

This function... Is described here...

Change the default authentication
scheme to be used for My webMethods
Server.

"Specifying a Default Authentication
Scheme" on page 231

Specify an authentication scheme for
an individual server resource

"Assigning an Authentication Scheme
to a Server Resource" on page 232

Redirect a user to a page other than the
login page after logging in.

"Redirecting a User After Login" on
page 233

Redirect an unauthenticated request
for a protected server resource to a
specified login page other than the
default login page.

"Redirecting an Unauthenticated
Request" on page 233

Specifying a Default Authentication Scheme
When My webMethods Server is initialized, the forms authentication scheme is the
default. the forms authentication scheme redirects unauthenticated requests to a default
login page. You can change the default authentication scheme for My webMethods
Server to one of the registered authentication schemes.

Note: Do not use this procedure if you intend to use the hpHeader authentication
scheme to accept credentials from third-party security providers. Instead,
use the HTTP Header Authentication Administration page, described in
"Configuring External Configuration Credentials" on page 275.
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To change the default authorization scheme for My webMethods Server

1. As system administrator, click Administration Dashboard >Configuration > Alias
Management.

2. On the Keyword tab, type auth.scheme.default and click Search.

3. Click the Edit icon  for auth.scheme.default.

4. On the Update Alias panel, click Browse and browse to Folders > System >
Authentication Schemes.

5. Move the appropriate authentication scheme to Selected Items and click Select.

6. Click Update.

Assigning an Authentication Scheme to a Server Resource
Every server resource can have an authentication scheme that overrides the default
authentication scheme for My webMethods Server. The specific procedure depends on
whether or not the resource is a member of a Security Realm. The valid authentication
schemes are described in "Managing Authentication" on page 230.

To assign an authentication scheme for an individual server resource

1. As system administrator: Home > Folders and then navigate to the individual server
resource.

2. Click the Tools icon  and then click Permissions.

3. Click the Security Realm tab.

4. If the Security Realm Name field displays No Security Realm Assigned, do the following:

a. Click the Authentication tab.

b. From the Authentication Scheme list, choose the authentication scheme to apply to
the server resource and click Apply.

5. If the Security Realm Name field displays a Security Realm name, do the following:

a. Copy the Security Realm name, paste it into the input field of the page banner,
and click Search.

As an alternative, you can navigate to Folders > Administrative Folders >
Administration Dashboard > Configuration > Security Realms Administration to
locate the Security Realm.

b. Click the Tools icon  and then click Permissions.

c. Click the Authentication tab.

d. From the Authentication Scheme list, choose the authentication scheme to apply to
the Security Realm and click Apply.
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Redirecting a User After Login
By default, when a user logs into a server, redirects the user to the same page. You can
alter the Login Target property of the login portlet so a successful login redirects the user
to a page of your choosing.

To redirect a user to another page after login

1. At the right edge of the title bar for the login portlet, click the Tools icon  and then
click Properties.

2. For the Login Target property, do one of the following:

Click this... And do this...

Browse Move the target page to the Selected Items box and click Select.

Use Alias In the Alias Name field, type the alias of the page to which the
user should be redirected. Click Test to determine if the alias
is valid and the alias target is the correct one. If the alias is
correct, click Select.

Note: If you type /user.current.start.page, the user is
redirected to the start page defined by start-page rules.

3. Click Apply.

Redirecting an Unauthenticated Request
Using the forms authentication scheme, an unauthenticated request to a protected server
resource results in the user being redirected to a default login page. Alternatively, you
can redirect the user to a target of your choosing, whether it is a custom login page or a
page that provides unprotected content.

To redirect an unauthenticated request to a different page

1. As system administrator, click Administration > Folders > System > Authentication
Schemes.

2. Click the Tools icon  for the default authentication scheme, and then click
Properties.

By default, the forms authentication scheme redirects unauthorized requests to the
default login page. You can verify that an authorization scheme is the default by
looking at the Properties page; the Aliases list contains the auth.scheme.default alias.

3. In the Performs Redirect list of the Properties page for the authentication scheme,
make sure Yes, this performs a redirect is selected.
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4. Under Redirect URI, do one of the following:

Click this... And do this...

Browse Move the target page to the Selected Items box and click Select.

Use Alias In the Alias Name field, type the name of the alias to which the user
should be redirected. Click Test to determine if the alias is valid
and the alias target is the correct one. If the alias is correct, click
Select.

5. Click Apply.

Configuring NTLM Authentication
Using NTLM authentication, a user who has logged into a Windows domain does not
have to re-authenticate to log in to a server. A Primary Domain Controller is a Microsoft
Windows server responsible for handling all accounts in a domain. To use NTLM
authentication, you must explicitly specify the Primary Domain Controller in the NTLM
Authentication Scheme.

To specify a Primary Domain Controller for NTLM authentication

1. If you have NTLMv2 authentication configured, you need to disable it, as described
in "Disabling NTLMv2 Authentication" on page 236.

2. As system administrator, click Administration Dashboard > Configuration > NTLM
Authentication Administration.

3. In the Domain Controller Name field of the Properties page, type the hostname of the
Primary Domain Controller and click Submit.

Disabling NTLM Authentication
If you have NTLM enabled, you need to disable it before configuring NTLMv2.

To disable NTLM Authentication

1. As system administrator, click Administration Dashboard > Configuration > NTLM
Authentication Administration.

2. In the Domain Controller Name field, delete all characters including spaces and click
Submit.
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Configuring NTLMv2 Authentication
To use NTLM version 2 (NTLMv2), you need to purchase and install latest version of the
Jespa Java software library from IOPLEX Software.

To configure NTLMv2 authentication

1. If you have NTLM authentication configured, you need to disable it, as described in
"Disabling NTLM Authentication" on page 234.

2. Install and configure the Jespa Java software library, as described in the
documentation provided when you download Jespa.

The Jespa library should be located here:

Software AG_directory/MWS/lib/

3. Stop My webMethods Server.

4. Extract jcifs-1.3.17.jar from wm_ntlmv2authadmin.pdp, which you can find at this
location:

Software AG_directory
/MWS/components/admin/configuration/
wm_ntlmv2authadmin.pdp

5. Copy jespa-1.1.11.jar from the Jespa Java software library and jcifs-1.3.17.jar to this
location:

Software AG_directory/MWS/lib

6. From the command line, run mws update. See "Command Syntax for My
webMethods Server " on page 52.

7. Restart My webMethods Server.

8. As system administrator, click Administration Dashboard > Configuration > NTLMv2
Authentication Administration.

9. In the NTLMv2 Enabled field, make sure Yes, NTLMv2 is enabled is set.

10. Configure the properties in the remaining fields according to the information
provided in the Jespa documentation.

11. If you want to test the configuration, select Yes, test configuration before save.

12. Click Submit.

13. To make sure the new library is configured:

a. At a command line prompt, type the following command to move to the server’s
bin directory:
cd Software AG_directory \MWS\bin

b. Type mws stop.
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c. Type mws update.

d. Type mws start.

Disabling NTLMv2 Authentication
If you have NTLMv2 enabled, you need to disable it before configuring NTLM.

To disable NTLMv2 Authentication

1. As system administrator, click Administration Dashboard > Configuration > NTLMv2
Authentication Administration.

2. In the NTLMv2 Enabled field, make sure No, NTLMv2 is disabled is set and click Submit.

3. Delete the Jespa and Java CIFS libraries from this location:

Software AG_directory/MWS/lib/ext

4. To de-reference the libraries and reconfigure the server:

a. At a command line prompt, type the following command to move to the server’s
bin directory:
cd /Software AG_directory \MWS\bin

b. Type mws stop.

c. Type mws update.

d. Type mws start.

Clearing Session Passwords from Memory
By default, when a user logs in, the password is stored until the user logs out or until the
session times out. You can, however, cause My webMethods Server to clear passwords
from memory immediately after the login is completed. This seing clears all passwords
presented to My webMethods Server; you cannot clear passwords on a case-by-case
basis.

To clear session passwords from memory

1. As system administrator, click Administration > Folders > System > Managers >
sessionManager > default > validate.

2. At Configuration XML, click Edit.

3. In the Edit Text Area, change this text:
clearPassword= false

to this:
clearPassword= true
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4. To save the file and close the editor, click Update.

5. Click Apply.

This seing remains until you change it, even if you stop and restart My
webMethods Server.

Retaining Session Passwords in Memory

To retain session passwords in memory

1. As system administrator, click Administration > Folders > System > Managers >
sessionManager > default > validate.

2. At Configuration XML, click Edit.

3. In the Edit Text Area, change this text:
clearPassword= true

to this:
clearPassword= false

4. To save the file and close the editor, click Update.

5. Click Apply.

Turning On or Off Auto Complete for Usernames and
Passwords
When a user logs on to My webMethods Server, the browser allows the user to
remember the username and password. You can configure the My webMethods Server
login portlet to turn on or off the auto complete functionality. By default, auto complete
is turned on.

To turn on or off auto complete for usernames and passwords

1. As system administrator, go to Folders > My webMethods Applications > webMethods
Application Data > My webMethods Login Page.

2. Append ?layout=details to the end of the My webMethods Server URL in the
browser address bar to display the login portlet.

3. Click the Tools icon  for the login portlet and select Properties.

4. Do one of the following:

To turn off auto complete for usernames and passwords, clear the Allow Auto
Complete check box.
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To turn on auto complete for usernames and passwords, select the Allow Auto
Complete check box. The check box is selected by default.

5. Click Apply.

Controlling the Number of Failed Login Attempts
My webMethods Server controls the number of failed login aempts it will allow before
it temporarily locks the user account. You can control these values:

Window Duration How far back in time to look for failed aempts, in
milliseconds. The default is 30000.

Max Attempts in Window The maximum number of login aempts during the
window duration. The default is 10.

Lockout Duration The duration of the time the user will be locked out of
the server, in milliseconds. The default is 30000.

Changes on this page affect all logins to the server.

To control the number of failed login attempts

1. As system administrator, click Administration Dashboard > Configuration > Failed Logins
Administration.

2. Change values on the Failed Logins Administration page as needed.

3. Click Apply.

Controlling Login IP Ranges
You can use the Lockdown portlet to control the IP ranges from which users are allowed
to log in to My webMethods Server. Up to four different IP ranges are allowed. The
portlet does not take into account the credentials of the person logging in or any
authentication mechanism. Upon being unable to log in, the user is redirected to an error
page of your choosing. This portlet is useful for a site that allows guest access only, or
one that is to be access only from a secure location.

Important: If you make an error in configuring IP ranges, you may not be able to log in
to correct the problem. To correct the problem, you need to have physical
access to the machine on which My webMethods Server is running.
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Deploying the Lockdown Portlet
The Lockdown portlet is not deployed automatically when you initialize My
webMethods Server. The portlet is included in a My webMethods Server installation, but
you must deploy it before use.

To deploy the Lockdown portlet

1. Locate the Lockdown portlet within the webMethods installation directory at this
location:

\Software AG_directory\MWS\components\extras\security\wm_lockdown.pdp

2. Copy the wm_lockdown.pdp file to the deploy directory for the server instance:

\Software AG_directory\MWS\server\server_instance \deploy

My webMethods Server detects the presence of the portlet and automatically
deploys it.

Configuring the Lockdown Portlet
After the Lockdown Portlet is deployed, you can configure it for use.

To configure the Lockdown portlet on My webMethods Server

1. As system administrator, click Administration > Folders > System > Portlets >
Administration > Portal Lockdown Administration.

2. For the Error page property, find a page to which users are redirected if they fail to
log in by doing one of the following:

Click this... And do this...

Browse Move the target page to the Selected Items box and click Select.

Use Alias In the Alias Name field, type the alias of the page to which the user
should be redirected. Click Test to determine if the alias is valid
and the alias target is the correct one. If the alias is correct, click
Select.

3. (Optional) In the E-mail Address for Login Notification field, type an email address to
which My webMethods Server should send a notification if a login is aempted from
a disallowed IP address.

4. Specify up to four IP ranges from which users are allowed to log into My
webMethods Server.

For each range, provide a value in the Start IP Range and End IP Range fields.
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5. On the Is Active field, choose the True option.

6. Click Submit.

The lockdown is in effect immediately.

Disabling the Lockdown Portlet in My webMethods Server
If you can log in to My webMethods Server as system administrator, you can disable the
Lockdown portlet by doing the following.

To disable the Lockdown portlet in My webMethods Server

1. As system administrator, click Administration > Folders > System > Portlets >
Administration > Portal Lockdown Administration.

2. On the Is Active field, choose the False option.

3. Click Submit.

Disabling the Lockdown Portlet Manually
If you cannot log in to My webMethods Server as system administrator, you need to
have physical access to the machine on which My webMethods Server is installed, and
modify the portal.properties file. Everything in this file is set as a system property, read
after the My webMethods Server starts but prior to initialization of portlets.

To disable the Lockdown portlet manually

1. On the machine where My webMethods Server is installed, locate this file:

\Software AG_directory\MWS\server\server_instance \config\portal.properties

2. Open the portal.properties file in an editor and add the following line at the end of
the file:
lockdown.disable=false

For example, with a descriptive comment included:
#======================
# Lockdown Portlet
lockdown.disable=false

3. Restart My webMethods Server.

Note: After you have corrected the IP address range problem, you cannot
reactivate the Lockdown portlet until you remove this line from the
portal.properties file.
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Encrypting Passwords for Global Environment Variables
You can encrypt password fields for custom entries in Global Defaults environment
variables.

To encrypt password fields for Global Defaults environment variables

1. As system administrator, click Administration Dashboard > Configuration > CAF Application
Runtime Configuration.

2. In the result titlebar, click the Edit icon .

3. In the Password Env-Entry Names field, type the name of a custom environment entry
after the existing entries, separated by a comma, and click Save:

For example, wsclient-password,jcr/systemPassword,My_Password

4. Click Configure Global Defaults.

5. In the tree view, click Environment Entries, and then click Add New Entry.

6. In the Name field, type the name of the custom environment entry (for example,
My_Password) and click Add It.

7. Type a password value in the newly created environment entry and click Apply.

If you have correctly configured the environment entry, the password is masked as you
type it into the field. In addition, the password value is encrypted before it is stored in
the database.

If the consumer of the password value needs to get the original value back (for example,
to log in to some external server) it is possible to use the CipherUtil.decrypt(value) java
API to get the original value back. For information about the CipherUtil class, see the
webMethods CAF and My webMethods Server Java API Reference, which you can download
at the Software AG Documentation website

Allowing Context Impersonation
There may be cases in which you want to allow a user to impersonate another user. For
example, impersonation is used by the default Java Content Repository (JCR) Client. The
JCR session is created as a system user (SysAdmin by default) with a known password
and then the JCR session uses impersonation to switch to the real current user. This
impersonation makes it possible for the current user to log into the JCR repository.

We do not recommend that you use the SysAdmin user to implement context
impersonation, but another way to do so is to create a user with the Impersonate Users
Functional Privilege set.

To set the Impersonate Users Functional Privilege for a user, follow the procedure in
"Access Privileges and Functional Privileges" on page 144.

http://documentation.softwareag.com
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On the Permissions panel, Impersonate Users is located at Functional Privileges > MWS >
Impersonate Users.

Password Complexity Policies
A password complexity policy enforces requirements that make user passwords more
resistant to brute-force aacks. You can create a Password Complexity Class and add it
to My webMethods Server for use with the system directory service. You cannot use this
feature for external directory services.

To install a password complexity class for the system directory service

1. Stop My webMethods Server.

2. Save the Password Complexity class in a JAR file at this location:

Software AG_directory\MWS\lib

3. Create a jar_file_name .bnd file in the Software AG_directory \MWS\lib directory
whose file content looks like the following:
# attach as fragment to the caf.server bundle 
Fragment-Host: com.webmethods.caf.server 
#expand (inline) the contents of the jar containing the classes 
#into the bundle. 
# TODO: make sure this filename matches the name of your jar file 
Include-Resource: @jar_file_name.jar 
#import any external java packages that are required 
Import-Package: *;resolution:=optional 
#export the java packages that should be visible to external consumers 
Export-Package: * 
-nouses: true

4. To re-apply the custom JAR file to the My webMethods Server profile with the new
information, run this command from the command line:
./mws.[bat|sh] -s default update-osgi-profile

5. Restart My webMethods Server.

6. To navigate to the correct page, do one of the following:

In My webMethods: Navigate > Applications > Administration > My webMethods >
Directory Services > List Directory Services.

As system administrator: Administration > User Management > Directory Services
Administration > List Directory Services.

7. Click the system directory service.

8. In the Password Complexity Class field, type the name of the Password Complexity
Class created in the Composite Application Framework and click Apply.

If you need to update your custom JAR file, do the following:

1. Stop My webMethods Server.
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2. Update or copy the new custom JAR file to the Software AG_directory\MWS\lib
directory.

3. Run this command from the command line:
./mws.[bat|sh] -s default update-osgi-profile

4. Restart My webMethods Server.

Working with Response Header Rules
My webMethods Server enables you to create and manage rules that govern the HTTP
response messages that are sent after receiving and interpreting a request message. The
following topics describe how to work with response header rules.

Viewing Response Header Rules
To view response header rules

1. As system administrator: Administrative Folders > Administration Dashboard > User
Interface > Manage Response Header Rules.

2. Click the View Rules tab if it is not already selected.

Available rules are displayed in the Rule Name list. The list is empty if no rules are
defined. The following information appears for each rule:

The rule name. This is a clickable link that opens the Modify Rule where you can view
the rule conditions and make changes to the rule.

A description of the rule as entered by the rule creator.

Whether or not the rule is currently enabled.

Creating a Response Header Rule
To create a response header rule

1. As system administrator: Administrative Folders > Administration Dashboard > User
Interface > Manage Response Header Rules.

2. Click the Create Rule tab.

3. Do the following:

Type a name for the rule in the Rule Name field.

Type a description of the rule in the Description field.

If you want the rule to be enabled upon creation, select the Enabled check box.
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If you do not want the rule to be enabled upon creation, clear the Enabled check
box.

4. In the Condition field, use the available condition element buons to define a
condition expression for the rule. The following condition elements are available:

Current User(s)

Group/Role Membership

User Attributes

Request

Parent Resource

Current Resource Type

Resource Properties

Add Operator

Click the buon you want to work with and then use the resulting dialog box to
select the value you want to add to the condition expression. For example:
portalResource isDescendant ("webm.apps.data.page.login") || 
portalResource isDescendant ("portlet.login")

You can also type in an expression directly, or type to modify the expression after
you create it.

5. Click Add next to the Result field and specify the response header key field name and
value. You can add additional key/value pairs if needed. To remove a key/value pair,
select it in the list and click Remove.

6. Click Create Rule.

Modifying a Response Header Rule
To modify a response header rule

1. As system administrator: Administrative Folders > Administration Dashboard > User
Interface > Manage Response Header Rules.

2. Do either of the following:

Click the rule name in the Rule Name field.

Click the Tools icon  for the rule you want to work with and then click Modify
Rule.

3. On the Modify Rule tab, make changes to the rule as required:

In the Condition field, use the available condition element buons to add a
condition expression to the rule, or type to modify the expression directly.
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4. In the Result field, select a response header key field name and value and do one of
the following:

Click Add to specify an additional key/value pair.

Click Modify to make changes to an existing key/value pair.

Click Remove to remove a key/value pair.

5. Click Modify Rule.

Copying a Response Header Rule
You can copy a rule to create a new rule in the Manage Response Header Rules page.
When you copy a rule, you provide a name and description for the new rule, and the
rule condition and result information is copied from the original rule into the new rule.

Note: When you copy a rule, the seing of the Enabled check box in the original
rule is also copied into the new rule. If the Enabled check box is selected in the
original rule, the new copied rule will be enabled as soon as you create it.

To copy a response header rule

1. As system administrator: Administrative Folders > Administration Dashboard > User
Interface > Manage Response Header Rules.

2. Click the Tools icon  for the rule you want to work with and then click Copy Rule.

3. On the Copy Rule tab, type a name and description for the new rule.

4. Click Copy the Rule.

Removing a Response Header Rule
To remove a response header rule

1. As system administrator: Administrative Folders > Administration Dashboard > User
Interface > Manage Response Header Rules.

2. Click the Tools icon  for the rule you want to work with and then click Remove
Rule.

3. Click OK in the confirmation dialog box to remove the rule.

Changing the Response Header Rule Evaluation Order
To change the response header rule evaluation order

1. As system administrator: Administrative Folders > Administration Dashboard > User
Interface > Manage Response Header Rules.
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2. Click the Change Rule Evaluation Order tab.

3. In the Evaluation Order list, select a rule name and use the arrow buons to the right to
move the selected rule up or down in the evaluation order.

4. Click Update Rule..

Changing the Default Internet Explorer Compatibility Setting
By default, My webMethods Server sets the compatibility mode for Internet Explorer to
IE8. See About the Default Response Header Rules.

To change the Internet Explorer document compatibility setting.

1. As system administrator: Administrative Folders > Administration Dashboard > User
Interface > Manage Response Header Rules.

2. Locate the IE - parameter for compatibility mode rule and do either of the following:

Click the rule name in the Rule Name field.

Click the Tools icon  for the rule you want to work with and then click Modify
Rule.

3. Click Update next to the Result field, edit the Value field, and click Apply.

The default value is IE-8.

4. Click Update Rule.

About the Default Response Header Rules
The following response header rules are available in My webMethods Server by default:

Rule Name Enabled? Description

Login Page
Deny Non
Same-Origin
Framing

Yes This rule guards against cross-site scripting
and clickjacking aacks on the Login page by
implementing the X-Frame-Options HTTP
response header. This header indicates whether
or not a browser should be allowed to render a
page in a <frame> or <iframe>, thus ensuring that
content is not embedded into other sites. The key/
value pair is:
X-Frame-Options SAMEORIGIN

The page can only be displayed in a frame of the
same origin as the page itself.
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Rule Name Enabled? Description

Login Page
Deny All
Framing

No This is a more stingent Login page anti-cross-site
scripting and clickjacking rule. The key/value pair
is:
X-Frame-Options DENY

In this case, the page cannot be displayed in a
frame, regardless of the site aempting to do so.

IE -
parameter for
compatibility
mode

Yes This seing sets the standard document type for
Internet Explorer in rendering HTML pages. The
default value is IE8.

Basic support for the X-Frame-Options header response is available in these (and later)
browser versions:

Chrome 4.1.249.1042

Firefox 3.6.9

Gecko 1.9.2.9

Internet Explorer 8.0

Opera 10.5

Safari 4.0
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Overview
My webMethods Server provides administrators with a number of tools for analyzing,
reporting, managing, and maintaining server deployment. This chapter provides
detailed instructions on how to use these tools.

Controlling Server Logging
As My webMethods Server runs, it collects logging information for a variety of
categories, for web applications, and for portlet applications. Logging information is
collected in two stages, Logger and Output.

Logger stage allows you to define the level of messages you want to collect for each
category, web application, and portlet application.

Output stage determines the level of messages that you want My webMethods Server
to write to the console and the log files.

You can control each stage independently. The logger threshold takes precedence over
an output threshold. If My webMethods Server discards a logging message because
it does not meet a logger threshold, and is therefore not collected for a category or
application, that message cannot be wrien to the output, that is, it cannot be wrien to
the console or a log file.

Use the Logging Configuration page to control logging for the server. For more
information, see "About Logging Thresholds" on page 250 and "Seing Logger and
Output Thresholds" on page 252.

As My webMethods Server writes log messages to the output log files, the files will
grow in size. Periodically, the My webMethods Server rolls over to a new set of files,
making it easier to locate a specific date and to discard old log files as needed. For more
information about the output log files, how often My webMethods Server rolls over files,
and how you can control the rollover, see "About the Log-File Rollover Period" on page
254 and "Modifying the Log-File Rollover Period" on page 257.

About Logging Thresholds
Define logging thresholds to control the log messages that My webMethods Server
collects. Each log message is assigned a log level. A threshold indicates the log level
of messages you want My webMethods Server to collect. My webMethods Server
logs messages that have the level you specify and all higher levels. As a result, by
seing thresholds, you can limit the growth of log files. Set lower log levels when you
want to collect more information and higher log levels when you want to collect less
information.

The following table describes the levels, from the lowest level to the highest:
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Log level Description

TRACE Set a threshold to this level if you want the logs to contain messages
of all levels. This level provides the most detail; however, log files
grow quickly.

DEBUG The server issues DEBUG messages at multiple points within a
server event. Set a threshold to this level to collect DEBUG messages
and all higher-level messages (e.g., INFO, WARN, etc.). This level is
useful for debugging a problem; however, log files grow quickly.

INFO The server issues INFO messages to indicate that a server event has
occurred. Set a threshold to this level to collect INFO messages and
all higher-level messages.

WARN The server issues WARN messages to warn you of an error that is
not serious. Set a threshold to this level to collect WARN, ERROR,
and FATAL messages.

ERROR The server issues ERROR messages when a non-fatal error occurs.
Set a threshold to this level to collect ERROR and FATAL messages.

FATAL The server issues ERROR messages when a fatal error occurs. Set a
threshold to this level to collect only FATAL messages.

To define a threshold, assign one of the levels described in the table above.

Assign a log level to a logger threshold for a category, web application, or portlet application
to control the messages that My webMethods Server collects for that category or
application. You can view the categories and applications for which My webMethods
Server can collect messages on the Logging Configuration page.

Assign a log level to an output threshold to control the messages that My webMethods
Server writes to the console or one of the following log files:

_full_.log, which can contain all level of messages from all categories, web
applications, and portlet applications.

_problems_.log, which contains messages from all categories, web applications,
and portlet applications; however, it restricts the level to WARN messages or
higher, that is WARN, ERROR, or FATAL messages.

_errors_.xm_, which is an XML fragment that contains messages from all
categories, web applications, and portlet applications. By default it contains only
FATAL messages.
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Note: You can wrap the XML fragment that is contained in the errors log with
a root XML element to produce well-formed XML.

The logger threshold takes precedence over an output threshold. When the server
collects a log message, it first sends the message to a specified logger. If the message
does not meet the threshold, it is discarded. However, if the log level of the message
meets or exceeds the logger threshold, the server forwards the message on to the
logging outputs. If the log level of the message does not meet the output threshold,
it is discarded. Finally, if the message meets or exceeds the output threshold, the
server writes the message to the output. In other words, if a message does not meet the
threshold you set for a category or application (logger threshold), it is discarded and
therefore cannot be wrien to the output.

Setting Logger and Output Thresholds
You can set both logger thresholds and output thresholds on the Logging Configuration
page.

Note: When you update the thresholds on the Logging Configuration page,
the seings are permanent until you update them again. If you want My
webMethods Server to temporarily use debug seings that last only until
the server is shut down, you can start the server using the -d startup option.
For more information, see "Temporarily Seing Debug Thresholds" on page
252.

To set a logger or output threshold

1. As system administrator, click Administration Dashboard > Analysis > Logging
Configuration.

2. For each category, web application, and/or portlet application you want to modify,
in the Logger Threshold column, select the log level to the lowest level of message you
want to accept.

3. For each output threshold you want to modify, in the Output Threshold list, select the
log level to the lowest level of message you want to accept.

Tip: To set all logger thresholds or output thresholds to the same logging
level, click the Tools icon  to the right of the Logger Threshold or Output
Threshold label and then select the log level to use.

4. Click Apply.

Temporarily Setting Debug Thresholds
By default, the server configuration uses a java system property (logj4.default.log.level)
to set the logging threshold for several categories to the WARN threshold. When you
start the server with the -d startup option, the logj4.default.log.level variable is set
to DEBUG. As a result, the server collects messages for the categories at the DEBUG
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threshold until the server is shut down. Use this the -d startup option to run the server
in debug mode. This is an easy way to temporarily increase the log level for many
categories to perform troubleshooting.

The following section of the logging configuration shows the categories that are affected
by the -d startup option:
# default level controled by -d=DEBUG otherwise =WARN 
log4j.category.Framework=${log4j.default.log.level} 
log4j.category.frameworkInit=${log4j.default.log.level} 
log4j.category.dataAccess=${log4j.default.log.level} 
log4j.category.jsp=${log4j.default.log.level} 
log4j.category.jsf=${log4j.default.log.level} 
log4j.category.directory=${log4j.default.log.level} 
log4j.category.portlet=${log4j.default.log.level} 
log4j.category.classManager=${log4j.default.log.level} 
log4j.category.taglibs=${log4j.default.log.level} 
log4j.category.mail=${log4j.default.log.level} 
log4j.category.search=${log4j.default.log.level} 
log4j.category.messaging=${log4j.default.log.level} 
log4j.category.notifications=${log4j.default.log.level} 
log4j.category.schedule=${log4j.default.log.level} 
log4j.category.version=${log4j.default.log.level} 
log4j.category.task=${log4j.default.log.level} 
log4j.category.webservice=${log4j.default.log.level} 
log4j.category.wsclient=${log4j.default.log.level}

For instructions for how to start the server using the -d startup option, see "Command
Syntax for My webMethods Server " on page 52.

Exporting Threshold Settings to a File
You can export your logger and output threshold seings to a file named
log4.override.properties. Then later, you can import them from the
log4.override.properties file into a My webMethods Server database.

You might want to export your threshold seings if you want to save a backup copy or if
you want to use the same seings in another My webMethods Server instance that is not
in the same cluster.

To export threshold settings

1. As system administrator, click Administration Dashboard > Analysis > Logging
Configuration.

2. Click Export.

3. If you want to open the file in a text editor to view it before saving:

a. Select the Open with option.

b. Select the text editor you want to use to view the file.

c. Click OK.

My webMethods Server downloads the file from the database and opens it in the
selected editor.
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d. Use the text editor save function to save the file.

4. If you want to save the file without opening it:

a. Select Save File.

b. Click OK.

My webMethods Server downloads the threshold seings to the
log4.override.properties file and places the file on your desktop.

Importing Threshold Settings from a File
If you previously exported the logger and output threshold seings to the
log4.override.properties file, you can use the following procedure to import them into a
My webMethods Server instance.

To import threshold settings

1. As system administrator, click Administration Dashboard > Analysis > Logging
Configuration.

2. Click Import.

3. Click Browse, navigate to the location of the log4.override.properties file containing
the seings you want to import, and click Open.

4. In the Import Mode field, select whether you to merge the seings or completely
replace the seings.

Select Merge with Existing Configuration to merge the seings in the
log4.override.properties file with the current threshold seings in the My
webMethods Server database.

Select Replace Existing Configuration if you want to completely replace the
threshold seings in the My webMethods Server database with the seings in the
log4.override.properties file.

5. Click Import Configuration.

About the Log-File Rollover Period
Periodically, the logging process rolls over to a new set of files based on either date or
file size. When My webMethods Server rolls over a file based on date, it renames the old
log file so that it includes the date so that if you need to refer to old log data, it is easier
to find the data for a specific date. When My webMethods Server rolls over based on
size, it maintains a specified number of backup files and discards older data.

My webMethods Server log files reside in the following directory:

Software AG_directory\MWS\server\server_instance \logs
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The following table describes the log files that My webMethods Server creates and the
default for when My webMethods Server rolls over the log file. For information about
how to customize the rollover periods, see "Modifying the Log-File Rollover Period" on
page 257.

Log file By default, this log contains... By default, the log is rolled over...

_full_.log Log messages from all
categories and all enabled
thresholds (for example,
TRACE, DEBUG, INFO,
WARN, ERROR, and
FATAL).

Daily at midnight

When the log is rolled over, the
past days log messages are rolled
over into a file that is named
to reflect the date of the log
information it contains:

_full_.yyyy-MM-dd.log

You can customize how often My
webMethods Server rolls over this
log.

_problems_.log WARN, ERROR, and
FATAL log messages from
all categories.

Daily at midnight

When the log is rolled over, the
past days log messages are rolled
over into a file that is named
to reflect the date of the log
information it contains:

_problems_.yyyy-MM-dd.log

You can customize how often My
webMethods Server rolls over this
log.

install.log DEBUG level log
messages from the install

When the log size reaches 100 MB

When the log is rolled over, the
old log messages are rolled over
into a backup file that uses the
following naming convention,
where N  is a number.

install.N .log

For example, the first time the
log is rolled over, the backup
log is named install.1.log. By
default, My webMethods Server
maintains up to three backups.
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Log file By default, this log contains... By default, the log is rolled over...

You can customize the maximum
size limit for this file before My
webMethods Server rolls it over
and how many backup files the
server maintains.

caf.log CAF application log
messages

Daily at midnight

When the log is rolled over, the
past days log messages are rolled
over into a file that is named
to reflect the date of the log
information it contains:

caf.yyyy-MM-dd.log

You cannot customize how often
My webMethods Server rolls over
this log.

schema.log Log messages from DDL
statements execution for
creating, modifying, or
deleting x-type objects

When the log size reaches 5 MB

When the log is rolled over, the
old log messages are rolled over
into a backup file that uses the
following naming convention,
where N  is a number.

schema.N .log

For example, the first time the
log is rolled over, the backup
log is named schema.1.log. By
default, My webMethods Server
maintains up to ten backups.

You can customize the maximum
size limit for this file before My
webMethods Server rolls it over
and how many backup files the
server maintains.

_errors_.xm_ An XML fragment of
FATAL log messages from
all categories

You can wrap the XML
fragment that is contained
in the errors log with

This log is not rolled over
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Log file By default, this log contains... By default, the log is rolled over...
a root XML element to
produce well-formed
XML.

Modifying the Log-File Rollover Period
My webMethods Server maintains the seings for how to roll over the log files in the My
webMethods Server database. As a result, if you are running the server in the cluster,
all server instances use the same rollover seings. To update the rollover seings,
you can have My webMethods Server download the seings to a local file named
log4j.init.properties file, modify the rollover periods in the downloaded file, and then
upload the changes back to the database.

If My webMethods Server rolls over the log file based on:

Date and time, (used for the _full_.log and _problems_.log files)

The rollover configuration is controlled by the appender type
org.apache.log4j.DailyRollingFileAppender. To update the rollover period, you
identify a new DatePaern for the appender. The following table describes the
DatePaerns you can use.

Date Pattern My webMethods Server rolls over the log file...

'.'yyyy-MM At the beginning of each month

For example, for the _full_.log if you set the
DatePaern to ‘.’yyyy-MM, at midnight on January
31, 2010, My webMethods Server copies the log data to
the file _full_.2010-01.log. My webMethods Server logs
messages for the month of February to the _full_.log
file until it is rolled over the next month.

'.'yyyy-ww At the first day of each week. The first day of the week
depends on the locale.

For example, assume the first day of the week
is Sunday and that for the _problems_.log you
set the DatePaern to '.'yyyy-ww. On Saturday
midnight, May 15, 2010, My webMethods Server
copies the log data for the 19th week of the year
to the file _problems_2010-19. My webMethods
Server logs messages for the 20th week of 2010 to the
_problems_.log file until it is also rolled over the next
week.
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Date Pattern My webMethods Server rolls over the log file...

'.'yyyy-MM-dd At midnight each day.

For example, for the _full_.log if you set the
DatePaern to '.'yyyy-MM-dd, at midnight on
February 22, 2010, My webMethods Server copies the
log data to the file _full_2010-02-22. My webMethods
Server logs messages for February 23, 2010 to the
_full_.log file until it is also rolled over the next day.

'.'yyyy-MM-dd-a Twice each day, at noon and midnight.

For example, for the _problems_.log if you set the
DatePaern to '.'yyyy-MM-dd-a, at noon on February
22, 2010, My webMethods Server copies the log data to
the file _problems_2010-02-22-A.M. My webMethods
Server logs messages for the afternoon of February 22,
2010 to the _problems_.log file until it is rolled over at
midnight into the file _problems_2010-02-22-P.M. Then,
My webMethods Server logs messages for February 23,
2010 to the _problems_.log file.

'.'yyyy-MM-dd-HH Every hour of each day.

For example, for the _full_.log if you set the
DatePaern to '.'yyyy-MM-dd-HH, at approximately
11:00 A.M. on February 22, 2010, My webMethods
Server copies the log data for the 10 o’clock hour to the
file _full_2010-02-22-10. My webMethods Server logs
messages for the 11 o’clock hour to the _full_.log file
until it is rolled over at the beginning of the next hour.

'.'yyyy-MM-dd-
HH-mm

Every minute of each day.

For example, for the _full_.log if you set the
DatePaern to '.'yyyy-MM-dd-HH-mm, at
approximately 11:46 A.M. on February 22, 2010, My
webMethods Server copies the log data to the file
_full_2010-02-22-11-45. My webMethods Server logs
messages for the next minute to the _full_.log file until
it is rolled over a minute later.

File size, (used for the install.log file)

The rollover configuration is controlled by the
org.apache.log4j.RollingFileAppender. You can update the log level of the messages
collected in the install.log file, the maximum size of the log file before it is rolled
over, and the number of backup log files that My webMethods Server maintains.
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Note: The following procedure describes how to modify the
roll over periods by updating parameters for the default
appenders (org.apache.log4j.DailyRollingFileAppender and
org.apache.log4j.RollingFileAppender) that are defined out-of-the-
box. However, if you want, you can update the seings to use an
alternative appender to meet your needs. For example, you can change the
_problems_.log to use the RollingFileAppender if you want it to roll over
based on size or FileAppender if you do not want the log to roll over. You can
use any appender that log4j library supports. For more information, see hp://
logging.apache.org/log4j/1.2/index.html.

To modify the log-file rollover period

1. Download the log4j.init.properties file from the My webMethods Server database:

a. At a command line prompt, change directories to move to the server’s bin
directory:

Software AG_directory\MWS\bin

b. To retrieve the log4j.init.properties file from the database, type this command:

mws -s server_instance  getconfig log4j.init.properties

2. Edit the log4j.init.properties file.

a. Navigate to the following directory, where the getconfig command placed the
log4j.init.properties file:

Software AG_directory\MWS\server\server_instance \config

b. Open the log4j.init.properties file in a text editor.

3. To modify the rollover seings for the _full_.log file:

a. Locate the following portion of the file:
log4j.appender.rootFile=org.apache.log4j.DailyRollingFileAppender
log4j.appender.rootFile.DatePattern='.'yyyy-MM-dd
log4j.appender.rootFile.File=${log4j.logging.dir}/_full_.log

b. Update the date paern to define when you want the _full_.log file to rollover.

4. To modify the rollover seings for the _problems_.log file:

a. Locate the following portion of the file:
log4j.appender.rootErrorsFile=org.apache.log4j. 
    DailyRollingFileAppender
log4j.appender.rootErrorsFile.DatePattern='.'yyyy-MM-dd
log4j.appender.rootErrorsFile.File=${log4j.logging.dir}/ 
    _problems_.log

b. Update the date paern to define when you want the _problems_.log file to
rollover.

5. To modify the rollover seings for the install.log file:

http://logging.apache.org/log4j/1.2/index.html
http://logging.apache.org/log4j/1.2/index.html
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a. Locate the following portion of the file:
log4j.appender.installFile=org.apache.log4j.RollingFileAppender
log4j.appender.installFile.threshold=DEBUG
log4j.appender.installFile.MaxFileSize=100MB
log4j.appender.installFile.MaxBackupIndex=3
log4j.appender.installFile.File=${log4j.logging.dir}/install.log

b. To change the size limit of the file, update the value on the
log4j.appender.installFile.MaxFileSize line to specify an alternative
maximum file size.

c. To change the number of backups that you want My
webMethods Server to maintain, update the value on the
log4j.appender.installFile.MaxBackupIndex line.

It is recommended that you do not update the
log4j.appender.installFile.threshold line to change the threshold level for
the install.log. Because the installation process issues INFO messages, if you raise the
threshold, no messages will be logged.

6. To modify the rollover seings for the schema.log file:

a. Locate the following portion of the file:
log4j.appender.DDLSchemaFileAppender=org.apache.log4j. 
    RollingFileAppender
log4j.appender.DDLSchemaFileAppender.threshold=INFO
log4j.appender.DDLSchemaFileAppender.MaxFileSize=5MB
log4j.appender.DDLSchemaFileAppender.MaxBackupIndex=10
log4j.appender.DDLSchemaFileAppender.File=${log4j.logging.dir} 
    /schema.log
log4j.appender.DDLSchemaFileAppender.layout=org.apache.log4j. 
    PatternLayout
log4j.appender.DDLSchemaFileAppender.layout.ConversionPattern= 
    ${log4j.mes 
sage.pattern}

b. To change the size limit of the file, update the value on the
log4j.appender.DDLSchemaFileAppender.MaxFileSize line to specify an
alternative maximum file size.

c. To change the number of backups that you want My
webMethods Server to maintain, update the value on the
log4j.appender.DDLSchemaFileAppender.MaxBackupIndex line.

7. Save the log4j.init.properties file.

8. Deploy the revised file to the My webMethods Server database:

a. At a command line prompt, change directories to move to the server’s bin
directory:

Software AG_directory\MWS\bin

b. To write the log4j.init.properties file back to the database, type this command:

mws -s server_instance  putconfig log4j.init.properties
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c. Delete the local copy of the log4j.init.properties file.

If you do not delete the file, the server instance will continue to use the local
version of the file.

9. Restart the cluster.

Changes do not take effect until the cluster is restarted.

Changing the Default Logging Directory
By default, logs for a server instance reside in this location:

Software AG_directory\MWS\server\server_instance \logs

You can change the location of this directory by modifying the systemPaths.properties
file.

Changing the default logging directory

1. Download the systemPaths.properties file from the My webMethods Server
database:

a. At a command line prompt, change directories to move to the server’s bin
directory:

Software AG_directory\MWS\bin

b. To retrieve the systemPaths.properties file from the database, type this
command:

mws -s server_instance  getconfig systemPaths.properties

2. Open, in a text editor, the systemPaths.properties file, which you will find in this
location:

Software AG_directory\MWS\server\server_instance \config

3. Modify this line to point to the new location of the logs directory, and save the file:
system.path.logs=root:/logs

4. Deploy the revised file to the My webMethods Server database:

a. At a command line prompt, change directories to move to the server’s bin
directory:

Software AG_directory\MWS\bin

b. To write the systemPaths.properties file back to the database, type this command:

mws -s server_instance  putconfig systemPaths.properties

c. Delete the local copy of the systemPaths.properties file.

If you do not delete the file, the server instance will continue to use the local
version of the file.
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5. Restart the server instance.

Changes do not take effect until the server is restarted.

Viewing Logging Messages
The Log Viewer page allows you to view the latest messages in the _full_.log,
_problems_log, and _errors_.xm files.

For the Log Viewer page to be useful, you need to make sure you are collecting the right
messages for your needs. Use the Logging Configuration page to set message collection
criteria. For more information, see "About Logging Thresholds" on page 250 and
"Seing Logger and Output Thresholds" on page 252.

To view logging messages

1. As system administrator, click Administration Dashboard > Analysis > Log Viewer.

2. Select the number of lines that you want to view.

3. Select from which log you want to view messages.

4. Click Refresh Now.

Managing Security Audit Logging
By default, My webMethods Server performs audit logging on all auditable events.
Using the Audit Administration page, you can enable or disable audit logging, or choose
which events are to be logged. By default, audit logging is enabled and all available
auditable events are logged.

My webMethods Server writes the audit log to the audit.log file, which resides in the
following directory:

Software AG_directory\MWS\server\server_instance \logs

To manage security audit logging

1. As system administrator, click Administration Dashboard > Configuration > Audit
Administration.

2. To enable or disable audit logging:

a. To enable audit logging, select Enable Auditing.

This is the default seing.

b. To disable audit logging, clear Enable Auditing.

3. In the Auditable column, select events to be logged and clear events that are not to be
logged.
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Selected events are not logged if audit logging is disabled.

4. Click Apply.

The changes take effect immediately.

Monitoring Real-Time User Activity
The Session Monitor page can be used to monitor real-time user activity for a server
deployment and send status messages to active users by means of E-mail. For active
users, a system administrator can accomplish two important functions:

view a user's profile information

send the user E-mail directly from within this page

To view all active server sessions

1. As system administrator, click Administration Dashboard > Analysis > Session Monitor.

2. (Optional) On the list of active sessions, click a user's name to view that user's
profile.

3. (Optional) On the list of active sessions, click the E-mail icon .

If you have an E-mail client installed on the machine you are working on, an E-mail
message window is displayed allowing you to compose and send an E-mail to the
selected user. If the user does not have a valid E-mail address in User Information,
the To field is empty.

Collecting Data about Server Events
The Events Collector page collects data about events on the server so they can be used by
other pages.

When deployed on a server, the Events Collector page captures information about
certain types of server events and places them in the server database.

Login and logout.

Get events, such as when a user browses a page.

Operation events, such as when an object is created, updated, moved, or deleted.

For each event captured, the page collects information on the user associated with the
event, the date and time of the event, the host name of the machine, and where possible,
information about the operation being performed.

To take advantage of data collected by this page, another page performs a query against
the server database and then displays the results on a page. You can find examples
of pages that perform these queries on the Software AG Developer Community for
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webMethods at hp://communities.softwareag.com/. To try one or more of these pages,
you need to take the following actions:

This function... Described here...

Deploy the Events Collector page and
the sample pages on the server.

"Deploying the Events Collector Page"
on page 264.

Configure the Events Collector page "Configuring the Events Collector
Configuration Page" on page 264

Populate a page with the sample
portlets that display server events

"Managing Pages in My webMethods
Server " on page 319.

Sample pages include portlet source code so you can import the portlets into
Software AG Designer and see how they function. An example of the database schema
used by the Events Collector page for placing data into the server database appears in
"Events Collector Database Schema" on page 265.

Deploying the Events Collector Page
The Events Collector page is part of a standard My webMethods Server installation but
is not deployed by default. Before you can use the page, you must first deploy it on the
server.

To deploy the Events Collector Configuration page on a server

1. Locate the Events Collector Configuration page at this location in the My
webMethods Server directory structure:

\Software AG_directory\MWS\components\extras\analysis
\wm_eventscollector.pdp

2. Copy the wm_eventscollector.pdp file and paste it into the Deploy directory:

\Software AG_directory\MWS\server\server_name \deploy

where server_name  is the name of the server. After a few seconds, the page is
automatically deployed on the server.

Configuring the Events Collector Configuration Page
By default, the Events Collector Configuration page is ready to begin collecting data on
events as soon as you deploy it, but you may want to change how long data is kept, or to
disable the page.

http://communities.softwareag.com/
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To configure the Events Collector Configuration page

1. As system administrator, click Administration Dashboard > Analysis > Events Collector
Configuration.

Note: If you cannot find the Events Collector Configuration page in the Analysis
folder, it may not be deployed. See "Deploying the Events Collector Page"
on page 264.

2. Use the Collection Enabled check box to control data collection by doing one of the
following:

Do this... To have this effect...

Select the check
box

Enable the collection of server event data. Data collection is
enabled by default.

Clear the check
box

Disable the collection of server event data.

3. In the Keep Data for list, select how long to keep server event data.

Choices range from One Day to One Year. The default is One Month.

4. Click Apply.

Events Collector Database Schema
The Events Collector page uses the following database schema.
tblwEvents (main table where events data is being collected) 
  idEvent    - Primary key 
  idType     - Foreign key to tblwEventTypes. Stores the type 
                  of an event. 
  idHost     - Foreign key to tblwEventHosts. Stores the host 
                  where the event occurs. 
  timestamp  - Time stamp of an event, defined as the number of 
                  milliseconds since epoch(java.lang.System. 
                  currentDateMillis()). 
  userID     - Database ID of the user who performed an operation. 
  thingID_1  - object_1. For example, for Get type events this is 
                  the database ID of the object being viewed. 
  thingID_2  - object_2. Used in rare cases where two objects are 
                  involved, for example when an object is created. 
                  Then object_1 is the database ID of the container, 
                  and object_2 is the database ID of an object that 
                  was created. 
  action     - Used for Login events: 1 - user logged in, 2 - user 
                  logged out. 
tblwEventHosts (stores mapping between hostID and hostname) 
  idHost     - Host id. 
  hostname   - Actual host name where the event occurs. 
tblwEventTypes (stores mapping between eventID and eventTypeName) 
  idType     - Event type ID. 
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 eventType   - Event type name. 
Possible eventType name values: 
  com.webmethods.portal.event.add.impl.CreateEvent    
    - New object is created. 
  com.webmethods.portal.event.impl.GetEvent           
    - Object is being browsed. 
  com.webmethods.portal.event.system.impl.LoginEvent  
    - User logs in/out. 
  com.webmethods.portal.event.modify.impl.UpdateEvent 
    - Object is updated. 
  com.webmethods.portal.event.remove.impl.DeleteEvent 
    - Object is deleted.

Collecting Data about Database Changes
You can collect logging information about DDL statements execution to the My
webMethods Server database. All data about database changes is collected and wrien
to the schema.log file. You can find the seing for logging database changes information
in the Administration Dashboard > Analysis > Logging Configuration page.

For more information on seing up the logging thresholds, see "Controlling Server
Logging" on page 250.

For more information on how to view the collected data, see "Viewing Logging
Messages" on page 262.

My webMethods Server Diagnostic Tools
You can use the My webMethods Server diagnostic tools to capture and analyze data
about server operation. The My webMethods Server diagnostic tools have two types
of tools, diagnostic command line tools and diagnostic portlets. This topic contains a
brief overview of the diagnostic tools. For complete information, see Diagnosing My
webMethods Server.

With the diagnostic command line tools, you can do the following:

Use the threaddump tool to capture data on thread execution for servers on a local or
remote system

Use the envcapture tool to capture environment-specific server information to be
provided to Software AG Global Support for troubleshooting assistance

Use the envdiff tool to compare XML files that result from the capture of
environment-specific server information

Use the memorydump tool to capture server memory allocation information

Use the loganalyzer tool to identify and analyze issues reported in the errors.log file

With the diagnostic portlets you can do the following:

Use the thread Dump tool to monitor thread execution deadlocks in server threads
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Use the Performance Analysis tool to measure and analyze the performance of
services and custom portlets or applications using an embedded performance-
monitoring service

Use the Performance Statistics tools to display statistic and analysis information
about the performance of various server actions, which are grouped by categories

Use the Log Analysis tools to read and analyze log files created within the server in
accordance with the log4j mechanism

Use the Memory Monitor tool to monitor the memory usage of the Java Virtual
Machine (JVM) and send notifications to administrators when the configured
threshold limits are reached



M
Even Header

Administering My webMethods Server Version 9.8 268



M
Odd Header

My webMethods Server Configuration

Administering My webMethods Server Version 9.8 269

16   My webMethods Server Configuration

■   Overview .....................................................................................................................................    270

■   Managing Aliases .......................................................................................................................     270

■   Configuring External Configuration Credentials .........................................................................     275

■   Deploying My webMethods Server Components .......................................................................    277

■   Setting up Single Sign-On .........................................................................................................     281

■   Displaying System Information ..................................................................................................     285



M
Even Header

My webMethods Server Configuration

Administering My webMethods Server Version 9.8 270

Overview
My webMethods Server provides administrators with a number of tools that can be
used to help configure your server. You perform these functions after installing and
configuring a default server instance. This chapter provides detailed instructions on
how to use the My webMethods Server Configuration tools to configure your My
webMethods Server deployment.

Managing Aliases
The Alias Management page lets you manage URL aliases as server objects. With this
page, you can create, view, modify, or delete custom URL aliases and create more
friendly URLs for various parts of your server.

For example, if you want to create an area of the server for the Sales Department, and
you have already created a folder for the Sales team in your server’s Public Folders, it
might be referenced by a non-intuitive URL such as:

hp://server /meta/default/folder/0000002216

To make it easier for the Sales team to remember the location of the Sales server, you can
use the Alias Management page to create a more user friendly URL such as:

hp://server /Sales

You can perform the following functions within the Alias Management page:

This function... Is described here...

Create a new alias "Creating an Alias to a Server Resource on the
Properties Page" on page 271 and "Creating an
Alias to a Server Resource on the Alias Management
Page" on page 271

Search for aliases "Performing a Simple Alias Search" on page 272

Save alias searches "Using Saved Alias Searches" on page 274

Modify the target server
resource for an alias

"Modifying an Alias to Point to a Different Server
Resource" on page 274

Delete an alias "Deleting an Alias" on page 275



M
Odd Header

My webMethods Server Configuration

Administering My webMethods Server Version 9.8 271

Creating an Alias to a Server Resource on the Properties Page
You can create an alias for a server resource on the Properties page of the server
resource:

To create an alias to a server resource on the Properties page

1. As system administrator, navigate to the page where the server resource is located.

2. On the server resource, click the Tools icon  and then click Properties.

3. On the Alias field of the Properties page, click Add.

4. Type an alias name for the server resource and click OK.

Do not include spaces in your alias name, or the alias will not function properly.

5. Click Apply.

Creating an Alias to a Server Resource on the Alias Management
Page
You can create an alias for a server resource on the Alias Management page:

To create an alias to a server resource on the Alias Management page

1. As system administrator, click Administration Dashboard > Configuration > Alias
Management.

2. Click Create.

3. In the Alias Name field, type the name for the new alias you want to create (such as
Sales).

Do not include spaces in your alias name, or the alias will not function properly.

4. In the Target panel, select a target for the new alias by doing one of the following:

If you want to... Do this...

Target a server resource Select the Resource option and then click Browse.
Move the resource (folder, item, or portlet) to the
Selected Items box and click Select.

Note: To pass parameters or invoke a server
command on the resource the alias references,
click the Append this string option, and then
append the string portion of the alias.
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If you want to... Do this...

Target an external
resource

Select the Path option. In the Path box, type the
path to the resource. For example,
http://www.softwareag.com

5. Click Add Alias.

6. Confirm that your alias behaves as expected by browsing to the user-friendly URL
for your new alias.

By default, when you create an alias, it is appended to the root URL for your server.
For example, if you create an alias called Sales, you can access the new alias by
typing the URL
http://server :port /Sales.

Searching for Aliases
You can use the Alias Management page to search for existing aliases. The page places
search results in a list from which you can modify or delete aliases, or view target
resources.

Tip: In the alias search field, you can use a single wildcard character (*) to
substitute for text anywhere within the name.

Performing a Simple Alias Search
To search for aliases, use the following procedure.

To perform a simple search for aliases

1. As system administrator, click Administration Dashboard > Configuration > Alias
Management > Search.

2. Type the name of the alias you want to find.

To specifically include or exclude system aliases from search criteria, 1bf Specifically
Including or Excluding System Aliases, below.

3. Click Go.

All aliases that match the search appear in a table.

Specifically Including or Excluding System Aliases
To include or exclude system aliases during a search, use the following procedure.

To include or exclude system aliases during a search

1. As system administrator, click Administration Dashboard > Configuration > Alias
Management > Search.
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2. Type the name of the alias you want to find.

3. Click Refine.

4. In the Include System Aliases list, choose one of the following:

Choose this... To do this...

Yes Include system aliases in the search

No Exclude system aliases from the search

5. Click Go.

6. To close the refined search panel, click Close.

Performing an Advanced Alias Search
To perform an advanced search for aliases, use the following procedure.

To perform an advanced search for aliases

1. As system administrator, click Administration Dashboard > Configuration > Alias
Management > Advanced.

2. Type the name of the alias you want to find.

3. Modify any or all of the following search criteria:

Search criteria Actions

System aliases In the Include System Aliases list, choose one of the following:

 Choice Action

 Yes Includes system aliases in the search

 No Excludes system aliases from the search

Search for a
target resource

For the Alias Target panel, do one of the following:

 Browse Move the target resource to the Selected Items
box and click Select.

 Use Alias In the Alias Name field, type the alias of the
target resource. Click Test to determine if the
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Search criteria Actions
alias is valid and the alias target is the correct
one. If the alias is correct, click Select.

4. Click Go.

Using Saved Alias Searches
You can save an alias search for regular use. The techniques for using saved alias
searches is similar to those described in "Using a Saved Search" on page 115 except they
are performed from this location:

As system administrator, click Administration Dashboard > Configuration > Alias
Management.

Modifying an Alias to Point to a Different Server Resource
To modify an alias to point to a different server resource, follow these steps:

To modify an existing alias to point to a different server resource

1. As system administrator, click Administration Dashboard > Configuration > Alias
Management.

2. Use the Alias Search panel to find the alias you want to modify.

3. In the search results, click the Edit icon  for the alias to be modified.

4. In the New Target panel, select a new target for the alias by doing one of the following:

If you want to... Do this...

Target a server resource Select the Resource option and then click Browse.
Move the resource (folder, item, or portlet) to the
Selected Items box and click Select.

Note: To pass parameters or invoke a server
command on the resource the alias references,
click the Append this string option, and then
append the string portion of the alias.

Target an external
resource

Select the Path option. In the Path box, type the
path to the resource. For example,
http://www.softwareag.com

5. Click Update.
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Deleting an Alias
To delete an alias, use the following procedure.

To delete an existing alias

1. As system administrator, click Administration Dashboard > Configuration > Alias
Management.

2. Use the Alias Search panel to find the alias you want to modify.

3. In the search results, click the Edit icon  for the alias to be deleted.

4. In the search results, select the check boxes beside the alias you want to delete, and
click Delete.

Configuring External Configuration Credentials
The HTTP Header Authentication Administration page allows system administrators
to configure My webMethods Server to accept external HTTP authentication credentials
from third party security and access control products such as SiteMinder (Computer
Associates) or Oblix. These credentials are case-sensitive and, depending on the platform
and web server, will most likely be sm_user or SM_USER.

Enabling Authentication

Important: The HTTP Header Authentication Administration page should only be
enabled if you are using a third-party security provider. After the page is
enabled, the server acts as though all users have been authenticated.

To accept authentication from a third party security and access control product

1. As system administrator, click Administration Dashboard > Configuration > HTTP Header
Authentication Administration.

2. For User Header Name, type sm_user or SM_user.

3. Select the Enable HTTP Header Authentication check box.

4. If appropriate, in the Logout URL field, type the URL to which the user is redirected
after logging out of the server.

5. Click Submit.

6. Configure the third party security and access control software as directed in your
vendor’s product documentation.
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Note: To properly configure an external security and access control product, both
My webMethods Server and the third party product must point to the same
directory server instance.

Checking Logs for HTTP Header Authentication Problems
If you are having a problem in geing HTTP Header authentication on to work
properly, you can check log files to assist in diagnosing the problem. Log messages for
HTTP Header authentication are assigned to the portalLogin category. Before you can
display HTTP Header authentication logging messages, you need to change the logging
threshold values. The default thresholds for writing to the console, the _full.log file, and
the portalLogin.log file are set to the INFO log level but HTTP Header authentication
logging messages use the DEBUG log level, which is lower.

Server log files reside in the \Software AG_directory\MWS\server\server_instance \logs
directory. For information on controlling the collection of logs, see "Viewing Logging
Messages" on page 262. For information on searching for log messages, see "Viewing
Logging Messages" on page 262.

Setting Login Logging Thresholds
You need to set both the category and output seings to DEBUG if you want the logging
messages to be wrien to the output. For information on seing logging thresholds, see
"Controlling Server Logging" on page 250.

To set category and output thresholds for HTTP Header authentication

1. As system administrator, click Administration Dashboard > Analysis > Logging
Configuration > Logging Thresholds.

2. In the Category Threshold list, select the DEBUG log level for any or all of the
following logging categories:

Logging category Controls output for...

root The console and the _full.log file

portalLogin The portalLogin.log file

3. In the Output Threshold list, select the DEBUG log level for any or all of the following
logging output types:

Logging output Controls output for...

Console Logging messages sent to the console

_full.log Logging messages sent to the _full.log file
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Logging output Controls output for...

portalLogin Logging messages sent to the portalLogin.log file

4. Click Apply.

Checking HTTP Header Authentication Logs for Problems
With HTTP Header authentication enabled, the server acts as though all users have
been authenticated. With this in mind, the log messages will reveal one of three likely
outcomes, as described in the following sections.

The Login is Successful

Messages for a successful login using HTTP Header authentication look similar to the
following example:
Date_and Time  (portalLogin : DEBUG) - HttpHeaderHandler Auth Handler 
   looking for: user_name
Date_and Time  (portalLogin : DEBUG) - Found userID: user_name

where user_name  is the name of the user who logged in under HTTP Header
authentication.

HTTP Header Authentication is Disabled

If you have not enabled HTTP Header authentication, the log message looks similar to
the following example:
Date_and Time  (portalLogin : DEBUG) - HttpHeaderHandler Auth Handler is
   not enabled

To enable HTTP Header authentication, see "Enabling Authentication" on page 275.

The Problem Rests with the Third-Party Site

If the third-party site is not configured correctly, HTTP Header authentication will fail.
The resulting log message looks similar to the following example:
Date_and Time  (portalLogin : DEBUG) - HttpHeaderHandler Auth Handler 
   looking for:
Date_and Time  (portalLogin : DEBUG) - No value found!

Deploying My webMethods Server Components
System administrators have the following options available to them when installing
server components, such as portlets or DBOs, on a server.

Through the Install Administration page on the Administration Dashboard.

Through the Deploy folder on the server’s File System. This folder allows system
administrators and developers to copy or paste a newly developed portlet package
(such as a portlet, CAF application, Task application, or deployable package) into a
specific directory that is periodically polled by the server. If the server detects new
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deployable components in this folder, these components are automatically retrieved
and installed on the server. You have the option to configure the polling interval
that specifies how often the server will poll the Deploy directory to detect any new
components.

You can perform the following functions within the Datasource Administration page:

This function... Is described here...

Modify the polling interval used in
deploying portlets to a server

"Modifying the Polling Interval" on
page 278

Install a portlet using the Deploy folder
for a server

"Installing a Portlet Using the Deploy
Folder" on page 279

Install a portlet or other deployable
component using the Install
Administration page

"Installing Portlets or Other
Deployable Server Components" on
page 279

Uninstall a server component "Uninstalling Portlets or Other
Deployable Server Components" on
page 280

Modifying the Polling Interval
If your organization is developing multiple portlets, this installation method may be
more convenient than manually installing portlets one at a time. The default file system
location for the Deploy folder is:

\Software AG_directory\MWS\server\server_instance \deploy

Note: Polling can be turned on or off by modifying the PhaseProvider.xml
configuration file on the server's file system. Use the following instructions to
modify the polling interval.

To modify the polling interval

1. At a command line prompt, type the following command to move to the server’s bin
directory:
cd Software AG_directory \MWS\bin

2. To retrieve the phaseProvider.xml file from the My webMethods Server database,
type this command:

3. Navigate to the following location:

\Software AG_directory\MWS\server\server_instance \config
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4. Open the phaseProvider.xml configuration file in a text editor or equivalent XML
editing facility. Locate the following XML fragment:
<Phase name="deploySync" enabled="true" 
    class="com.webmethods.portal.system.init.impl.MasterServerPhase">
<PhaseInfo name="startTimedSyncDeploy" enabled="true" 
    class="com.webmethods.portal.bizPolicy.biz.install.impl.
SyncDeployService" interval="5" />
</Phase>

5. To turn polling off, change the enabled aribute from true to false.

6. To change the polling interval, modify the interval aribute to the desired value. The
default seing is 5 seconds.

Note: This seing will not have an impact on overall performance

7. Save the file.

8. To deploy the revised file to the My webMethods Server database, type this
command:
mws putconfig file name

9. Delete the file from the \server_name \config directory.

If you do not delete the file, this server instance will continue to use the local version
of the configuration file.

10. Restart your server instance.

Installing a Portlet Using the Deploy Folder
To use the Deploy folder to install a portlet on a server, do the following.

To install a portlet using the Deploy folder

Copy and paste the server component(s) that you want to deploy into the deploy
directory.

Note: If any server component fails to deploy, the server will automatically
create a Failed directory on the server’s file system in the Deploy folder.
All components that do not install properly will be copied into the Failed
directory.

Installing Portlets or Other Deployable Server Components
To use the Install Administration page to install portlets or other deployable server
components, do the following



M
Even Header

My webMethods Server Configuration

Administering My webMethods Server Version 9.8 280

To install a portlet or other deployable server component

1. As system administrator, click Administration Dashboard > Configuration > Install
Administration.

2. Click Install New Component.

3. Choose Local or Network Location or Remote Location.

4. Do either of the following:

If the deployable component resides on your local file system, click Browse and
navigate to the location.

If the deployable component is in a remote location, type the complete path to
the component.

5. Click Next.

6. Review the Component Info Summary and then click Install.

If the component is installed successfully, you will get a confirmation message
verifying that the install succeeded.

Note: If a component install fails, that component is automatically uninstalled.
Be sure to check your log files to troubleshoot the installation failure.

Uninstalling Portlets or Other Deployable Server Components
Before you uninstall a component, determine how its removal will affect all of its
instances on a user’s page. Uninstalling will break any page that contains specific portlet
instances of the portlet that was uninstalled, and disrupt any portlets that may be wired
to that portlet using the portlet wiring feature.

For example, you are not warned about wiring relationships when removing a portlet
that is wired to another portlet.

You may want to change the portlet’s status property to Hidden or Disabled to phase out
the portlet before you uninstall it. After users are informed of the impending uninstall
and have removed it from their page, it will then be safe to uninstall it.

Important: When an uninstalled portlet’s instances are broken, it causes errors on each
page on which that portlet is being used. It also may remove the data for a
portlet and its instances, the configuration files, the portlet database tables,
and the portlet packaging files. Reinstalling will not restore the broken
references caused by uninstalling a portlet.

To uninstall a component using the Install Administration page

1. As system administrator, click Administration Dashboard > Configuration > Install
Administration.
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2. On the tree list, select one or more components to be uninstalled, click Uninstall
Selected, and click Next.

3. To confirm the uninstall action, click Uninstall.

Setting up Single Sign-On
Single sign-on is the ability for a user to log into one application and then use other
applications without having to log into each one separately. My webMethods Server
supports single sign-on through the Security Assertion Markup Language (SAML), an
XML-based framework for the exchange of security information. Using SAML, an entity
on a target computer grants access based on an assertion from the source computer
that the user is logged into the source computer. You need to add the certificate used in
signing the assertion to the truststore on the target instance of My webMethods Server.
See "Importing CA Certificates" on page 36.

My webMethods Server can provide a single sign-on capability in the following ways:

Between a source server and one or more target servers

Between a server and other webMethods applications that have single sign-on
capability

Between a server and a third-party application that supports SAML

(Deprecated) Between a server, an Artifact Receiver that authenticates the user sign-
on, and a target web application

Using this model, one server is the source, providing a central login for users. Links on
pages on the source server point to any number of SAML-capable entities. Also, a target
server can accept assertions from any number of servers as long as the truststore of the
target server has the certificate of the source server.

To take advantage of single sign-on, a user must be known on both the source server and
the target entity. In most cases, common knowledge of a user is provided by use of the
same directory service.

Configuring a Server as a Target for Single Sign-On
A server can be a target for only one single sign-on source at a time.

To configure a server to be a target for single sign-on

1. As system administrator, click Administration Dashboard > Configuration > SAML
Authentication Administration.

2. Modify Properties as follows:
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For this property... Do this...

Artifact Parameter
Name

(Deprecated) If this is a SAML connection with another
webMethods server, do not change the default value
SAMLart. If this is a SAML connection to a third-party
source, type the artifact parameter name used by the third-
party application.

Assertion Parameter
Name

The HTTP request parameter name where the server will
look for the SAML assertion value. The default value is
SAMLResponse.

Security Provider
URI

(Deprecated—used with the Artifact Parameter Name)
Type the URI of the SAML security provider (source). If
this is a connection with another webMethods server, use
this syntax:
server_name :port /services/SAML

where server_name  is the host where the source server is
running and port  is the server port number. The default
port number is 8585.

3. Click Submit.

Setting SAML Links on a Source Server
On any page, you can add a link to a SAML target entity, such as a server. If the target
accepts SAML assertions from the source server, when a known user clicks the link, no
login credentials are required. If the target entity does not accept SAML assertions from
the source server, or if the user is not known on the target entity, login credentials may
be required.

(Deprecated—valid only with a SAML Artifact Receiver) Under the SAML specification,
an intermediary called an artifact receiver can perform authentication on behalf of the
target web application. In such a case, the SAML source requires two URLs: one for
the Artifact Receiver and one for the target web application. You can place one or more
SAML links on any page you have permission to edit.

You can place one or more SAML links on any page you have permission to edit.

To create a SAML link on a source page

1. In the upper right-hand corner of the page, click the Tools icon  and click Edit
Page.

2. In the Root list of the Available Portlets panel, click Links.
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3. In the Links list of the Available Portlets panel, drag the wm_xt_ssolink portlet and drop
it onto the page at the location where you want to add the link.

A red box appears beneath the cursor location whenever the cursor is over a valid
page location, indicating where the portlet would be positioned if you released the
mouse buon.

4. On the left side of the page control area, click Save.

5. At the right edge of the title bar for the single sign-on portlet, click the Tools icon 
and click Properties.

6. In the Properties page make modifications as appropriate:

Make changes here... If you want to...

Name Replace wm_xt_ssolink with the text that is to go
with the link.

SAML Type Select the version of the SAML specification to be
used:

SAML2 POST

SAML1 POST

SAML Artifact — (Deprecated)

SAML Authentication URL Type the URL for a resource on the target
computer. The target can be any page on a server.

(Deprecated) If you are connecting to a web
application through a SAML Artifact Receiver, use
this field for the Artifact Receiver URL.

Use POST or GET (Deprecated— Valid only if the SAML Type field is
set to SAML Artifact) Determines the method used
to pass data to the target computer.

 POST Passes data to a gateway program’s
STDIN. POST, the default, is the
preferred method for single sign-on
data.

 GET Passes data as a string appended to the
URL after a question mark.
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Make changes here... If you want to...

Assertion Parameter Name The HTTP request parameter name where the
server will look for the SAML assertion value. The
default value is SAMLResponse.

Artifact Parameter Name (Deprecated— Valid only if the SAML Type field is
set to SAML Artifact) If this is a SAML connection
with another server or other webMethods product,
do not change the default value SAMLart. If this is
a SAML connection to a third-party source, type
the artifact parameter name used by the third-party
application.

Application Target URL (Deprecated) If you have typed the URL for a
SAML Artifact Receiver in the SAML Authentication
URL field, type the URL for a web application.
Otherwise, leave this field empty.

7. Click Apply.

Configuring Profiles for SAML
Under the Security Infrastructure (SIN), you can configure the security properties that
are set during server startup. The configuration file com.softwareag.sso.pid.properties is
located here:

Software AG_directory
/profiles/profile /configuration/com.softwareag.platform.
config.propsloader

The default configuration is:
com.softwareag.security.idp.keystore.keyalias=ssos 
com.softwareag.security.idp.SSOassertion.lifeperiod=5 
com.softwareag.security.idp.keystore.type=JKS 
com.softwareag.security.idp.assertion.skew=30 
com.softwareag.security.idp.truststore.location=/common/conf/ 
   platform_truststore.jks 
com.softwareag.security.idp.truststore.password=manage 
com.softwareag.security.idp.keystore.location=/common/conf/keystore.jks 
enabled=false 
com.softwareag.security.idp.keystore.password=manage 
com.softwareag.security.idp.truststore.keyalias=ssos 
com.softwareag.security.idp.assertion.lifeperiod=300 
com.softwareag.security.idp.truststore.type=JKS

Configuring truststores and keystores

The configuration allows you to specify the location of truststore and keystore files
relative to the installation directory:
com.softwareag.security.idp.keystore.location=/common/conf/keystore.jks 



M
Odd Header

My webMethods Server Configuration

Administering My webMethods Server Version 9.8 285

com.softwareag.security.idp.truststore.location=/common/conf/ 
   platform_truststore.jks

To use absolute paths for configuring truststore and keystore files, add these two
properties to the configuration file:
com.softwareag.security.idp.keystore.location.isabsolute=true 
com.softwareag.security.idp.truststore.location.isabsolute=true

Time Skew

If a SAML assertion is issued on one physical machine and validated on another, but the
two machines are not synchronized with a time server, the validation phase may fail. By
default, SIN allows a time skew of 30 seconds.

To modify the time skew value, use the following property:
com.softwareag.security.idp.assertion.skew=n

where n is the time in seconds.

Ehcache Configuration

SIN uses Ehcache to ensure that a single sign-on (SSO) assertion cannot be used more
than one time. The default time to live of an SSO assertion in Ehcache is 120 seconds. The
location of the Ehcache configuration file relative to the installation directory is defined
in the SIN configuration file using this property:
com.softwareag.security.idp.ehcache.location=/ehcachesin.xml

To use an absolute path for location of the ehcachesin.xml file, add this property to the
configuration file:
com.softwareag.security.idp.ehcache.location.isabsolute=true

To modify the time Ehcache time-to-live value, use the following property:
com.softwareag.security.idp.ehcache.ttl=n

where n is the time in seconds.

Displaying System Information
The System Information page provides a wealth of information about the current state
of the server. The page gathers the information dynamically at the time you open each
panel.

To display system information about the current state of the server

As system administrator, click Administration Dashboard > Analysis > System Information.

Panels of the System Information Page
The System Information page contains five panels. When you click a panel to bring it to
the front, the page dynamically collects the data for display:
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Panel and Heading Description

Request/Response Information that is gleaned from the user's web request.

Request Information Typical cgi-bin parameters describing the requested path.

Request Headers Incoming HTTP headers.

Request Parameters Incoming HTTP parameters on the URL.

Request Attributes Aributes (objects) stored on the current request.

Response Information Miscellaneous information, such as encoding and locale,
gleaned from the request.

Session Misc User session information.

Session Attributes Aributes (objects) stored on the user’s session.

Locale Information The current locale of the user.

Presentation Data Various information used to render requests for this user.

Session Attributes Portlet Controller Session objects associated with this
user.

Request Attributes Portlet Controller Request objects associated with this
user's request.

Application Attributes Information shared throughout the server (across all
users).

System Information Environment variables, such as Classpath, path, and so
forth).

Server Information Information about the current front-end server.

Context Information Servlet object information.
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Overview
My webMethods Server provides administrators with a number of tools that can be used
to help manage server content. This chapter provides detailed instructions on how to use
My webMethods Server tools to manage server content.

Migrating My webMethods Server Content
The Content Migration Wizard page enables system administrators to migrate server
content from one server instance to another, such as from development to staging to
production.

This page can be used to migrate the following types of server content: documents,
folders, external links, internal links (using aliases), pages (including layouts), portlets,
Dynamic Business Objects (DBOs), permissions, subscriptions, and portlet wiring
properties.

Content Migration Considerations
Content migration involves two distinct activities: exporting the content from the source
server instance, followed by importing the content on the target server instance. Before
performing these actions, consider the following:

Migrating portlets and DBOs: If you are developing or installing any portlets on a
development server and want to migrate pages that contain instances of these
portlets, you must deploy them on the target server before migrating any pages
or published instances of the portlets that were developed or installed on the
development server instance.

Migrating published content: Content published to the Content Management system
can be migrated from one server instance to another. If you are using your
development environment to configure permissions on items published to the
content management system, you have the option to migrate the permissions as well.

Migrating links: To properly migrate internal links with references to other objects,
such as a link from one page to another, create aliases for these links instead of using
the base URL.

For example, if you want to publish a link to an existing page, such as a Sales page
that has the following as its initial URL:
http://server /meta/default/folder/0000002132

Create an alias that points to this URL, but has a more friendly URL such as the
following:
http://server /Sales
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Migrating permissions and subscriptions: To properly migrate permissions and
subscriptions from a source to target server instance, be sure that both servers are
pointing to the same directory services.

Managing Content Storage
The Content Service page allows system administrators to manage the storage locations
available for content published to the server, which is physically stored in the locations
configured in the content service. It typically resides on a separate file server for backup
and redundancy purposes.

Configuring a New Content Service
To configure a new Content Service for the server repository

1. As system administrator: Administration Dashboard > Content > Content Service > Create
New Content Service.

2. In the Service Name field, type a name for your new content service and click Next.

3. Type a physical storage location for your content service.

Valid locations include the following types of network paths:

file:\\y:\ (where y:\is a mapped network drive to an external file server)

f:\repository (where f:\ repository is a separate hard drive on the server
machine)

Note: There are many ways to configure an external content repository for My
webMethods Server. The two examples here assume that your network
administrator has provided the proper security seings to allow the server
to access a network shared on a separate file server.

4. To make the new content service the default content service, click the Tools icon 
and then click Set As Default.

The new Content Service becomes the default location for storing new content that is
published to the server.

Importing Content from a Content Service
To import content from an existing content service

1. As system administrator: Administration Dashboard > Content > Content Service > View
Content Services.

2. Locate the content service into which you want to migrate the contents of an existing
content service, click the Tools icon  and then click Import Content.
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3. For the Target Folder property, do one of the following:

Click this... And do this...

Browse Move the target page to the Selected Items box and click Select.

Use Alias In the Alias Name, type the alias of the page to which the user
should be redirected. Click Test to determine if the alias is valid
and the alias target is the correct one. If the alias is correct, click
Select.

4. Click Import.

Setting the Maximum Size for Content
To set the maximum file size for content published to the server repository

1. As system administrator: Administration Dashboard > Content > Content Service > Set
Publish Constraints.

2. In the Max Publish Size (MB) field, type a maximum publish size (in Megabytes).

3. Click Apply.

Specifying Allowed File Extensions for Content
By default, there are no restrictions on the type of file that can be stored in the server
repository. However, it is possible to limit the file types that can be stored.

To specify the allowed file extensions for content

1. As system administrator: Administration Dashboard > Content > Content Service > Set
Publish Constraints.

2. In the Allowed File Extensions field, enter a comma-delimited list of file extensions that
are allowed.

The default value of * allows the use of any file type. As an example of allowed file
extensions, you might see the following list:

zip,doc,xsl,ppt,pdf,gif,jpg,png

3. Click Apply.

Publishing Portlets as an Administrator
The Publish page provides system administrators with expanded publishing capabilities
that are generally not exposed to most users. The Publish page allows administrators to



M
Odd Header

Managing My webMethods Server Content

Administering My webMethods Server Version 9.8 291

publish many different types of content such as files, folders, forms, links, and specific
portlet instances. You can also publish custom content types such as Dynamic Business
Objects or Custom Forms from this page.

To publish content using the Publish page

1. As system administrator: Administration > Content > Publish.

2. Select the corresponding option for the content type you wish to publish. The default
options are: File, Folder, Form (for DBOs only), Link, and Portlet.

3. For a given content type, select one of the options from the drop down menu.

Note: If you previously created any custom objects that are based on any given
content type, they will now show up as options in the drop down menu
for the respective content type. As an example, the RSS Feed option under
the Folder content type is a Dynamic Business Object. It was created to
extend the Folder object type with custom aributes and business logic for
publishing RSS syndicated news feeds to a folder object type.

4. Click Next.

5. From the Location heading, click Browse to select a parent folder location for the
content item you are publishing.

Note: You can optionally click Use Alias if you want to publish the content item to
a location that is referenced by an existing alias.

6. Click Next.

7. Enter a name for the content item you are publishing.

8. (Optional) Enter a description for the content item you are publishing.

9. Depending on the type of content you are publishing, fill in any Extended Properties
for the given content type (such as. RSS Feed URL for an RSS Feed content item).

10. Click Next.

11. Click Finish.

Rebuilding the Search Index
The Search Administration page allows system administrators to rebuild the search
index for the Lucene search engine that is offered with My webMethods Server.

Rebuilding the search index will re-index all content that was previously published
to the server and update the default search indexes again. A system administrator
might need to do this if the search index somehow becomes corrupted and search stops
working.
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Tip: If your server has a lot of content published to the content management
system, this operation can take a long time to run. You should run this
operation at off-peak hours.

To rebuild the search index

1. As system administrator: Administration > Configuration > Search Administration.

2. Click Start Rebuild.

Adding Custom JAR Files
My webMethods Server runs in an Open Services Gateway initiative (OSGi) framework.
You can add custom JAR files to the server instance, which converts those JAR files
into OSGi bundles. If a JAR file is to be a fragment of another bundle, you can provide
instructions in a bind file.

The following procedure describes how to add custom JAR files and how to aach a JAR
file as a fragment bundle. For more complete information on bundles, see the OSGi Core
Specification, available on the OSGi Alliance website.

To add custom JAR files

1. Copy the JAR file to this location:

Software AG_directory/MWS/lib

2. If the JAR file is to be a fragment of another bundle, do the following:

a. Create a file with the name jar_file_name .bnd where jar_file_name  is the name of
the custom JAR file, without the .jar extension.

b. In the bind file, add the instructions on how to bind the JAR file. For example:
# attach as fragment to the caf.server bundle 
Fragment-Host: com.webmethods.caf.server

c. Place the bind file in the same directory where you placed the JAR file:

Software AG_directory/MWS/lib

3. Run the update command for the server instance.
Software AG_directory /MWS/bin/mws.[bat | sh] update



M
Odd Header

Managing the User Interface

Administering My webMethods Server Version 9.8 293

18   Managing the User Interface

■   Locale Administration .................................................................................................................     294

■   What are Server Rules? ............................................................................................................     294

■   Creating Locale Rules ................................................................................................................    296

■   Creating Login Page Rules ........................................................................................................    297

■   Creating Start Page Rules .........................................................................................................     299

■   Creating Rendering Rules ..........................................................................................................    301

■   Modifying a Rule ........................................................................................................................     302

■   Copying a Rule ..........................................................................................................................     304

■   Managing the Evaluation Order for Rules .................................................................................     304

■   Removing a Rule .......................................................................................................................     305

■   Managing Skin Rules .................................................................................................................     305

■   Managing Shell Rules ................................................................................................................     307



M
Even Header

Managing the User Interface

Administering My webMethods Server Version 9.8 294

Locale Administration
My webMethods Server uses several decision points to determine the locale for a user, in
this order:

1. The locale preference of the user, if specified in the User Profile. See "User
Information" on page 125.

2. The Locale Rules. See "Creating Locale Rules" on page 296

3. The browser locale preference.

4. The system locale of the computer where the server is running, which is the default.

The Locale Administration page allows you to set the default locale rules for My
webMethods Server when they are not determined by other rules, as described in
"Creating Locale Rules" on page 296.

To set the default My webMethods Server locale rule

1. As system administrator: Administration > User Interface > Locale Administration.

2. From the Locale list, choose the locale to be used as the default rule for My
webMethods Server.

3. Click Apply.

What are Server Rules?
My webMethods Server uses rules to control a variety of user activities, from which page
they use to log into the server, to the appearance of the pages they see. Using rules, you
can define default behaviors for the entire application or you can dynamically control
the experience of a given user, group, or role.You can create rules of the following types:

Rule type Description

Locale rules Rules that allow you to dictate what locale should be used
for a user session if it is not defined in the user profile. See
"Creating Locale Rules" on page 296.

Login page rules Rules that determine what login page should be used. You
can, for example, redirect users to different login pages,
depending on whether they are inside or outside the firewall.
See "Creating Login Page Rules" on page 297.
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Rule type Description

Start page rules Rules that determine what start page should be used. The
start page is the page to which the server redirects users after
log in. See "Creating Start Page Rules" on page 299.

Rendering rules Rules that determine what renderer should be used.Renderers
are user interface formaing capabilities that can be assigned
to specific server objects by defining rendering rules. You can
define rendering rules for virtually any server object type.
Rendering rules are useful in providing a consistent look and
feel for common object types that can be invoked through
explicit rule definitions. See "Creating Rendering Rules" on
page 301.

Skin rules Rules that determine what skin should be used. A skin is an
installable My webMethods Server component that defines
the look and feel of the user interface. Skin rules define what
skin should be displayed for a given user, group, or server
resource. For example, if a server serves both employees and
customers, and there are requirements for a different set of
graphics, colors, and fonts for each distinct user population,
you can use skin rules to assign the corresponding skin to a
given user group. See "Creating Skin Rules" on page 306.

Shell rules Rules that determine what shell should be used. A shell is an
installable component that generates the My webMethods
Server header, footer, and portlet title bars. Shell rules
define what shell elements should be displayed for a given
user, group, or role. For example, if a server serves both
employees and customers, you can use shell rules to assign
the corresponding shell to a given user group. See "Creating
Shell Rules" on page 308.

In addition to the rule types described here, you can use rules for the creation of roles,
which are collections of users, groups, and other roles. You can create a rule-based role
that defines members based on the same types of criteria as are used for the rule types.
For information, see "Adding a Rule-Based Role" on page 161.

These aspects of rule management are described as follows:

This aspect... Is described here...

Modifying rules "Modifying a Rule" on page 302

Copying rules "Copying a Rule" on page 304
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This aspect... Is described here...

Changing the evaluation order of rules "Changing the Order or Rule
Evaluation" on page 304

Removing rules "Removing a Rule" on page 305

Creating Locale Rules
The Manage Locale Page Rules page allows you to define rules that dictate what locale
should be used for a user session if it is not defined in the user profile.

To create a new locale rule

1. As system administrator: Administration > User Interface > Manage Locale Rules > Create
New Rule.

2. In the Name field, type a name for the rule.

3. (Optional) On the Description field, type a description for the new rule.

4. Unless you want to disable the rule during creation, leave Is Enabled selected.

5. To add a condition for individual users, click Current User(s) and do the following:

a. In the Keywords field, type a keyword representing the users you want to search
for, and click Search.

b. Move one or more users to the Selected box and click Apply.

6. To add a condition based on group or role membership, click Group / Role Membership
and do the following:

a. Under Search For, choose the Groups or Roles option.

b. In the Keywords field, type a keyword representing the groups or roles you want
to search for, and click Search.

c. Move one or more groups or roles to the Selected box and click Apply.

7. To add a condition based on user aributes, click User Attributes, on the Pick User
Attribute list, choose a user aribute, and click Apply.

For more information about the user aributes in the list, see "User Information" on
page 125.

8. To add a condition based on the request header, click Request and do the following:

a. Choose the expression, and click Submit.

b. In the Condition field, complete the expression.
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For example, assume that you want to match any HTTP GET request. The wizard
moves #{request.method} into the Condition field and you type the remainder:
#{request.method} == "GET"

9. To add a condition that matches the current resource or a parent of the current
resource, click Parent Resource and then do the following:

a. To find children of a resource, click the name of the resource.

b. To select a resource, click the option buon to the left of the resource.

c. Click Apply.

10. To add a condition that matches the current resource type, click Current Resource
Type, choose the resource type and do the following:.

a. To find children of a resource, click the name of the resource.

b. To select a resource, click the option buon to the left of the resource.

c. Click Apply.

11. To add a condition for a resource property and a value associated with it, click
Resource Properties, and do the following:

a. In the Property Name field, type the property name.

b. In the Property Value field, type the property value.

c. Click Apply.

For example, if you want to match files that are PDFs, the property name is
mimeType and the property value is pdf.

12. From the Result list, choose the locale to be used for the rule.

13. Click Create Rule.

Creating Login Page Rules
The Manage Login Page Rules page allows you to define rules that dictate what login
page should be used. Login page rules can be defined to dynamically set the default
login page for a given for a given user, group, or role.

To create a new login page rule

1. As system administrator: Administration > User Interface > Manage Login Page Rules >
Create New Rule.

2. In the Name field, type a name for the rule.

3. (Optional) On the Description field, type a description for the new rule.

4. Unless you want to disable the rule during creation, leave Is Enabled selected.
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5. To add a condition for individual users, click Current User(s) and do the following:

a. In the Keywords field, type a keyword representing the users you want to search
for, and click Search.

b. Move one or more users to the Selected box and click Apply.

6. To add a condition based on group or role membership, click Group / Role Membership
and do the following:

a. Under Search For, choose the Groups or Roles option.

b. In the Keywords field, type a keyword representing the groups or roles you want
to search for, and click Search.

c. Move one or more groups or roles to the Selected box and click Apply.

7. To add a condition based on user aributes, click User Attributes, on the Pick User
Attribute list, choose a user aribute, and click Apply.

For more information about the user aributes in the list, see "User Information" on
page 125.

8. To add a condition based on the request header, click Request and do the following:

a. Choose the expression, and click Submit.

b. In the Condition field, complete the expression.

For example, assume that you want to match any HTTP GET request. The wizard
moves #{request.method} into the Condition field and you type the remainder:
#{request.method} == "GET"

9. To add a condition that matches the current resource or a parent of the current
resource, click Parent Resource and then do the following:

a. To find children of a resource, click the name of the resource.

b. To select a resource, click the option buon to the left of the resource.

c. Click Apply.

10. To add a condition that matches the current resource type, click Current Resource
Type, choose the resource type and do the following:.

a. To find children of a resource, click the name of the resource.

b. To select a resource, click the option buon to the left of the resource.

c. Click Apply.

11. To add a condition for a resource property and a value associated with it, click
Resource Properties, and do the following:

a. In the Property Name field, type the property name.

b. In the Property Value field, type the property value.
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c. Click Apply.

For example, if you want to match files that are PDFs, the property name is
mimeType and the property value is pdf.

12. On the Result field, type an alias for the login page, or to browse to the page, click
Pick and do the following:

a. To find children of a resource, click the name of the resource.

b. To select a resource, click the option buon to the left of the resource.

c. Click Apply.

13. Click Create Rule.

Creating Start Page Rules
The Manage Start Page Rules page allows system administrators to define rules that
dictate what start page should be used. The start page is the page to which the server
redirects users after log in. Start page rules can be defined to dynamically set the default
start page for a given for a given user, group, or role.

To create a new start page rule

1. As system administrator: Administration > User Interface > Manage Start Page Rules >
Create New Rule.

2. On the Name field, type a name for the rule.

3. (Optional) On the Description field, type a description for the new rule.

4. Unless you want to disable the rule during creation, leave Is Enabled selected.

5. To add a condition for individual users, click Current User(s) and do the following:

a. In the Keywords field, type a keyword representing the users you want to search
for, and click Search.

b. Move one or more users to the Selected box and click Apply.

6. To add a condition based on group or role membership, click Group / Role Membership
and do the following:

a. Under Search For, choose the Groups or Roles option.

b. In the Keywords field, type a keyword representing the groups or roles you want
to search for, and click Search.

c. Move one or more groups or roles to the Selected box and click Apply.

7. To add a condition based on user aributes, click User Attributes, on the Pick User
Attribute list, choose a user aribute, and click Apply.
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For more information about the user aributes in the list, see "User Information" on
page 125.

8. To add a condition based on the request header, click Request and do the following:

a. Choose the expression, and click Submit.

b. In the Condition field, complete the expression.

For example, assume that you want to match any HTTP GET request. The wizard
moves #{request.method} into the Condition field and you type the remainder:
#{request.method} == "GET"

9. To add a condition that matches the current resource or a parent of the current
resource, click Parent Resource and then do the following:

a. To find children of a resource, click the name of the resource.

b. To select a resource, click the option buon to the left of the resource.

c. Click Apply.

10. To add a condition that matches the current resource type, click Current Resource
Type, choose the resource type and do the following:.

a. To find children of a resource, click the name of the resource.

b. To select a resource, click the option buon to the left of the resource.

c. Click Apply.

11. To add a condition for a resource property and a value associated with it, click
Resource Properties, and do the following:

a. In the Property Name field, type the property name.

b. In the Property Value field, type the property value.

c. Click Apply.

For example, if you want to match files that are PDFs, the property name is
mimeType and the property value is pdf.

12. On the Result field, type an alias for the start page, or to browse to the page, click Pick
and do the following:

a. To find children of a resource, click the name of the resource.

b. To select a resource, click the option buon to the left of the resource.

c. Click Apply.

13. Click Create Rule.
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Creating Rendering Rules
The Manage Rendering Rules page allows system administrators to configure rendering
rules for specific server objects, such as a folder, page, portlet, and so forth. For example,
an administrator who wants all folders to display a detailed view of content can create a
rendering rule that applies a “details renderer to all folder objects. For each of the types
of conditions you can apply in the following procedure, you can add multiple instances,
one at a time.

To create a new Rendering rule

1. As system administrator: Administration > User Interface > Manage Rendering Rules >
Create New Rule.

2. On the Name field, type a name for the rule.

Example: folder-thumbnails view (for image files).

3. (Optional) On the Description field, type a description for the new rule.

4. Unless you want to disable the rule during creation, leave Is Enabled selected.

5. To add a condition for individual users, click Current User(s) and do the following:

a. In the Keywords field, type a keyword representing the users you want to search
for, and click Search.

b. Move one or more users to the Selected box and click Apply.

6. To add a condition based on group or role membership, click Group / Role Membership
and do the following:

a. Under Search For, choose the Groups or Roles option.

b. In the Keywords field, type a keyword representing the groups or roles you want
to search for, and click Search.

c. Move one or more groups or roles to the Selected box and click Apply.

7. To add a condition based on user aributes, click User Attributes, on the Pick User
Attribute list, choose a user aribute, and click Apply.

For more information about the user aributes in the list, see "User Information" on
page 125.

8. To add a condition based on the request header, click Request and do the following:

a. Choose the expression, and click Submit.

b. In the Condition field, complete the expression.

For example, assume that you want to match any HTTP GET request. The wizard
moves #{request.method} into the Condition field and you type the remainder:
#{request.method} == "GET"
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9. To add a condition that matches the current resource or a parent of the current
resource, click Parent Resource and then do the following:

a. To find children of a resource, click the name of the resource.

b. To select a resource, click the option buon to the left of the resource.

c. Click Apply.

10. To add a condition that matches the current resource type, click Current Resource
Type, choose the resource type and then do the following:.

a. To find children of a resource, click the name of the resource.

b. To select a resource, click the option buon to the left of the resource.

c. Click Apply.

11. To add a condition for a resource property and a value associated with it, click
Resource Properties, and do the following:

a. In the Property Name field, type the property name.

b. In the Property Value field, type the property value.

c. Click Apply.

For example, if you want to match files that are PDFs, the property name is
mimeType and the property value is pdf.

12. On the Result list, choose the target renderer.

The renderer you select will be applied to all server objects that meet the evaluation
criteria you define in the following steps. For example, the thumbnails renderer is
useful for displaying thumbnail views for images that are published to the server.

13. Click Create Rule.

Modifying a Rule
After a rule exists, you can modify any portion of it that is editable.

To modify a rule

1. As system administrator: Administration > User Interface > Manage rule-type  Rules > View
Rules.

where rule-type contains the rule you want to modify.

2. For the rule you want to modify, click the Tools icon  and then click Modify Rule.

3. Do any of the following:

In the Name field, type a new name for the rule.

(Optional) On the Description field, type a new description for the rule.
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To disable the rule, clear Is Enabled.

To modify a condition for individual users, click Current User(s) and do the
following:

i. In the Keywords field, type a keyword representing the users you want to
search for, and click Search.

ii. Move one or more users to the Selected box and click Apply.

To modify a condition based on group or role membership, click Group / Role
Membership and do the following:

i. Under Search For, choose the Groups or Roles option.

ii. In the Keywords field, type a keyword representing the groups or roles you
want to search for, and click Search.

iii. Move one or more groups or roles to the Selected box and click Apply.

To modify a condition based on user aributes, click User Attributes, on the Pick
User Attribute list, choose a user aribute, and click Apply.

For more information about the user aributes in the list, see "User Information"
on page 125.

To modify a condition based on the request header, click Request and do the
following:

i. Choose the expression, and click Submit.

ii. In the Condition field, complete the expression.

For example, assume that you want to match any HTTP GET request. The wizard
moves #{request.method} into the Condition field and you type the remainder:
#{request.method} == "GET"

To modify a condition that matches the current resource or a parent of the
current resource, click Parent Resource and then do the following:

i. To find children of a resource, click the name of the resource.

ii. To select a resource, click the option buon to the left of the resource.

iii. Click Apply.

To modify a condition that matches the current resource type, click Current
Resource Type, choose the resource type and do the following:.

i. To find children of a resource, click the name of the resource.

ii. To select a resource, click the option buon to the left of the resource.

iii. Click Apply.

To modify a condition for a resource property and a value associated with it,
click Resource Properties, and do the following:
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i. In the Property Name field, type the property name.

ii. In the Property Value field, type the property value.

iii. Click Apply.

Modify the Result as needed field as needed.

4. Click Update Rule.

Copying a Rule
If you want to create a rule that is similar to an existing one, you can do so by copying
the existing rule.

To copy a rule

1. As system administrator: Administration > User Interface > Manage rule-type  Rules > View
Rules.

where rule-type contains the rule you want to copy.

2. For the rule you want to copy, click the Tools icon  and then click Copy Rule.

3. Type a name for the new rule.

4. (Optional) Type a description for the new rule.

5. Click Copy The Rule.

You can then modify the new rule, as described in "Modifying a Rule" on page
302.

Managing the Evaluation Order for Rules
When a user requests a server resource, the server uses rules to determine how to fill the
request. For example, perhaps the look and feel of the page is dependent on whether
the user is a company employee or a customer. The server evaluates the skin rules to
determine which skin to apply, in this order:

1. If there are multiple skin rules, the skin associated with the first rule that matches the
user applies.

2. If none of the rules match the user, or if there are no skin rules, the default skin
assigned in the User Preferences tab of the user’s Profile page applies.

3. If no skin is assigned on the Profile page, the default skin for the server applies.

Changing the Order or Rule Evaluation
If there are multiple skin rules, you can determine the order in which they are evaluated.
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To change the order in rules are evaluated

1. As system administrator: Administration > User Interface.

2. Click the name of the set of rules you want to manage.

3. Click Change Rule Evaluation Order.

4. To reorder rules, move them up or down as needed.

The first rule in the list is searched first, followed by the second, and so on.

5. Click Update.

Removing a Rule
To remove a rule, use the following procedure.

To remove a rule

1. As system administrator: Administration > User Interface > Manage rule-type  Rules > View
Rules.

where rule-type contains the rule you want to remove.

2. For the rule you want to remove, click the Tools icon  and then click Remove Rule.

Managing Skin Rules
A skin is an installable My webMethods Server component that defines the look and feel
of the My webMethods Server user interface. A skin modifies the images, fonts, colors,
and other subtle stylable aspects of HTML content, but it does not modify the HTML
content in any functional way.

A developer creates new custom skins to accomplish many different functions. Some of
these include:

Branding the server with corporate, partner, or departmental logos.

Aligning the color scheme with corporate, partner, or departmental colors.

Developers create skins with the Skin Administration page and customize them as
needed. See "Customizing Skins" on page 375.

My webMethods Server offers a variety of ways to configure personalization rules that
dictate what skin is displayed for a given user, group, or resource. You can explicitly
assign a particular skin to a specific user or set up rules that dynamically assign a skin
based on a variety of criteria.

The Manage Skin Rules page allows you to define rules that dictate what skins
can be used by users, groups, or roles. This page allows a system administrator to
create, modify, or remove rules, and change the evaluation order of a list of rules that
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are evaluated for each user every time the user logs in. The following list provides
information about managing rules:

This information about managing rules... Is described here...

Changing the evaluation order of rules "Changing the Order or Rule
Evaluation" on page 304

Creating rules "Creating Skin Rules" on page 306

Modifying rules "Modifying a Rule" on page 302

Copying rules "Copying a Rule" on page 304

Removing rules "Removing a Rule" on page 305

Creating Skin Rules
To create a new skin rule, use the following procedure.

To create a new skin rule

1. As system administrator: Administration > User Interface > Manage Skin Rules > Create New
Rule.

2. On the Name field, type a name for the rule.

3. (Optional) On the Description field, type a description for the new rule.

4. Unless you want to disable the rule during creation, leave Is Enabled selected.

5. To add a condition for individual users, click Current User(s) and do the following:

a. In the Keywords field, type a keyword representing the users you want to search
for, and click Search.

b. Move one or more users to the Selected box and click Apply.

6. To add a condition based on group or role membership, click Group / Role Membership
and do the following:

a. Under Search For, choose the Groups or Roles option.

b. In the Keywords field, type a keyword representing the groups or roles you want
to search for, and click Search.

c. Move one or more groups or roles to the Selected box and click Apply.

7. To add a condition based on user aributes, click User Attributes, on the Pick User
Attribute list, choose a user aribute, and click Apply.
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For more information about the user aributes in the list, see "User Information" on
page 125.

8. To add a condition based on the request header, click Request and do the following:

a. Choose the expression, and click Submit.

b. In the Condition field, complete the expression.

For example, assume that you want to match any HTTP GET request. The wizard
moves #{request.method} into the Condition field and you type the remainder:
#{request.method} == "GET"

9. To add a condition that matches the current resource or a parent of the current
resource, click Parent Resource and then do the following:

a. To find children of a resource, click the name of the resource.

b. To select a resource, click the option buon to the left of the resource.

c. Click Apply.

10. To add a condition that matches the current resource type, click Current Resource
Type, choose the resource type and then do the following:.

a. To find children of a resource, click the name of the resource.

b. To select a resource, click the option buon to the left of the resource.

c. Click Apply.

11. To add a condition for a resource property and a value associated with it, click
Resource Properties, and do the following:

a. In the Property Name field, type the property name.

b. In the Property Value field, type the property value.

c. Click Apply.

For example, if you want to match files that are PDFs, the property name is
mimeType and the property value is pdf.

12. On the Result list, choose the target skin.

13. Click Create Rule.

Managing Shell Rules
A shell is an installable component of My webMethods Server. A shell is segment is
a special kind of page that generates the My webMethods Server header, footer, and
portlet title bars.
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Where regular portlets produce the primary content of a page, a shell provides the
structure that frames that primary content. Common web page idioms such as banners,
standard links, and search boxes appear in a shell.

A developer creates new custom shells to accomplish many different functions, such as:

Adding a row of links to other corporate websites below the page banner

Changing the default search box to one that searches the corporate catalogue

Adding a left-hand navigation bar to every page.

You can set up many different criteria to determine which shell is used for a
particular user request. My webMethods Server offers a variety of ways to configure
personalization rules that dictate what shell is displayed for a given user, group, or
resource.

Note: Unlike skins, you cannot explicitly assign a particular shell to a specific user.
You need to use rules that dynamically assign a shell based on a variety of
criteria.

The Manage Shell Rules page allows you to define rules that dictate what shells
can be used by users, groups, or roles. This page allows a system administrator to
create, modify, or remove rules, and change the evaluation order of a list of rules that
are evaluated for each user every time the user logs in. The following list provides
information about managing rules:

This information about managing rules... Is described here...

Changing the evaluation order of rules "Changing the Order or Rule
Evaluation" on page 304

Creating rules "Creating Skin Rules" on page 306

Modifying rules "Modifying a Rule" on page 302

Copying rules "Copying a Rule" on page 304

Removing rules "Removing a Rule" on page 305

Creating Shell Rules
To create a new shell rule, use the following procedure.

To create a new shell rule

1. As system administrator: Administration > User Interface > Manage Shell Rules > Create
New Rule.
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2. On the Name field, type a name for the rule.

Example: folder-thumbnails view (for image files).

3. (Optional) On the Description field, type a description for the new rule.

4. Unless you want to disable the rule during creation, leave Is Enabled selected.

5. To add a condition for individual users, click Current User(s) and do the following:

a. In the Keywords field, type a keyword representing the users you want to search
for, and click Search.

b. Move one or more users to the Selected box and click Apply.

6. To add a condition based on group or role membership, click Group / Role Membership
and do the following:

a. Under Search For, choose the Groups or Roles option.

b. In the Keywords field, type a keyword representing the groups or roles you want
to search for, and click Search.

c. Move one or more groups or roles to the Selected box and click Apply.

7. To add a condition based on user aributes, click User Attributes, on the Pick User
Attribute list, choose a user aribute, and click Apply.

For more information about the user aributes in the list, see "User Information" on
page 125.

8. To add a condition based on the request header, click Request and do the following:

a. Choose the expression, and click Submit.

b. In the Condition field, complete the expression.

For example, assume that you want to match any HTTP GET request. The wizard
moves #{request.method} into the Condition field and you type the remainder:
#{request.method} == "GET"

9. To add a condition that matches the current resource or a parent of the current
resource, click Parent Resource and then do the following:

a. To find children of a resource, click the name of the resource.

b. To select a resource, click the option buon to the left of the resource.

c. Click Apply.

10. To add a condition that matches the current resource type, click Current Resource
Type, choose the resource type and then do the following:.

a. To find children of a resource, click the name of the resource.

b. To select a resource, click the option buon to the left of the resource.

c. Click Apply.
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11. To add a condition for a resource property and a value associated with it, click
Resource Properties, and do the following:

a. In the Property Name field, type the property name.

b. In the Property Value field, type the property value.

c. Click Apply.

For example, if you want to match files that are PDFs, the property name is
mimeType and the property value is pdf.

12. On the Result list, choose the target shell.

The renderer you select will be applied to all server objects that meet the evaluation
criteria you define in the following steps. For example, the thumbnails renderer is
useful for displaying thumbnail views for images that are published to the server.

13. Click Create Rule.

Setting Shells for Requests
To set a specific shell for a request, a developer creates a link to a server resource and
adds a shell parameter to the link. The shell parameter value should be an alias to the
target shell.

For example, the URL for a link to the public folder with the extranet shell is /
folder.public?shell=shell.extranet. When users follow the link, they view the public
folder framed with the specified extranet shell. When users click another link from the
public folder page, they return to whatever shell they were using before, provided the
link does not also have a shell parameter.

Setting Shells for Sessions
T o set a specific shell for a session, sometimes referred to as a sticky shell because
the seing is retained for the duration of the session, a developer creates a link to the
forceShell command. This command takes a returnUrl parameter, which redirects a user
to the specified URL once the shell has been set.

For example, the URL for a link to the public folder with a sticky extranet shell is /?
command=forceShell&shellURI=shell.extranet&returnUrl=folder.public. When users
follow the link, they view the public folder now framed with the extranet shell. When
users click another link from the public folder page, provided the link does not have a
shell parameter, they see that page still framed with the extranet shell.
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Managing User Information with the Common Directory
Service API
My webMethods Server provides several directory service options for managing users
and groups:

My webMethods system directory. This is an internal My webMethods Server user
directory, available by default in all installations of My webMethods Server. You can
access information in this directory server using the My webMethods user interface
and the Common Directory Services (CDS) API. Both read and write access are
available.

LDAP (Lightweight Directory Access Protocol). My webMethods enables you
to define one or more external LDAP user directories. For a list of supported
directory server products, see the PDF publication webMethods and Intelligent Business
Operations System Requirements. You can access information in this directory server
using the My webMethods user interface and the CDS API. Only read access is
available.

Database. My webMethods Server also enables you to authenticate users against
a database directory, which is a set of RDBMS tables and an SQL configuration to
access these tables. You can implement a custom authentication module to extend
authentication against a database directory. You can access information in this
directory server using the My webMethods user interface and the CDS API. Only
read access is available.

My webMethods Server and applications and services running within it can access
the user information contained in these directories, and you can configure external
applications and services that have access to My webMethods Server to use this data.

In addition to working with users and groups in a directory service, you can access
and maintain role information, which is maintained separately in the My webMethods
Server database.

For example, you can:

Configure other suite applications, such as webMethods Integration Server, to
authenticate users from any of the above user directory options instead of from a
user directory unique to Integration Server.

Configure a process step in a business process to call a Java service to obtain user
aributes from the directory service or role membership from the My webMethods
Server database, and pass that data into the process pipeline.

Configure a Java service to assign a user to a role programmatically.

The CDS API offers support for the following:

Search and discovery of users, groups, and roles.

Support for LDAP search controls for large directories.
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Create and update users and groups in the system directory. All other external
directories are read-only.

Delete users and groups from the system directory.

Create, update, and delete roles in My webMethods Server.

Read custom aributes from LDAP and database directories.

Read and write custom profile aributes for users, groups, and roles (that is,
aributes which are not managed by external directories).

To view the Javadoc for the Common Directory Services API, refer to these packages:

com.webmethods.sc.directory

com.webmethods.sc.mws

Javadocs can be installed with other My webMethods Server documentation using
the Software AG Installer, and they are also available from the website hp://
documentation.softwareag.com/.

About the Common Directory Services API
When connected to a My webMethods Server database schema, CDS behaves very much
like a My webMethods Server cluster instance, and it participates in all the distributed
caching across a My webMethods Server cluster. When a system directory user is
updated, this change will be seen by all CDS instances connected to the same database
within a few minutes.

Directory services are defined and managed in My webMethods Server, by logging in to
My webMethods as either SysAdmin or as Administrator. For more information about
working with directory services, see "Managing Directory Services" on page 84 and
"Managing External Directory Services" on page 87.

In addition to working with the CDS API, you can use the My webMethods interface to
perform all directory management activities:

User, group, and role management. For more information, see " My webMethods
Administrator Functions" on page 81.

Authentication management. For more information, see "System Administrator
Functions" on page 205.

Implementation of aribute providers. For more information, see "System
Administrator Functions" on page 205.

Prerequisites
Before you can work with the CDS API, you must take the following actions:

http://documentation.softwareag.com/
http://documentation.softwareag.com/
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The My webMethods Server database tables must be created by the webMethods
Database Component Configurator. This is normally carried out immediately after
installation.

The My webMethods Server instance must be created and started.

CDS must be initialized with a JDBC connection to the My webMethods Server
database schema. For more information, see "Initializing Common Directory
Services" on page 314.

Class Path Considerations
If you want to use CDS in a stand-alone application, in addition to providing the correct
JDBC connection information, all CDS .jar files must be present in the class path of the
external application running CDS. To ensure that these .jar files are available, include
all .jar files from Software AG_directory/common/lib and /common/lib/ext (assuming you
have a standard installation of My webMethods Server and Integration Server).

Initializing Common Directory Services
When the CDS API is accessed from inside My webMethods Server (from a CAF
application for example), CDS is already initialized and no further action is needed. If
you want to use the CDS API from an external application or service that has access to
My webMethods Server, the CDS API must be explicitly initialized from the external
application or service.

You initialize Common Directory Services by invoking the
com.webmethods.sc.mws.MWSLibrary.init() static method. The input parameters are
expected as Java system properties and must describe a JDBC connection URL to a
My webMethods Server database schema. Instead of using remote call backs to My
webMethods Server, the CDS API connects to this schema and reads all configuration
and principal information.

Here is sample code showing how to initialize CDS using the MWSLibrary class:
System.setProperty(MWSLibrary.SYSTEM_PROP_DB_DRIVER, 
"com.wm.dd.jdbc.sqlserver.SQLServerDriver"); // JDBC Driver Class
System.setProperty(MWSLibrary.SYSTEM_PROP_DB_URL, 
"jdbc:wm:sqlserver://localhost:1433;DatabaseName=webm82_dev"); 
    // JDBC Connection URL
System.setProperty(MWSLibrary.SYSTEM_PROP_DB_USER, "webm82_dev"); 
    // DB username
System.setProperty(MWSLibrary.SYSTEM_PROP_DB_PASSWORD, "password"); 
    // DB 
password
MWSLibrary.init();

CDS Code Examples
The following are a few examples of common CDS code:



M
Odd Header

Working with the Common Directory Services API

Administering My webMethods Server Version 9.8 315

List All Roles
IDirectorySession session = 
DirectorySystemFactory.getDirectorySystem().createSession();
List roles = session.listRoles();
for (IDirectoryRole role: roles) {
    String roleID = role.getID();
    String roleName = role.getName();
    String roleDN = role.getDN();
}

Lookup a User by Name and Fetch all Attribute
IDirectorySession session = 
DirectorySystemFactory.getDirectorySystem().createSession();
IDirectoryUser user = (IDirectoryUser) session.lookupPrincipalByName 
   ("user1", IDirectoryPrincipal.TYPE_USER);
Map attributes = user.getAllAttributes();

Authenticate User
IDirectorySession session = 
DirectorySystemFactory.getDirectorySystem().createSession();
IDirectoryUser user = session.authenticateUser("username", "password");

Create Static Role and Add User as a Member
IDirectorySession session = 
DirectorySystemFactory.getDirectorySystem().createSession();
IDirectoryUser user = (IDirectoryUser) session.lookupPrincipalByName 
    ("user1", IDirectoryPrincipal.TYPE_USER);
IDirectoryRole role = session.createRole(IDirectoryRole.STATIC_ROLE_TYPE, 
    "roleName", Collections.EMPTY_MAP);
session.addPrincipalToRole(user.getID(), role.getID());
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Page Development Overview
My webMethods Server provides features that allow you to easily create custom pages
and have My webMethods Server serve the custom pages as webpages. For more
information, see "About Custom Folders and Pages" on page 320.

My webMethods Server also provides a flexible architecture that allows you to
customize the My webMethods user interface, as described in the table below.

You can... For more information, see...

Update the My webMethods navigation panel
by:

Adding selections to the navigation panel

Removing selections from the navigation panel

Hiding standard tabs and sections in the
navigation panel

Completely replacing the navigation panel

"About Customizing the My
webMethods Navigation" on
page 338

Update the My webMethods look-and-feel by:

Replacing the logo image

Changing the color scheme

Using the 7.x color scheme

Applying a custom look-and-feel

"About Customizing the My
webMethods Look-And-Feel"
on page 342

Build an alternate way to access My
webMethods application pages; that is, building
a simple front-end page that provides links to
only a few My webMethods pages that users
require

"Building a Simple Front-End
Page to My webMethods " on
page 348

Additionally, you can use the techniques listed above (e.g., building custom pages,
techniques for updating skins and shells) to build complete, custom applications that
run in My webMethods Server.

About Custom Folders and Pages
You can create custom folders and pages that My webMethods Server serves as
webpages. To My webMethods Server both are functionally equivalent; that is, My
webMethods Server displays the contents of both as portlets on a webpage. You decide
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whether to use a folder or page based on how you intend to use it. Use a folder if you
want a container that holds other folders and pages. Use a page if you want to display
information.

Create custom pages when you need a page that you would consider permanent,
that is to be used for a long period of time. If you need a page that is not intended
to be permanent and that you can use as a work area, it is more appropriate to use a
workspace. For information, see "Managing Workspaces in My webMethods Server " on
page 353.

To add content to a page, you drag and drop portlets on to the page. You can position
the portlets where you want, size them, and set their properties. You can make the page
dynamic by using wiring:

You can wire the property of one portlet to the property of another. By doing so,
when the property in the source portlet is set, the change is automatically reflected in
the destination portlet.

You can wire information about the user accessing the custom page to portlet
properties. For example, if you have a portlet that displays the weather, you can
wire the postal code aribute from a user profile to the postal code property of the
weather portlet. As a result, when the user displays the page, My webMethods
Server automatically uses the postal code from the user’s profile to set the postal
code property of the weather portlet and the user’s local weather displays.

Creating Custom Pages
Create portal pages by logging into My webMethods using the SysAdmin user account
or another user account that is a member of the Admin role. To build a page, you must
switch to page editing mode. In page editing mode, the system administrator user
interface changes to display a Tools tab on the left and the custom page on the right. The
Tools tab lists portlets that you can add to the custom page.

To create a custom page

1. As system administrator, navigate to the folder where the new page is to reside. If
the folder you want to use does not exist, create it.

If you want to add the page to the My webMethods Applications navigation,
navigate to a location within:

Folders > My webMethods Applications > Fabric Tasks

If you want to add the page to a different taxonomy, it is recommended that you
use a location within either of the following:

Folders (root folder)

Folders > Public Folders

2. In the folder title bar, click Tools > New > Page.

3. In the New Page window, do the following:
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a. In the Name field, type the name of the new page.

b. In the Description field, optionally type a description of the new page.

c. Click Create.

4. Open the new page you just created by clicking the link for the page.

5. In the page title bar, click Tools > Edit Page to switch to page editing mode.

6. Set the page properties. For instructions, see "Page Properties" on page 324 and
"Seing Page Properties" on page 324.

7. Define the page layout. For instructions, see "Controlling the Page Layout" on page
326.

8. Build the page by performing the tasks listed in the table below.

Task For more information, see...

Add portlets by dragging portlets
from the Tools tab on to the page
canvas.

"Adding Portlets to a Page" on page
329

Position the portlets on the page. "Positioning Portlets on a Page" on
page 330

Set the portlet properties. "Modifying Portlet Properties" on
page 334

Optionally, set up portlet aliases. "Managing Portlet Aliases" on page
335

Optionally, wire the portlets. "Wiring the Property of One Portlet
to the Property of Another" on page
336 and "Wiring a Principal
Aribute to a Portlet Property" on
page 337

9. In the page title bar, click Save.

To make your new page available, you can:

Provide the page URL so that users can access it directly. Make the URL simpler
by assigning the page an alias. For example, if you assign the page the alias
“MyCustomPage”, users can enter the following URL where MWSHost  is the My
webMethods Server host name and MWSPort  is its port number.

hp://www.MWSHost:MWSport /MyCustomPage
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For more information about how to assign aliases, see "Seing Page Properties" on
page 324.

Add the page to the My webMethods navigation so that users can select it from
there. For more information, see "Adding Selections to the My webMethods
Navigation" on page 338.

Editing an Existing Page
After you initially create a page, you can open the page in page editing mode at any time
to make additional changes to it.

To edit an existing page

1. As system administrator, navigate to and open the page you want to edit.

2. In the page title bar, click Tools > Edit Page to switch to page editing mode.

3. Make your edits. You can:

Task For more information, see...

Update the page properties, for
example, to change the name of the
page.

"Page Properties" on page 324 and
"Seing Page Properties" on page
324

Change the page layout. "Controlling the Page Layout" on page
326

Add more portlets to the page. "Adding Portlets to a Page" on page
329

Remove portlets from the page "Removing Portlets from a Page" on
page 330

Reposition the portlets on the page "Positioning Portlets on a Page" on
page 330

Update portlet properties. "Modifying Portlet Properties" on
page 334

Set up portlet aliases. "Managing Portlet Aliases" on page
335

Wire the portlets. "Wiring the Property of One Portlet
to the Property of Another" on page
336 and "Wiring a Principal
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Task For more information, see...
Aribute to a Portlet Property" on
page 337

4. In the page title bar, click Save.

Page Properties
The following lists the general properties for a page; that is, the properties listed on the
General tab for a page. For instructions for how to set the properties, see "Seing Page
Properties" on page 324. For information about the Layout tab, see "Controlling the
Page Layout" on page 326.

Property Description

Name The name of the page.

Description An optional description of the page.

Keywords Optional keywords that you assign to a page for your own
use. Out-of-the-box, My webMethods Server does not provide
functionality that uses the keywords. However, you can write
custom code that takes advantage of the keywords. For example,
you might create custom search code that allows you to search
based on the keywords.

Owner The owner of the page. Click the link to view the owner’s profile.

Created On The date and time when the page was created.

Modified On The date and time the page was last updated.

Aliases Aliases assigned to the page.

Setting Page Properties
Use the following procedure to set properties for a page. For a description of the
properties, see "Page Properties" on page 324.

To set page properties

1. As system administrator, navigate to and open the page for which you want to set
properties.

2. In the page title bar, click Tools > Edit Page to switch to page editing mode.
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3. Click Properties.

4. Ensure the General tab is selected.

5. Edit the properties:

To... Use this property Action

Change the name of the page Name Type a new name in the Name
field.

Change or add a description of
the page

Description Type a description in the
Description.

Assign keywords to the page Keywords In the Keywords field, type one
or more keywords separated by
commas.

Assign aliases to the page Aliases To add an alias:

  a. Click Add.

b. In the text box, type the alias
name you want to add.

c. Click OK.

  To update an alias:

  a. Select the alias you want to
change.

b. Click Edit.

c. In the text box, type the
updated alias name.

d. Click OK.

  To remove an alias:

  a. Select the alias you want to
remove.

b. Click Remove.

6. Click OK.

7. In the page title bar, click Save.
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Controlling the Page Layout
To define how the portlets within a page can be positioned, define the page layout.
There are two types of layouts:

Column layout. In this layout, all the portlets in a page are aligned in columns. Portlets
cannot overlap within a column. You can define a page to have one, two, three, or
four columns. The default for a new page is a two column layout.

Each column has a single row. You can add additional rows to a column by dragging
the Row tool into the column. For more information about using rows, see "Adding
Rows When Using a Column Layout" on page 328 and "Removing Rows When
Using a Column Layout" on page 329.

Free Form layout. In this layout, you can place portlets on the page in any location.
Portlets can overlap and even completely cover one another.

For instructions for adding portlets to a page, see "Adding Portlets to a Page" on page
329. For instructions for how to position portlets within a page, see "Positioning
Portlets on a Page" on page 330.

To define the layout of a page

1. As system administrator, navigate to and open the page for which you want to
define the layout.

2. In the page title bar, click Tools > Edit Page to switch to page editing mode.

3. Click Properties.

4. Select the Layout tab.

5. Use the View As list to indicate whether you want to view column, row, and portlet
borders and hidden portlet title bars.

Select End User if you do not want to view borders or hidden title bars.

Select Expert User if you want to view borders and hidden title bars.

Borders are helpful when you are positioning portlets. Also, if you set a portlet’s
properties so that the title bar is hidden, you must view the page as an expert
user to re-display the title bar so that you can take action on that portlet, for
example, to move it or access its properties.

Note: The seing to view as an expert is temporary. If you leave the edited
page, when you return, the view will be as an end user again.

Note: The View As Expert check box at the top of the page serves the same purpose
as the View As property. If you select Expert User in the View As property,
My webMethods Server automatically selects the View As Expert check
box when you save the properties. Similarly, if you select End User in the
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View As property, My webMethods Server automatically clears the View As
Expert check box when you save the properties.

6. Set the Editable Canvas property based on whether you want users to be able to
reposition and/or resize portlets on the page.

Select the Editable Canvas check box if you want users to be able to reposition and
resize portlets on the page.

Clear the Editable Canvas check box if you do not want users to be able to
reposition and resize portlets on the page.

Clearing the Editable Canvas check box prevents end users from inadvertently
changing the layout while using the page. If you select a free form layout for the
page, a user can inadvertently change the page simply by clicking a portlet.

Note: When the Editable Canvas check box is selected, users can change the
layout. This is true even when users are denied edit permissions, although
they are prevented from saving those edits. However, when the Editable
Canvas check box is cleared, all users are prevented from changing the
layout.

7. From the Columns list, select layout that you want to use for the page.

8. If you select One Column, Two Columns, Three Columns, or Four Columns, you can set
additional properties for each column in the layout.

a. In the Attributes field, optionally specify aributes for the column for your own
use. Out-of-the-box, My webMethods Server does not provide functionality that
uses the aributes. However, you can write custom code that takes advantage of
the aributes.

b. In the Width field type the percentage of the page to use for the column. By
default the percentages are set for evenly spaced columns.

c. Select the Word Wrap check box if you want the server to aempt to wrap long text
lines within portlets to fit the column size. Clear the check box if you do not want
long lines to wrap.

Allowing long lines to wrap helps to beer fit portlets within columns.

d. From the Horizontal Alignment list select how the portlets should be aligned
horizontally in the column. By default, the server left aligns the portlets in each
column.

e. From the Vertical Alignment list select how the portlets should be aligned vertically
in the column. By default, the server aligns the portlets at the top of each column.

f. To apply a CSS class to the column, in the CSS Class field, type the name of the
class, omiing the leading period. For example, type nav for the “.nav” class.

Specify a CSS class defined by a CSS style sheet included in the page, either the
CSS style sheet that is:
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Used by the current skin

Included with a custom portlet in the page content or the current shell

g. To apply a style to the column, in the CSS Style field, type any style that is valid
for use in a CSS file. For example, if you type border: 1pt dashed red, a
dashed red line appears as a column border.

h. To apply a background image to the column, in the Skin Background Image field,
type the name of the image file from the current skin.

You specify the name of the skin property. For example, to use the main logo
image from the skin, type images/logo.gif. Determine the skin property name
for an image by accessing the skin editor (via the Administration Dashboard > User
Interface > Skin Administration portlet) and locating the image in the Images page.
The skin property is "images/" followed by the property name, such as "images/
logo.gif".

Note: To apply an image that is not in the current skin, specify the standard
CSS background-image property in the CSS Style field. You can also
specify properties in the CSS Style field to control how the background
is displayed, such as whether it repeats, is centered, scrolls with the
page, etc.

9. Click OK.

10. In the page title bar, click Save.

Adding Rows When Using a Column Layout
By default, when you set the layout of a page to use a column layout, the page has a
single row in each column. The portlets you add to a column are aligned vertically based
on the vertical alignment you specify for the column. However, you might want to add
additional rows to one or more columns.

To add a row to a column on a page

1. As system administrator, navigate to and open the page to which you want to add a
row.

2. In the page title bar, click Tools > Edit Page to switch to page editing mode.

3. Select the View As Expert check box so that you can see the borders and title bars of
the rows that you add to the page.

4. In the Tools tab, expand the Layout item to reveal the Row tool.

5. Drag the Row tool into the column where you want it.

The system displays a red box beneath the cursor position to indicate where the row
would be positioned if you released the mouse buon.

6. Click Save.
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Removing Rows When Using a Column Layout
If you added rows to a column in the layout and no longer want the row, you can
remove it.

To remove rows from a column

1. As system administrator, navigate to and open the page from which you want
remove a row.

2. In the page title bar, click Tools > Edit Page to switch to page editing mode.

3. Select the View As Expert check box so that you can see the borders and title bars of
the rows on the page.

4. If the row contains any portlets that you want to preserve, drag them out of the row
into a to a different location on the page.

5. In the title bar of the row, click Delete.

6. Click Save.

Adding Portlets to a Page
You can add as many portlets as you want to a page. You can also add the same portlet
multiple times. Where you can position a portlet on a page depends on the page
layout. For more information, see "Controlling the Page Layout" on page 326 and
"Positioning Portlets on a Page" on page 330.

To add portlets to a page

1. As system administrator, navigate to and open the page to which you want to add
portlets.

2. In the page title bar, click Tools > Edit Page to switch to page editing mode.

In page editing mode, the Tools tab on the left lists the portlets you can add to a page.
Many of the portlets listed in the Tools tab are described in the My webMethods Server
Portlet Reference.

3. If you want to view the column, row, and portlet borders to help with the placement
of your portlets, select the View As Expert check box. Clear the check box when you no
longer want to view the borders.

4. In the Tools tab select the portlet you want to add and drag it on to the page.

The system displays a red box beneath the cursor position to indicate where the
portlet would be positioned if you released the mouse buon.

5. Click Save.
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Removing Portlets from a Page
To remove a portlet from a page, use the following procedure.

To remove a portlet from a page

1. As system administrator, navigate to and open the page from which you want to
remove portlets.

2. In the page title bar, click Tools > Edit Page to switch to page editing mode.

3. If the title bar of the portlet you want to remove is hidden, select the View As Expert
check box so that you can see the title bar.

4. In the title page of the portlet that you want to delete, click Menu > Delete.

5. Click Save.

Positioning Portlets on a Page
Where you can position portlets on a page depends on the page layout.

When using a column layout (e.g., Three Columns), the layout forces the portlets to
be aligned within the columns. You can move portals up and down within a column
or from one column to another.

When using a free form layout, you can move portlets anywhere within the page.
Portlets do not have to be aligned and can overlap one another.

For instructions for how to define the page layout, see "Controlling the Page Layout" on
page 326.

To position a portlet on a page

1. As system administrator, navigate to and open the page you want to update.

2. In the page title bar, click Tools > Edit Page to switch to page editing mode.

3. If the title bar of the portlet you want to reposition is hidden, select the View As Expert
check box so that you can see the title bar.

4. Move your cursor over the title bar of the portlet you want to reposition until the
system displays the move cursor.

5. Click and drag the portlet to the new location.

The system displays a red box beneath the cursor position to indicate where the
portlet would be positioned if you released the mouse buon.

6. Click Save.
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Portlet Properties
General Tab

The following table describes the portlet properties displayed on the General tab. My
webMethods Server displays these properties when you select to view the properties in
regular mode and in page editing mode.

Section Property Description

General Name Name of the portlet that appears in the portlet title bar.

 Description Optional description of the portlet.

 Keywords Optional keywords that you assign to a portlet for
your own use. Out-of-the-box, My webMethods
Server does not provide functionality that uses the
keywords. However, you can write custom code that
takes advantage of the keywords.

Full Page
View

Display to use for the portlet when you navigate to the
portlet itself where My webMethods Server displays a
page that contains only the portlet.

Display

Portlet View Display to use for the portlet when you navigate to the
page that contains the portlet.

Maintenance Owner The user name of the user that added the portlet to the
page.

 Created On The date and time the portlet was added to the page.

 Modified On The date and time the portlet was last updated.

 Aliases Optional aliases assigned to the portlet. For more
information, see "Managing Portlet Aliases" on page
335.

Preferences Tab

The Preferences tab contains properties that are specific to the portlet and that usually
define the information that My webMethods Server displays in the portlet. For example,
for the HTML Text tool, you can specify the text to display in the portlet on the Preferences
tab.
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To view the Preferences tab, you must view the properties from page editing mode. Not
all portlets use a Preferences tab.

Layout Tab

The Layout tab contains properties that dictate how My webMethods Server is to display
the portlet. To view the Layout tab, you must view the properties from page editing
mode.

The following table lists the typical properties that are included on the Layout tab.

Section Property Description

Size and
Positioning

Width How wide to make the portlet. Specify the
number of pixels to use for the portlet width.

 Height How tall to make the portlet. Specify the
number of pixels to use for the portlet height.

 Auto Positioned How My webMethods Server positions the
portlet when rendering the page. If Auto Position
is toggled:

On: My webMethods Server automatically
positions the portlet, ignoring any positioning
information stored with the portlet.

Off: My webMethods Server uses positioning
information stored with the portlet to
determine where to place the portlet on the
page. As a result, My webMethods Server
uses the location from when the page was last
saved.

Display Titlebar Whether you want My webMethods Server to
display the portlet title bar. Select the check box
to display the title bar; clear the check box to
hide the title bar.

Note: If you hide the title bar, when editing the
page, select View As Expert to temporarily
view the title bar so that you can manipulate
the portlet on the page.

 Border Whether you want My webMethods Server to
display the portlet border. Select the check box
to display the border; clear the check box to
hide the border.
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Section Property Description

Note: If you hide the border, when editing the
page, select View As Expert to temporarily
view the border to help you as you position
and/or resize the portlet.

 Minimized Whether you want My webMethods Server
to initially display the portlet as minimized
when it displays the page that contains the
portlet. Users can restore the portlet to view its
contents.

 CSS Class A CSS class to apply to the portlet. Type the
name of the class, omiing the leading period.
For example, type nav for the “.nav” class.

Specify a CSS class defined by a CSS style sheet
included in the page, either the CSS style sheet
that is:

Used by the current skin

Included with a custom portlet in the page
content or the current shell

 CSS Style A style to apply to the portlet. Type any style
that is valid for use in a CSS file. For example, if
you type border: 1pt dashed red, a dashed
red line appears as a portlet border.

 Skin
Background
Image

A background image to use for the portlet. Type
the name of the image file from the current skin.

You specify the name of the skin property. For
example, to use the main logo image from the
skin, type images/logo.gif. Determine the
skin property name for an image by accessing
the skin editor (via the Administration Dashboard
> User Interface > Skin Administration portlet) and
locating the image in the Images page. The skin
property is "images/" followed by the property
name, such as "images/logo.gif".

Note: To apply an image that is not in the current
skin, specify the standard CSS background-
image property in the CSS Style field. You
can also specify properties in the CSS Style
field to control how the background is
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Section Property Description
displayed, such as whether it repeats, is
centered, scrolls with the page, etc.

Metadata Tab

The Metadata tab contains properties that are specific to the portlet and that usually
define the information that My webMethods Server displays in the portlet.

To view the Metadata tab, you must view the properties from page editing mode. Not all
portlets use a Preferences tab.

Wiring Tab

Use the Wiring tab to wire the values of the properties. To view the Wiring tab, you
must view the properties from page editing mode. For more information about wiring
properties, see "Wiring the Property of One Portlet to the Property of Another" on page
336 and "Wiring a Principal Aribute to a Portlet Property" on page 337.

Modifying Portlet Properties
Configure portlet properties to specify display seings for the portlet and define how
the portlet functions. You configure the properties for a portlet independently from the
properties of the page on which the portlet resides.

To modify portlet properties

1. As system administrator, navigate to and open the page containing the portlets you
want to update.

2. In the page title bar, click Tools > Edit Page to switch to page editing mode.

3. If the title bar of the portlet you want to update is hidden, select the View As Expert
check box so that you can see the title bar.

4. In the portlet title bar, click Tools > Properties.

5. Make the changes you want to the properties. For information about the properties,
see "Portlet Properties" on page 331.

6. At the boom of the portlet, click Apply.

7. Click Save.

Tip: If the title bar of the portlet you want to update is visible, you can update the
portlet’s property without switching to page editing mode. To view a portlet’s
properties while in regular view mode, in the portlet title bar click Tools >
Properties.
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Managing Portlet Aliases
You can assign aliases to individual portlets. An alias is a new or simpler name for a
portlet. By assigning an alias to a portlet, My webMethods Server recognizes the alias
when it appears in a URL and automatically redirects a user to the portlet.

Use the aliases to access the portlets directly. Aliases are also useful to page developers
when building multi-portlet applications; developers can use the aliases to allow one
portlet to communicate with another.

To add, edit or remove portlet aliases

1. As system administrator, navigate to and open the page containing the portlets you
want to update.

2. In the page title bar, click Tools > Edit Page to switch to page editing mode.

3. If the title bar of the portlet you want to update is hidden, select the View As Expert
check box so that you can see the title bar.

4. In the portlet title bar, click Tools > Properties

5. To add an alias:

a. In the Aliases section of the Properties page, click Add.

b. Type the portlet alias that you want to add in the text box.

c. Click OK.

6. To change an existing alias:

a. In the Aliases section of the Properties page, select the alias you want to update
and click Edit.

b. Type the new portlet alias in the text box.

c. Click OK.

7. To remove an alias, in the Aliases section of the Properties page, select the alias you
want to remove and click Remove.

8. At the boom of the page, click Apply.

9. Click Save.

Tip: If the title bar of the portlet you want to update is visible, you can work with
portlet aliases without switching to page editing mode. To view a portlet’s
properties while in regular view mode, in the portlet title bar click Tools >
Properties.
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Wiring the Property of One Portlet to the Property of Another
You can connect, or wire , any property of any portlet on a page to any property of any
other portlet. When you wire one property to another, whenever the page is rendered,
the server automatically sets the value of the destination property to the value of the
source property. This feature allows you to quickly create a composite application out of
several different portlets.

For example, if you create a page with two portlets, one a search form and one a search
results display, you can wire the search form value (the source value) to the results
display input value (the destination value). When a user enters some information into
the search form and submits it, the server updates the results display to the results of
that search.

To wire one portlet to another

1. As system administrator, navigate to and open the page containing the portlet you
want to wire.

2. In the page title bar, click Tools > Edit Page to switch to page editing mode.

3. Decide which portlet is the wiring source and which is the wiring destination.

The destination portlet property receives its property value from the source portlet
property.

4. If the title bar of the destination portlet is hidden, select the View As Expert check box so
that you can see the title bar.

5. In the portlet title bar of the destination portlet, click Tool > Properties.

6. Click the Wiring tab.

The wiring tab displays a list of properties on the destination portlet that are
available for wiring.

7. For a target property that you want to wire, in the SOURCE PORTLET column, select
the portlet that you want to use as the source.

8. In the SOURCE PROPERTY column, specify the specific property of the source portlet
that you want to use.

a. Click Browse.

b. Select the property you want to use from the list.

c. Click Select.

9. Click Apply.

10. Click Save.

The run-time view of the page should display the destination portlet with whatever
values are configured in the source portlets.
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Tip: If the title bar of the destination portlet is visible, you can wire the portlet
without switching to page editing mode. To view the wiring page for a
portlet, in the portlet title bar click Tools > Wiring.

Wiring a Principal Attribute to a Portlet Property
Users and groups have a set of Principal Aributes that you can wire to a portlet. For
example, suppose a portlet uses a postal code to display certain information when a
user views a page. If the postal code is provided by wiring from a Principal Aribute
Provider, when the postal code aribute is modified within a directory service, the
portlet uses the modified aribute value.

To wire a Principal Attribute to a portlet

1. As system administrator, navigate to and open the page containing the portlet you
want to wire.

2. In the page title bar, click Tools > Edit Page to switch to page editing mode.

3. If the title bar of the portlet is hidden, select the View As Expert check box so that you
can see the title bar.

4. In the portlet title bar of the portlet, click Tool > Properties.

5. Click the Wiring tab.

6. For a target property that you want to wire, in the SOURCE PORTLET column, select
Other.

The Select Portlet Resource window opens.

7. Click Global Wiring Data.

8. Move Use Profile Wiring to the Selected Items box and click Select.

The Select Portlet Resource window closes.

9. In the SOURCE PROPERTY column, specify the specific property to use for the source.

a. Click Browse.

The Select Wired Property window opens.

b. Select the property you want to use from the list.

c. Click Select.

10. Click Apply.

11. Click Save.

The portlet is now wired to use the aribute value belonging to the user who
viewing the page on which the portlet resides.
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Tip: If the title bar of the portlet is visible, you can wire the portlet without
switching to page editing mode. To view the wiring page for a portlet, in the
portlet title bar click Tools > Wiring.

About Customizing the My webMethods Navigation
To customize the My webMethods navigation panel, you can:

Add selections to the Applications section of the navigation panel. You can add:

Additional pages to the Monitoring or Administration subsections

New folders of pages to the Applications section

The folder becomes a new subsection within the Applications section. The items
contained in the folder become selections within the new subsection.

For more information, see "Adding Selections to the My webMethods Navigation" on
page 338.

Remove selections from the Monitoring or Administration subsections of the Applications
section of the navigation panel. For more information, see "Removing Selections
from the My webMethods Navigation" on page 339.

Hide standard tabs and sections of the navigation panel.

You can hide the Navigate tab completely. If you show the Navigate tab, you can hide
either the Applications and/or Workspaces sections that are on the Navigate tab. You can
also hide the Tools tab completely. For more information, see "Hiding Standard Tabs
and Sections of the My webMethods Navigation" on page 340.

Completely replace the Applications section of the My webMethods navigation with
a custom taxonomy. For more information, see "Replacing the My webMethods
Application Navigation with Your Own Taxonomy" on page 341.

Adding Selections to the My webMethods Navigation
System administrators can add custom pages or folders of pages to the Applications
section of the My webMethods navigation.

To add selections to the Applications section of the My webMethods navigation

1. Create the custom folder or custom page that you want to add to the navigation
panel. For more information, see "About Custom Folders and Pages" on page 320
and "Creating Custom Pages" on page 321.

When creating the folder or page, save it in one of the following locations:

To add a page to the Monitoring subsection of the Applications section, add it to:

Folders > My webMethods Applications > Fabric Tasks > Monitoring
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To add a page to the Administration subsection of the Applications section, add it to:

Folders > My webMethods Applications > Fabric Tasks > Administration

To add a folder to create a new, custom subsection within the Applications section,
add it to:

Folders > My webMethods Applications > Fabric Tasks

To add a page to a custom subsection, add the page to the folder you are using
for the subsection. For example, if you add a folder named “Custom Pages”, then
you can add a page to the following location:

Folders > My webMethods Applications > Fabric Tasks > Custom Pages

2. As system administrator, navigate to and open the folder or page you want to add to
the navigation panel.

3. In the page title bar, click Tools > Properties.

4. Select the Is Task Folder check box to indicate that you want My webMethods Server
to display the page in the My webMethods navigation panel.

5. Select the Is Openable check box if you want My webMethods Server to automatically
open a page in a new tab when a user navigates to it from the navigation panel.

6. Click Apply to close the Properties page.

You can set Access Privileges for the page in the same manner you set Access Privileges
for any other My webMethods page.

Removing Selections from the My webMethods Navigation
System administrators can remove both custom pages and folders, as well as, out-of-the
box pages from the Applications section of the My webMethods navigation.

To remove custom pages and/or folders, you can:

Permanently remove them by deleting them from their location within Folders >
My webMethods Applications > Fabric Tasks

Temporarily hide them so that My webMethods does not display them in
the navigation, by clearing the Is Task Folder check box in the page or folder’s
properties.

To remove out-of-the-box pages, it is recommended that you clear the Is Task Folder
check box in the page’s properties rather than deleting the pages.

To remove either one or both of the out-of-the-box Monitoring or Administration
subsections, update the properties of Folders > System > Shell Sections > Noodle Shell
LeftNav > Leftnav. For more information, see "Hiding Standard Tabs and Sections of
the My webMethods Navigation" on page 340.



M
Even Header

Managing Pages in My webMethods Server

Administering My webMethods Server Version 9.8 340

To remove selections from the Applications section of the My webMethods navigation

1. As system administrator, navigate to and open Folders > My webMethods Applications >
Fabric Tasks.

2. To permanently remove a custom folder or page, delete it by selecting Delete in the
title bar of the folder or page.

3. To hide a custom folder, custom page, or out-of-the-box page:

a. Open the properties for the folder or page by selecting Tools > Properties in the
title bar of the folder or page.

b. Clear the Is Task Folder check box.

c. Click Apply.

Hiding Standard Tabs and Sections of the My webMethods
Navigation
System administrators can configure the properties of the left navigation page that is
used for My webMethods navigation to:

Completely hide the Navigate tab or Tools tab

Hide either or both of the Applications section or Workspaces section that are
displayed on the Navigate tab.

To hide standard tabs and/or sections of the My webMethods navigation

1. As system administrator, navigate to the following location:

Folders > System > Shell Sections > Noodle Shell Leftnav > Leftnav

2. In the row for the Leftnav page, select Tools > Properties.

3. In the PORTLET PREFERENCES section of the page, clear following check boxes to hide
tabs or sections. Select the check boxes to display the tabs or sections.

Check box Description

Show
Workspaces

Hides or shows the Workspaces section of the Navigate tab.

Show
Applications

Hides or shows the Applications section of the Navigate tab.

Show Tools Hides or shows the Tools tab.

Show Navigate Hides or shows the Navigate tab.
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4. Click Apply.

Replacing the My webMethods Application Navigation with Your Own
Taxonomy
System administrators can completely replace the Applications section of the My
webMethods navigation panel with a custom taxonomy.

To create a custom taxonomy, you create an alternative applications root page that
contains the taxonomy you want to use. Then you configure the properties for the
Leftnav page that My webMethods uses for its navigation panel to point to your new
application root.

To replace the My webMethodsApplications taxonomy with a custom taxonomy

1. As system administrator, create a new page to use as the application root. It is
recommended that you create the page within either of the following locations.

Folders

Folders > Public Folders

When creating the page, assign it a name that you want to appear in the navigation
panel. The name you assign will be the new name of the Applications section.

2. Assign an alias to the new application root page.

a. In the row for the new application root page, select Tools > Properties.

b. In the Aliases field, click Add.

c. In the text box, assign the alias you want to give the new application root and
click OK.

d. Click Apply.

3. Build the taxonomy within the new applications root page.

To add a subsection to the taxonomy, add a page or folder to use as a container.
Assign it a name that you want to use for the name of the subsection within the
taxonomy.

To add a page that displays information, add a page. Assign it a name that you
want to appear in the taxonomy.

For more information about creating custom folders and pages, see "About Custom
Folders and Pages" on page 320 and "Creating Custom Pages" on page 321.

4. Configure the properties of the Leftnav page that My webMethods Server uses for
the My webMethods navigation to point it to the new, custom application root.

a. Navigate to the following location:

Folders > System > Shell Sections > Noodle Shell Leftnav > Leftnav
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b. In the row for the Leftnav page, select Tools > Properties.

c. In the Applications Root field, type the name of the alias you assigned to the
applications root page you created.

d. Click Apply.

Modifying the Bean Expiration Policy
By default, when a My webMethods user returns to a previous folder, such as a Task
Inbox, the folder refreshes itself and unsaved changes to the folder are lost. System
administrators can modify the bean expiration policy for a Fabric folder or a workspace
template so it displays existing data when users return to the tab that contains it.
Once set, the policy applies any time a user displays that folder or workspace in My
webMethods.

To modify bean expiration policy

1. As system administrator do one of the following:

For Fabric folders navigate to Folders > My webMethods Applications > Fabric Tasks.

Folders that allow the you to modify the bean expiration policy are identified by
the  icon.

For workspace templates navigate to Folders > System > Templates > Workspace
Templates > Default Workspace Template.

2. In the Fabric folder title bar or in the Default Workspace Template, click Tools >
Properties.

3. In the beanExpirePolicy field, type do_not_expire.

4. Click Apply.

Make this change individually for each folder you want to modify.

About Customizing the My webMethods Look-And-Feel
System administrators can change the My webMethods look-and-feel by updating the
skin that My webMethods uses. To customize the My webMethods look-and-feel, you
can:

Change the Software AG logo, for example, to display your own corporate logo. For
more information, see "Replacing the Logo in the My webMethods User Interface" on
page 343.

Change the colors that are used in the My webMethods user interface. For more
information, see "Changing the Color Scheme of the My webMethods User Interface"
on page 344.
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Apply the look-and-feel used in My webMethods 7.x to the current version of My
webMethods. For more information, see "Using the 7.x Skin and Shell with My
webMethods " on page 345.

Completely customize the My webMethods look-and-feel by using a custom shell
and skin. For more information, see "Applying a Custom Skin and Shell to My
webMethods " on page 348.

Replacing the Logo in the My webMethods User Interface
System administrators can change the images used in the My webMethods user
interface by updating the images in the skin that My webMethods uses. To change the
Software AG logo that appears at the top of the interface, update the logo.gif image. For
more information about skins, see "Customizing Skins" on page 375.

My webMethods uses the “Noodle - Twilight” skin. It is recommended that you do not
update the “Noodle - Twilight” skin, but rather make a copy of it, update the copy, then
configure the My webMethods to use the modified copy of the skin.

To replace the logo in the My webMethods user interface

1. Make a copy of the “Noodle - Twilight” skin.

a. As system administrator navigate to the following location.

Folders > Administrative Folders > Administration Dashboard > User Interface > Skin
Administration

b. Click the Create New Skin link, which is at the top of the page.

c. Complete the fields for the new skin.

In this field... Specify...

System Name A short name that contains only leers, numbers, and the
underscore character. My webMethods Server uses this name
internally.

Display Name A descriptive name that My webMethods Server uses when it
displays the skin name in the user interface.

Parent Skin Noodle - Twilight

d. Click Save.

2. Edit the properties for the new skin by selecting Tools > Edit.

3. Click the Images tab.

4. Update the image for the logo.gif image. For instructions, see "Replacing Images in a
Skin" on page 382.
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5. Configure My webMethods so that it uses the updated skin.

a. Navigate to the following:

Folders > Administrative Folders > Administration Dashboard > User Interface > Manage
Skin Rules

b. Click the My webMethods link to open the skin rule that My webMethods uses.

c. On the Modify Rules tab, in the Results list select the new skin.

d. Click Update Rule.

Changing the Color Scheme of the My webMethods User Interface
System administrators can change the colors used in the My webMethods user interface
by updating the colors in the skin that My webMethods uses. For more information
about skins, see "Customizing Skins" on page 375.

My webMethods uses the “Noodle - Twilight” skin. It is recommended that you do not
update the “Noodle - Twilight” skin, but rather make a copy of it, update the copy, then
configure the My webMethods to use the modified copy of the skin.

To change the colors in the My webMethods user interface

1. Make a copy of the “Noodle - Twilight” skin.

a. As system administrator navigate to the following location.

Folders > Administrative Folders > Administration Dashboard > User Interface > Skin
Administration

b. Click the Create New Skin link, which is at the top of the page.

c. Complete the fields for the new skin.

In this field... Specify...

System Name A short name that contains only leers, numbers, and the
underscore character. My webMethods Server uses this name
internally.

Display Name A descriptive name that My webMethods Server uses when it
displays the skin name in the user interface.

Parent Skin Noodle - Twilight

d. Click Save.

2. Edit the properties for the new skin by selecting Tools > Edit.

3. Click the Colors tab.
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4. Update the colors. For instructions, see "Replacing Colors Using a Color Picker" on
page 383.

5. Configure My webMethods so that it uses the updated skin.

a. Navigate to the following:

Folders > Administrative Folders > Administration Dashboard > User Interface > Manage
Skin Rules

b. Click the My webMethods link to open the skin rule that My webMethods uses.

c. On the Modify Rules tab, in the Results list select the new skin.

d. Click Update Rule.

Using the 7.x Skin and Shell with My webMethods
My webMethods Server still provides the skin and shell that were used for My
webMethods version 7.x. As a result, system administrators can configure My
webMethods so that it uses the 7.x skin and shell, and as a result, revert My
webMethods so that it has the look-and-feel of the My webMethods version 7.x.

If you later decide you want to use the 8.0 look-and-feel, follow the procedure in
"Restoring the 8.0 Look-and-Feel" on page 346.

To update My webMethods so it uses the My webMethods 7.x look-and-feel

1. Configure My webMethods so that it uses the “My webMethods Shell” shell, which
is the shell that My webMethods version 7.x used:

a. Navigate to the following:

Folders > Administrative Folders > Administration Dashboard > User Interface > Manage
Shell Rules

b. Click the My webMethods link to open the shell rule that My webMethods uses.

c. On the Modify Rules tab, in the Results list select My webMethods Shell.

d. Click Update Rule.

2. Configure My webMethods so that it uses the “Pearls - Electric Blue” skin, which is
the skin that My webMethods version 7.x used:

a. Navigate to the following:

Folders > Administrative Folders > Administration Dashboard > User Interface > Manage
Skin Rules

b. Click the My webMethods link to open the skin rule that My webMethods uses.

c. On the Modify Rules tab, in the Results list select Pearl - Electric Blue.

d. Click Update Rule.
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3. Create the start page you want to use for the 7.x look-and-feel. This is the page that
will be displayed when users log into My webMethods.

a. Navigate to the following:

Folders > My webMethods Applications > Fabric Tasks

b. Rename the existing Home shortcut to 80_Home by updating the Name property.
For instructions, see "Seing Page Properties" on page 324.

c. Create a new page in the “Fabric Tasks” folder and assign it the name Home.

d. Assign the new Home page the alias 7x_home. For more information about how
to assign aliases, see "Seing Page Properties" on page 324.

e. Optionally, edit the page and add any content you want. For more information,
see "Creating Custom Pages" on page 321.

4. Configure My webMethods so that it displays the 7.x Start Page when a user logs
into My webMethods.

a. Navigate to the following:

Folders > Administrative Folders > Administration Dashboard > User Interface > Manage
Start Page Rules

b. Select the Create New Rule tab.

c. Fill in the following fields:

In this field... Specify...

Name 7x_Start_Page

Condition “My webMethods Users” matches
user.roleMembershipDNs()

Results The alias you assigned to the 7.x start page you created, that is
7x_home

d. Click Create Rule.

e. Select the Change Rule Evaluation Order tab.

f. Move the “7x_Start Page” rule that you just created to the top.

g. Click Update.

Restoring the 8.0 Look-and-Feel
If a system administrator configured My webMethods so that it uses the 7.x look-and-
feel using the procedure in "Using the 7.x Skin and Shell with My webMethods " on page
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345, a system administrator can use the following procedure to restore the 8.0 look-
and-feel.

Note: The procedure assumes that the names and aliases specified in the procedure
in "Using the 7.x Skin and Shell with My webMethods " on page 345 were
used.

To restore the My webMethods 8.0 look-and-feel

1. Configure My webMethods so that it uses the “Noodle Shell” shell, which is the shell
that My webMethods version 80 uses:

a. Navigate to the following:

Folders > Administrative Folders > Administration Dashboard > User Interface > Manage
Shell Rules

b. Click the My webMethods link to open the shell rule that My webMethods uses.

c. On the Modify Rules tab, in the Results list select Noodle Shell.

d. Click Update Rule.

2. Configure My webMethods so that it uses the “Noodle Twilight” skin, which is the
skin that My webMethods version 8.0 uses:

a. Navigate to the following:

Folders > Administrative Folders > Administration Dashboard > User Interface > Manage
Skin Rules

b. Click the My webMethods link to open the skin rule that My webMethods uses.

c. On the Modify Rules tab, in the Results list select Noodle Twilight.

d. Click Update Rule.

3. Configure the start page that My webMethods is to display.

a. Navigate to the following:

Folders > Administrative Folders > Administration Dashboard > User Interface > Manage
Start Page Rules

b. Select the Change Rule Evaluation Order tab.

c. Move the “7x_Start Page” rule to the boom of the list and “My webMethods
Last Active Tab” is at the top.

d. Click Update.

4. Set the Home page for the 8.0 look-and-feel.

a. Navigate to the following:

Folders > My webMethods Applications > Fabric Tasks
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b. Rename the Home to 72_Home by updating the Name property. For instructions,
see "Seing Page Properties" on page 324.

c. Rename the 80_Home shortcut to Home by updating the Name property.

Applying a Custom Skin and Shell to My webMethods
System administrators can completely change the look-and-feel of My webMethods by
configuring it to use a custom skin and shell.

To apply a custom skin and shell to My webMethods

1. Create the custom shell you want to use. For instructions, see "Working with Shells
in My webMethods Server " on page 403.

2. Create the custom skin you want to use. For instructions, see "Customizing Skins" on
page 375.

3. Configure My webMethods so that it uses your custom shell:

a. Navigate to the following:

Folders > Administrative Folders > Administration Dashboard > User Interface > Manage
Shell Rules

b. Click the My webMethods link to open the shell rule that My webMethods uses.

c. On the Modify Rules tab, in the Results list select the name of your custom shell.

d. Click Update Rule.

4. Configure My webMethods so that it uses your custom skin:

a. Navigate to the following:

Folders > Administrative Folders > Administration Dashboard > User Interface > Manage
Skin Rules

b. Click the My webMethods link to open the skin rule that My webMethods uses.

c. On the Modify Rules tab, in the Results list select the name of your custom skin.

d. Click Update Rule.

Building a Simple Front-End Page to My webMethods
If you have users that need access to only a few My webMethods pages and you want to
simplify their access to those pages, you can build a simple page that provides links to
only the pages the users require.

The links you include in the front-end page can use URLs that use a page alias. Some
My webMethods application pages are assigned aliases out-of-the-box. If an application
page that you want to use does not have an alias, you can assign one to the page. After
an alias is assigned, as an alternative to selecting the page from the My webMethods
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navigation panel, you can navigate directly to it by entering a URL that uses the page
alias.

To build a simple front-end page to My webMethods

1. Determine the application pages that you want to include in the front-end page.

2. For each application page, determine its page an alias or assign one if the page does
not have an alias.

a. As system administrator, navigate to the following:

Folders > My webMethods Applications > Fabric Task

b. Further navigate to and open the Application page you want.

c. In the page title bar, click Tools > Properties

d. In the Aliases section of the screen, note the page alias. If there is no page alias,
assign one.

e. Click Apply to close the Properties page.

3. Build a webpage that includes links to the Application pages. Use the following for
the URL where:

MWSHost  and MWSPort  are the host name and port number of the My
webMethods Server

alias  is the alias name of the application page

hp://MWSHost :MWSPort /alias

For example if the host name and port of My webMethods Server is
“mws.company.com:8585” and you want to access the Tasks Inbox page, which has
the alias “webm.apps.workflow.inbox”, use the following URL:

hp://mws.company.com:8585/webm.apps.workflow.inbox

Creating Links for Single Sign-On
Single sign-on is the ability for a user to log into one application and then use other
applications without having to log into each one separately. My webMethods Server
supports single sign-on through the Security Assertion Markup Language (SAML), an
XML-based framework for the exchange of security information.

To take advantage of single sign-on, a user must be known on both the source server
and the target entity. In most cases, common knowledge of a user is provided by use of
the same directory service. For more information on configuring a server to be used as a
target for single sign-on, see "Seing up Single Sign-On" on page 281.

On any page, you can add a link to a SAML target entity, such as a server. If the target
accepts SAML assertions from the source server, when a known user clicks the link, no
login credentials are required. If the target entity does not accept SAML assertions from
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the source server, or if the user is not known on the target entity, login credentials may
be required.

Under the SAML specification, an intermediary called an artifact receiver can perform
authentication on behalf of the target web application. In such a case, the SAML source
requires two URLs: one for the Artifact Receiver and one for the target web application.

You can place one or more SAML links on any page you have permission to edit.

To create a SAML link on a source page

1. In the upper right-hand corner of the page, click the Tools icon  and click Edit
Page.

2. In the Root list of the Available Portlets panel, click Links.

3. In the Links list of the Available Portlets panel, drag the Single Sign-on Link portlet and
drop it onto the page at the location where you want to add the link.

A red box appears beneath the cursor location whenever the cursor is over a valid
page location, indicating where the portlet would be positioned if you released the
mouse buon.

4. On the left side of the page control area, click Save.

5. At the right edge of the title bar for the single sign-on portlet, click Tools >
Properties.

6. In the Properties page make modifications as appropriate:

Make changes here... If you want to...

Name Replace Single Sign-on Link with the text
that is to go with the link.

SAML Authentication URL Type the URL for a resource on the target
computer. The target can be any page on a
server. If you are connecting to a web application
through a SAML Artifact Receiver, use this field
for the Artifact Receiver URL.

Determines the method used to pass data to the
target computer.

POST Passes data to a gateway program’s
STDIN. POST, the default, is the
preferred method for single sign-on
data.

Use POST or GET

GET Passes data as a string appended to
the URL after a question mark.
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Make changes here... If you want to...

Artifact Parameter Name If this is a SAML connection with another server
or other webMethods product, do not change
the default value SAMLart. If this is a SAML
connection to a third-party source, type the
artifact parameter name used by the third-party
application.

Application Target URL If you have typed the URL for a SAML Artifact
Receiver in the SAML Authentication URL field, type
the URL for a web application. Otherwise, leave
this field empty.

7. Click Apply.
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About Workspaces
Workspaces are pages that users create and use as work areas for some specific purpose.
Users build the content of the workspace by dragging portlets on to the workspace.
For example, users might create a workspace to gather information about an issue they
need to solve. They might aach files to the workspace related to the issue by adding the
Aachments tool to the workspace. If they have a screen shot that illustrates the issue,
they might add the Image tool to the workspace.

Users can also share workspaces with other users so that multiple users can work
together. For example, a user might add the Aachments tool to the workspace so that
the users sharing the workspace can upload and share files. The owner of the workspace
sets the permissions that dictate that actions that other users sharing the workspace can
perform.

Users can create as many workspaces as they need. When the workspace is no longer
needed, for example because the issue for which it was established is resolved, users can
simply delete the workspace.

For more information about the basic use of workspaces, such as, creating workspaces,
sharing workspaces, and adding portlets to workspaces, see Working with My
webMethods.

System administrators and My webMethods administrators can restrict or enhance the
a user’s workspace functionality. For more information, see "Administration Tasks for
Workspaces" on page 355.

To restrict functionality, an administrator can set users’ permissions to deny
functionality that they are granted out-of-the-box. For example, you can deny the
functional privilege that allows a user to create new workspaces.

To enhance functionality, an administrator can set users’ permissions to grant
functionality that they are not granted out-of-the-box. For example, you can grant:

The functional privilege that makes a user an expert user. Expert users have
access to additional properties and menu actions that aid in developing
workspaces. For more information, see "Expert User Features for Workspace
Development" on page 358.

Access to the Navigate > Applications > Administration > System-Wide >
Workspace Management page from which a user can perform actions against
workspaces. For more information, see "Workspace Actions You Can Perform
from the Workspace Management Page" on page 365.

Additionally, system administrators can customize the Tools tab of the My webMethods
navigation. For more information, see "About the My webMethods Tools Navigation" on
page 372.
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Administration Tasks for Workspaces
System administrators and My webMethods administrators can enhance or restrict the a
user’s workspace functionality by performing the following tasks:

Grant users access to the Navigate > Applications > Administration > System-Wide
> Workspace Management page, which allows users to search for and take action on
workspaces. For more information, see "Allowing Users to Access the Workspace
Management Page" on page 355.

Prohibit users from performing basic workspace actions, such as viewing
workspaces and creating workspaces. For more information, see "Workspace
Functional Privileges" on page 356 and "Controlling the Workspace Functions a
User Can Perform" on page 358.

Grant users Expert Workspace Development privileges, giving them additional
functionality that they can use when building workspaces. For more information,
see "Workspace Functional Privileges" on page 356, "Controlling the Workspace
Functions a User Can Perform" on page 358, and "Expert User Features for
Workspace Development" on page 358.

Remove the Workspaces section of the My webMethods navigation for all users. For
more information, see "Hiding Standard Tabs and Sections of the My webMethods
Navigation" on page 340.

Customize the taxonomy displayed on the Tools tab of the My webMethods
navigation. For more information, see "Customizing the My webMethods Workspace
Tools" on page 373.

If a system administrator needs to take action to fix or delete a user’s workspace
and cannot do so via the Navigate > Applications > Administration > System-Wide >
Workspace Management page, they can aempt to correct the problem by accessing
it in the user’s personal folder. My webMethods Server stores each workspace in the
personal folder of the user who created the workspace. For example, if the user “jsmith”
creates a workspace, you can use the system administrator user interface to navigate to
the workspace in Folders > Users > jsmith's Root Folder > Workspaces.

Allowing Users to Access the Workspace Management Page
My webMethods includes the Navigate > Applications > Administration > System-Wide
> Workspace Management page that allows users to take actions against workspaces.
For a description, see "Workspace Actions You Can Perform from the Workspace
Management Page" on page 365.

By default, only My webMethods administrators have access to the Workspace
Management page; end users do not. However, end users can perform many of the
same actions from the right-click menu in the Workspaces section of the My webMethods
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navigation and from the menu on the tab of an open workspace. The workspace actions
that are only available via the Workspace Management page are:

Searching for workspaces.

Exporting workspaces to a file.

Importing workspaces that were previously exported to a file.

System administrators and My webMethods administrators can assign permissions to
allow users, groups, and/or roles to access the Workspace Management page.

To allow users access the Workspace Management page

1. Navigate to the Permissions Management page.

In My webMethods: Navigate > Applications > Administration > System-Wide >
Permissions Management.

As system administrator: Folders > Administrative Folders > Administration Dashboard
> Configuration > Permissions Management.

2. Use the Permissions Management page to select the users, groups, and/or roles to
which you want to grant access and to set the access privilege to the Workspace
Management Page.

When seing privileges, in the Permissions tree select the following:

Access Privileges > Administration > System-Wide > Workspace Management

For instructions for how to use the Permissions Management page to set access
privileges, see "Access Privileges and Functional Privileges" on page 144.

Workspace Functional Privileges
The following table describes the functional privileges that govern actions that
users can take against workspaces. The table also lists whether users are granted or
denied a functional privilege by default. System administrators and My webMethods
administrators can change the default permissions for users, groups, and/or roles. For
more information, see "Controlling the Workspace Functions a User Can Perform" on
page 358.

Functional
Privilege

By default,
the privilege
is...

Description

View
Workspaces

Granted Controls whether users can view workspaces.

My webMethods Server does not display the
Workspaces section on the Navigate tab of the My
webMethods navigation when a user is denied
the View Workspaces functional privilege.
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Functional
Privilege

By default,
the privilege
is...

Description

Note: Even when the View Workspaces functional
privilege is denied, if users have access to
the Workspace Management page, they can
search for and open workspaces. For more
information, see "Allowing Users to Access
the Workspace Management Page" on page
355 and "Opening a Workspace" on page
368.

Edit Workspaces Granted Controls whether users can add portlets to a
workspace.

My webMethods Server does not display the
Tools tab of the My webMethods navigation
when a user is denied the Edit Workspaces
functional privilege.

Note: Even when the Edit Workspaces functional
privilege is denied, users can still set
workspace properties, reposition portlets
in a workspace, set portlet properties, and
delete portlets from workspaces.

Create
Workspaces

Granted Controls whether users can create new
workspaces.

My webMethods Server does not display the
New tab in My webMethods when a user is
denied the Create Workspaces functional
privilege.

Import
Workspaces

Granted Controls whether users can import workspaces
that were previously exported to a file.

My webMethods Server does not display the
Import buon on the Workspace Management
page when a user is denied the Import
Workspaces functional privilege.

Expert
Workspace
Development

Denied Provides users with extra functionality that
they can use when building workspaces
and pages. Users with Expert Workspace
Development functional privilege have access
to additional properties and menu actions. For
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Functional
Privilege

By default,
the privilege
is...

Description

more information, see "Expert User Features for
Workspace Development" on page 358.

Controlling the Workspace Functions a User Can Perform
System administrators and My webMethods administrators can use the following
procedure to grant or deny users, groups, and/or roles the functional privileges
described in "Workspace Functional Privileges" on page 356.

To grant or deny users workspace functional privileges

1. Navigate to the Permissions Management page.

In My webMethods: Navigate > Applications > Administration > System-Wide >
Permissions Management.

As system administrator: Folders > Administrative Folders > Administration Dashboard
> Configuration > Permissions Management.

2. Use the Permissions Management page to select the users, groups, and/or roles with
which you want to work and to grant or deny the functional privileges.

To grant or deny workspace functional privileges, navigate to the following part
of the Permissions tree and grant or deny the privileges described in "Workspace
Functional Privileges" on page 356.

Functional Privileges > General

For instructions for how to use the Permissions Management page to set functional
privileges, see "Access Privileges and Functional Privileges" on page 144.

Expert User Features for Workspace Development
Expert users are users who have been assigned the Expert Workspace Development
functional privilege. For instructions for how administrators can assign this functional
privilege, see "Controlling the Workspace Functions a User Can Perform" on page
358.

Expert users have access to additional:

Workspace properties to beer manage the layout of a workspace. For more
information, see "Workspace Properties for Expert Users" on page 359.

Properties for portlets in a workspace to beer manage the content of portlets and how
they appear on the workspace. For example, expert users can set up a portlet so that
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its title bar does not display. For more information, see "Portlet Properties for Expert
Users" on page 362.

Portlet menu actions to:

Indicate that you want My webMethods Server to position a portlet when
rendering the workspace

Set permissions for portlets

For more information, see "Portlet Menu Options for Expert Users" on page 364.

Note: Expert users also see these additional properties and portlet menu options
when working with regular pages, not just workspaces.

Workspace Properties for Expert Users
General Tab

The workspace properties on the General tab are identical for users with and without
the Expert Workspace Development privilege. For information about these workspace
properties, see Working with My webMethods.

Layout Tab

The following table describes the workspace properties on the Layout tab. While
the Layout tab is available for both users with and without the Expert Workspace
Development privilege, some of the properties are only available for expert users.

Property Available for Description

View As expert users This property indicates whether you want to
view column, row, and portlet borders and
hidden portlet title bars.

Select End User if you do not want to view
borders or hidden title bars.

Select Expert User if you want to view
borders and hidden title bars.

Borders are helpful when you are
positioning portlets. Also, if you set a
portlet’s properties so that the title bar
is hidden, you must view the page as an
expert user to re-display the title bar so
that you can take action on that portlet, for
example, to move it or access its properties.
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Property Available for Description

Editable
Canvas

expert users This property indicates whether you want
users viewing the workspace to be able to
reposition and/or resize portlets.

Clear the Editable Canvas check box to
prevent users from inadvertently changing
the layout while using the workspace. If you
select a free form layout for the workspace,
a user can inadvertently change the page
simply by clicking a portlet.

Note: When the Editable Canvas check box is
selected, users can change the layout.
This is true even when users are denied
permissions to edit a workspace,
although they are prevented from saving
those edits. However, when the Editable
Canvas check box is cleared, all users are
prevented from changing the layout.

Columns all users This property specifies the layout to use
for the workspace. The layout defines how
the portlets within a workspace can be
positioned. You can define either a:

Column layout. In this layout, all the portlets
in a workspace are aligned in columns.
Portlets cannot overlap within a column.
You can define a workspace to have one,
two, three, or four columns.

Free Form layout. In this layout, you can
place portlets on the workspace in any
location. Portlets can overlap and even
completely cover one another. This is the
default for a new workspace.

Attributes expert users When using a column layout, this property
specifies aributes for the column that
you can use for your own use. Out-of-
the-box, My webMethods Server does not
provide functionality that uses the aributes.
However, you can write custom code that
takes advantage of the aributes.
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Property Available for Description

Width all users When using a column layout, this property
specifies the percentage of the workspace to
use for the width of the column.

Word Wrap all users When using a column layout, this property
specifies whether you want to wrap long text
lines within portlets to fit the column size.

Horizontal
Alignment

all users When using a column layout, this property
specifies how the portlets should be aligned
horizontally in the column.

Vertical
Alignment

all users When using a column layout, this property
specifies how the portlets should be aligned
vertically in the column.

CSS Class expert users When using a column layout, this property
specifies a CSS class to apply to the column.
Type the name of the class, omiing the
leading period. For example, type nav for
the “.nav” class.

Specify a CSS class defined by a CSS style
sheet included in the workspace, either the
CSS style sheet that is:

Used by the current skin

Included with a custom portlet in the
workspace content or the current shell

CSS Style expert users When using a column layout, this property
specifies a style to apply to the column.
Type any style that is valid for use in a CSS
file. For example, if you type border: 1pt
dashed red, a dashed red line appears as a
portlet border.

Skin
Background
Image

expert users When using a column layout, this property
specifies an image from the current skin to
use as the background image for the column.

Type the name of the skin property. For
example, to use the main logo image
from the skin, type images/logo.gif.
System administrators can determine



M
Even Header

Managing Workspaces in My webMethods Server

Administering My webMethods Server Version 9.8 362

Property Available for Description
the skin property name for an image
by accessing the skin editor (via the
Administration Dashboard > User Interface >
Skin Administration portlet) and locating the
image in the Images page. The skin property
is "images/" followed by the property name,
such as "images/logo.gif".

Note: To apply an image that is not in the
current skin, specify the standard CSS
background-image property in the CSS
Style field. You can also specify properties
in the CSS Style field to control how the
background is displayed, such as whether
it repeats, is centered, scrolls with the
page, etc.

Portlet Properties for Expert Users
General Tab

The portlet properties on the General tab are identical for users with and without the
Expert Workspace Development privilege. For information about these workspace
properties, see Working with My webMethods.

Preferences Tab

The Preferences tab is available for both users with and without the Expert Workspace
Development privilege. Not all portlets have a Preferences tab.

The properties on the Preferences tab are specific to each portlet and usually define the
information that My webMethods Server displays in the portlet. For example, for the
HTML Text tool you can specify the text to display in the portlet on the Preferences tab.

Layout Tab

The following table describes the portlet properties on the Layout tab. The Layout tab is
available for only users with Expert Workspace Development privilege.

Property Description

Attributes Aributes for your own use. Out-of-the-box, My webMethods
Server does not provide functionality that uses the aributes.
However, you can write custom code that takes advantage of the
aributes.
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Property Description

Width How wide to make the portlet. Specify the number of pixels to
use for the portlet width.

Height How tall to make the portlet. Specify the number of pixels to use
for the portlet height.

Titlebar Whether you want My webMethods Server to display the portlet
title bar. Select the check box to display the title bar; clear the
check box to hide the title bar.

Note: If you hide the title bar, use the View As property, which
is on the Layout tab of the workspace properties, to
temporarily view the title bar so that you can manipulate
the portlet on the workspace.

Border Whether you want My webMethods Server to display the portlet
border. Select the check box to display the border; clear the check
box to hide the border.

Note: If you hide the title bar, use the View As property, which
is on the Layout tab of the workspace properties, to
temporarily view the title bar so that you can manipulate
the portlet on the workspace.

Minimized Whether you want My webMethods Server to initially display
the portlet as minimized when it displays the workspace that
contains the portlet. Users can restore the portlet to view its
contents.

CSS Class A CSS class to apply to the portlet. Type the name of the class,
omiing the leading period. For example, type nav for the “.nav”
class.

Specify a CSS class defined by a CSS style sheet included in the
workspace, either a CSS style sheet that is:

Used by the current skin

Included with a custom portlet in the workspace content or the
current shell

CSS Style A style to apply to the portlet. Type any style that is valid for use
in a CSS file. For example, if you type border: 1pt dashed red,
a dashed red line appears as a portlet border
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Property Description

Skin
Background
Image

An image from the current skin to use as the background image
for the portlet.

Type the name of the skin property. For example, to use the
main logo image from the skin, type images/logo.gif. Expert
users can ask system administrators for information about the
properties available. System administrators can determine the
skin property name for an image by accessing the skin editor
(via the Administration Dashboard > User Interface > Skin
Administration portlet) and locating the image in the Images
page. The skin property is "images/" followed by the property
name, such as "images/logo.gif".

Note: To apply an image that is not in the current skin, specify the
standard CSS background-image property in the CSS Style
field. You can also specify properties in the CSS Style field to
control how the background is displayed, such as whether
it repeats, is centered, scrolls with the page, etc.

Metadata Tab

The Metadata tab is available only users with Expert Workspace Development privilege.
The properties on the Metadata tab are specific to each portlet and usually define the
information that My webMethods Server displays in the portlet.

Portlet Menu Options for Expert Users
The following table describes the additional portlet menu actions that are available only
for users with Expert Workspace Development privilege. Expert users can access these
actions by clicking Menu in the title bar of a portlet.

Action Description

Auto Position Defines how My webMethods Server positions the portlet when
rendering the workspace. If Auto Position is toggled:

On: My webMethods Server automatically positions the portlet,
ignoring any positioning information stored with the portlet.

Off: My webMethods Server uses positioning information stored
with the portlet to determine where to place the portlet on
the workspace. As a result, My webMethods Server uses the
location from when the workspace was last saved.

Permissions Sets permissions for how users can interact with the portlet
on the page. For more information about the permissions and
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Action Description
how to set them, see "Managing Permissions for an Individual
Resource" on page 146 and "Using Security Realms" on page 148.

Workspace Actions You Can Perform from the Workspace
Management Page
Use the Navigate > Applications > Administration > System-Wide > Workspace
Management page to perform actions against workspaces. By default, only My
webMethods administrators have access to the Workspace Management page. My
webMethods administrators can grant other users access to the Workspace Management
page; see "Allowing Users to Access the Workspace Management Page" on page 355.

The following table lists the actions you can take from the Navigate > Applications >
Administration > System-Wide > Workspace Management page.

Action For more information, see...

Search for workspaces "Performing a Keyword Search for
Workspaces" on page 366 and
"Performing an Advanced Search for
Workspaces" on page 366

Open a workspace in a new My
webMethods tab

"Opening a Workspace" on page 368

Add workspaces to your My
webMethods navigation

"Adding a Workspace to Your
Navigation" on page 368

Delete workspaces "Deleting a Workspace" on page 369

Rename workspaces "Renaming a Workspace" on page
369

Share workspaces with other users,
groups, and/or roles

"Sharing a Workspace" on page 370

Stop sharing workspaces with other
users, groups, and/or roles

"Unsharing Workspaces" on page
370

Set the general properties for a
workspace

"Seing the Properties of a Workspace"
on page 371
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Action For more information, see...

Export workspaces to a file "Exporting Workspaces" on page
371

Import workspaces from a file "Importing Workspaces" on page
372

Performing a Keyword Search for Workspaces
Use this search to find workspaces by specifying text found in the names, description,
or keywords of the workspaces. If you want to specify detailed search criteria, see
"Performing an Advanced Search for Workspaces" on page 366.

You can find workspaces for which you are the owner or shared workspaces for which
you have at least View Only permissions. My webMethods administrators can search for
workspaces owned by any users.

Note: For more information about sharing workspaces, see "Sharing a Workspace"
on page 370. For more information about workspace permissions, see
Working with My webMethods.

To perform a keyword search for workspaces

1. In My webMethods: Navigate > Applications > Administration > System-Wide > Workspace
Management.

2. Click the Keyword search tab if it is not already displayed.

Tip: For instructions for how to use the Advanced tab, see "Performing an
Advanced Search for Workspaces" on page 366. For instructions for
how to use the Saved and Options tabs, see Working with My webMethods.

3. In the text box, type one or more strings that are contained in the names of the
workspaces you want to find.

For more information about how to specify keywords and using special characters,
see Working with My webMethods.

4. Click Search.

My webMethods Server displays the search results in the Results panel (below the
Search panel).

Performing an Advanced Search for Workspaces
Use an advanced search to specify detailed criteria to search for workspaces.
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You can find workspaces for which you are the owner or shared workspaces for which
you have at least View Only permissions. My webMethods administrators can search for
workspaces owned by any users.

Note: For more information about sharing workspaces, see "Sharing a Workspace"
on page 370. For more information about workspace permissions, see
Working with My webMethods.

To perform an advanced search for workspaces

1. In My webMethods: Navigate > Applications > Administration > System-Wide > Workspace
Management.

2. Click the Advanced search tab if it is not already displayed.

Tip: For instructions for how to use the Keyword tab, see "Performing a
Keyword Search for Workspaces" on page 366. For instructions for how
to use the Saved and Options tabs, see Working with My webMethods.

3. In the Keywords field, optionally type text found in the names, description, or
keywords of the workspaces you want to find.

4. To specify detailed criteria, specify each criterion you want to use:

a. From the list, select a criterion you want to use:

If you select... Do this...

Name In the text box, type a string contained in the names of the
workspaces you want to find.

Description In the text box, type a string contained in the descriptions
of the workspaces you want to find.

Keyword In the text box, type a string contained in the keywords of
the workspaces you want to find.

Alias In the text box, type a string contained in the aliases
assigned to the workspaces that you want to use to find.

Type Select the type of workspaces you want to find from the
list.

Owner a. Click Browse.

b. Use the Select Users window to search for and select
the users whose workspaces you want to find. For
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If you select... Do this...
instructions for how to search for users, see Working with
My webMethods.

c. Click Apply.

Created Date In the Date Range list, select the date range you want to use
to search for workspaces that were created within the date
range you specify.

Modified Date In the Date Range list, select the date range you want to use
to search for workspaces that were modified within the
date range you specify.

b. To add another criterion, select Add and repeat this step.

5. In the Search Condition list, select:

AND if you want My webMethods Server to search for workspaces that meet all
the criteria you specify.

OR if you want My webMethods Server to search for workspaces that meet any
the criteria you specify.

6. Click Search.

Opening a Workspace
To view a workspace, you can open it in a new tab.

To open a workspace

1. Search for the workspaces that you want to open. For instructions, see "Performing a
Keyword Search for Workspaces" on page 366.

2. In the search results in the row for a workspace you want to open, click  and select
Open In New Tab.

Adding a Workspace to Your Navigation
You can add workspaces to the Workspaces section of your My webMethods navigation.
After adding a workspace, you can open it by simply clicking on its name in the
navigation.

When you add a workspace, you select the folder where you want the workspace to
appear. By default, the Workspaces section of the navigation has two folders, Recently
Added and My Workspaces. You can add additional folders. For instructions for how
to add additional workspace folders and also how to remove workspaces from the
navigation, see Working with My webMethods.
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To add workspaces to your navigation

1. Search for the workspaces with which you want to work. For instructions, see
"Performing a Keyword Search for Workspaces" on page 366 or "Performing an
Advanced Search for Workspaces" on page 366.

2. You can add workspaces to your navigation by performing either of the following:

In the search results, select the check box beside each workspace that you want to
add to your navigation, and click Add to Navigation.

In the row for a workspace you want to add to your navigation, click  and
select Add to Navigation.

3. In the Add to Navigation window, select the folder to which you want to add the
workspace.

4. Click Apply.

Deleting a Workspace
If you no longer need a workspace, you can delete it. If you want to save a backup of
the workspace before deleting it, you can export it to a file first. For instructions, see
"Exporting Workspaces" on page 371.

To delete workspaces

1. Search for the workspaces that you want to delete. For instructions, see "Performing
a Keyword Search for Workspaces" on page 366 or "Performing an Advanced
Search for Workspaces" on page 366.

2. If you want to notify users that share the workspace about the deletion, select the
Notify collaborators when a workspace is deleted check box.

3. You can delete workspaces by performing either of the following:

In the search results, select the check box beside each workspace that you want to
delete, and click Delete.

In the row for a workspace you want to delete, click  and select Delete
Workspace.

Renaming a Workspace
Use the following procedure to rename a workspace.

To rename a workspace

1. Search for the workspaces that you want to rename. For instructions, see "Performing
a Keyword Search for Workspaces" on page 366 or "Performing an Advanced
Search for Workspaces" on page 366.
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2. In the search results in the row for a workspace you want to rename, click  and
select Rename Workspace.

3. In the Rename Workspace window, type a new name in the New Name field.

4. Click Apply.

Sharing a Workspace
You can share workspaces with other users, groups, or roles. For details about sharing
workspaces, including permissions you can assign when sharing a workspace, see
Working with My webMethods.

To share a workspace

1. Search for the workspaces that you want to share. For instructions, see "Performing
a Keyword Search for Workspaces" on page 366 or "Performing an Advanced
Search for Workspaces" on page 366.

2. In the search results in the row for a workspace you want to share, click  and
select Share Workspace.

3. In the Workspace Sharing window click Add.

4. Use the Select Principal(s) window to search for and select the users, groups, and
roles with whom you want to share the workspace. When you are done, click Apply
to close the Select Principal(s) window. For more information about using the Select
Principal(s) window to search for users, groups, and/or roles, see Working with My
webMethods .

For each selected user, group, and/or role, My webMethods adds a row to the
Workspace Sharing window.

5. For each user, group, and/or role that you selected, select the permissions you want
to assign that user, group, or role from the list in the Permissions column. For more
information about the permissions you can assign, see Working with My webMethods .

6. If you want to notify the users affected by this change, select the Notify collaborators
when the workspace is shared or unshared check box.

7. Click Apply.

Unsharing Workspaces
Use the following procedure when you no longer want to share a workspace with a user,
group, or role.

To unshare a workspace

1. Search for the workspaces that you no longer want to share. For instructions, see
"Performing a Keyword Search for Workspaces" on page 366 or "Performing an
Advanced Search for Workspaces" on page 366.
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2. In the search results in the row for a workspace you want to unshare, click  and
select Share Workspace.

3. In the Workspace Sharing window, select the check box for the users, groups, and/or
roles with which you no longer want to share access to the workspace.

4. If you want to notify the users affected by this change, select the Notify collaborators
when the workspace is shared or unshared check box.

5. Click Delete.

6. Click Apply.

Setting the Properties of a Workspace
Use the following procedure to view and/or set the general properties for a workspace.

To set workspace properties

1. Search for the workspaces with which you want to work. For instructions, see
"Performing a Keyword Search for Workspaces" on page 366 or "Performing an
Advanced Search for Workspaces" on page 366.

2. In the search results in the row for the workspace for which you want to set
properties, click  and select Properties.

3. In the Workspace Properties window, update the general properties.

For a description of the general properties, see Working with My webMethods.

4. Click Apply.

Exporting Workspaces
You can export workspaces to save a copy of a workspace in a file. You can then import
the workspace into the same or another My webMethods Server.

You can use the export/import functionality if you want to migrate a workspace from
one My webMethods Server to another. You might also want to export a workspace to
save a copy before deleting a workspace; if you decide you need it again in the future,
you can then import it from the file.

To export workspaces

1. Search for the workspaces you want to export. For instructions, see "Performing
a Keyword Search for Workspaces" on page 366 or "Performing an Advanced
Search for Workspaces" on page 366.

2. In the search results, select the check box beside each workspace that you want to
export, and click Export.

3. In the Export Workspaces window, specify a file name for the file that will contain
the exported workspaces.
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4. If you also want to include information about how the workspaces are shared so that
information is set when you later import the workspaces, select the Include Shared
Settings check box.

5. Click Apply.

6. In the File Download window, click Save.

7. In the Save As window, select the location where you want to save the exported
workspaces file and click Save.

Importing Workspaces
If you have previously exported workspaces to a file, you can import them into My
webMethods Server.

My webMethods Server imports the workspace into the personal folder of the user that
performed the import. It is possible for multiple users to import the same workspace.
Each time a workspace is imported, My webMethods Server creates a copy of the
workspace, with all its content, into each user’s personal folder. A user’s personal folder
is located within Folders > Users; you can view it using the system administrator user
interface.

To import workspaces

1. In My webMethods: Navigate > Applications > Administration > System-Wide > Workspace
Management.

2. In the Result panel, click Import.

3. In the Import Workspaces window, click Browse.

4. In the Choose File to Upload window, navigate to and select the .cdp file that
contains the workspaces you want to import and click Open.

5. In the Import Workspaces window, click Apply.

About the My webMethods Tools Navigation
To add content to a workspace, you add tools to the workspace. The Tools tab in the My
webMethods navigation lists the tools that you can add. You add a tool by dragging it
onto the workspace canvas. For more information about adding content to a workspace,
see Working with My webMethods.

When you add a tool to a workspace, My webMethods adds a new portlet to the
workspace that is specific to the added tool. Out-of-the-box, several tools are provided
for end users. For information, see "Workspace Tools Available by Default" on page
373.

System administrators can replace the existing tools taxonomy with a custom taxonomy,
which can include additional tools or have some of the standard tools removed. For
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more information, see "Customizing the My webMethods Workspace Tools" on page
373.

Workspace Tools Available by Default
My webMethods provides tools for the end user to incorporate into a workspace. The
tools are available in the Workspace Tools section of the Tools tab in the My webMethods
navigation pane.

The following tools are available by default. For a description of each of these tools and
their behavior, see the PDF publication Working with My webMethods:

Tool Use to...

Attachments Enables the user to aach files to a workspace.

Bookmarks Enables the user to add links to other workspaces and to web
sites.

Directory Browser Enables the user to find identification information about
other My webMethods users.

HTML Text Enables the user to add formaed text to a workspace.

Image Enables the user to add an image to a workspace.

Note Enables the user to add simple, unformaed text to a
workspace.

User Calendar Enables the user to add a user’s calendar to a workspace.

Note: It is possible to log in as sysadmin and customize the Workspace Tools list.
Also, if you are working with an upgraded installation of My webMethods
Server, some tools may be present that have been deprecated or removed with
newer versions.

Customizing the My webMethods Workspace Tools
System administrators can update the My webMethods tools navigation to modify or
completely replace the standard My webMethods tools with a custom taxonomy.

In your customization, you can use existing tools, including the default tools that are
listed on the Tools tab of the system administrator user interface when in editing a page.
Many of the available system administrator page editing tools are described in the My
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webMethods Server Portlet Reference. You can also add custom tools that you create and
deploy to My webMethods Server.

Note: Tools are portlets. You can create portlets using Software AG Designer.

To customize the My webMethods Workspace Tools navigation

1. As system administrator, create a new folder that will be the tools root folder and
will hold your custom taxonomy. Add the new folder to this location: Folders >
System > Palee Registry.

2. If you want sections in your tools taxonomy, create folders in your custom tools root
folder. The name you assign each folder will become a section name on the Tools tab
of the My webMethods navigation.

3. To add existing tools to your taxonomy, use the Administration Dashboard >
Content > Publish portlet to publish instances of folders, forms, links, or portlets into
the custom tools taxonomy.

For example, you can publish existing tools that are available to My webMethods
Server system administrators when in page editing mode.

4. If you want to include custom tools, create them and save them in a folder within
your custom tools root folder.

A tool can be any portlet. You can create custom tools using Software AG Designer
and then deploy them to My webMethods Server.

5. Configure the properties of the Leftnav page that My webMethods Server uses for
the My webMethods navigation to point it to you new, custom tools root folder.

a. Navigate to this location: Folders > System > Shell Sections > Noodle Shell
Leftnav > Leftnav.

b. In the row for the Leftnav page, select Tools > Properties.

c. In the Tools Root field, type the name you assigned your custom tools root folder.

Note: The name you specify in the Tools Root field must be a folder or page
that resides in Folder > System > Palee Registry.

d. Click Apply.
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What are Skins?
The look and feel of a page is encapsulated in a skin. You can associate a skin with a
particular user or group, in which case they view the contents of a page using that skin.
You can associate a skin with a particular folder hierarchy. All users who view pages
within that hierarchy view them using the skin.

When you customize a skin, you can modify its look, such as to:

Brand the page with your own corporate logo

Change the color scheme to match your corporate colors

Adopt a look and feel similar to the one used within your company

As a system administrator, you can perform simple customization of skin properties
(images, colors, and fonts) using the Skin Administration page of My webMethods
Server. To perform more sophisticated customization, you need to directly edit the
components that define the skin.

My webMethods Server offers a variety of ways to configure personalization rules that
dictate what skin is displayed for a given user, group, or resource. See "Managing Skin
Rules" on page 305.

How Skins Use Inheritance
A skin can inherit properties from a parent skin. When you create a customized skin,
first make a copy of an existing skin. Through inheritance, you need only identify the
ways the custom skin is different from its parent.

Inheritance for skins follows these rules:

A skin can have only one parent, but the parent skin can also have a parent. In this
way, a skin could have a list of ancestors from which it inherits properties.

A parent skin can have any number of children that inherit properties from it.

Each skin has a skin.properties.xml file that lists the properties the skin does not
inherit from its parent. In turn, if this skin has a child skin, the child inherits these
modified properties.

The skin.properties.xml file also can contain a "parent" property that identifies the
parent of the skin.

In addition to the properties in the skin.properties.xml file, a child also inherits the
stylesheets and HTML fragments of the parent skin.

If a skin does not have a parent identified in the skin.properties.xml file, it inherits
the properties of the My webMethods Server default skin, which is identified by the
skin.default alias.
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Choosing How Much Customization to Use
When you customize skins, the preferred method is to create a new skin inherited from
an existing skin and then modify the new skin. Do not modify the skins that are installed
with My webMethods Server. When you create a new skin and then export it for editing
outside the server, you can then deploy it to every server where it is to be used.

You can use one or more of the following techniques to do customization from the
simple to the complex:

Modify fonts, colors, and images

The Skin Administration page enables you to create and delete custom skins, and
modify the use of images, colors, and fonts. This is the only method of customization
you can use without exporting a skin and editing files that make up the skin
package. See "Using the Skin Administration Page" on page 381.

Even if you plan to make more extensive modifications, you can create a custom
skin, make changes to fonts, colors, or images in the Skin Administration page, and
then export the skin for further editing.

Use an extended.css file ("Cascading Style Sheet Definitions" on page 397) to
modify skin properties you cannot manage with the Skin Administration page.

This customization is suitable if you want to make small modifications to existing
properties in a skin package. To use an extended.css file, you need to define it in the
skin.properties file of the skin.

Use a skin.properties.xml file "The Skin Properties File" on page 391) if you want
to modify values of existing properties but are not adding new properties to the
custom skin.

For example, you can change the value for a font or color already defined in a parent
skin. In this case, the skin.properties.xml file overrides properties in the parent skin,
but continues to use the CSS of the parent.

Use an extended.csi file (dynamic CSS file) ("Cascading Style Sheet Definitions" on
page 397) to add new CSS classes to the custom skin. To use an extended.csi file,
you need to define it in the skin.properties file of the skin.

Using an extended.csi file to create new classes is the simplest way to add new styles
to a custom skin.

For definitions of CSS and dynamic CSS files, see "Cascading Style Sheets" on page
396

To create a new skin from an existing skin, see "Creating and Modifying a New Skin" on
page 378.

To export a skin from to your computer for editing, see "Exporting a Skin to Your
Computer" on page 379.
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How Do I Know What to Modify?
If modifications to a custom skin package are to be more extensive than you can achieve
using the Skin Administration page (fonts, colors, and images), you need to know what
properties or CSS classes you want to modify from among the hundreds of properties
that exist in a skin package. One way to do this is to use a browser developer tool such
as the Firebug Add-on for Mozilla Firefox.

Open My webMethods Server in the browser and navigate to a page that uses the
skin package you want to examine. Using the developer tool, you can explore the user
interface and determine the CSS classes used to display it. With this knowledge, you
override values in the parent skin through the use of extended.css or extended.csi files in
the custom skin.

Creating and Modifying a New Skin
As a system administrator, you can create a skin with the Skin Administration page.
After you have created the new skin, you can customize it using the Skin Administration
page or by manually editing the skin package.

To create a new skin

1. As system administrator: Administration Dashboard > User Interface > Skin Administration >
Create New Skin.

2. In the System Name field, type a short name that contains only leers, numbers, and
the underscore character.

This name is used internally by the server.

3. In the Display Name field, type the skin title that you want users to see.

This name has no character restrictions.

4. From the Parent Skin list, choose the skin from which the new skin will inherit any
unspecified properties.

The system default skin is selected by default.

5. Click Create.

A new skin initially inherits all of its properties (colors, fonts, and images) from its
parent. You can modify the new skin, changing just a single property, such as adding
a new header logo, or you can modify the skin to create a radical new look and feel
with completely different colors, fonts, and images.

Having created a new skin, you can begin to customize it by doing one or more of the
following:

Modify the use of images, colors, and fonts, described in "Using the Skin
Administration Page" on page 381.
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Note: You should make any planned changes in the Skin Administration page
before using either of the manual editing techniques.

Export the skin for manual editing, described in "Exporting a Skin to Your
Computer" on page 379.

Import the skin into Designer for manual editing, described in "Using Designer to
Modify Skin Packages" on page 380.

Example:

Assume you want to create a new skin from the parent skin Pearls.

1. As system administrator: Administration Dashboard > User Interface > Skin Administration >
Create New Skin.

2. In the System Name field, type a name such as wm_skin_carbon.

3. In the Display Name field, type the skin title, Carbon Sailing Skin.

4. From the Parent Skin list, choose the Pearls skin.

This is the skin from which the new skin will inherit any unspecified properties.

5. Click Create.

Exporting a Skin to Your Computer
If you intend to modify a skin package using the Skin Administration page ("Using the
Skin Administration Page" on page 381), you should do so before performing manual
editing.

As a system administrator, you can use the Skin Administration page to export a skin
package to your computer for manual editing. The skin package is a zip file with a .skin
file extension.

Tip: Another way to perform manual editing on a skin package is to import the
skin into Designer. See "Using Designer to Modify Skin Packages" on page
380.

To export a skin

1. As system administrator: Administration Dashboard > User Interface > Skin Administration >
Create New Skin.

2. Click the Tools icon  for the skin to be exported and then click Export.

3. Choose the Save File option and click OK.

My webMethods Server downloads the file to the default download destination for
your browser.

4. Unzip the skin package so you can perform manual editing.
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Using Designer to Modify Skin Packages
If you intend to modify a skin package using the Skin Administration page ("Using the
Skin Administration Page" on page 381), you should do so before exporting the file
and performing manual editing.

One way to modify files in a custom skin package is to import the skin into Software AG
Designer and make changes in the UI Development perspective. You can export the skin
package directly from My webMethods Server, edit CSS, dynamic CSS, or XML files, and
then deploy the skin back to the server without unzipping the skin package.

Note: This topic is not intended to provide details of working in Software AG
Designer. For specific information on working in the MWS Admin and
Servers views of Designer, see the Composite Application Framework online
help.

To modify custom skin packages in Designer

1. In the MWS Admin view of the UI Development perspective, connect to the instance
of My webMethods Server (create a data provider) that contains the custom skin
package.

The MWS Admin view contains a tree view of folders and other My webMethods
Server assets.

2. Expand the Skins folder, right-click the custom skin package and click Import/Export >
Extract Asset into Project.

3. In the Extract Asset into Project wizard, click New.

4. In the Project Name field, type the name of the skin package exactly as it appears in
the MWS Admin view and click Finish twice.

Designer creates an MWS Skin Project and extracts the assets of the skin package into
it.

5. Use either the Navigator view or Project Explorer view to locate CSS, dynamic CSS,
or XML files in the skin project, and open the files in a text editor.

6. To deploy the skin package to an instance of My webMethods Server, use the Servers
view to connect to the server and then publish the skin package.

To test the skin package, you need to create a skin rule that will trigger the use of the
custom skin. See "Managing Skin Rules" on page 305.

Note: Do not test the skin package using the Preview Server in Designer. That
server instance does not have the skin rules needed to properly display the
skin.
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Using this technique, you can make incremental changes and publish the results to the
server periodically for confirmation. Associate the custom skin with a test page so you
can perform design work without affecting other users.

Using the Skin Administration Page
The Skin Administration page of My webMethods Server enables you to create and
delete custom skins, and modify the use of images, colors, and fonts. To use the
Skin Administration page, you must either have the system administrator grant you
permission to access the page, or you must log in as the system administrator.

If you want to do more extensive customization than is available through the Skin
Administration page, you may still find it convenient to create the custom skin on this
page before making modifications.

You can perform the following functions on the Skin Administration page:

These functions... Are described here...

Create a new skin. "Creating and Modifying a New Skin"
on page 378

Delete an existing skin. "Deleting a Skin" on page 382

Replace images in a skin with images
from your local drive, from an existing
skin, or from a website.

"Replacing Images in a Skin" on page
382

Replace colors in a skin using a color
picker.

"Replacing Colors Using a Color
Picker" on page 383

Replace colors in a skin from an
existing skin or from a website.

"Replacing Colors from a Skin or
Website" on page 385

Replace font values in a skin using a
picker.

"Replacing Fonts Using a Picker" on
page 386

Replace font values in a skin from a
website.

"Replacing Fonts from a Web Site" on
page 388

Preview changes made to a skin using
pages not in the My Folders, Home
Page, or Public Folders folders.

"Previewing a Page Elsewhere on the
Server" on page 390
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My webMethods Server applies any changes you changes you make to images, colors, or
fonts to the skin.properties.xml file that is part of the skin package.

Deleting a Skin
As a system administrator, you can delete a skin with the Skin Administration page.

To delete a skin

1. As system administrator: Administration Dashboard > User Interface > Skin Administration.

2. To delete a skin, click the Tools icon  and then click Delete.

Replacing Images in a Skin
The skin of a page contains images, such as logos, that help shape the appearance and
structure of the page. Using the Skin Administration page, you can replace images in a
skin with images from your local drive, images from an existing skin, or images from a
website.

To replace an image in a skin

1. As system administrator: Administration Dashboard > User Interface > Skin Administration.

2. To modify a skin, click the Tools icon  and then click Edit.

3. Click Images.

4. Click the skin property for the image you want to replace.

The property is highlighted with a red box.

5. Depending on the source of the image, do one of the following:

If the image source is... Do this...

On the local drive In the Picker panel, click Choose File. Browse to the new
image, click Open, and then click Upload. To replace the
image, click .

Part of an existing
skin

In the Select palette list, select the skin from which you
want to copy the image. Select the new image and click

.

On a website In the Select palette list, select URL, type the website
URL and click OK. Select the new image and click .

6. Click Preview.

The preview demonstrates how your changes have affected the skin.
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Tip: To preview a page other than My Folders, My Home Page, or Public
Folders, see "Previewing a Page Elsewhere on the Server" on page 390.

7. Close the Preview window and click Save.

Example:

Assume you have the Carbon Sailing skin installed and want to change from the
webMethods logo to the Carbon Sailing logo, carbon-logo.png, which exists on your
local file system.

1. As system administrator: Administration Dashboard > User Interface > Skin Administration.

2. Click the Tools icon  for the Carbon Sailing Skin and click Edit.

3. Click Images.

4. Click the logo.gif skin property.

The property is highlighted with a red box.

5. In the Picker panel, click Choose File, browse to the carbon-logo.png image, click
Open, and then click Upload.

The new image appears in the Picker panel.

6. To replace the image, click .

7. In a similar way, select the banner-bg.gif property and replace the image with the
carbon-bg.jpg file.

The resulting combination results in a complete banner.

8. In the Preview panel, choose My Home Page from the list and click Preview.

9. Close the Preview window and click Save.

Replacing Colors Using a Color Picker
There are a number of different color seings in a skin that affect different parts of a
page. To change seings, you select colors in the skin editor, apply the colors to skin
properties, and preview your changes.

To replace the color of a skin property using a color picker

1. As system administrator: Administration Dashboard > User Interface > Skin Administration.

2. To modify a skin, click the Tools icon  and then click Edit.

3. Click Colors.

4. Click the skin property for which you want to replace the color.

The skin property is highlighted with a red box.

5. In the Picker panel, click the color to be used as a replacement.
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The selected color appears in the horizontal bar at the boom of the Picker panel, and
the hexadecimal value appears in the # field at the top.

Tip: If you know the hexadecimal value of the replacement color, you can type
it directly in the # field.

6. To save a color to the Scratchpad panel, click the down arrow directly beneath the
Picker panel.

Tip: If you want lighter and darker shades of a particular color for use in
foregrounds and backgrounds, save the color in the Scratchpad panel and,
in the vertical bar on the right edge of the Picker panel, click above or
below the original color. Save multiple colors to the Scratchpad.

7. To set the color for a skin property, click  from either the Picker panel or the
Scratchpad panel.

8. At the boom of the page, click Preview.

The preview demonstrates how your changes have affected the skin.

Tip: If the page is not in one of the folders labeled My Folders, My Home Page,
or Public Folders, see "Previewing a Page Elsewhere on the Server" on
page 390.

9. Close the Preview window.

10. Click Save.

Example:

Assume you have created the Carbon Sailing skin as described in "Creating and
Modifying a New Skin" on page 378 and want to change the colors used for buons.

1. As system administrator: Administration Dashboard > User Interface > Skin Administration.

2. To modify a skin, click the Tools icon  and then click Edit.

3. Click Colors.

4. Click the button - button text skin property.

5. In the Color field of the Picker panel, replace the default color (BUTTON if the parent
skin is Pearls) by typing FFFFFF.

6. Click  from the Picker panel.

The check box in the Inherited column is cleared, indicating this skin property is no
longer inherited from the parent skin.

7. Click the button-bg - button background skin property.

8. In the Picker panel, replace the default color by typing 9EB6C7.

9. Click  from the Picker panel.
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10. In a similar way, replace the remaining buon color properties with these values:

Property Value

button-border - button border 668899

button-border-light - button border BBDDEE

button-hover - button text FFFFFF

button-hover-bg - button background 4C7499

buon-hover-border - buon border 395874

button-hover-border-light - button border ABC9D8

button-disabled - disabled button text C5C7C7

button-disabled-bg - disabled button background FFFFFF

button-disabled-border - disabled button border C5C7C7

11. At the boom of the page, click Preview.

Default buon:

New color:

New hover color:

Final buon:

The final buon includes font changes made in "Replacing Fonts Using a Picker" on
page 386.

12. Click Save.

Replacing Colors from a Skin or Website
You can replace the color of a skin property using color values from an existing skin or
from a website.
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To replace the color of a skin property using a color from a skin or a website

1. As system administrator: Administration Dashboard > User Interface > Skin Administration.

2. To modify a skin, click the Tools icon  and then click Edit.

3. Click Colors.

4. Click the skin property for which you want to replace the color.

The skin property is highlighted with a red box.

5. Depending on the source of the color, do one of the following:

If the color source is... Do this...

Part of an existing
skin

In the Select palette list, select the skin from which you
want to copy the color. Select the new image and click

.

On a website In the Select palette list, select URL, type the website
URL and click OK. Select the new color and click .

6. At the boom of the page, under the Preview heading, click Preview.

The preview demonstrates how your changes have affected the skin.

Tip: If the page is not in one of the folders labeled My Folders, My Home Page,
or Public Folders, see "Previewing a Page Elsewhere on the Server" on
page 390.

7. Close the Preview window.

8. Click Save.

Replacing Fonts Using a Picker
There are a number of different font seings in a skin that affect different parts of a page.
To change seings, you select font seings in the skin editor, apply the seings to skin
properties, and preview your changes.

Note: Font properties used by individual skins can vary. The properties described in
the following sample procedure may not be available in all skins.

To replace the font settings using a picker

1. As system administrator: Administration Dashboard > User Interface > Skin Administration.

2. To modify a skin, click the Tools icon  and then click Edit.

3. Click Fonts.
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4. Click the skin property for which you want to replace the font seings.

The skin property is highlighted with a red box.

5. In the Picker panel, click the color to be used as a replacement.

You can make changes to a variety of font values:

Font settings Selections

Font-family Font family. You can select first through tenth choice, enabling
the browser to use fonts available on the computer.

Font-size Select from a list of relative size values or specify a numeric
value.

Font-style Select bold, italic, or underline.

Capitalization Select from a list of capitalization styles.

Text-spacing Specify values to be used for leer spacing, word spacing, and
line height.

6. To set the font values for a skin property, click  from either the Picker panel or the
Scratchpad panel.

7. At the boom of the page, click Preview.

The preview demonstrates how your changes have affected the skin.

Tip: If the page is not in one of the folders labeled My Folders, My Home Page,
or Public Folders, see "Previewing a Page Elsewhere on the Server" on
page 390.

8. Close the Preview window.

9. Click Save.

Example:

Assume you have created the Carbon Sailing skin as described in "Creating and
Modifying a New Skin" on page 378 and want to change the font values used for
buons.

1. As system administrator: Administration Dashboard > User Interface > Skin Administration.

2. To modify a skin, click the Tools icon  and then click Edit.

3. Click Fonts.

4. Click the button - button text skin property.
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5. Under Font-family, in the Primary list, select the Tahoma font.

6. In the Primary list, select the sans-serif.

7. Under Font-style, select Bold.

8. Click  from the Picker panel.

The check box in the Inherited column is cleared, indicating this skin property is no
longer inherited from the parent skin.

9. At the boom of the page, click Preview.

Default buon:

New font value:

Final buon:

The final buon includes color changes made in "Replacing Colors Using a Color
Picker" on page 383.

10. Click Save.

Replacing Fonts from a Web Site
In controlling the font families used by a skin, you have the choice of designing the
style yourself or selecting a set of font families used by another Web site. The following
procedure presents a scenario describing how you might go about capturing and using
families from another site.

Note: Font properties used by individual skins can vary. The properties described in
the following sample procedure may not be available in all skins.

To replace the font families used by a skin with the font families used by another Web site

1. As system administrator: Administration Dashboard > User Interface > Skin Administration.

2. To modify a skin, click the Tools icon  and then click Edit.

3. Click Fonts.

4. On the Select palette list, select URL, type the Web site URL and click OK.

The Palee displays a list of font families derived from the Web site.

5. In the Palee on the lower-right side of the page, find a line that seems to represent
the normal body text of the Web site, and select it.

This action should result in several font families being listed in the Picker panel. If
not, try some other lines in the palee that look like normal body text.
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6. Click  directly above the Palee.

This action saves the font information to the Scratchpad panel for later use.

7. In the line you just created in Scratchpad panel, select the text in the edit field and
rename it to something meaningful, such as my regular text.

8. In the Skin Properties list on the left side of the page, select the regular skin property.

The regular skin property is highlighted with a red box, meaning it is selected for
editing.

9. To set the regular skin property, click  from the Scratchpad panel.

This action sets the regular skin property with the value selected in the Scratchpad
panel.

10. In the Skin Properties list on the left side of the page, select the bold skin property.

The bold skin property is highlighted with a red box.

11. In the Scratchpad panel, select my regular text.

Because the my regular text scratchpad item was already the active item in the
Scratchpad panel (with a dark red border around it), selecting it again makes it the
active item for the page (with a bright red border around it), and loads the my regular
text font information back into the Picker panel.

12. In the Font-style area of the Picker panel, select the Bold check box.

13. Click  from the Picker panel.

This action sets the bold skin property with the value in the Picker panel.

14. In the Skin Properties list, click the small skin property.

15. In the Scratchpad panel, select my regular text.

16. In the Font-size area of the Picker panel, do one of the following:

If this option is selected... Do this...

Relative size Change the value in the list to be a size smaller than the
existing size

Numeric size Edit the number in the field to be a value two or three
smaller than the existing size

17. Click the arrow directly to the left of the Picker panel.

18. In the Skin Properties list, select the medium skin property.

19. In the Scratchpad panel, select my regular text.
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20. In the Preview list at the boom of the page, choose Public folders and then click
Preview.

The preview demonstrates how your changes have affected the skin.

Tip: If the page is not in one of the folders labeled My Folders, My Home Page,
or Public Folders, see "Previewing a Page Elsewhere on the Server" on
page 390.

21. Close the preview window.

22. Click Save.

Previewing a Page Elsewhere on the Server
You can preview a page other than My Folders, My Home Page, or Public Folders in the
skin editor.

To preview a page elsewhere on the server

1. Make changes to skin properties within Skin Administration.

2. In thePreviewlist at the boom of the page, chooseURL.

3. Open a new browser window, navigate to the server, navigate to the page you want
to preview.

4. In theAddressbar of the browser, select the URL and type CTRL+C to copy it.

5. Return to the Script Prompt dialog from the first browser and paste in the URL by
typing CTRL+V.

6. ClickOK.

7. ClickPreview.

Make-up of a Skin Package
There are two ways to make a skin package available for editing.

"Exporting a Skin to Your Computer" on page 379

"Using Designer to Modify Skin Packages" on page 380

With a skin package exposed for editing, you can see the files and directories that make
up the package:

The skin.properties.xml file describes the components implemented by the skin. You
can modify fonts, colors, and images using the Skin Administration page, but for
other skin components, you need to edit the skin properties file directly. For more
information, see "The Skin Properties File" on page 391.



M
Odd Header

Customizing Skins

Administering My webMethods Server Version 9.8 391

If you have created a new skin in My webMethods Server but not yet made any
changes, the only property in the file may be the parent skin from which all
properties are inherited.

The skinDeploy.xml file contains deployment information for the skin package. For
more information, see "The Skin Deployment File" on page 395.

The css directory. Cascading Style Sheets (CSS) describe the properties that make
up a skin. A generated CSS for a skin is derived from the skin.properties.xml file
as modified by other style sheet files. For more information, see "Cascading Style
Sheets" on page 396.

If you have created a new skin in My webMethods Server but not yet made any
changes, there may be no Cascading Style Sheets in the directory because all
properties are inherited from the parent skin. If you add or modify stylesheets, you
should place them in this directory.

The components directory. This directory contains proprietary files you are not
likely to modify as part of a skin package.

The images directory. If you add or modify images used in the skin, you should
place them in this directory.

The Skin Properties File
The skin.properties.xml file describes the components implemented by the skin. Any
changes you make to a skin using the Skin Administration page ("Using the Skin
Administration Page" on page 381) are reflected in the skin.properties.xml file for the
skin. The base.csi file for a skin references the properties in the skin.properties.xml file
for use when My webMethods Server generates the base.css file.

The Importance of the Skin Properties File
The base.csi file for a skin references properties defined in the skin.properties.xml file.
My webMethods Server uses the base.csi file to generate the base.css file that governs
how the skin is displayed. This is a powerful mechanism that enables you to create new
skins based on a common ancestor by specifying images, fonts, and colors in a new
skin.properties.xml file without having to re-create a new stylesheet for each skin.

In the following examples, the Pearls skin is the a parent. No CSS (.css or .csi) change is
required in the custom skin.

Replacing images

You can change the banner background image in a custom skin by modifying the value
of the images/banner-bg.gif property in the skin.properties.xml file for the custom
skin.
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File Contents

parent
skin.properties.xml

<property> 
     <name>images/banner-bg.gif</name> 
     <value>images/dot.gif</value> 
     <description>banner background</description> 
</property>

parent base.csi
background-image: url(@skin images/banner-bg.gif;);

child
skin.properties.xml

<property> 
    <name>images/banner-bg.gif</name> 
    <value>images/carbon-bg.jpg</value> 
</property>

Also, see "How do I replace one image with another?" on page 394.

Globally replacing fonts

You can globally change the fonts used in a custom skin by modifying the value of the
fonts/regular property in the skin.properties.xml fil

e for the custom skin.

File Contents

parent
skin.properties.xml

<property> 
    <name>fonts/regular</name> 
    <value>font-family: tahoma, sans-serif; 
        font-size: 0.7em;</value> 
    <description>standard text</description> 
</property>

parent base.csi @skin fonts/regular;

child
skin.properties.xml

<property> 
  <name>fonts/regular</name> 
  <value>font-family: Georgia, 'Times New Roman', 
    Times, serif; font-size: 1em; font-size: 0.7em; 
  </value> 
  <description>standard text</description> 
</property>

Globally replacing colors

You can globally change the colors used in a custom skin. In this example, the colors/
section-body-border property controls the color of row borders. One change in the
skin.properties.xml file for the custom skin, affects seven properties in the base.csi file.

File Contents

parent
skin.properties.xml

  <property> 
    <name>colors/section-body-border</name> 
    <value>#ccc</value> 
    <description>row border</description> 
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File Contents
</property>

parent base.csi
.tbl { 
    border: @skin sizes/section-body-border; 
        solid @skin colors/section-body-border;; 
    . 
    . 
}

child
skin.properties.xml

  <property> 
    <name>colors/section-body-border</name> 
    <value>#dfe6ec</value> 
    <description>row border</description> 
</property>

Also, see "How do I modify colors?" on page 394.

Making Entries in a Skin Properties File
If you edit the skins.properties.xml file manually, you do not need to include
components inherited from one of the skin’s ancestors. Rather, you need only include
modifications to inherited components. A good way to see the properties that describe
a skin is to export the parent skin package using the method described in "Exporting
a Skin to Your Computer" on page 379, unzip the skin package, and examine the
skin.properties.xml file.

Note: Modifying the skin properties in the skins.properties.xml file requires CSS
expertise.

The skin.properties.xml file is made up of property elements, each describing a
component of the skin. The property elements have this format:
<property> 
    <name>property_name </name> 
    <value>property_value </value> 
    <description>optional_description </description> 
</property>

The following guidelines apply to the property element:

If the value is the same as the name, you can omit the value.

The description is optional.

You can add comments using standard XML comment syntax:
<!-- This is a comment -->

A skin component can have multiple properties associated with it. For example, the
banner that appears at the top of a My webMethods Server page has over twenty
properties that determine its appearance, such as:

Color, position, and padding of the background
Color, font, and weight of link text, selected links, including hover characteristics
Images and their positioning
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To see the properties that describe a skin, export the pearls skin package using the
method described in "Exporting a Skin to Your Computer" on page 379, unzip the
skin package, and examine the skin.properties.xml file. The following examples describe
a few ways to modify properties.

How do I specify a parent skin?

To make the development of a custom skin easier, you need to specify a parent skin
from which the custom skin inherits its properties. A skin can have only one parent skin.
In the following example, the skin.properties.xml file specifies the pearls skin package as
the parent of the custom skin:
<!-- parent skin; all unspecified properties are inherited --> 
<property> 
    <name>parent</name> 
    <value>skin.wm_skin_pearls</value> 
    <description>parent skin</description> 
</property>

How do I replace one image with another?

To replace one image with another, you first need to move a copy of the new image into
the images directory for the skin package. Then you need to locate the property for the
image in the skins.properties.xml file.

For example, perhaps you want to rebrand the page by changing the logo image that
appears in the left side of the banner. The new image has the name my_logo.png.
 <!-- images --> 
<property> 
    <name>images/logo.gif</name> 
    <value>images/my_logo.png</value> 
    <description>header logo</description> 
</property>

How do I modify colors?

The topic "Replacing Colors Using a Color Picker" on page 383 shows several colors
modified in the Skin Administration page. The same changes look like this in the
skin.properties.xml file.
<property> 
    <name>colors/button</name> 
    <value>#FFFFFF</value> 
    <description>button text</description> 
</property> 
<property> 
    <name>colors/button-bg</name> 
    <value>#9EB6C7</value> 
    <description>button background</description> 
</property> 
<property> 
    <name>colors/button-border</name> 
    <value>#668899</value> 
    <description>button border</description> 
</property> 
<property> 
    <name>colors/button-border-light</name> 
    <value>#BBDDEE</value> 



M
Odd Header

Customizing Skins

Administering My webMethods Server Version 9.8 395

    <description>button border</description> 
</property> 
<property> 
    <name>colors/button-hover</name> 
    <value>#FFFFFF</value> 
    <description>button text</description> 
</property> 
<property> 
    <name>colors/button-hover-bg</name> 
    <value>#4C7499</value> 
    <description>button background</description> 
</property> 
<property> 
    <name>colors/button-hover-border</name> 
    <value>#395874</value> 
    <description>button border</description> 
</property> 
<property> 
    <name>colors/button-hover-border-light</name> 
    <value>#ABC9D8</value> 
    <description>button border</description> 
</property> 
<property> 
    <name>colors/button-disabled</name> 
    <value>#C5C7C7</value> 
    <description>disabled button text</description> 
</property> 
<property> 
    <name>colors/button-disabled-bg</name> 
    <value>#FFFFFF</value> 
    <description>disabled button background</description> 
</property> 
<property> 
    <name>colors/button-disabled-border</name> 
    <value>#C5C7C7</value> 
    <description>disabled button border</description> 
</property>

How do I add Cascading Style Sheets?

You can add multiple style sheets to a skin.properties.xml file. For more information, see
"Adding Stylesheets to a Skin Package" on page 399.

The Skin Deployment File
The skinDeploy.xml file contains deployment information for the skin package. This
deployment information is contained entirely as aributes of the root wm_xt_skin
element.

Note: It is unnecessary to make any modifications to this file for a newly created
custom skin package.

These are the aributes of the wm_xt_skin element in the skinDeploy.xml file
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Attribute Description

name The name of the skin package.

alias A comma-separated list of aliases to the skin as used
by My webMethods Server.

description The display name for the skin as it appears in the user
interface.

version The version number of the skin. When you modify
and release the skin package, you should increment
the minor version number.

cssPreview A semicolon-separated list of CSS style declarations
that demonstrates the style on an html element in the
user interface.

serversideResourcePath A legacy aribute. The value of this aribute should
always take the form /ui/skins/skin-name/ where
skin-name is the skin's system name.

clientsideResourcePath A legacy aribute. The value of this aribute should
always take the form /ui/skins/skin-name/ where
skin-name is the skin's system name.

Example

The Carbon Sailing skin package used as an example elsewhere in this guide has a
skinDeploy.xml file that looks like this:
<wm_xt_skin name="wm_skin_carbon" 
    alias="skin.wm_skin_carbon,skin.carbon" 
    description="Carbon Sailing Skin" 
    version="1.0" 
    cssPreview="color:#fff; background-color:#6f6f60;" 
    serversideResourcePath="/ui/skins/wm_skin_carbon/" 
    clientsideResourcePath="/ui/skins/wm_skin_carbon/"> 
</wm_xt_skin>

Cascading Style Sheets

Note: Modifying the files described in this topic requires CSS expertise.

When My webMethods Server displays a page, the skin for that page uses a Cascading
Style Sheet (CSS) that describes all of the properties making up the skin. My
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webMethods Server generates this base CSS at the time you deploy the skin package to
the server and every time the server starts. The generated CSS file is based on properties
that can be provided from a number of sources:

Properties inherited from a hierarchy of parent skins

A skins.properties.xml file that is part of the skin package

One or more CSS or dynamic CSS files in the skin package

My webMethods Server uses dynamic CSS files to reference property values in the
skin.properties.xml file and place them in the generated base.css file for a skin package.
See "How Dynamic CSS Files Work" on page 398.

Cascading Style Sheet Definitions

base.css
The primary CSS for a skin package. A base.css file most often exists only as a generated
CSS file, having been defined by other sources in the skin package or its parent. The
base.css can be modified by one or more extended CSS or dynamic CSS files. It is not
recommended that you create a base.css file for a custom skin package, but if you do
so, define it in the skin.properties.xml file. You cannot define both a base.css file and a
base.csi file in the same custom skin package.

extended.css
A secondary CSS for a skin package. Entries in the extended CSS file override the
base.css file. You can have multiple extended CSS files, such as to provide browser-
specific CSS values. Extended CSS files, each with a different name, are defined in the
skin.properties.xml file.

base.csi
A dynamic CSS file that references properties in the skin.properties.xml file ("How
Dynamic CSS Files Work" on page 398). As a result of the base.csi file, the
generated base.css file contains properties from the skin.properties.xml file. The
skin.properties.xml file for a top-level skin package (one that has no parent) describes all
properties that make up a skin. If there is no base.csi file in a skin package, it is inherited
from a parent skin. The base.csi file is defined in the skin.properties.xml file. You cannot
define both a base.css file and a base.csi file in the same custom skin package.

extended.csi
A secondary dynamic CSS file for a skin package ("How Dynamic CSS Files Work"
on page 398). Entries in the extended.csi file override the base.csi file. You can
have multiple extended.csi files, such as to provide browser-specific CSS values. the
extended.csi files, each with a different name, are defined in the skin.properties.xml file.

How Do I Choose Which Type of Stylesheet to Modify?

Use these guidelines in determining which stylesheet to use:

Use an extended.css file to make selected modifications to a custom skin that is not
significantly different from the parent skin on which it is based. An extended.css file
overrides:



M
Even Header

Customizing Skins

Administering My webMethods Server Version 9.8 398

The base.css or base.csi file in the parent skin package

If you define an extended.csi file for a custom skin, the classes in it override only the
corresponding classes in the base.css or base.csi file of the parent skin.

Use an extended.csi file to change selected references to a skin.properties.xml file,
either in the custom skin package or in its parent. An extended.csi file overrides:

The base.csi file in the parent skin package

The base.csi file in the custom skin package, if you have created one.

Using an extended.csi file to create new classes is the simplest way to add new styles
to a custom skin.

As an alternative to defining extended.css files in the skin.properties.xml file, you
can use import statements to include them in an extended.csi file. For example, the
following statements cause two CSS files to be included during generation of the
base.css for a skin:
@import url(@skin css/general.css;);#" 
@import url(@skin css/dialog_styles.css;);#

Use a base.csi file if you have made extensive modifications to the skin.properties file
in the custom skin package that require a revised set of references. A base.csi file is
required in any skin package that does not have a parent skin package.

If you define a base.csi file for a custom skin, it completely overrides any base.css
or base.csi file in the parent skin. If the custom base.csi file contains a subset of the
classes defined for the parent skin, the generated base.css file will contain only that
same subset of classes.

How Dynamic CSS Files Work
My webMethods Server replaces skin property references in a dynamic CSS file with
property values in the skin.properties.xml file and places them in the generated base.css
file for a skin package. A top-level skin package (one that has no parent) typically has no
base.css file, instead using the base.csi file to create the generated base.css file.

Used in custom skin packages, this feature makes it possible to create new skins based
on a common ancestor by simply specifying skin properties in a new skin.properties.xml
file. If you make simple modifications to the skin.properties.xml file that do not require
changes to the dynamic CSS file, you can use the base.csi file inherited from the parent
skin. If you make more extensive modifications, you may have to create an extended.csi
file to properly reference the changed or added properties.

Note: Modifying the files described in this topic requires CSS expertise.

Dynamic CSS files make use of at-rules (or @rules) to reference properties in the local
skin.properties.xml file or properties inherited from the parent skin. For example, if your
base.csi file contains this rule:
body { 
      @skin fonts/regular; 
      color: @skin colors/text;; 
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      background-color: @skin colors/text-bg;; 
      direction: @skin dir/text;;}

and the skin.properties.xml files contains these property definitions:
<property> 
  <name>fonts/regular</name> 
  <value>font-family: trebuchet; font-size: 20px;</value> 
</property> 
<property> 
  <name>colors/text</name> 
  <value>#000</value> 
</property> 
<property> 
  <name>colors/text-bg</name> 
  <value>#fff</value> 
</property> 
<property> 
  <name>dir/text</name> 
  <value>ltr</value> 
</property>

the generated base.css file will contain this rule:
body { 
      font-family: trebuchet; font-size: 20px; 
      color: #000; 
      background-color: #fff; 
      direction: ltr; 
}

If you create a base.csi or extended.csi file for use with a skin package, you need to
declare it in the skin.properties.xml file, as described in "Adding Stylesheets to a Skin
Package" on page 399.

Adding Stylesheets to a Skin Package
You can use CSS and dynamic CSS files to modify the generated base.css file for a
skin package. To add a CSS or dynamic CSS file to a skin package, you define it in the
skin.properties.xml file for the custom skin package. Each stylesheet is defined in a
property element having this form:
<property> 
   <name>css/name .css</name> 
   <value>css/name.extension </value> 
   <description>optional
description </description> 
</property>

If the file name in the <value> element is the same as the <name> element, you can omit
the <value> element.

If the skin.properties.xml file does not have property element for a stylesheet, it inherits
the stylesheet in the parent skin.

Note: When you add or modify a stylesheet, you should place it in the css directory
of the skin package.
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Example: base.css

Note: We do not recommend that you create a base.css file for use in a custom skin
package. However, you can use the syntax here to compare with the examples
that follow.

You can have only one base.css element in the skin.properties.xml file. In the following
example, you could omit the <value> element because it is identical to the <name>
element.
<property> 
   <name>css/base.css</name> 
   <value>css/base.css</value> 
</property>

Example: base.csi

If you want to make extensive changes that override the base.csi file of a parent skin, you
might create a new base.csi file and define it in the custom skin package. In this case, the
<name> element is base.css and the <value> element is base.csi, as shown here:
<property> 
   <name>css/base.css</name> 
   <value>css/base.csi</value> 
</property>

Example: extended.css or extended.csi

The rules for extended.css and extended.csi files are the same as those for base.css:
<property> 
   <name>css/extended.css</name> 
   <value>css/extended.css</value> 
</property>

or:
<property> 
   <name>css/extended.css</name> 
   <value>css/extended.csi</value> 
</property>

Example: Multiple extended.css or extended.csi Files

A skin.properties.file can have properties for multiple extended.css or extended.csi files
at the same time. One use for this capability is to provide browser-specific properties.
<property> 
   <name>css/extended.css</name> 
   <value>css/extended.csi</value> 
</property> 
<property> 
   <name>css/ie6.css</name> 
   <value>css/ie6.csi</value> 
   <description>special ie6 stylesheet rules</description> 
</property> 
<property> 
   <name>css/ie7.css</name> 
   <value>css/ie7.csi</value> 
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   <description>special ie7 stylesheet rules</description> 
</property>
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What are Shells?
My webMethods Server derives the content and layout of the header and footer of
a page from the content and layout of the current shell's Header and Footer folders.
When the server renders one page, it is actually displaying the contents of up to five
folders at once: the shell's Header, the shell's Leftnav, the requested page, the shell's
Rightnav, and the shell's Footer. The server displays the content of the requested page as
individual portlets, but it renders the content of shell sections without title bars, borders,
or additional spacing. You can apply Cascading Style Sheet (CSS) classes and styles
to the rows and columns that compose the shell sections, as well as specify the exact
dimensions of those rows and columns, to further customize the layout of the shell.

The Titlebar shell section applies a title bar to each portlet on the page, which includes
the display name and buons for controlling the portlet. You can hide the Titlebar shell
section individually for each portlet.

You can create and modify a shell with the Shell Administration page. To use the
Shell Administration page, you must either have the system administrator grant you
permission to access the portlet, or you must log in as the system administrator.

Creating a New Shell
The first step in constructing a new shell is to create it using an existing shell as a parent.
A new shell initially inherits all of its properties from its parent. These properties (or
shell sections) are: Header, Footer, Leftnav, Rightnav, and Titlebar. You can replace any
of these sections with a new, custom shell section.

To create a new shell

1. As system administrator: Administration Dashboard > User Interface > Shell Administration
> Create New Shell.

2. In the Name field, type a name for the shell.

This name has no character restrictions.

3. (Optional) In the Description field, type a description of the shell.

The description appears in the list of shells on the Shell Administration page.

4. From the Parent Shell list, choose the shell from which the new shell will inherit any
unspecified properties.

The system default shell is selected by default.

5. Click Create.
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Modifying a Shell
After you have created a new shell from a parent shell, you can modify individual
sections of that shell independently to construct a new shell.

To modify a shell

1. As system administrator: Administration Dashboard > User Interface > Shell Administration.

2. To modify a shell, click the Tools icon  and then click Properties.

3. If you want to change the display name for the shell, in the Display Name field, type a
new name for the shell.

4. If you want to change the parent shell from which to take the various shell sections,
in the Parent list, choose the parent shell. The list contains shells that currently exist
on the server.

5. For each shell section, choose the parent or source for the section from among these
choices:

Choose this option... To do this...

Inherited To use the shell section from the shell chosen in the Parent
Shell field.

Portal Page (Not available for the Titlebar shell section.) To use the
content of an existing folder for the shell section, move the
folder to the Selected Items box and then click Select.

Portlet (Titlebar shell section only.) To use an existing portlet,
move the portlet to the Selected Items box and then click
Select.

6. For shell sections that you want to edit, take one of the following actions:

To accomplish this... Do this...

Edit a shell section inherited from
another shell

With the Inherited option selected, click
Clone from Parent.

The server creates a folder based on the
inherited shell section.

Edit an existing folder used as a
shell section

With the Portal Page option selected,
make sure the name of the target folder
is displayed.



M
Even Header

Working with Shells in My webMethods Server

Administering My webMethods Server Version 9.8 406

Note: Within the server, you cannot edit portlets. You need to use Software AG
Designer.

7. Click Edit.

The folder that represents the shell section opens in edit mode.

8. Modify the shell section just as you would any other folder.

9. Click Save.

Inserting Extra Tags into the HTML <head> Element
You can insert JavaScript libraries and stylesheets into the <head> element of a shell. The
valid HTML tags are <link>, <meta>, <script>, and <style>.

To insert into the HTML <head> element

1. As system administrator: Administration Dashboard > User Interface > Shell Administration.

2. To modify a shell, click the Tools icon  and then click Properties.

3. In the Extra Tags for HTML <head> field, type the HTML tags that add custom code to
the shell. For example:
<link href="default.css" rel="stylesheet" type="text/css"

4. Click Save.

Using an Alias with a Shell Section
If a folder has an alias, you can use the alias to select it for use as a shell section. For
information about using aliases with folders, see "Managing Aliases" on page 270.

To select a shell section using an alias

1. As system administrator: Administration Dashboard > User Interface > Shell Administration.

2. To modify a shell, click the Tools icon  and then click Edit.

3. In the shell section you want to associate with an alias, click Use Alias.

4. In the Alias Name field of the server resource selector, type the alias of the folder you
want to use for this shell section.

5. To determine if the server can find the alias, click Test.

6. If the server correctly resolves the alias, click Select.

7. If needed, you can clone this folder or edit it directly, as described in "Modifying a
Shell" on page 405.

8. Click Save.
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Deleting a Shell
After it is no longer needed, you can delete a shell.

To delete a shell

1. As system administrator: Administration Dashboard > User Interface > Shell Administration.

2. To delete a shell, click the Tools icon  and then click Delete.

Making an Empty Shell Section
A shell always has the four folders that make up the shell sections. You may, however,
want a shell design in which one or more of the shell sections is empty and takes up
no space in the display. A shell section is empty if it contains no portlets and has no
formaing information associated with it. In the default shells provided with My
webMethods Server, the Leftnav and Rightnav shell sections display as being empty.

You cannot edit the Titlebar shell section as you do the others. To hide the title bar, you
need to set the Titlebar aribute for individual portlets to No.

To make a shell section (other than a Titlebar) empty

1. As system administrator: Administration Dashboard > User Interface > Shell Administration.

2. To modify a shell, click the Tools icon  and then click Edit.

3. In the Alias Name field of the resource selector, type the alias shell.section.blank.

4. To determine if the server can find the alias, click Test.

5. If the server correctly resolves the alias, click Select.

6. Click Save.
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M
Index

Administering My webMethods Server Version 9.8 416

HTTP certificate file location
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HTTP Header Authentication
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HTTP Listener, configuring  30, 30,
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HTTPS client, My webMethods
Server as 36
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maximum memory limit 68

JVM 68
UNIX or Linux 68

Memory Monitor diagnostic tool 267
memorydump command line
diagnostic tool 266
Microsoft SQL Server 101
Microsoft SQL Server data source
101
Microsoft SQL Server databases,
adding as a data source 101
migrating server content to other
server instances 288
modifying

alias for a server resource 274
data source 107
permissions 144
polling interval 278
portlet properties in a page 334
rules 302
shells 405

Monitor and HTTP listener 30
moving

portlets on a page 330
multi-home machines, configuring
single IP address 78
multiple instances of My
webMethods Server 29
mws.db.xml file 184
My webMethods

add selections to the navigation
338
allowing externally-defined users
access to 96
allowing users access to 158
applying a custom look-and-feel
348
changing the colors in the user
interface 344
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changing the logo in the user
interface 343
custom front-end with links to
selected pages 348
hiding sections and tabs in the
navigation 340
removing selections from the
navigation 339
replacing the navigation 341
using 7.x look-and-feel 345

My webMethods Administrator
description 85
initial password  22, 85
user ID  22, 85

My webMethods Administrators role
156
My webMethods Server

command syntax, simple 55
diagnostic tools 266
guidelines for multiple instances
29
logging into 24
logging out of 25
roles

Admin Role 156
My webMethods Administrators
156
My webMethods Users 156

starting as a Windows service 23
stopping as a Windows service 24

My webmethods Server database
connection retries 184
My webMethods Users role 156
My webMethods Users role,
purpose of 157

N
nodes

creating from an image 193
partitioning 194

non-default JDK or JRE, specifying
32
Notification Attribute Provider 213
Notification role, clusters 175

notifications, configuring an email
server 108
NTLM authentication

configuring 234
defined 219
disabling 234

NTLMv2 authentication
configuring 235
disabling 236

O
opening

workspaces 368
Oracle data source 102
Oracle databases, adding as a data
source 102
OSGi bundles 292

P
partitions

configuration files 195
creating 198
default configuration 198
defined 194
guidlines 195
reasons for 194
viewing in the user interface 202

password complexity policy, system
directory service 242
passwords

changing 26
clearing from memory 236
generating encrypted 39
retaining in memory 237

Perfo rmance Analysis diagnostic
tool 267
Performance Statistics diagnostic
tool 267
permissions

add Principal 147
adding to resources 142
modifying  144, 147
remove Principal 148

phaseProvider.xml file 196
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phaseProvider.xml file , overriding
198
polling interval, modifying 278
Portal Developer Commands
Security Realm 149
Portal Developer user, description of
85
portlets

add alias to 335
adding to a page 329
aliases, managing 335
edit alias 335
general properties for expert
users 362
layout properties for expert users
362
menu actions for expert users 364
modifying properties in a page
334
positioning on a page 330
remove alias from 335
removing from a page 330
wiring 336

Portlets.properties file 197
ports, listener 30
positioning portlets on a page 330
previewing a portal page elsewhere
on the server 390
Principal Attribute Providers 208
profile

updating 26
User Information tab 26

properties, page
General tab 324
Layout tab 326
setting 324

properties, portlet
General tab 331
Layout tab 332
Metadata tab 334
Preferences tab 331
setting 334
Wiring tab 334

Public Commands Security Realm
149
Publish page, configuring 290
putconfig command 71

Q
query groups across directory
services 93

R
rearranging Principal Attribute
Providers in Profile 215
reasons for cluster partitioning 194
rebuilding search indexes 291
redirection whitelist

adding servers to 34
managing 33
removing servers from 34

remove Principal from permissions
148
removing

containers 151
portlets from a page 330
Principal Attribute Provider from
Profile 216
resources from Security Realms
153
rules 305
Security Realms 152
selections from the My
webMethods navigation 339
users to certificates in My
webMethods 45

renaming
containers 151
Security Realms 153
workspaces 369

rendering rules
creating  301, 301
defined 295

re-ordering
dynamic attributes 168
search order of directory services
99
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replacing
colors created in a color picker
383
colors from a skin or Web site 385
keystore 38
My webMethods navigation 341

request, setting a shell for 310
response header rules

changing evaluation order 245
copying 245
creating 243
modifying 244
removing 245
viewing 243

Restricted Commands Security
Realm 149
retaining passwords in memory 237
role cache lifecycle, configuring 74
role Information 210
roles

accessing with CDS API 312
Admin Role 156
changing order of dynamic
attributes 168
clusters 175
creating types 158
database role, description 159
definition 156
deleting 166
dynamic attributes

changing order 168
default value 166
deleting 168
user-specific 167

LDAP query 160
LDAP query role description 158
membership

about 156
dynamic 156
editing 165
static 156
types 156
ways to define 156

My webMethods Administrators
156
My webMethods User, purpose of
157
My webMethods Users 156
rule based role

description 158
saved searches

creating 114
deleting 117
modifying 116
using 115

searching for 112
static 159
static role, description 158
static, adding 159

rollover, log-file 255
rule-based roles

description 158
rule-based roles, adding 161
rules

copying 304
creating skin 306
disabling 303
evaluation criteria 304
locale 294
login page 294
modifying 302
removing 305
rendering 295
shell 295
skin 295
start page 295

S
sagdemoca.jks file 38
SAML

configuring a target 281
links on a source page 282

SAML Authentication Administration
page, using 281
saved searches, creating 114
schema, Events Collector page 265
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Search Administration page,
configuring 291
search engine (Lucene)
management 291
search indexes

rebuilding 291
search role, assigning in a cluster
182
Search role, clusters 175
searching

certificates in My webMethods 42
exporting search results to .csv
file 117
for aliases 272
for workspaces  366, 366
group information 112
role information 112
user information 112

Security Assertion Markup
Language (SAML) 223
security audit logging, managing
262
Security Provider URI, SAML 282
Security Realms

adding resources 153
Administrative Commands 149
Developer Commands 149
Directory Management
Commands 149
Directory Service Commands 149
Public Commands 149
removing 152
removing resources 153
renaming 153
Restricted Commands 149
User Profile Management
Commands 150

Security Realms Administration
page, using 148
server authorization 223
server configuration, changing 28
server repository, managing  188,
289
server resources

add Principal to permissions for
147
creating aliases 271
modify permissions 147
modifying an alias for 274
remove Principal from
permissions 148
view and change owner 146

Session Monitor page, configuring
263
session, setting a shell for 310
setenv.sh, run in 32- or 64-bit mode
73
setting logging thresholds  250, 252
setting maximum file size 290
setting workspace general
properties 371
setup, system directory service 86
sharing workspaces 370
shell rules, defined 295
shells

aliases with 406
creating new 404
creating rules for 308
custom tags in <head>element
406
deleting 407
empty sections 407
managing rules for 307
modifying 405
setting for a request 310
setting for a session 310
sticky 310

simple search for aliases 272
simple start and stop commands 55
single IP address for HTTP listeners

GLUE Web services registry 76
JCR Repository RMI server 77
SOAP Monitor portlet 77

single IP address for HTTP
listeners, Jetty 76
single IP address for multi-home
machines 78
single sign-on
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Artifact Parameter Name
(Deprecated) 282
Assertion Parameter Name 282
configuring a target 281
described 281
links for 349
links on a source page 282
Security Provider URI 282

Skin Administration page,
configuring 305
skin package 379
skin rules, defined 295
skin.properties.xml file 391

format of property elements 393
modify colors 394
replace images 394
specify parent skin 394
the importance of 391

skinDeploy.xml file 395
skins

creating new 378
creating rules for 306
defined 376
deleting 382
exporting to a computer 379
font families

replacing from a Web site 388
replacing using a picker 386

how much customization to use
377
images, replacing 382
inheritance in 376
knowing what to modify 378
modifying in Designer 380

SOAP Monitor portlet, configuring
single IP address 77
Solaris, 32- or 64-bit mode 73
specifying allowed file extensions
290
specifying non-default JDK or JRE
32
splash page behavior, extending
221
start page rules 299

start page rules, defined 295
starting

My webMethods Server
command syntax, simple 55

starting My webMethods Server as a
Windows service 23
static roles

adding 159
description 158
editing members 159

status, cluster 186
sticky shells 310
stopping My webMethods Server

command syntax, simple 55
stopping My webMethods Server as
a Windows service 24
storage locations, managing  188,
289
Sybase Adaptive Server data source
103
Sybase Adaptive Server databases,
adding as a data source 103
System Admin user, description 85
system directory service

accessing with CDS API 312
adding groups 134
adding users 122
allowing users access to My
webMethods 158
assigning users to a group 131
definition 84
deleting users 132
group information 135
groups, searching for 112
password complexity policy 242
setup 86
user information 125
users

allowing access to My
webMethods 158
searching for 112

systemPaths.properties file, change
logging directory 261
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T
Task Engine role 175
threaddump command line
diagnostic tool 266
truststore 38

U
uninstalling portlets, Install
Administration page 280
Universal Messaging Server

JMS provider 180
UNIX, maximum memory limit 68
unsharing workspaces 370
update information for My
webMethods Server 53
updatesinfo command 53
updating

configuration of external
directories 98
dynamic attributes order 168
roles 165
search order of directory services
99

URL redirection 33
URL to access My webMethods 25
User Attribute Provider 211
user calendars, managing 110
User Information

system directory service 125
User Information tab 26

changing password 26
user information, editing 210
user locale, determining 294
User Preferences 128
User Preferences Attribute Provider
210
User Profile 126
user profile information, viewing 263
User Profile Management
Commands Security Realm 150
users

accessing with the CDS API 313

adding to the system directory
service  122, 313
allowing access to My
webMethods 96
assign to group (system directory
service) 131
deleting (system directory service)
132
disabling login (system directory
service) 124
editing information for 124
internal system directory
service, allowing access to My
webMethods 158
locating the home folder 132
managing 121
overview of 120
saved searches

deleting 117
modifying 116
using 115

saved searches, creating 114
searching for 112

V
viewing

details of certificates in My
webMethods 43
user profile information 263

Viewing
cluster partitions 202

W
Web server integration 48
webMethods System user 86
whitelist

redirection
adding servers to 34
managing 33
removing servers from 34

wiring
global 337
one portlet to another 336
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principal attributes to portlet
properties 337

workspaces
adding to My webMethods
navigation 368
customizing available tools 373
deleting 369
expert users 358
exporting 371
functional privileges 356
general properties for expert
users 359
granting access to Workspace
Management page 355
granting and denying functional
privileges 358
importing 372
layout properties for expert users
359
opening 368
renam ing 369
searching for  366, 366
setting general properties of 371
sharing 370
standard tools 373
unsharing 370

wrapper.conf file 64
wrapper.conf.template file 64
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